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i
 Introduction
W elcome to the PaymentNet® User Guide. This guide is written for corporate 
card program administrators and explains how to set up and customize 

PaymentNet. This guide also contains information cardholders should understand in 
order to use the system.

The introduction explains how to find and use information in this guide and provides 
instructions for sending feedback to J.P. Morgan.

To get started using PaymentNet, first time users should read this introduction and 
then read Chapter 1, “Getting Started” on page 19.

The introduction explains the following:
 Obtaining Technical Assistance
 Conventions Used in this Guide
 Related Publications
 Related Applications
 Sending Feedback to J.P. Morgan
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Obtaining Technical Assistance
As a starting point for all questions, refer to this user guide first. Questions can be 
resolved by following the instructions in this guide. 

If you are a cardholder, support is provided by either your program administrator or 
by the J.P. Morgan Cardholder Product Support team. If you are a program 
administrator, support is provided by the J.P. Morgan Client Application Support 
team.

This section explains the following topics:
 Cardholder Support
 Program Administrator Support

Cardholder Support
If after reviewing this guide you still have questions, or if you encounter any system 
problems as you use the product, contact your program administrator. If you can 
access PaymentNet, go to the Contact Information icon on the PaymentNet 
navigation bar.

If you need further assistance, contact J.P. Morgan Cardholder Services by calling the 
number on the back of your J.P. Morgan card. If you don’t have a card, please 
contact J.P. Morgan Cardholder Services at 1-800-270-7760.

Program Administrator Support
If after reviewing this guide you still have questions about your card program, please 
contact your J.P. Morgan program coordinator. If you have additional questions about 
PaymentNet, please contact J.P. Morgan Client Application Support at  
1-855-886-7638.
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Conventions Used in this Guide 
This guide uses specific typographical conventions to describe how to use J.P. Morgan 
products. Please be aware of the following conventions when reading this guide.

 Table 1: Typographic Conventions 

Convention Example Description

Bold Text Click Submit or press Enter. In step-by-step instructions, the names of 
menus, buttons, and fields in the user 
interface, or keys on the keyboard, display in 
bold typeface.

Greater Than ( > ) Select File > New from the 
menu.

In step-by-step instructions, the menu path 
and menu selection display in bold typeface 
with embedded greater than symbols.

Related Publications
The PaymentNet documentation set includes:
 PaymentNet User Guide
 PaymentNet Online Help

In addition, Quick Reference Cards are available for various PaymentNet topics. To 
obtain a related PaymentNet document, contact your J.P. Morgan program 
coordinator.

Related Applications
Depending on how your J.P. Morgan Commercial Card program is set up, you may 
have access to additional J.P. Morgan applications. For example, if you are a 
PaymentNet user who is also a cardholder, you may have access to the J.P. Morgan 
Commercial Card mobile website. The mobile website provides anytime, anywhere 
access to your account balances and transactions from a mobile device.

Before logging on to the J.P. Morgan Commercial Card mobile website, you must 
already have access to PaymentNet and have completed your PaymentNet profile.
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To access the J.P. Morgan Commercial Card mobile website from a mobile device, 
visit: m.jpmorgan.com/card.

Sending Feedback to J.P. Morgan
It is the goal of J.P. Morgan to provide you with accurate and useful documentation. 
We welcome your feedback and will use it to improve future versions of this guide. 
To provide feedback, send an email message with your comments to:

wcp.business.communications@jpmchase.com.

Please include the J.P. Morgan product name and version number, documentation 
topic title, publication date, and a brief description and context of the suggestion.
PaymentNet User Guide
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1
 Getting Started
T his chapter provides information to help new PaymentNet users get started. This 
chapter covers the specifications required for PaymentNet to operate on your 

computer, explains how to log on and how to log out, and provides an overview of 
the common user interface items available throughout the system.

PaymentNet is available 24 hours a day, seven days a week except during scheduled 
maintenance. Maintenance occurs each week from 8 p.m. ET Saturday through 
1 a.m. ET Sunday.

This chapter explains the following sections:
 PaymentNet Specifications
 Logging On
 Logging Out
 Understanding the User Interface
 Navigating PaymentNet
 Data Retention
19
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PaymentNet Specifications
To optimize system performance and provide a high level of security, PaymentNet 
requires adherence to specific set up protocols and security standards. The following 
list outlines requirements to use the full functionality available in PaymentNet.

Note: The list of required system components may change. You will receive notification of 
any updates as they occur.

 List 1: Required System Components 

Processor Pentium® or Celeron® 500 MHz processor (minimum)

Operating System Microsoft Windows XP (SP2), Windows 7.

Internet Browser Microsoft Internet Explorer® 8.0, 9.0, and Firefox® 3.6, 10.

Browser Requirements
Configure your Internet browser to accommodate the following:
 Enable JavaScript
 Allow cookies
 Turn off pop-up blocking in your browser and within any other security 

software on your computer
 Verify your selected browser supports AES 128-bit encryption security
 Keep your “Trusted Root Authorities” up-to-date. For example, MSIE 

users can get more information here: http://www.microsoft.com/
downloads/details.aspx?FamilyID=f814ec0e-ee7e-435e-99f8-
20b44d4531b0

 Support EV SSL (Extended Validation SSL) certificates
 Adjust cache settings (temporary Internet files) to automatically check 

for updated versions of stored pages. For MSIE instructions, see:  
http://www.microsoft.com/windows/ie/ie6/using/howto/
customizing/clearcache.mspx#EAF

Additional Software  Adobe® Acrobat® Reader® 4.0 or higher  
Reader is available for free at http://get.adobe.com/reader

 Any file decompression software (for example, WinZip®)

Memory 512 Mb RAM (minimum), 1 GB RAM (recommended)

Storage Capacity 300 Mb available free space after installation of operating system and 
browser (minimum), 500 Mb (recommended)

Communication Direct Internet connection 
PaymentNet works best over broadband connections; dial-up connections 
are not recommended for performance reasons.
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Logging On
Logging On
In order to access PaymentNet, you must navigate to the PaymentNet Log On screen 
and enter your organization ID, assigned user ID, and temporary password. To obtain 
log-on credentials, contact your program administrator.

When you log on for the first time, PaymentNet prompts you to change your 
password. Once you set up a new password, PaymentNet automatically registers your 
computer.

You are required to change your password every 90 days. PaymentNet prompts you to 
change your password when it expires and you cannot log on until the password is 
changed.

The PaymentNet Log On screen times out after 15 minutes of inactivity. If your 
session times out, close the Internet browser window and open a new browser 
window.

This section explains the following topics:
 Logging On for the First Time
 Logging On with a Temporary Password
 Logging On from a Registered Computer
 Logging On from an Unregistered Computer
 Forgot Your Password?

Monitor/Resolution SVGA 1024 x 768 resolution, 256-color (minimum)

Spam Blocking Check with your company or organization technical support department 
to verify the following email addresses and domains are not blocked:

E-mail Addresses:
 no.replies@paymentnet.jpmorgan.com
 jpmorgan.access@jpmorgan.com

Domains:
 paymentnet.jpmorgan.com
 jpmchase.com
 chase.com
 jpmorgan.com

 List 1: Required System Components (continued)
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Logging On for the First Time
Before you log on to PaymentNet, you must first obtain your organization ID, user ID, 
and temporary password. If you do not have this information, contact your program 
administrator.

The first time you log on to PaymentNet, you must change your temporary password 
and establish your authentication questions. If you do not, your account will be 
disabled.

Your temporary password expires after 90 days. The password expiration period can 
also be modified at the organization level to expire at 120 or 150 days. If your 
password expires, contact your program administrator to have it reset.

To log on for the first time:

1. Using your Internet browser, navigate to the following address:
https://www.paymentnet.jpmorgan.com
PaymentNet displays the Log On screen.

2. Complete the following fields on the Log On screen:
 Organization ID: Enter your organization ID (e.g., us12345). The 

organization ID is assigned by J.P. Morgan and is unique to your 
organization.

 User ID: Enter your user ID. The user ID is assigned by your program 
administrator and uniquely identifies you within your organization.

 Password: Enter your case-sensitive temporary password. The password is a 
security feature that prohibits unauthorized access to PaymentNet. Your 
initial password is assigned by J.P. Morgan and may only be used once. You 
must change your password the first time you log on to the system.

3. Select the Remember my Organization ID checkbox. PaymentNet saves your 
organization ID so you do not have to enter it each time you log on.

Note: If you access PaymentNet from a public computer, J.P. Morgan discourages 
selecting this option.

4. Click Log On.
PaymentNet registers your computer to your user ID.
PaymentNet User Guide
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5. Complete the following fields on the Password Setup: Change Password screen. 
If you do not complete this step, your account is disabled.
 Organization ID: Reenter your organization ID.
 User ID: Reenter your assigned User ID.
 New Password: Enter a new password. Passwords are case sensitive and 

must conform to the password constraints that display above these fields.
 Re-enter New Password: Reenter your new password.

6. Click Next. 
PaymentNet displays the Password Setup: Complete screen.

7. Click Next. 

8. Complete all five questions on the Select Authentication Questions screen. The 
screen indicates that only three questions are required, but J.P. Morgan 
recommends that you complete all five questions. If you forget your password, 
these questions allow you to request a temporary password.

9. Click Submit.
PaymentNet displays the Welcome screen.

Logging On with a Temporary Password
If you have successfully logged on to PaymentNet in the past, complete the steps in 
this section. Alternately, you can complete these steps if you are using a temporary 
password obtained either from your program administrator or through the password 
reset process described in “Forgot Your Password?” on page 27.

Your temporary password is deactivated after three failed attempts to log on. If your 
temporary password is deactivated, follow the instructions in “Forgot Your 
Password?” on page 27 to request a new temporary password. Once you receive a 
new temporary password, log on by completing the steps below.

To log on with a temporary password:

1. Using your Internet browser, navigate to the following address:
https://www.paymentnet.jpmorgan.com
PaymentNet displays the Log On screen.
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2. Complete the following fields on the Log On screen:
 Organization ID: Enter your organization ID (e.g., us12345). The 

organization ID is assigned by J.P. Morgan and is unique to your 
organization.

 User ID: Enter your user ID. The user ID is assigned by your program 
administrator and uniquely identifies you within your organization.

 Password: Enter your case-sensitive temporary password. The password is a 
security feature that prohibits unauthorized access to PaymentNet. Your 
temporary password may only be used once and must be changed the first 
time you log on to the system.

3. Select the Remember my Organization checkbox. If you are accessing 
PaymentNet from a public computer, J.P. Morgan recommends that you do not 
select this option.
PaymentNet saves your organization ID.

4. Click Log On.
PaymentNet registers your computer to your user ID if you are logging on from 
an unregistered computer.

5. Enter the following on the Password Setup: Change Password screen:
 Organization ID: Reenter your organization ID.
 User ID: Reenter your user ID.
 New Password: Enter a new password. Passwords are case sensitive and 

must conform to the password constraints that display above these fields.
 Re-enter Password: Reenter your new password.

6. Click Next. 
PaymentNet displays the Password Setup: Complete screen.

7. Click Next.
PaymentNet displays the Welcome screen.

Logging On from a Registered Computer
You can access PaymentNet from any computer registered to your user ID. The 
computer from which you log on is registered if it meets one of three different 
scenarios. 

First, if you have used the same Internet browser on the computer to successfully log 
on to PaymentNet. Second, if you did not clear the option to have PaymentNet retain 
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registration on your computer. Third, the cookies, cache, or temporary files have not 
been cleared since you last logged on.

To log on from a registered computer:

1. Using your Internet browser, navigate to the following address:
https://www.paymentnet.jpmorgan.com
PaymentNet displays the Log On screen.

2. Complete the following fields on the Log On screen:
 Organization ID: Enter your organization ID (e.g., us12345). The 

organization ID is assigned by J.P. Morgan and is unique to your 
organization.

 User ID: Enter your user ID. The user ID is assigned by your program 
administrator and uniquely identifies you within your organization.

 Password: Enter your case-sensitive password. The password is a security 
feature that prohibits unauthorized access to PaymentNet. Your initial 
password is assigned by J.P. Morgan and must be changed the first time you 
log on to the system.

3. Select the Remember my Organization checkbox. If you are accessing 
PaymentNet from a public computer, J.P. Morgan recommends that you do not 
select this option.
PaymentNet saves your organization ID.

4. Click Log On. 
PaymentNet displays the Welcome screen.

Logging On from an Unregistered Computer
For security purposes, you must register your user ID on each computer you use to 
access PaymentNet. If you try to access PaymentNet from an unregistered computer, 
PaymentNet guides you through the registration process.

The computer from which you are logging on is unregistered if it meets one of three 
different scenarios. First, you have never used the computer, or are using a different 
Internet browser to log on to PaymentNet. Second, you cleared the option to have 
PaymentNet retain registration on the computer. Third, the cookies, cache, or 
temporary files have been cleared since you last logged on.
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Complete the steps in this section if you have successfully logged on to PaymentNet 
in the past, are using your regular password, and are logging on using an 
unregistered computer.

If you log on to PaymentNet from an unregistered computer using a temporary 
password, PaymentNet requires you to set up a new password. Once you complete 
this process, PaymentNet automatically registers your computer. For instructions on 
how to log in to PaymentNet using a temporary password, see “Logging On with a 
Temporary Password” on page 23.

To log on from an unregistered computer:

1. Using your Internet browser, navigate to the following address:
https://www.paymentnet.jpmorgan.com
PaymentNet displays the Log On screen.

2. Complete the following fields on the Log On screen:
 Organization ID: Enter your organization ID (e.g., us12345). The 

organization ID is assigned by J.P. Morgan and is unique to your 
organization.

 User ID: Enter your user ID. The user ID is assigned by your program 
administrator and uniquely identifies you within your organization.

 Password: Enter your case-sensitive password. The password is a security 
feature that prohibits unauthorized access to PaymentNet. 

3. Select the Remember my Organization checkbox. If you are accessing 
PaymentNet from a public computer, J.P. Morgan recommends that you do not 
select this option.
PaymentNet saves your organization ID.

4. Click Log On. 
PaymentNet displays the Register Machine screen.

5. Select the I have an e-mail address on file with J.P. Morgan option. 
Alternately, if you do not have an email address on file with J.P. Morgan, select 
the I do not have an e-mail address on file with J.P. Morgan option and 
contact your program administrator to have your password reset. The computer 
you use the first time you log on after a password reset is automatically 
registered.

6. Click Next. 
J.P. Morgan sends the activation code to the email address in your PaymentNet 
profile. If you do not receive the email, contact your program administrator for 
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assistance. The activation code expires after five days. However, if you request 
additional activation codes, only the most recently received code is valid.

7. On the Register Machine screen, complete the following fields:
 Activation Code: Enter the activation code provided by J.P. Morgan.
 Password: Enter your PaymentNet password.

Note: If you are accessing PaymentNet from a public computer, J.P. Morgan 
recommends clearing the Retain registration on this workstation after logging 
out checkbox. Clearing this checkbox helps to protect your log on information 
by requiring you to reregister this computer the next time you log on.

8. Click Next. 
PaymentNet registers your computer and displays the Welcome screen.

Forgot Your Password?
If you cannot remember your password, you can request a new one. The process to 
request a new password varies based on whether you know your organization and 
user ID and have logged on to PaymentNet before.

If you know your organization and user ID and have logged on to PaymentNet before, 
you can request a temporary password by answering your authentication questions. 
After you log on with your temporary password, you must set up a new password.

If you cannot remember your password and have never logged on to PaymentNet, 
contact your program administrator to have your password reset and then complete 
the steps described in “Logging On for the First Time” on page 22.

To request a temporary password:

1. Using your Internet browser, navigate to the following address:
https://www.paymentnet.jpmorgan.com
PaymentNet displays the Log On screen.

2. Click the Forgot your password? link on the Log On screen.
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3. Enter the following on the Logon Information screen:
 Organization ID: Enter your organization ID (e.g., us12345) in this field. 

The organization ID is assigned by J.P. Morgan and is unique to your 
organization.

 User ID: Enter your user ID in this field. The user ID is assigned by your 
program administrator and uniquely identifies you within your organization.

4. Click Submit. 
PaymentNet displays the select Authentication Questions screen.

5. Confirm that the email address listed below your authentication questions is 
correct. If your email address is incorrect, contact your program administrator 
before proceeding.

6. Select two different authentication questions and enter the answers to the 
questions in the corresponding fields. 

7. Click Submit. 
PaymentNet sends a temporary password to the email address in your 
PaymentNet profile. If you do not receive the email, contact your program 
administrator for assistance.

Note: Your temporary password expires after 90 days, and you are required to change 
the password after logging on to PaymentNet.

8. Click the Return to Login Page link and log on using your temporary password.

Logging Out
You should log out each time you finish using PaymentNet. Logging out ensures your 
identity cannot be used without your permission after you leave your computer.

Note: PaymentNet automatically logs you out after 15 minutes of inactivity. After 12 
minutes of inactivity, PaymentNet displays a message warning your session is about to 
expire and any unsaved work will be lost. If you do not respond to the warning 
message, you will be automatically logged out three minutes later. PaymentNet 
automatically logs you out after eight hours of continuous use.A warning message 
also appears after eight hours of continuous use. You will then be redirected to the 
Log On screen. You must log on again to resume activity, which includes completing 
any updates that were not saved.
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To log out:

1. Click the Logout icon . The Logout icon is located at the top of the screen to 
the right of the menu bar. PaymentNet logs you out of the system.

Understanding the User Interface
The PaymentNet user interface includes navigational features such as the menu 
items and quick link icons located at the top of the screen, and a variety of elements 
for updates and notification purposes.

Required fields are marked with an asterisk ( * ). PaymentNet prompts you to 
complete any required fields before saving your information.

Note: When printing a screen or viewing the Print Preview from PaymentNet using Internet 
Explorer®, occasionally only the right half of the screen displays. 
If this occurs, copy the screen and paste it into another application (e.g., Microsoft 
Word® or PowerPoint®) and print the screen from there.

This section explains the following topics:
 Menu Bar
 Icons
 Welcome Screen

Menu Bar
The menu bar, located at the top of the screen, lists the primary PaymentNet 
modules you are authorized to access. Menu options include:
 Transactions: From this menu, you can view, review, approve, and dispute a 

transaction.
 Orders: From this menu, you can view itemized information for a specific 

Single-Use Account order, as well as create, and reconcile your Single-Use 
Account orders.

 Reports: From this menu, you can view, create, schedule, download, and delete 
reports.

 Accounts: From this menu, you can view card account detail, create a new card 
account, issue a new card account, change card account status, and manage 
card account spend and Merchant Category Code Groups (MCCGs) limits.
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 Employees: From this menu, you can view the user account profile, add a new 
user account, change user account information, assign or change user access 
roles, and unlock or change a user account password.

 Payments: From this menu, you can view payment history, set up bank 
information, as well as make, schedule or cancel a payment.

 Administration: From this menu, you can manage and set up organization 
hierarchy, chart of accounts, cycle, imports, mappers/exports, custom fields, 
customer code, reports, roles, and merchant defaults.

 Help: From this menu, you can quickly and conveniently access online 
information and step-by-step instructions on using PaymentNet.

Note: Each menu option includes a set of sub-functions you can perform. Menu sub-
functions may be accessed by moving your cursor over each primary menu option.

Icons
The icons, located at the top of the screen to the right of the menu, are shortcuts to 
basic user interface options. These icons can be accessed from all PaymentNet 
screens. Icon options include:

 Home Page : Returns you to the Welcome screen.

 Contact Information : Includes key program contact information.

 My Profile : Directs you to your PaymentNet profile information.

 Logout : Allows you to securely end your PaymentNet session.

Welcome Screen
The Welcome screen displays each time you log in to PaymentNet; it serves as your 
starting point or home page. The Welcome screen displays important information 
from J.P. Morgan and your company or organization in the Messages section. In 
addition, depending on your role and permissions, the Welcome screen displays 
tasks, when assigned, in the Items Awaiting Your Action section.

This topic explains the following tasks:
 Customizable Messages
 Items Awaiting Your Action
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Customizable Messages
Customizable Messages, located on the Welcome screen in the Messages field, allow 
you to display and customize by hierarchy the following types of messages:
 Message from Program Administrators to their users: Customizable by your 

company or organization to display messages to all of your users, by role.
 Message from J.P. Morgan to Program Administrators: Includes upcoming 

enhancements, training documents and other key information.
 Message from J.P. Morgan to all users: Important updates from J.P. Morgan to 

all PaymentNet users.

For information about managing messages, see “Setting Up Messages or Greetings” 
on page 42.

Items Awaiting Your Action
The Items Awaiting Your Action section, located on the Welcome screen, provides 
you with a quick link to key actions such as transactions for you to review or 
approve, and access to files available for you to download. This section displays 
regardless of whether you have items awaiting your attention.

Note: The number of items awaiting your action does not decrease after you view a file. 
The number of items only decreases after deleting a file.
For example, if PaymentNet displays that you have 8 New Files for Download and you 
then run a report, PaymentNet displays that you have 9 New Files for Download. 
After you view the report, but do not delete it, PaymentNet displays that you still 
have 9 New Files for Download. If you delete the report file, PaymentNet once again 
indicates that you have 8 Files for Download.

 

Note: The Transaction for review link in the Items Awaiting Your Action section on the 
Welcome screen is displaying even when there are no transactions that need to be 
reviewed.
Users should check the link regularly and review transactions that are waiting. If no 
transactions are listed, the user does not have any transaction waiting for their 
review.
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Navigating PaymentNet
PaymentNet provides common navigation and user interface options throughout the 
system. For example, to help you find information, you can sort data within 
PaymentNet by most list columns. When there is more data than a screen can 
display, PaymentNet provides paging arrows to access additional screens.

This section explains the following topics:
 Sorting
 Paging Arrows
 Multi-Select
 Previous/Next

Sorting
PaymentNet allows you to sort list column information in ascending and descending 
order. Once you have accessed the list data, click an underlined column heading of 
the item you want sorted. Clicking the column once sorts the data in ascending 
order, clicking it again sorts the data in descending order.

Paging Arrows
When there is more data than a screen can display, PaymentNet provides paging 
arrows to access additional screens. In addition, if you know the page number where 
the data is located, you can use the Page field to jump directly to the desired page.

Multi-Select
The multi-select functionality allows you to quickly and easily select individual 
records from a list and perform common tasks on that group of items. For example, 
you may want to review and approve a group of transactions all at once, export 
specific account records to a file, or change the accounting codes for all transactions 
through a mass update.

Multi-select is available on list screens in the following areas of PaymentNet:
 Accounts
 Customer Code Defaults
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 Employees
 Merchants
 Merchant Category Codes
 Orders
 Transactions

Depending on the type of records selected, you can perform one or more of the 
following tasks:
 Export records
 Review transactions
 Approve transactions
 Perform an account or transaction mass update
 Reconcile orders
 Attach receipt images to transactions

This topic explains the following tasks:
 Understanding the Multi-Select Options
 Using Multi-Select
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Understanding the Multi-Select Options
The multi-select user interface options operate the same way for each list screen on 
which they display in PaymentNet. You have the ability to select individual records in 
the list, select all records on the screen, or to select all records across all pages. 
Once you select the desired records, you can perform common tasks.

Shown below, Figure 1: “Multi-Select Features” on page 34, provides an example of 
the multi-select features on a list screen and provides an explanation of their use.

 Figure 1: Multi-Select Features

A B
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C

D

A. Select All Pages. Click this link to select all records across all pages.
B. Clear All Pages. Click this link to clear all selected records across all pages.
C. Header Checkbox. Mark this checkbox to select all records on the page. Clear the 

checkbox to clear all selected records on the page.
D. Individual Checkboxes. Mark the checkbox next to the records you want to select. 

Clear the checkboxes next to the records you want to clear.
E. Task Buttons. Click a button to perform the associated tasks on the selected items.
F. Counter. Displays the number of records selected from the total number of records.
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Using Multi-Select
Multi-select is available in many list screens throughout PaymentNet.The 
functionality of this feature is the same regardless of the type of records you are 
selecting. However, the record types selected determine the types of actions you 
can perform. For example, in order to review and approve transactions, you must 
first select transactions from the Transaction List. 

In addition to performing actions, the multi-select feature allows you to limit the 
number of records when using the previous/next feature. For more information, see 
“Previous/Next” on page 36.

To use multi-select:

1. Navigate to a list screen that uses multi-select.

2. Locate the desired records by performing a query, if needed. It is a good idea to 
perform a query to reduce the number of records in the list. This makes it easier 
for you to locate the records you want to select. For information about running 
queries, see Chapter 9, “Queries” on page 259.

3. Select the desired records by doing one of the following:
 To select all records across all pages, click the Select All Pages link.
 To select all of the records on the page, mark the checkbox on the left side 

of the header row.

 To select specific records on the page, mark the individual checkboxes on 
the line of each record. You can manually select up to 100 individual 
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records on the same page. You cannot manually select individual records 
across pages.

Note: Although you can select up to 100 individual records on a page, the total 
number of records you can select is dependant on the number of records 
displayed. In the My Profile section of PaymentNet, you can choose to 
display 20, 50, or 100 records on a page at a time. To change the number of 
records that display, see “Setting Up Screen Views” on page 54.

PaymentNet enables the task buttons and updates the counter to indicate the 
number of records selected from the total number of available records.

4. Depending on the type of records selected, do one of the following:
 Click Mass Update to update multiple accounts or transactions at the same 

time. For instructions on performing a mass update, see “Running a Mass 
Update for Multiple Accounts” on page 165 or “Running a Mass Update for 
Multiple Transactions” on page 285.

 Click Reviewed to review the selected transactions. For instructions on 
reviewing transactions, see “Reviewing a Transaction” on page 315.

 Click Approved to approve the selected transactions. For instructions on 
approving transactions, see “Approving Transactions” on page 316.

 Click Attach Receipts to attach receipt images to the selected 
transactions.For instructions on attaching receipt images to transactions, 
see “Attaching a Receipt to a Transaction” on page 289 and “Attaching 
Receipts to Multiple Transactions” on page 293.

 Click Export to export the selected records to a file. For instructions on 
exporting records, see “Configuring an Export File” on page 188.

 Click Reconcile to reconcile the selected Single-Use Account (SUA) orders. 
For instructions on reconciling SUA orders, see “Manually Reconciling 
Single-Use Account Orders” on page 345.

Previous/Next
The previous/next functionality allows you to move sequentially through a set of 
records from a detail screen without returning to the list screen and selecting the 
next record. For example, when viewing the details of an individual transaction, you 
can click the Next link to view the detail screen of the next transaction in the list. 
The same tab you were viewing remains active when you use the previous/next 
feature to view another record.
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The previous/next functionality is located in the upper and lower right corner of 
each detail screen and is available for Accounts, Employees, Transactions, and 
Orders.

 Figure 2: Previous/Next Features
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A CB

A. First Record. Click this link to display the first record in the group.
B. Counter. Indicates the displayed record and the total number of records in the group.
C. Last Record. Click this link to display the last record in the group.
D. Previous. Click this link to display the previous record in the group.
E. Next. Click this link to display the next record in the group.

The total number of records in the previous/next group is determined by the number 
of records in the list. For example, by default, the Transaction List displays all 
transaction records for the last 30 days. If you do not limit the number of records 
that display, such as by performing a query, all transactions for the last 30 days will 
be included in the previous/next group.

In addition, you can use the multi-select checkboxes to choose only the records that 
you want included in the previous/next group. To do so, mark the checkbox next to 
the records you want to include and then select a record to view the detail screen. 
For more information about using the multi-select features, see “Multi-Select” on 
page 32.
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Data Retention
PaymentNet retains transaction and audit data for a limited time period.

Audit data — such as user information related to field changes — is stored for 12 
months. After 12 months, audit data is deleted from PaymentNet.

Transaction data is stored for 24 months. After 24 months, transaction data is 
deleted from PaymentNet and basic transaction information is stored in a separate 
database for an additional five years. To obtain transaction data after 24 months, 
contact your J.P. Morgan program coordinator or relationship manager.
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 Configuring PaymentNet
PaymentNet offers an easy-to-use interface designed with flexibility, efficiency, 
and scalability in mind. PaymentNet is a customizable reporting system that 

offers you the functionality to configure settings that are specific to the 
Administrator and User level.

This chapter explains the following sections:
 Configuring Administration Settings
 Configuring User Settings

Configuring Administration Settings
PaymentNet provides you the flexibility to configure administration features such as 
user roles, hierarchy settings, and reports based the specific needs of your company 
or organization.

This section explains the following topics:
 Managing Hierarchy Settings
 Setting Up Custom Fields
 Setting Up User Roles
 Setting Up Reports
 Managing Cycles
 Managing Merchants
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 Merchant Category Codes
 Merchant Category Code Groups

Managing Hierarchy Settings
PaymentNet allows you to customize hierarchy settings, including: system messages 
and user greetings, available modules, and transaction approval rules. In addition, 
you can configure transaction default priorities and Single-Use Account settings. 

For information about creating, adding, renaming, or moving a hierarchy, see 
“Managing Hierarchy IDs” on page 125.

This topic explains the following items:
 Setting Up Page Banners
 Setting Up Messages or Greetings
 Setting Up Contact Information
 Specifying Language Display Preference
 Setting Up Modules
 Setting Up Screen Views
 Setting Up Transaction Approval Rules
 Configuring Transaction Hierarchy Settings
 Configuring Compliance Monitoring
 Managing Single-Use Account Orders

Setting Up Page Banners
You can customize page banner elements, including the graphic and screen 
background color, that display at the top of each PaymentNet screen.

This task explains the following items:
 Viewing Page Banner Settings
 Customizing the Page Banner
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Viewing Page Banner Settings

To view page banner settings:

1. Select Administration > Hierarchy > Settings > Page Banner. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Page Banner from the Select Configuration to Edit drop-down list.

Customizing the Page Banner

To customize the page banner:

1. Display the Hierarchy Settings screen. See “Viewing Page Banner Settings” on 
page 41.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Page Banner from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Click the Browse button located to the right of the Logo Image field to select 
the desired graphic.

Note: For best results, J.P. Morgan recommends .gif or .jpg formats no larger than 100 
pixels in height.
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6. Locate the desired graphic. Click Open.

7. Enter the HTML color code in the Background Color field to change the 
background color.

Note: Consult your Marketing or IT department to obtain the exact HTML color code 
needed to match your company or organization guidelines.

 

8. Click Save.

Setting Up Messages or Greetings
System messages or greetings display on the Welcome screen and are specific to a 
role or hierarchy ID. The system message or greeting displays in the Messages 
section until the greeting is modified, deleted, or expires.

This task explains the following items:
 Viewing System Message or Greeting Settings
 Creating a System Message or Greeting
 Modifying a System Message or Greeting
 Deleting a System Message or Greeting

Viewing System Message or Greeting Settings

To view system message or greeting settings:

1. Select Administration > Hierarchy > Settings > Greeting. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Greeting from the Select Configuration to Edit drop-down list.
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Creating a System Message or Greeting

To create a system message or greeting:

1. Display the Hierarchy Settings screen. See “Viewing System Message or 
Greeting Settings” on page 42.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Greeting from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Enter the date you want the system message or greeting to begin displaying. Do 
one of the following:
 Enter the begin date in the Begin Date field.
 Click the Begin Date calendar icon and select the begin date from the pop-

up calendar.

6. Enter the date you want the system message or greeting to end displaying. Do 
one of the following:
 Enter the end date in the End Date field.
 Click the End Date calendar icon and select the end date from the pop-up 

calendar.

7. Enter the system message or greeting you want to display in the text editor 
Message field.

Note: The text editor provides a variety of text formatting options.
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8. From the Display for Roles section, select the checkbox to indicate which 
system default user roles you want to display the system message or greeting. 
System default user roles include:
 All
 Auditor
 Order Requestor 

Note: In addition to the system default user roles, you may also select custom 
roles (if any have been created for the company or organization.) For more 
information, see “Defining System Default User Roles” on page 86.

9. To add additional system messages or greetings, click the Add (plus symbol) icon 
to display new system message or greeting fields.

10. Click Save.

Modifying a System Message or Greeting

To modify a system message or greeting:

1. Display the Hierarchy Settings screen. See “Viewing System Message or 
Greeting Settings” on page 42.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Greeting from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.
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5. Enter the date you want the system message or greeting to begin displaying. Do 
one of the following:
 Enter the begin date in the Begin Date field.
 Click the Begin Date calendar icon and select the begin date from the pop-

up calendar.

6. Enter the date you want the system message or greeting to end displaying. Do 
one of the following:
 Enter the end date in the End Date field.
 Click the End Date calendar icon and select the end date from the pop-up 

calendar.

7. Modify the system message or greeting you want to display in the text editor 
Message field, as needed.

Note: The text editor provides a variety of text formatting options.

8. From the Display for Roles section, select the checkbox to indicate which 
system default user roles you want to add or remove the system message or 
greeting. System default user roles include:
 All
 Auditor
 Order Requestor 

Note: In addition to the system default user roles, you may also select custom 
roles (if any have been created for the company or organization.) For more 
information, see “Defining System Default User Roles” on page 86.

9. To add additional system messages or greetings, click the Add (plus symbol) icon 
to display new message fields.

10. Click Save.

Deleting a System Message or Greeting

To delete a message:

1. Display the Hierarchy Settings screen. See “Viewing System Message or 
Greeting Settings” on page 42.
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2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Greeting from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Click the Delete (trash can symbol) icon next to the system message or greeting 
you want to delete.

6. Click Save.

Setting Up Contact Information
You can set up key contact information for your users to reference. Contact 
information can be accessed by selecting the Contact (phone symbol) icon located at 
the top of the screen to the right of the menu.

Contact information may vary based on where the user is located within the 
hierarchy.

This task explains the following items:
 Viewing Contact Settings
 Creating Contact Information

Viewing Contact Settings

To view contact settings:

1. Select Administration > Hierarchy > Settings > Contact. 
The Hierarchy Settings screen displays.
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2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Contact from the Select Configuration to Edit drop-down list.

Creating Contact Information

1. Display the Hierarchy Settings screen. See “Viewing Contact Settings” on 
page 46.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Contact from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Enter the appropriate information in the fields provided in the Contact section. 

6. Click Save.

Specifying Language Display Preference
PaymentNet is set to display English as the system default for language preference.

This task explains the following items:
 Viewing Preference Settings
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Viewing Preference Settings

To view preference settings:

1. Select Administration > Hierarchy > Settings > Preferences. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Preferences from the Select Configuration to Edit drop-down list.

Setting Up Modules
You can select the modules that are available to a hierarchy ID.

Note: Enabling a module does not override user access roles for the hierarchy ID.

This task explains the following items:
 Viewing Modules Settings
 Enabling Modules
 Disabling Modules

Viewing Modules Settings

To view module settings:

1. Select Administration > Hierarchy > Settings > Modules. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Modules from the Select Configuration to Edit drop-down list.
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Enabling Modules

To enable modules:

1. Display the Hierarchy Settings screen. See “Viewing Modules Settings” on 
page 48.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Modules from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the checkbox in front of each module you want to enable from the 
Enabled Modules section. For a complete list of modules, see List 2: 
“PaymentNet Modules” on page 50. 

Note: Only those modules that have been purchased by your company or organization 
may be modified.
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6. Click Save. 

 List 2: PaymentNet Modules 

Account Management Use the Account Management module to configure and edit account 
settings. This includes updating the account holder’s contact information, 
verifying current balance, changing account limits, changing MCC Groups, 
requesting new or replacement cards, closing or suspending accounts, and 
submitting a Central Bill Account Request form.
For information on card account details, see Chapter 5, “Managing Card 
Accounts” on page 147.

Convenience Checks Use the Convenience Checks module to manage your organization’s 
convenience check program.
If your organization has implemented a convenience check program to 
complement your purchasing card solution, you can order new checks and 
request stop-payments on unpaid checks. 
Convenience check transactions are shown in PaymentNet and on 
cardholder statements to facilitate reporting and billing activities. 
Printed in packages of 20 or 50, convenience checks are cross-referenced 
to and draw directly from individual purchasing card accounts.
Due to the nature of checks, MCC blocking is unavailable, but checks are 
validated against other authorization parameters (e.g., available credit 
limit) when received by J.P. Morgan. If a check exceeds a cardholder’s 
limit or other authorization parameter, it may be declined and returned 
to the merchant unpaid. When necessary, stop-payment requests can be 
submitted for checks if they have not already posted to an account.
For more information on managing convenience checks, see Chapter 14, 
“Convenience Checks” on page 347.

Chart of Accounts Use the Chart of Accounts module to manage accounting codes.
You can create or modify a chart of accounts within PaymentNet. Once 
you configure a chart of accounts, you can assign the chart to an 
employee, an account, a merchant, a Merchant Category Code (MCC), a 
hierarchy, or a customer code. The values you assign are known as the 
default accounting codes (transaction defaulting) and are applied to the 
transaction in PaymentNet.
Optionally, your J.P. Morgan implementation manager can upload your 
organization’s chart of accounts to PaymentNet. For more information, 
contact your J.P. Morgan implementation manager.
For more information on using chart of accounts, see Chapter 4, “Working 
with Accounting Codes and Chart of Accounts” on page 129.

Custom Fields Use the Custom Fields module to create and edit custom fields for the 
following: Transaction, Order, Merchant, Employee, Account, and 
Merchant Category Codes modules.
When you create a custom field, you specify the custom field name, 
description, and type, such as a checkbox, a text box of up to 99 
characters, or a drop-down list with a defined set of values.
You can set up custom fields as required or optional fields. For Transaction 
Custom fields, you can also set role restrictions to control which user 
roles have edit access to the custom field.
For more information on managing custom fields, see “Setting Up Custom 
Fields” on page 79.
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Cycles Use the Cycles module to create or modify an existing cycle and configure 
cycle period settings, including cycle start date, cycle period begin date, 
and cycle period end date.
You can add new cycles based on the accounting needs of your company or 
organization. This includes the ability to configure PaymentNet to 
automatically generate the periods within a cycle. Alternately, you can 
manually create the periods within a cycle. A period is a sub-portion of a 
cycle. 
For instructions on how to create account cycles, see “Managing Cycles” 
on page 91.

Electronic Payment Use the Electronic Payment module to enable users to make card account 
payments online. This module also allows users to review completed and 
recurring payments.
For instructions on how to set up banking details and to view payment 
information, see“Setting Up Bank Account Information” on page 115 and 
“Viewing Payment Information” on page 119.

Electronic Statement Use the Electronic Statement module to define what accounts can access 
their statements online through PaymentNet. 
Once you enable this module, users can manage how they receive 
statements for each account through the Accounts screen under My 
Profile icon.
For instructions on how users can manage the statement delivery 
preferences for an account, “Selecting Statement Delivery Preference” on 
page 120.

Flex Mappers Use the Flex Mapper module if your organization needs to move data 
between PaymentNet and your organization’s accounting system, such as 
a general ledger (GL) or enterprise resource planning (ERP) system. Flex 
mappers are data export files in a specific layout and format, usually a 
limited or fixed-length text file.
Unlike reports, a flex mapper gives you the option to mark transactions as 
export. Once a transaction is marked as exported, you cannot edit any 
information tied to the transaction and the flex mapper will not extract 
the transaction data again. This ensures that a transaction will not be fed 
to your internal system more than once. 
For instructions on how to use flex mappers, see Chapter 8, “Flex 
Mappers” on page 235.

Custom Mappers Use the Custom Mappers module if after running a flex mapper you still 
require data beyond the scope of a flex mapper. 
To manage a custom mapper, contact your J.P. Morgan representative for 
more information.

 List 2: PaymentNet Modules (continued)
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Import With the Imports module, you can transfer data to PaymentNet from an 
external file. Import files are useful for importing large amounts of data 
to PaymentNet, such as setting up a new organization or making a large 
number of changes to existing data. The following import files are used to 
upload data in to PaymentNet: 
 Account. Used to create or modify a group of accounts.
 Chart of Accounts. Used to create, modify, remove, or replace Chart 

of Account values.
 Employee. Used to create or modify employees and modify user 

authority.
 Hierarchy. Used to create, modify, or remove Hierarchy Nodes.
 Merchant. Used to modify specific merchant information.
 Merchant Category Code. Used to modify specific Merchant Category 

Code (MCC) information such as, MCC Type and T&E Type.
 Transaction Defaults. Used to create, modify, remove, or replace the 

defaults for Employees, Accounts, Merchant Category Codes, 
Merchants, Hierarchy, and Customer Codes.

For instructions on how to use imports, see Chapter 7, “Managing Import 
Files” on page 191.

MCC Use the Merchant Category Code (MCC) module to assign default 
accounting codes to an MCC. An MCC is a four-digit number assigned to a 
business by Visa or MasterCard and is used to classify businesses by the 
type of goods or services they provide and allows enhanced merchant 
data to be passed to PaymentNet. Each merchant is responsible for 
selecting their own MCC when they enroll to accept Visa or MasterCard.
For instructions on how to use MCCs, see “Merchant Category Codes” on 
page 107.

MCCG Use a Merchant Category Code Group (MCCG), a collection of multiple 
MCCs, in the same manner that you can control spending by MCC. You can 
apply restrictions to an MCCG. The restrictions set on an MCCG apply to 
all MCCs in the group. For example, using an MCCG can help control 
whether cardholders may purchase from particular types of merchants.
Use the MCCG module to create custom groups for MCCs of your choice. 
For example, you could create an MCCG called Prohibited Airlines and 
assign individual airline carries, by their MCC, to the group.
For instructions on how to use MCCGs, see “Merchant Category Code 
Groups” on page 109.

Merchants The Merchants module of PaymentNet lists and provides details about all 
merchants in the system. A merchant is any business or organization from 
which goods and services are purchased. The merchant information in 
PaymentNet is supplied by the card associations and is, by default, 
automatically updated. Your organization can manually configure 
merchant information as necessary.
For more information about merchants, see “Managing Merchants” on 
page 98.

 List 2: PaymentNet Modules (continued)
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Orders If Single-Use Accounts are enabled for your organization, you can enable 
the Orders module. Use the Orders module to create new Orders or 
modify existing orders, each of which act as a request form for a 
Single-Use account. The Orders module also provides options for 
managing, reconciling, and searching for orders.
Single-Use Accounts act like a traditional purchasing card, but use a 
different account number for each payment that needs to be made—each 
account being tailored to that particular payment.
For more information on Single-Use Accounts and Orders, see Chapter 13, 
“Single-Use Account Orders” on page 339.

Query Use the Query module to search for information and filter the data you 
want to view. You can save a custom query and use it as often as you need 
it.
For details on how to use search functionality in PaymentNet, see Chapter 
9, “Queries” on page 259.

Transaction Defaulting Use the Transaction Defaulting module to automatically apply default 
accounting codes to each transaction based on the employee, hierarchy, 
merchant, MCC, account, or customer code.
After a transaction posts, it shows a pre-populated, or default, accounting 
code. You can manually change the default accounting codes on a 
transaction.
For details on enabling transaction defaulting, see “Configuring 
Transaction Hierarchy Settings” on page 64.

Transactions Use the Transactions module to manage transaction details like adding 
transaction notes, reviewing and approving transactions, applying 
accounting codes.
If your Organization has Receipt Imaging enabled, you can also attach or 
fax receipts.
For further information on managing transactions, see Chapter 10, 
“Transactions” on page 279.

Login Credentials - Auto 
Email

Use this option to have PaymentNet automatically send an email message 
to new system users with their organization ID, user ID, and password 
information. For new users, these login credentials are sent in separate 
emails. 
In addition, PaymentNet sends an existing user their new password when 
it is changed by anyone other than the user. For example, if a program 
administrator performs a Password Reset for a cardholder, then the 
cardholder will receive an email with their new password. PaymentNet 
sends these messages to the email address listed in the employee record. 
You can track when PaymentNet sends credentials by adding the 
Credentials Sent column to the Employee List screen view.

 List 2: PaymentNet Modules (continued)
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Disabling Modules

To disable modules:

1. Display the Hierarchy Settings screen. See “Viewing Modules Settings” on 
page 48.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Modules from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Deselect the checkbox in front of each module you want to disable from the 
Enabled Modules section. For a complete list of modules, see List 2: 
“PaymentNet Modules” on page 50.

Note: Only those modules that have been purchased by your company or organization 
may be modified.

6. Click Save.

Note: Even if a higher hierarchy ID has a module disabled, a lower hierarchy ID may 
still enable that module.

Setting Up Screen Views
Setting up screen views allows you to select the required fields that display on the 
PaymentNet List screens for everyone in the selected hierarchy ID and hierarchy ID 
children.
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This task explains the following items:
 Viewing Screen View Settings
 Selecting the List Screen to Configure
 Selecting Fields to Display
 Removing Fields from Display
 Configuring Field Display Order

Viewing Screen View Settings

To view screen view settings:

1. Select Administration > Hierarchy > Settings > Screen Views. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Screen Views from the Select Configuration to Edit drop-down list.

Selecting the List Screen to Configure

To set up screen views:

1. Display the Hierarchy Settings screen. See “Viewing Screen View Settings” on 
page 55.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Screen Views from the Select Configuration to Edit drop-down list.
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4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the List screen to configure from the Screen to Configure drop-down list. 
List screens include:
 Account List
 Employee List
 MCC List
 Merchant List
 Order List
 Transaction List

Note: The ability to customize an individual profile by adding additional columns 
and arranging the order in which the fields display is available from the 
Screen Views tab accessed through the My Profile screen.

6. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.

Selecting Fields to Display

To add fields to display:

1. Display the Hierarchy Settings screen. See “Viewing Screen View Settings” on 
page 55.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Screen Views from the Select Configuration to Edit drop-down list.
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4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the List screen to configure from the Screen to Configure drop-down list. 
List screens include:
 Account List
 Employee List
 MCC List
 Merchant List
 Order List
 Transaction List

6. Select the field you want to display from the Available Columns list box. To add 
multiple fields do one of the following:
 To add fields in sequential order, click the first field you want to display, 

hold down the SHIFT key, and click the last field you want to display.
 To add fields in non-sequential order, click the first field you want to 

display, hold down the CTRL key, and click the additional fields you want to 
display.

 To add all fields select Add All.

7. Click Add. The field(s) are added to the Selected Columns list box. 

8. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.

Removing Fields from Display

To remove fields from display:

1. Display the Hierarchy Settings screen. See “Viewing Screen View Settings” on 
page 55.
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2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Screen Views from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the List screen to configure from the Screen to Configure drop-down list. 
List screens include:
 Account List
 Employee List
 MCC List
 Merchant List
 Order List
 Transaction List

6. Select the field you want to delete from the Selected Columns list box. To 
remove multiple fields do one of the following:

 To remove fields in sequential order, click the first field you do not 
want to display, hold down the SHIFT key, and click the last field you 
do not want to display.

 To remove fields in non-sequential order, click the first field you do not 
want to display, hold down the CTRL key, and click the additional fields 
you do not want to display. Required fields cannot be removed.

 To remove all fields select Remove All.

7. Click Remove. The field(s) are removed from the Selected Columns list box.

8. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.
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Configuring Field Display Order

To configure field display order:

1. Display the Hierarchy Settings screen. See “Viewing Screen View Settings” on 
page 55.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Screen Views from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the List screen to configure from the Screen to Configure drop-down list. 
List screens include:
 Account List
 Employee List
 MCC List
 Merchant List
 Order List
 Transaction List

6. Select the field you want to move from the Selected Columns list box. Using the 
Arrows to the right of the Selected Columns list box do one of the following:
 Click the First up arrow key to move the field to the top of the list. 
 Click the Move Up arrow key to move the field up one level.
 Click the Move Down arrow key to move the field down one level.
 Click the Last Down arrow key to move the field to the bottom of the list.
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7. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.

Setting Up Transaction Approval Rules
You can view and manage all transaction approval rules.

This task explains the following items:
 Viewing Transaction Approval Rule Settings
 Creating Transaction Approval Rule Settings

Viewing Transaction Approval Rule Settings

To view approval rule settings:

1. Select Administration > Hierarchy > Settings > Approval Rules. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Approval Rules from the Select Configuration to Edit drop-down list.

Creating Transaction Approval Rule Settings

To create approval rules:

1. Display the Hierarchy Settings screen. See “Viewing Transaction Approval Rule 
Settings” on page 60.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
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3. Select Approval Rules from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. Select the Enable Approval Processing checkbox. The ability to configure 
transaction approval rules is now enabled.

Note: Selecting the Enable Approval Rules checkbox also allows you to set up 
additional transaction approval settings that can be accessed from other areas 
within the system. Select this option to display:
 Approved and Reviewed fields as available columns on the Hierarchy 

Settings > Screen Views and My Profile screens. See “Setting Up Screen 
Views” on page 54.

 Approval field columns on the Transaction Detail screen.
 Transactions awaiting review/approval reminders on the Welcome screen.

6. Select the minimum number of approval levels (if desired) from the Minimum 
Number of Approval Levels drop down list. The Minimum Number of Approval 
Levels field is used to define the level required to approve transactions. Select 
0 if the transaction does not require approval after it is reviewed by the 
cardholder. 

Note: When you select 0 as the Minimum Number of Approval Levels available, the 
Reviewed checkbox will still display, and can be used by the cardholder to 
notate the transaction has been reviewed.

 

Note: If a transaction becomes “stalled” in the approval process because no more 
approvers are available, you cannot remove the transaction from the stalled 
status by reducing the Minimum Number of Approval Levels setting. 
To move a transaction from the Stalled to Approved status: 
 Create a new transaction approver user. 
 Select the next higher number from the Minimum Number of Approval 

Levels drop-down list and save the change. For example, if the drop-down 
list is set to 2, select 3. 

 Use the new transaction approver user to approve the transaction.
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7. Select the additional levels required (if desired) for transaction approval from 
the Additional Approval Levels drop down list. Enter the dollar amount for 
which additional approval levels are required in the When Transaction Amounts 
Exceed field.

8. Select the Use Hierarchy Approval Routing checkbox (if desired). The Use 
Hierarchy Approval Routing checkbox allows the system to route transactions 
to an approval authority in a hierarchy level above the employee. If there are no 
additional approvers above the employee’s level, then approval routing is 
considered complete.

9. Select the Permit Final Approver Directed Routing checkbox (if desired).The 
Permit Final Approver Directed Routing checkbox allows transactions to be 
routed to the person listed as the Last Approver, and is above the employee’s 
level in the hierarchy.

Permit Final Approver Directed Routing is a user-driven (manual) process, which 
offers additional approval routing options above and beyond the Minimum 
Number of Approval Levels option. The Permit Final Approver Directed Routing 
allows the user to define the users for each level in the approval workflow.

You do not need to enable Hierarchy Approval Routing to implement the Permit 
Final Approver Directed Routing option. Permit Final Approver Directed Routing 
is enabled by completing the following steps:
 Select the Final Approver Directed checkbox.
 Deselect the Hierarchy Approval Routing checkbox.

10. Select the Allow Transaction Editing After Approval checkbox (if desired). The 
Allow Transaction Editing After Approval checkbox allows transaction 
accounting codes to remain editable throughout the transaction approval 
process. The transaction becomes locked for editing only after it is exported by 
the mapper.

For example, cardholders can edit chart of accounts even after the transaction 
is approved by the manager, provided the transaction is not exported.

11. Select the number of days before the transaction is forwarded to the next level 
for approval from the Forward to Next Approver After drop down list. The 
Forward to Next Approver After drop down list allows the system to 
automatically skip an approval level when an approver is unavailable.

12. Select the frequency of email notifications from the E-mail Notification 
Schedule drop down list. The E-mail Notification Schedule drop down list 
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allows you to select how often approval email notifications are sent to the 
employee.

13. Click Save.

Configuring Transaction Hierarchy Settings
New transactions loaded into PaymentNet can be automatically populated with 
transaction accounting code defaults. When loading transactions into the system you 
can configure which transaction accounting code and default priority settings to 
apply. This includes the ability to define the maximum number lines and the 
minimum length allotted for notating an accounting code entry. You can also 
determine which transaction defaults will take priority in cases where the same 
accounting code default applies.

Note: Transaction accounting code and default priorities are typically configured during the 
implementation process. If a new or modification to an accounting code or default 
priority setting is needed, we recommend contacting your J.P. Morgan Relationship 
Manager for assistance.

This task explains the following:
 Viewing Transaction Hierarchy Settings
 Configuring Transaction Hierarchy Settings

Viewing Transaction Hierarchy Settings

To view transaction hierarchy settings:

1. Select Administration > Hierarchy > Settings > Transaction. 
The Hierarchy Settings screen displays.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Transaction from the Select Configuration to Edit drop-down list.
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Configuring Transaction Hierarchy Settings

To configure transaction hierarchy settings:

1. Display the Hierarchy Settings screen. See “Viewing Transaction Hierarchy 
Settings” on page 63.

2. Select the hierarchy ID. Do one of the following:
 Enter the default Hierarchy ID in the field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.

3. Select Transaction from the Select Configuration to Edit drop-down list.

4. Click the Override Inheritance checkbox.

Note: The Override Inheritance checkbox overrides the settings from the parent 
hierarchy ID. This allows you to set up or modify the module settings for the 
selected hierarchy ID. If the Override Inheritance checkbox is not selected, 
then the module will retain the parent hierarchy ID settings listed in the 
Inherited From field.

 

5. From the Transaction Setting section, do the following:
 Select the Accounting Code Entry on List Screen checkbox (if desired). 

Selecting the Accounting Code Entry on List Screen checkbox enables all 
users within the specified hierarchy to configure transaction default 
accounting code information from the Transaction List screen.

Note: You must authorize your users to access the Transactions module and to 
view the Transaction Defaulting Accounting Code column. For more 
information, see “Viewing Modules Settings” on page 48 and “Viewing 
Screen View Settings” on page 55. The user must also select to display the 
Transaction Defaulting Accounting Code column on the Transaction List 
screen. See “Screen Views” on page 117.

 

 Select the Require Lines checkbox (if desired). When the Required Lines 
checkbox is selected it is necessary for the user to create at least one line 
item, or transaction split, on the Transaction Detail screen. 

Note: If 0 (zero) is entered in the Maximum Number of Lines field the Required 
Lines checkbox is disabled.
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 Enter the total number of lines allowed in the Maximum Number of Lines 
field (if desired). The Maximum Number of Lines field allows you to set the 
total number of line items, or splits, allowed on the transaction. Entering 0 
(zero) in the Maximum Number of Lines field disables transaction lines and 
controls from displaying on the Transaction Detail screen.

Note: It is not recommended to have more than 15 lines or splits.

 Enter the basic number of characters allowed for notes on the accounting 
code entry in the Minimum Length of Note field (if desired). Entering a 
value indicates notes are required and also defines the minimum number of 
characters needed. Entering 0 (zero) in the Minimum Length of Note field 
indicates notes are not required.

6. From the Transaction Default Priorities section, do the following:
 Set the desired order and number of priorities for transaction defaults from 

the Object drop-down list. Transaction default options include:
 Account
 Customer Code

Note: PaymentNet Customer Code transaction defaulting is incorrectly 
taking case sensitivity into consideration when the customer code 
contain letters. If your organization uses Customer Code transaction 
defaulting and there is a difference in cases between the customer 
code set up in PaymentNet and the customer code supplied by the 
merchant, transactions will not default.
If this issue affects your organization, contact a J.P. Morgan program 
coordinator for assistance.

 Employee
 Hierarchy ID
 MCC
 Merchant
 Order
 None
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7. From the Transaction Defaults section, do the following:
 Select the appropriate default accounting code from the Chart of Accounts 

drop-down list.
 Enter the applicable information in the additional fields that display when a 

specific Chart of Accounts is selected.

Note: The criteria filter options that display vary based on the Chart of Accounts 
selected from the Chart of Accounts drop-down list.

 

8. Click Save.

Configuring Compliance Monitoring
As a program administrator, you likely have oversight responsibilities for your 
organization’s cardholders. One task might be to ensure that cardholder transactions 
adhere to your card policy. To help you with this task, PaymentNet provides 
Compliance Monitoring.

You can use Compliance Monitoring to track and monitor cardholder transactions by 
setting up monitor rules in four different categories: 
 Single Transaction Amounts. The Single Transaction Amounts monitor type 

allows you to flag transactions over a specified dollar amount.
 Split Transactions. Use the Split Transactions monitor type if you want to flag 

transactions whereby a cardholder breaks up a purchase into multiple 
transactions in order to circumvent the account single transaction limit.

 Questionable Merchant Category Codes (MCCs). You can use the Questionable 
Merchant Category Codes monitor type to flag transactions at a merchant that 
belongs to a specific MCC. 

 Questionable Merchants. You can use the Questionable Merchants monitor type 
to flag transactions completed at a specific merchant.

When you set up a monitor rule, past transactions are not affected or flagged. For 
example, on June 7, you might set up a monitor rule to flag transactions at an office 
supply merchant. Any transactions completed prior to June 7 at the merchant are 
not flagged; transactions completed on or after June 7 are flagged.

Before you can enable Compliance Monitoring at the Hierarchy level, your 
J.P. Morgan implementation manager must enable the Compliance Monitoring option 
at the Organization level. For more information, contact your implementation 
manager.
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Once you complete the configuration steps described in this section, you can view 
flagged transactions on the Transaction List screen. For more information on how to 
view flagged transactions, see “Viewing Flagged Transactions” on page 301.

This section explains the following topics:
 Configuring the Single Transaction Amounts Monitor Type
 Configuring the Split Transactions Monitor Type
 Configuring Questionable Merchant Category Codes Monitor Type
 Configuring the Questionable Merchants Monitor Type

Configuring the Single Transaction Amounts Monitor Type
Use the Single Transaction Amounts monitor type to flag transactions that are more 
than a specified dollar amount.

To configure the single transaction amounts monitor type:

1. Select Administration > Hierarchy > Settings > Compliance Monitoring.
PaymentNet displays the Hierarchy Settings screen for Compliance Monitoring.

2. Select the hierarchy ID for which you want to configure Compliance Monitoring 
settings.

3. Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

4. Select the Override Inheritance checkbox.

5. Click the Save button.
PaymentNet saves the inherited settings from the parent hierarchy and enables 
the Add links.

6. For the Single Transaction Amounts monitor type, click the Add link.
PaymentNet displays the Single Transaction Amounts screen.
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7. Complete the following fields:

Monitor Name Enter a unique name in this field to identify this monitor.

Amount Over Enter the dollar amount for transactions you want to monitor. For 
example, if you want to monitor transactions of $50.00 or more, 
enter $50.00 in this field.

8. Click the Save button.

Configuring the Split Transactions Monitor Type
Use the Split Transactions monitor type if you want to flag transactions whereby a 
cardholder breaks up a purchase into multiple transactions in order to circumvent 
the account single transaction limit.

To configure compliance monitoring for split transactions:

1. Navigate to the Hierarchy Settings screen for Compliance Monitoring.

Select Administration > Hierarchy > Settings > Compliance Monitoring.
PaymentNet displays the Hierarchy Settings screen for Compliance Monitoring.

2. Select the hierarchy ID for which you want to configure Compliance Monitoring 
settings.

3. Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

4. Select the Override Inheritance checkbox.

5. Click Save.
PaymentNet saves the inherited settings from the parent hierarchy and enables 
the Add links.

6. For the Split Transactions monitor type, click the Add link.
PaymentNet enables the Monitor Name field for Split Transactions.

7. In the Monitor Name field, enter a unique name to identify this monitor.
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8. Click Save.
PaymentNet saves the monitor settings and displays a confirmation message.

Configuring Questionable Merchant Category Codes Monitor Type
Configure the Questionable Merchant Category Codes monitor type to flag 
transactions completed at merchants that belong to a specific merchant category 
code. This monitor type allows you to track transactions on a broader level.

Merchant Category Codes are assigned by the card association (Visa and MasterCard); 
MCC values cannot be modified in PaymentNet.

To configure the merchant category codes monitor types:

1. Select Administration > Hierarchy > Settings > Compliance Monitoring.
PaymentNet displays the Hierarchy Settings screen for Compliance Monitoring.

2. Select the hierarchy ID for which you want to configure Compliance Monitoring 
settings.

3. Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

4. Select the Override Inheritance checkbox.

5. Click Save.
PaymentNet saves the inherited settings from the parent hierarchy and enables 
the Add links.

6. For the Questionable Merchant Category Codes monitor type, click the Add 
link.
PaymentNet displays the Questionable Merchant Category Codes screen.

7. In the Monitor Name field, enter a unique name to identify this monitor.

8. Enter the MCC value or MCC description of the MCC you want to monitor in the 
Merchant Category Code field.
PaymentNet displays the MCCs that match the value you enter.

9. Select the value that identifies the MCC you want to monitor.
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10. Optionally, to monitor another MCC, click the Add (+) button.
PaymentNet displays another row where you can add an MCC.

11. Repeat steps 8 through 10 to add MCCs. You can add up to 100 MCCs.

12. Click Save.

Configuring the Questionable Merchants Monitor Type
Configure the Questionable Merchants monitor type to track transactions completed 
at specific merchants.

To configure compliance monitoring for questionable merchants:

1. Select Administration > Hierarchy > Settings > Compliance Monitoring.
PaymentNet displays the Hierarchy Settings screen for Compliance Monitoring.

2. Select the hierarchy ID for which you want to configure Compliance Monitoring 
settings.

3. Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

4. Select the Override Inheritance checkbox.

5. Click Save.
PaymentNet saves the inherited settings from the parent hierarchy and enables 
the Add links.

6. For the Questionable Merchants monitor type, click the Add link.
PaymentNet displays the Questionable Merchants screen.

7. In the Monitor Name field, enter a unique name to identify this monitor.

8. Enter the name of the merchant you want to monitor in the Parent Merchant 
Name field.
PaymentNet displays the merchants that match the value you enter.

9. Select the merchant that you want to monitor.
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10. Complete these fields:

Any Amount Select this checkbox if you want to flag any transaction amount 
at the specific merchant. Alternately, you can enter a designated 
amount in the Amount Over text box.

Amount Over If you want to specify a benchmark amount for flagging 
transactions at the specific merchant, enter a value in this field. 
For example, if you want to monitor transactions of $50.00 or 
more, enter $50.00 in this field.

11. Optionally, to monitor another merchant, click the Add (+) button.
PaymentNet displays another row where you can add a merchant.

12. Repeat steps 8 through 11 to add merchants. You can add up to 100 merchants.

13. Click Save.
PaymentNet saves the Questionable Merchants and display a confirmation 
message.

Managing Single-Use Account Orders
You can customize Single-Use Account Orders, including the reconciliation and Order 
settings, along with the merchant email notifications. 

If your J.P. Morgan implementation manager enables the Orders module at the 
Organization level, then the Orders module is available for configuration at the 
Hierarchy level. For instructions on how to enable a module at the Hierarchy level, 
see “Enabling Modules” on page 49.

This task explains the following items:
 Customizing Single-Use Account Order Settings
 Configuring a Merchant Email Notification

Customizing Single-Use Account Order Settings
You can configure PaymentNet to automatically reconcile Single-Use Account Orders. 
When you configure this option, completed Orders are marked as Automatically 
Reconciled.
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To customize Single-Use Account order settings:

1. Select Administration > Hierarchy > Settings > Order.
PaymentNet displays the Hierarchy Settings screen for Orders.

2. Select the hierarchy ID for which you want to configure Orders. 

Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

3. Ensure that Order is selected from the Select Configuration to Edit drop-down 
list.
PaymentNet User Guide



Configuring Administration Settings
4. To change the settings for the current Hierarchy ID and reset the Hierarchy ID 
values, select the Override inheritance checkbox.
PaymentNet activates the Allow auto-reconciliation checkbox.

5. Optionally, if you want PaymentNet to automatically reconcile Orders, select 
the Allow auto-reconciliation checkbox.

6. Click Save.
PaymentNet saves the Order settings and displays a confirmation message.

Configuring a Merchant Email Notification
You can send Single-Use Account payment information to merchants using a 
merchant email notification. If you configure this option, a notification is 
automatically generated and sent to the related merchant once an Order is created 
in PaymentNet.

Merchant reminder email messages include “Reminder:” in the subject line to 
distinguish them from new payment email messages.

If you pay multiple invoices with one Single-Use Account, you can also provide a 
detailed description of each line item within the merchant email notification.
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To configure a merchant email notification:

1. Select Administration > Hierarchy > Settings > Order.
PaymentNet displays the Hierarchy Settings screen for Orders.

2. Select the hierarchy ID for which you want to configure merchant email 
notifications. 

Do one of the following:
 Enter the default Hierarchy ID in the Hierarchy ID field.
 Click the Hierarchy ID link and select the Hierarchy ID from the pop-up 

window.
PaymentNet displays the Hierarchy ID in the Hierarchy ID field.

3. Ensure that Order is selected from the Select Configuration to Edit drop-down 
list.
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4. Click the Merchant E-mail tab.
PaymentNet displays the Merchant E-mail tab.
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5. To change the settings for the current Hierarchy ID and reset the Hierarchy ID 
values, select the Override inheritance checkbox.
PaymentNet activates the Enable merchant email notification checkbox.

6. Select the Enable merchant e-mail notification checkbox.

7. Complete the Merchant E-mail Notification fields that display. For a complete 
list of fields, see List 3: “Merchant E-mail Notification Fields” on page 77.

8. Select the Order Fields you want to include in the notification. For a complete 
list of Order Fields, see List 4: “Merchant E-mail Order Fields” on page 78.

9. Complete the Merchant E-mail Notification Reminder fields that display. For a 
complete list of fields, see List 5: “Merchant E-mail Notification Reminder 
Fields” on page 79.

10. As necessary, add reminders using the plus icon and delete reminders using the 
trash can icon.

11. Optionally, to preview the e-mail notification, click the Preview E-mail button.
PaymentNet displays a preview of the e-mail. 
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12. To exit the e-mail preview, click the Return to Hierarchy Settings button.
PaymentNet displays the Merchant E-mail tab. 

13. Click Save.
PaymentNet saves the email notification settings and displays a confirmation 
message.    

 List 3: Merchant E-mail Notification Fields 

Alias Enter a name to identify the sender. For example, you might enter a 
known nickname or first name.

Reply To Enter the email address to which the response should be sent. You can 
enter one email address in this field.

CC address Enter up to five additional email addresses that should be carbon copied 
on the reply. Separate multiple email addresses with a semi-colon (;).

Subject Enter the email subject.

Message introduction Enter the message introduction. The introduction displays at the 
beginning of the email message.
Note: Bullets entered in this field display as question marks (?) in the 
PaymentNet user interface. However, the bullets display correctly in the 
email messages sent by PaymentNet.

Order Fields Selected the fields to display in the email message from the Available 
Columns box and click the Add> button to add the fields to the Selected 
Columns box. To add all the fields, click the Add All> button. 
Similarly, to remove fields from the Selected Columns box, select the 
fields to remove and click the <Remove button. To remove all the fields, 
click the <<Remove All button.
For a complete list of Order Fields, see List 4: “Merchant E-mail Order 
Fields” on page 78.

Message closing Enter the closing message. The closing message displays at the end of the 
email message.
Note: Bullets entered in this field display as question marks (?) in the 
PaymentNet user interface. However, the bullets display correctly in the 
email messages sent by PaymentNet.

On order create Select this checkbox if you want the email sent to the merchant when a 
new order is first saved or when a valid XML message to create a new 
Order is received.
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On order activate Select this checkbox if you want the email sent to the merchant when the 
system date equals the order start date. Use this feature for Orders 
created with a future start date. 
The email notification is not sent when the order start date is the current 
system date or in the past. 

On order change Select this checkbox if you want the email sent to the merchant when an 
existing Order’s begin date, end date, order total, or list of MCC Groups is 
changed, either online or with a valid XML message.

 List 4: Merchant E-mail Order Fields

Account Number Select this field to include the Single-Use Account number. Only the last 
nine digits display in the merchant email; the first seven digits are 
masked.

Available Order Amount Select this field to include the Order amount available for the merchant 
to charge.

Expiration Date Select this field to include the Single-Use Account expiration date.

Merchant Name Select this field to include the merchant authorized for the Single-Use 
Account.

Order End Date Select this field to include the last day on which the merchant can charge 
the Single-Use Account.

Order Line Items Select this field to include a detailed description of each transaction 
authorized for the Single-Use Account. The description includes the item 
number, the number of units purchased, and the total charge.

Order Notes Select this field to include a description of the remittance detail, such as 
invoice numbers. This field has a 2000 character limit.

Order Start Date Select this field to include the first day on which the merchant can charge 
the Single-Use Account.

Order Total Select this field to include the Order total.

 List 3: Merchant E-mail Notification Fields (continued)
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 List 5: Merchant E-mail Notification Reminder Fields

Days before order end 
date

If you select this option, then you must select a value between 0 and 90. 
The value you select identifies the number of days before the Order end 
date.

Percentage of order 
duration

This percentage is the system date minus the Order start date divided by 
the Order end date minus the Order state date. Options include 25%, 50%, 
or 75%. The default value is 25%.

Weekly Select the day of the week when you want the email reminder sent. The 
default value is Monday.

Monthly Select the day of the month when you want the email reminder sent. The 
default value is the 1st.

Cycle Select the user-defined cycle date (first or last) when you want the email 
reminder sent. 

Setting Up Custom Fields
Use the Custom Fields Setup screen to create and manage custom fields that are 
unique to your company or organization. You can also modify an existing custom 
field.

Additionally, the Transaction module allows you to restrict the user roles that can 
edit the custom field values on the Transaction Detail screen and the Mass Update - 
Transaction screen. 

This topic explains the following:
 Viewing Custom Field Settings
 Creating Custom Fields
 Creating Custom Fields for Transactions

Viewing Custom Field Settings

To view custom field settings:

1. Select Administration > Custom Fields.
The Custom Field Setup screen displays.

2. Select the module to configure from the Select Module drop-down list.
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Creating Custom Fields
Use the steps in this section to create custom fields for the following modules: 
Account, Employee, Merchant, Merchant Category Code and Order.

To create custom fields:

1. Select Administration > Custom Fields.
The Custom Field Setup screen displays.

2. Select the module to configure from the Select Module drop-down list. You may 
set up custom fields for the following list and detail screens:
 Account
 Employee
 Merchant
 Merchant Category Code
 Order

To configure custom fields for the Transaction module, see “Creating Custom 
Fields for Transactions” on page 82.

3. Click the Add item icon (plus symbol) to add items. As required, click the 
Delete item icon (trash can symbol) to delete items. Depending on the module 
selected, one of the following screens display. 
The Custom Field Setup screen displays the same fields for the following 
modules: Account, Employee, Merchant, Merchant Category Code, and Order. 
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4. Enter the applicable criteria for the following fields:
 Description: Name of the custom field (required).
 Edit Type: Select the format for the field. Fields can be configured to 

display as a checkbox, drop-down list, or text box. If Drop Down List is 
selected, do the following:

a. Click the Values link under the Length column to create the values to 
include in the drop-down list.

b. Click the Add item icon (plus symbol) to add items. As required, click 
the Delete item icon (trash can symbol) to delete items.
A row is added where you enter the text in the Value field.

c. Enter the text in Value field; this is the content that will display in the 
drop-down list that the user will select.

d. Click the Continue button.
The Custom Field Setup screen displays.

e. Click the Save button on the Custom Field Setup screen.
The Values you entered are saved.

 Length: Enter the maximum number of characters allowed in the 
description field in the Length field. The Length field can be set from 1 to 
99 maximum characters.

 Required: Select the Required checkbox if the custom field is a mandatory 
item that users must complete.

 Instructional Text: Optionally, enter text describing the desired input from 
the user. This message will display when a user clicks the custom field name 
on the screen where the field appears.

5. Click the Add icon (plus symbol), to add multiple custom fields and complete 
the above steps as necessary. 

6. As required, click the Delete icon (trash can symbol), to delete a custom field
PaymentNet will prompt you to confirm the removal of custom fields.

7. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking the Save button.
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Creating Custom Fields for Transactions
Use the Custom Fields Setup screen to create and manage custom transaction fields 
that are unique to your company or organization. You can also modify an existing 
custom field. The steps in this section explain how to create custom fields for the 
Transaction module.

By default, all users have access to edit custom transaction fields. Users can restrict 
access to fields based on user role.

Also, role access to custom fields extends to custom roles. For example, if you 
restrict the Program Administrator role from editing a custom field, then all Custom 
Program Administrator roles are restricted from editing the same custom field. 

With custom transaction fields, when a user has multiple roles that are eligible for 
editing custom field values, the role that is not restricted takes precedence and the 
user will be able to edit the custom field value.

The roles that can have access are highlighted in Figure 3: “Role Access Setup for a 
Custom Field” on page 82; it shows a new custom field, Audited, and it specifies that 
two user roles, Program Administrators and Transaction Approvers, will be able to 
edit the field. 

 Figure 3: Role Access Setup for a Custom Field 

To create transaction custom fields:

1. Select Administration > Custom Fields.
The Custom Field Setup screen displays.
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2. Select the Transaction module from the Select Module drop-down list. 

To set up custom fields for the other modules (Account, Employee, Merchant, 
Merchant Category Code, and Order), see “Creating Custom Fields” on page 80.

3. Click the Add item icon (plus symbol) to add items. As required, click the 
Delete item icon (trash can symbol) to delete items.
The Custom Field Setup screen displays fields for the Transaction module. 

4. Enter the applicable criteria for the following fields:
 Description: Name of the custom field (required).
 Edit Type: Select the format for the field. Fields can be configured to 

display as a checkbox, drop-down list, or text box. If Drop Down List is 
selected, do the following:

a. Click the Values link under the Length column to create the values to 
include in the drop-down list.

b. Click the Add item icon (plus symbol) to add items. As required, click 
the Delete item icon (trash can symbol) to delete items.
A row is added where you enter the text in the Value field.

c. Enter the text in Value field; this is the content that will display in the 
drop-down list that the user will select.

d. Click the Continue button.
The Custom Field Setup screen displays.
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e. Click the Save button on the Custom Field Setup screen.
The Values you entered are saved.

 Length: Enter the maximum number of characters allowed in the 
description field in the Length field. The Length field can be set from 1 to 
99 maximum characters.

 Required: Select the Required checkbox if the custom field is a mandatory 
item that users must complete.

 Instructional Text: Optionally, enter text describing the desired input from 
the user. This message will display when a user clicks the custom field name 
on the screen where the field appears.

 Include in Line Item: This is marked by default.
 Change Role Access: Click the Roles link for the field that you want to 

specify user roles that can edit the custom field. 

Consider the following when assigning roles. With custom transaction fields, 
when a user has multiple roles that are eligible for editing custom field 
values, the role that is not restricted takes precedence and the user will be 
able to edit the custom field value.

Also, role access to custom fields extends to custom roles. For example, if 
you restrict the Program Administrator role from editing a custom field, 
then all Custom Program Administrator roles are restricted from editing the 
same custom field. 

To remove the editing capability, uncheck the role you want to restrict. 
The custom field values display on the Transaction Detail screen and the 
Mass Update - Transaction screen.

Note: These role access restrictions apply to both System and Custom Roles.
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f. Check each user role to that you want to allow to edit the transaction 
custom field.

g. Click the Continue button.
PaymentNet displays the Custom Field Setup screen.

h. Click Save.
PaymentNet saves your selections.

5. Click the Add icon (plus symbol), to add multiple custom fields and complete 
the above steps as necessary. 

6. As required, click the Delete icon (trash can symbol), to delete a custom field.
PaymentNet will prompt you to confirm the removal of custom fields.

7. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking the Save button.

 

Note: The e-mail message sent from PaymentNet after creating or deleting a custom 
field may contain odd spacing and line breaks. This may make the e-mail 
message difficult to read.

Setting Up User Roles
The Role SetUp screen allows you to create company specific roles to define security 
access and functionality. PaymentNet includes default system roles which cannot be 
modified, but may be used as a template to create custom roles which can be 
edited.

This topic explains the following:
 Viewing User Role List
 Viewing User Role Setup Details
 Defining System Default User Roles
 Creating a Custom User Role
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Viewing User Role List

To view user role settings:

1. Select Administration > Role Setup.
The Role List screen displays.

Viewing User Role Setup Details

To view user role setup details:

1. Display the Role List screen. See “Viewing User Role List” on page 86.

2. Click the role link from the Name column.
The Role Setup screen displays.

Defining System Default User Roles
PaymentNet includes user role system defaults. The user role system defaults are 
standard roles which cannot be modified. PaymentNet user role system defaults 
include:
 Auditor: This role may view all PaymentNet settings, transactions, employees 

(users), card accounts, and Single-Use Account orders (if applicable) within the 
auditor’s hierarchy and scope. Auditors can also run reports.

 Cardholder: This role may view and modify transactions within the cardholder’s 
hierarchy and scope.

 Manager: This role may view and modify all transactions, and manage 
employees (user access) and Single-Use Account orders (if applicable) within the 
manager’s hierarchy and scope.

 Order Requestor: For programs using Single-Use Accounts, this role may create, 
view, modify, and reconcile Single-Use Account orders within the order 
requestor’s hierarchy and scope.

 Program Administrator: This role may view, modify, and configure all 
PaymentNet settings, transactions, employees (users), card accounts, and 
Single-Use Account orders (if applicable) within the program administrator’s 
hierarchy and scope.

 Transaction Approver: This role may view and approve transactions within the 
transaction approver’s hierarchy and scope.
PaymentNet User Guide



Configuring Administration Settings
Creating a Custom User Role
You can select one of the system default user roles, or you can create specialized 
user roles tailored to meet the unique requirements of your company or 
organization. This is achieved by selecting an existing system default user role to act 
as a template for the new role. See “Defining System Default User Roles” on 
page 86. 

Using a template role duplicates all settings for the creation of the new role. This 
approach can save time and standardize the various role types used by your company 
or organization.

This task explains the following:
 Creating a Custom Role
 Modifying a Custom Role
 Deleting a Custom User Role

Creating a Custom Role

To create a custom user role:

1. Display the Role List screen. See “Viewing User Role List” on page 86.

2. Select the radial button next to the existing role that is the system default for 
creating a custom role from the Role List screen.

Note: The role type you select as a template must be the same as the role type you 
wish to customize.

3. Click Add New Role.

Note: This button is enabled after a template role has been selected.

4. From the Role Setup screen, do the following:
 Enter the new role ID in the Role ID field.

Note: The role ID is a required field and must be unique. The role ID is the 
description given to identify the custom role created.
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 Enter the desired name for the role in the Role Description field.

Note: The role description is used to provide additional information on the 
purpose or functionality of the role.

 From the Functions / Options list, do one of the following:
 Select the checkbox to enable the function/options for the new role 

from the Enable Function/Option list.
 Deselect the checkbox to disable the function/options for the new role 

from the Enable Function/Option list.

5. Click Save.

Modifying a Custom Role

To modify a customized role:

1. Display the Role List screen. See “Viewing User Role List” on page 86.

2. Select the radial button next to the existing role to be modified.

3. Click Add New Role. The Role Setup screen displays.

Note: This button is enabled after a the existing role has been selected.

4. Do the following to modify the fields:
 Enter the role ID in the Role ID field.

Note: The role ID is a required field and must be unique. The role ID is the 
description given to identify the custom role created.

 Enter the desired name for the role in the Role Description field.

Note: The role description is used to provide additional information on the 
purpose or functionality of the role.
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 From the Functions / Options list, do one of the following:
 Select the checkbox to enable the function/options for the new role 

from the Enable Function/Option list.
 Deselect the checkbox to disable the function/options for the new role 

from the Enable Function/Option list.

5. Click Save.

Deleting a Custom User Role

To modify a custom user role:

1. Display the Role List screen. See “Viewing User Role List” on page 86.

2. Select the radial button next to the existing role to be removed.

3. Click Add New Role. The Role Setup screen displays.

Note: This button is enabled after a the existing role has been selected.

 

4. Click Delete.

Note: Only a Custom PA role with the Role Setup Delete function enabled is allowed to 
delete custom roles. System PAs do not have Role Setup Delete functionality by 
default.

5. Click Save.

Setting Up Reports
The Report Set Up screen allows you to select which reports you want to allow your 
users to access. User access is based on the role ID assigned to the user. See “Setting 
Up User Roles” on page 85.

For information on customizing available PaymentNet reports, see Chapter 11, 
“Reports” on page 317.

This topic explains the following:
 Viewing Report Settings
 Setting Up Reports
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Viewing Report Settings

To view user role settings:

1. Select Administration > Report Setup.

2. The Report Setup screen displays.

Setting Up Reports

To set up reports:

1. Display the Report Setup screen. See “Viewing Report Settings” on page 90.

2. Select the applicable report category to filter the list of reports from the 
Category drop-down list, located in the top-left corner of the Report Setup 
screen. Reports types are categorized as follows:
 All
 Custom
 Administration
 Accounts
 Transaction
 Order (if applicable)
 Merchant

Note: PaymentNet displays all reports by default.

3. From the Reports list, do one of the following:
 To enable a role ID to access all reports, select the checkbox located 

directly under each user role type column heading.
 To enable access to a specific report for a specific role ID, select each 

checkbox in the report row for each desired role ID column.
 To disable access to a specific report for a specific role ID, deselect each 

checkbox in the report row for each desired role ID column.

4. Click Save.
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Managing Cycles
You can create a new or modify an existing cycle and configure cycle period settings, 
including cycle start date, cycle period begin date, and cycle period end date.

This topic explains the following:
 Viewing the Cycle List
 Viewing Cycle Detail
 Creating a New Cycle
 Using Automation to set up Periods within a Cycle
 Creating Periods within a Cycle using a Manual Process
 Editing an Existing Cycle
 Modifying Existing Period Descriptions
 Deleting an Existing Cycle

Viewing the Cycle List

To view the cycle list:

1. Select Administration > Cycles.
The Cycle List screen displays.

Viewing Cycle Detail

To view user role setup details:

1. Display the Cycle List screen. See “Viewing the Cycle List” on page 91.

2. Click the desired cycle link from the Name column.
The Cycle Detail screen displays.

Creating a New Cycle
You can add new cycles based on the accounting needs of your company or 
organization. This includes the ability to configure PaymentNet to automatically 
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generate the periods within a cycle. Alternately, you can also manually create the 
periods within a cycle, if preferred.

Note: A period is defined as sub-portion of a cycle.

To create a new cycle:

1. Display the Cycle List screen. See “Viewing the Cycle List” on page 91.

2. Click Add New Cycle. 
The Cycle Detail screen displays.

3. Enter a name for the new cycle in the Name field.

4. Select the Automatically Adjust Current Indicator checkbox (if desired). When 
you select the Automatically Adjust Current Indicator checkbox, PaymentNet 
automatically configures the start date for the first period within the new cycle.

5. Click Save.

Using Automation to set up Periods within a Cycle

To automate the set up of periods within a cycle:

1. Display the Cycle Detail screen. See “Viewing Cycle Detail” on page 91.

2. Enter a name for the new cycle in the Name field.

3. Select the Automatically Adjust Current Indicator checkbox (if desired).When 
you select the Automatically Adjust Current Indicator checkbox, PaymentNet 
automatically configures the start date for the first period within the new cycle.
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4. From the Create Periods for this Cycle section, do the following:
 Select the desired span between each period from the Range drop-down 

list. The range defines the number of days between the start of each period 
within the cycle. Options include:
 Biweekly
 Flexible Schedule

Note: The flexible schedule option is also known as 4-4-5. This option 
divides the year into four 13-week periods. Each 13-week period is 
further segmented into three month periods. Each three month period 
is then divided into increments of 4,4, and 5 weeks.

 Weekly
 Monthly

 Enter the date you want the automation process to begin creating periods 
within the cycle. Do one of the following:
 Enter the begin date in the Start Date field.

Note: The start date should be entered using the MM/DD/YYYY format. 

 Click the Start Date link and select the desired period start date from 
the pop-up calendar.

 Select the span of years over which to have periods within the cycle created 
automatically from the Number of Years drop-down list. You can select to 
have periods within the cycle automatically created for a minimum of one 
year and a maximum of three years.

 Select the Adjust for Weekends and Holidays checkbox (if desired). This 
option is used in cases when the begin or end dates for a period that was 
created automatically occurs on a weekend or holiday.

Note: If you need begin and end dates for an automatically created period to be 
adjusted for weekends and holidays, you should only select to have periods 
created for the current year - instead of over a span of multiple years.

5. Click Create Periods.
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6. PaymentNet automatically pre-populates the following information for each 
period:
 Period ID: A read-only field which lists the periods in sequential order.
 Description Field: A text field which allows you to input a unique name for 

each period. You may enter a maximum of 25 characters for the 
description.

 Begin Date: This field is the first day each automatically created period 
begins. The begin date is equal to the Start Date field, located in the 
Create Periods For This Cycle section.s

Note: When the begin date is automatically created, all subsequent begin dates 
are configured to start one day after the previous period.

 

 End Date: This field is the last day each automatically created period 
within the cycle ends. The end date is calculated based on the option 
selected from the Range drop-down list, located in the Create Periods for 
this Cycle section.

Note: The Description, Begin Date, and End Date fields can also be entered 
manually. See “Creating Periods within a Cycle using a Manual Process” on 
page 94.

 Current: This option allows you to easily identify the current period within 
a specific cycle.

7. If modifications to automatically created periods are needed, do one of the 
following:
 Click the Add icon (plus symbol), to add period fields.
 Click the Delete icon (trash can symbol), to delete period fields.

8. Click Save.

Creating Periods within a Cycle using a Manual Process

To manually create periods within a cycle:

1. Display the Cycle Detail screen. See “Viewing Cycle Detail” on page 91.

2. Enter a name for the new cycle in the Name field.
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3. Select the Automatically Adjust Current Indicator checkbox (if desired). When 
you select the Automatically Adjust Current Indicator checkbox, PaymentNet 
automatically configures the start date for the first period within the new cycle.
 Enter a unique name for each period within the cycle in the Description 

Field. A text field which allows you to input a unique name for each period. 
You may enter a maximum of 25 characters for the description.

4. Enter the following information for each period you wish to create:

Note: PaymentNet automatically pre-populates Period ID information for each period 
created.

 Description Field: A text field which allows you to input a unique name for 
each period. You may enter a maximum of 25 characters for the 
description.

 Begin Date: This field is the first day each created period begins. 
 End Date: This field is the last day each created period within the cycle 

ends.

Note: The Description, Begin Date, and End Date fields can also be 
automatically created. For instructions on how to automatically set up 
periods within a cycle, see “Using Automation to set up Periods within a 
Cycle” on page 92.

 Current: This option allows you to easily identify the current period within 
a specific cycle.

5. To add or delete period fields, do one of the following:
 Click the Add icon (plus symbol), to add period fields.
 Click the Delete icon (trash can symbol), to delete period fields.

6. Click Save.

Editing an Existing Cycle
Cycles may be edited to add additional periods, change the dates of existing periods, 
remove periods, or change the current period. In particular, mappers are generally 
configured to run on cycles, and need a current period to return accurate results. 
For this reason, any cycles in active use should be updated to ensure future periods 
are defined, and a current period exists. Use the following steps to add more periods 
to an existing cycle.
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To edit an existing cycle:

1. Select Administration > Cycles.
The Cycle List screen displays.

2. Click the desired cycle link from the Name column.
The Cycle Detail screen displays.

3. To modify the selected cycle, to add more periods, for example, use the Create 
Periods for this Cycle section and do the following:
 Select the desired span between each period from the Range drop-down 

list. The range defines the number of days between the start of each period 
within the cycle.
 Biweekly
 Flexible Schedule

Note: The flexible schedule option is also known as 4-4-5. This option 
divides the year into four 13-week periods. Each 13-week period is 
further segmented into three month periods. Each three month period 
is then divided into increments of 4,4, and 5 weeks.

 Weekly
 Monthly

 Enter the date you want the automation process to begin creating periods 
within the cycle. Do one of the following:
 Enter the begin date in the Start Date field.

Note: The start date should be entered using the MM/DD/YYYY format. 

 Click the Start Date link and select the desired period start date from 
the pop-up calendar.

 Select the span of years over which to have periods within the cycle created 
automatically from the Number of Years drop-down list. For example, if 
you need to add two years, select 02 from the list. You can select to have 
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periods within the cycle automatically created for a minimum of one year 
and a maximum of three years. 

 Select the Adjust for Weekends and Holidays checkbox (if desired). This 
option is used in cases when the begin or end dates for a period that was 
created automatically occurs on a weekend or holiday.

Note: If you need begin and end dates for an automatically created period to be 
adjusted for weekends and holidays, you should only select to have periods 
created for the current year - instead of over a span of multiple years.

4. Click Create Periods.

5. PaymentNet automatically pre-populates the following information for each 
period within the existing list of the Cycle Detail screen:
 Period ID: A read-only field which lists the periods in sequential order.
 Description: A text field which allows you to input a unique name for each 

period. You may enter a maximum of 25 characters for the description.
 Begin Date: This field is the first day each automatically created period 

begins. The begin date is equal to the Start Date field, located in the 
Create Periods For This Cycle section.

Note: When the begin date is automatically created, all subsequent begin dates 
are configured to start one day after the previous period.

 

 End Date: This field is the last day each automatically created period 
within the cycle ends. The end date is calculated based on the option 
selected from the Range drop-down list, located in the Create Periods For 
This Cycle section.

 Current: This option allows you to easily identify the current period within 
a specific cycle.

6. Deselect the Automatically Adjust Current Indicator checkbox; this is to clear 
the checkbox.

7. Select the Current button for the period within a specific cycle that you want as 
the current period.

8. Click Save.
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Modifying Existing Period Descriptions
PaymentNet allows you to make modifications to the name of a period within a 
cycle.

Note: PaymentNet only allows for you to modify the name of a period within a cycle. To 
prevent errors in cycle and period data, other modifications are not permitted.

To modify an existing cycle:

1. Display the Cycle List screen. See “Viewing the Cycle List” on page 91.

2. Select the cycle to be modified, from the Name column.

3. Enter the unique name for each period, in the Description Field. This is a text 
field which allows you to input a unique name for each period within the cycle. 
You may enter a maximum of 25 characters for the description.

4. Click Save.

Deleting an Existing Cycle
PaymentNet allows you to delete a cycle.

Note: You cannot delete a cycle if it is associated with transaction approval email 
notifications.

To delete an existing cycle:

1. Display the Cycle List screen. See “Viewing the Cycle List” on page 91.

2. Select the cycle to be deleted. The Cycle Detail screen displays.

3. Click Delete.

Managing Merchants
You can view, configure or export merchant information.You can also set up 
transaction defaults and custom fields for merchants.
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This topic explains the following:
 Viewing the Merchant List
 Viewing Merchant Details
 Configuring Merchant Settings

Viewing the Merchant List

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

To view the merchant list:

1. Select Administration > Merchants.
The Merchant List screen displays.
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Viewing Merchant Details

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

To view merchant details:

1. Display the Merchant List screen. See “Viewing the Merchant List” on page 99.

2. Do one of the following:
 Click the desired merchant from the Merchant Name column.
 Perform a Query to locate a specific record. See “Queries” on page 259.

3. Select the appropriate tab to view additional information. The following tabs 
are available from the Merchant Detail screen:
 General Information
 Status

Note: PaymentNet users may see an error message when clicking the MCC link on the 
Transaction Detail or Merchant Detail screens. This occurs when an MCC in 
PaymentNet has not been assigned a T&E Type. MCCs that do not have a T&E 
Type display on the Transaction Detail screen but do not display in the Merchant 
Category Code List screen.
Use the Merchant Category Code import file to update the T&E Type field for 
these MCCs in your organization.

 

Configuring Merchant Settings
You can view and configure merchant profile information from the Merchant Detail 
screen. You can allow PaymentNet to automatically configure the information, or 
you can configure the information manually.
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This task explains the following:
 Configuring Merchant General Information Automatically
 Configuring Merchant General Information Manually
 Configuring Merchant Status Settings Automatically
 Configuring Merchant Status Settings Manually

Configuring Merchant General Information Automatically

To configure merchant general information automatically:

Note: Card associations regularly update their merchant information. Automatically 
Update This Merchant sets the PaymentNet default to update the merchant 
information automatically when changes are provided by the card association.
Do not select this option if you prefer to manually update or preserve the existing 
information you have for the merchant.

1. Display the Merchant Detail screen. See “Viewing Merchant Details” on 
page 100. The General Information tab displays.

2. Select the Automatically Update This Merchant checkbox. The following fields 
update automatically and may not be edited:
 Address 1
 Address 2
 Zip/Postal Code
 Phone
 Fax

3. Complete the following fields (if applicable):

Note: The merchant information listed below is provided by the card association. With 
the exception of the parent merchant information, this information cannot be 
modified.
Though the option to modify parent merchant information is available, it is not 
recommended, as it can impact report data roll-up. For example, if your 
company or organization uses two different Store Depots to make purchases, 
one of which is named Store Depot #123 and the other Store Depot #345, but, 
the parent merchant name for one is Store Depot, while the other parent 
merchant is changed to Store Dpt, then the information for both Store Depots 
will roll up to two separate parent merchants instead of one. The result is the 
data for Store Depot will not be consolidated for reporting purposes.
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 Merchant Name: This field identifies where the purchase was made. This is 
a read-only field.

 Merchant ID: This field is a unique identifier used to help reference a 
merchant. This is a read-only field.

 Parent Merchant: This field identifies the parent of an individual merchant. 
This information is used for reporting purposes, providing information on 
merchant roll-up information. Program administrators can change the 
parent merchant name for an individual merchant.

 Association: This field identifies which card association provided the 
merchant data. This is a read-only field.

 MCC: This field displays the four-digit code assigned to the merchant by the 
card association. It is used to classify the type of good or services provided 
by the merchant.

4. Complete the Notes field:
 Notes: You may enter any additional information as needed. You may enter 

up to a maximum of 3,000 characters.

5. From the Transaction Defaults section, do the following:
 Select the appropriate default accounting code from the Chart of Accounts 

drop-down list.
 Enter the applicable information in the additional fields that display when a 

specific Chart of Accounts is selected.

Note: The criteria filter options that display vary based on the Chart of Accounts 
selected from the Chart of Accounts drop-down list.

 

6. Complete any additional custom fields (if applicable). See “Setting Up Custom 
Fields” on page 79.

7. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.
PaymentNet User Guide



Configuring Administration Settings
Configuring Merchant General Information Manually

To configure merchant general information manually:

1. Display the Merchant Detail screen. See “Viewing Merchant Details” on 
page 100. The General Information tab displays.

2. Deselect the Automatically Update This Merchant checkbox. See “Configuring 
Merchant General Information Automatically” on page 101.

3. Complete the following fields (if applicable):

Note: The merchant information listed below is provided by the card association. With 
the exception of the parent merchant information, this information cannot be 
modified.
Though the option to modify parent merchant information is available, it is not 
recommended, as it can impact report data roll-up. For example, if your 
company or organization uses two different Store Depots to make purchases, 
one of which is named Store Depot #123 and the other Store Depot #345, but, 
the parent merchant name for one is Store Depot, while the other parent 
merchant is changed to Store Dpt, then the information for both Store Depots 
will roll up to two separate parent merchants instead of one. The result is the 
data for Store Depot will not be consolidated for reporting purposes.

 Merchant Name: This field identifies where the purchase was made. This is 
a read-only field.

 Merchant ID: This field is a unique identifier used to help reference a 
merchant. This is a read-only field.

 Parent Merchant: This field identifies the parent of an individual merchant. 
This information is used for reporting purposes, providing information on 
merchant roll-up information. Program administrators can change the 
parent merchant name for an individual merchant.

 Association: This field identifies which card association provided the 
merchant data. This is a read-only field.

 MCC: This field displays the four-digit code assigned to the merchant by the 
card association. It is used to classify the type of good or services provided 
by the merchant.
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4. Complete the following merchant address fields:
 Address 1: This is a text field. You may enter a maximum of 25 characters.
 Address 2: This is a text field. You may enter a maximum of 25 characters.
 ZIP/Postal Code: You may enter a maximum of 10 characters. This field 

does not auto-validate the information.
 Phone: This field requires exactly 12 characters. The phone number can be 

entered with or without dashes, and will automatically format the number 
to display as 999-999-9999. This field does not auto-validate the 
information.

 Fax: This field requires exactly 12 characters. The phone number can be 
entered with or without dashes, and will automatically format the number 
to display as 999-999-9999. This field does not auto-validate the 
information.

5. Complete the Notes field:
 Notes: You may enter any additional information as needed. You may enter 

up to a maximum of 3,000 characters.

6. From the Transaction Defaults section, do the following:
 Select the appropriate default accounting code from the Chart of Accounts 

drop-down list.
 Enter the applicable information in the additional fields that display when a 

specific Chart of Accounts is selected.

Note: The criteria filter options that display vary based on the Chart of Accounts 
selected from the Chart of Accounts drop-down list.

 

7. Complete any additional custom fields (if applicable). See “Creating Custom 
Fields” on page 80.

8. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.
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Configuring Merchant Status Settings Automatically

To configure merchant status automatically:

1. Display the Merchant Detail screen. See “Viewing Merchant Details” on 
page 100. 

2. Select the Status tab.

3. Select the Automatically Update This Merchant checkbox.

Note: Card associations regularly update their merchant information. Automatically 
Update This Merchant sets the PaymentNet default to update the merchant 
information automatically when changes are provided by the card association.
Do not select this option if you prefer to manually update or preserve the 
existing information you have for the merchant.

4. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.

Configuring Merchant Status Settings Manually

To configure merchant status settings manually:

1. Display the Merchant Detail screen. See “Viewing Merchant Details” on 
page 100. 

2. Select the Status tab.

3. Deselect the Automatically Update This Merchant checkbox.
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4. Complete the following fields (if applicable):

Note: The merchant information listed below is provided by the card association. With 
the exception of the parent merchant information, this information cannot be 
modified.
Though the option to modify parent merchant information is available, it is not 
recommended, as it can impact report data roll-up. For example, if your 
company or organization uses two different Store Depots to make purchases, 
one of which is named Store Depot #123 and the other Store Depot #345, but, 
the parent merchant name for one is Store Depot, while the other parent 
merchant is changed to Store Dpt, then the information for both Store Depots 
will roll up to two separate parent merchants instead of one. The result is the 
data for Store Depot will not be consolidated for reporting purposes.

 Merchant Name: This field identifies where the purchase was made. This is 
a read-only field.

 Merchant ID: This field is a unique identifier used to help reference a 
merchant. This is a read-only field.

 Association: This field identifies which card association provided the 
merchant data. This is a read-only field.

 MCC: This field displays the four-digit code assigned to the merchant by the 
card association. It is used to classify the type of good or services provided 
by the merchant.

5. Complete the following merchant status fields (if applicable):
 Corporate Status Code: Identifies how the company or organization is 

classified.
 Taxpayer ID:A tax processing number issued by the Internal Revenue 

Service to individuals who are required to have a U.S. taxpayer 
identification number but who do not have, and are not eligible to obtain a 
Social Security Number (SSN) from the Social Security Administration (SSA).

 Business Owner Ethnicity: This option is available only for Visa Merchants. 

6. Select the status checkbox for all that apply to the merchant.

Note: You may select more than one status for a merchant.

7. Click Save.

Note: If you are performing multiple tasks, you can complete all of the tasks before 
clicking Save.
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Merchant Category Codes
You can view, configure or export Merchant Category Codes information from the 
Merchant Category List screen. In addition you can update information, including 
the assigned type classification, and add reference notes.

This topic explains the following:
 Viewing the Merchant Category Code List
 Viewing Merchant Category Code Details
 Configuring Merchant Category Code Settings

Viewing the Merchant Category Code List

To view the merchant category code list:

1. Select Administration > Merchant Category Codes. 
PaymentNet displays the Merchant Category Code List screen.

Viewing Merchant Category Code Details

To view merchant category code details:

1. Display the Merchant Category Code List screen. See “Viewing the Merchant 
Category Code List” on page 107.

2. Click the desired MCC from the MCC Description column. 
PaymentNet displays the Merchant Category Code Detail screen.

Configuring Merchant Category Code Settings
You can view, configure, or export Merchant Category Codes information from the 
Merchant Category List screen. In addition, you can update the assigned type 
classification and add reference notes.

To configure merchant category code settings:

1. Select Administration > Merchant Category Codes.
PaymentNet displays the Merchant Category Codes List screen.
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2. Click the name of the merchant category code whose details you want to edit 
from the MCC column. Alternately, you can conduct a query to find the 
merchant category code whose details you want to edit.
PaymentNet displays the Merchant Category Code Detail screen.

3. The following fields automatically populate with default information, as 
provided by the card association: 

Merchant Category Code This field displays the four-digit code assigned to the merchant 
by the card association. It classifies the type of goods or services 
provided by the merchant. This is a read-only field and cannot be 
modified.

Description This field identifies the type of merchant associated with the 
merchant category code. This is a read-only field.

4. Complete the fields that display. For a complete list of fields, see List 6: 
“Merchant Category Code Detail Fields” on page 109.

5. Optionally, you can review, add, and delete merchant category code transaction 
defaults:
 To review the merchant transaction default list, complete these steps:

a. Click the Advanced button in the Transaction Defaults box.
PaymentNet displays the Advanced Transaction Defaults List.

b. Review the Hierarchy ID and accounting code associated with the 
merchant.

 To add a merchant as a transaction default:

a. Click the Advanced button in the Transaction Defaults box.
PaymentNet displays the Advanced Transaction Defaults List.

b. Click the Add button.

c. Enter the Hierarchy ID to be associated with the merchant category 
code transaction default.

d. Select the Override Inheritance box, if applicable.

e. Click Save.
 To delete a merchant category code as a transaction default:

a. Click the Advanced button in the Transaction Defaults box.
PaymentNet displays the Advanced Transaction Defaults List.
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b. Click the Delete button.

6. Click Save.
PaymentNet saves the merchant category code settings and displays a 
confirmation message. 

 List 6: Merchant Category Code Detail Fields

Type Select the card program from this drop-down list. You can select T&E, 
Fleet, or Purchase. 

T&E Type If you select T&E from the Type drop-down list, then you must select a 
value from this drop-down list that identifies the travel expense. You can 
select one of these options:
 Lodging
 Other
 Travel
 Restaurant
 Car Rental
 Airline

Notes Enter any notes related to the Merchant Category Code.

Transaction Defaults Select the appropriate Chart of Accounts from the Chart of Accounts 
drop-down list and complete the remaining context-sensitive fields.

Merchant Category Code Groups
Merchant Category Code Groups (MCCGs) allow you to assign related MCCs to a 
particular group. For example, MCCs for an auto repair shop, auto service center, 
and an auto tire center may all be added to an “Automotive” MCCG. Most MCCGs are 
predefined; however, you can create your own MCCG to meet the needs of your 
organization, if needed. This capability streamlines the process of creating MCCGs 
and is configurable at the organization or hierarchy level. To create MCCGs, you 
must enable the MCCG module.

This topic explains the following tasks:
 Viewing Merchant Category Code Group Detail
 Configuring Merchant Category Code Groups
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Viewing Merchant Category Code Group Detail

To view merchant category code group detail:

1. Select Administration > Merchant Category Code Groups. 
PaymentNet displays the General Information tab.

Configuring Merchant Category Code Groups

To configure merchant category code groups:

1. Display the Merchant Category Code Detail screen. See “Viewing Merchant 
Category Code Group Detail” on page 110.

2. From the General Information tab, select the company number (e.g., US12345) 
provided by your processor to associate with the MCCG from the Company 
Number drop-down.

Note: Additional fields will appear once a company number is selected.

3. Select the bank number from the Bank drop-down list.

4. Enter an identifier (e.g., “Automotive,” “Restaurants,” “Hotels”) for the group 
in the MCCG Name field.

5. Enter identifying information in the MCCG Description field.

6. Click Continue.

7. From the Select MCCs tab, do one of the following:
 Enter the MCC ranges or individual MCCs to include in the MCCG in the text 

field. An MCCG should contain only unique MCC entries.

Note: MCC ranges must contain a hyphen (-) between each MCC and a comma 
must separate each range or individual MCC (i.e., 3000-4000, 6000-8000, 
0001).
PaymentNet User Guide



Configuring User Settings
 From the list of MCCs, select the checkbox next to each desired MCC. Click 
Add Selected MCCs to List to include in the group.

 Query for the desired MCCs. Select the checkbox next to each desired MCC. 
Click Add Selected MCCs to List to include in the group.

8. Click Continue.

9. From the Save Changes tab, confirm your selections. 

10. Click Save.

Configuring User Settings
You can manage user settings in the My Profile menu. For example, you can use the 
My Profile menu to set up email notifications, change your password, add bank 
account information, customize screen views, and manage account settings.

To access this menu, click the My Profile icon on the PaymentNet navigation bar.

This section explains the following:
 Managing Your Profile

Managing Your Profile
The My Profile screen is divided into four tabs: the General Information, Bank 
Information, Screen Views, and Accounts tabs.

This topic explains the following tasks:
 General Information
 Bank Account Information
 Screen Views
 Accounts

General Information
Use the General Information tab to change your password and manage your email 
notifications.
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This task explains the following items:
 Changing your Password
 Managing your Authentication Questions
 Setting up Email Notifications

Changing your Password
In order to access PaymentNet, you must enter your organization ID, user ID, and 
password. Your password is a security feature that prohibits unauthorized access to 
PaymentNet.

When you change your password, your new password must conform to the password 
constraints that display on the screen between the New Password and Confirm New 
Password fields, not contain any spaces, include at least one letter and one number, 
be different than your User ID, and be different than your last five passwords. 

Additionally, when you voluntarily change your password, you must enter the old 
password in addition to entering (and confirming) the new password. If this is not 
done successfully after six (6) attempts, the user logon is automatically disabled. 
Your Administrator must then enable your account before you can log on to 
PaymentNet.

To change your password:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click Change Password to expand the content and show the details.
PaymentNet displays the password fields.

3. Complete these fields:

Current Password Enter your old password. This field is case-sensitive and required.

New Password Enter your new password. This field is case-sensitive and 
required. Your new password must conform to the password 
constraints that display below this field.

Confirm New Password Confirm your new password. This field is case-sensitive and 
required.

4. Click the Save button.
PaymentNet saves the password settings. Your new password takes effect the 
next time you log in to PaymentNet.
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Managing your Authentication Questions
Authentication questions are used to verify your identity if you forget your password.

To manage your authentication questions:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Complete at least three of the Authentication Questions that display. 

3. Click Save.
PaymentNet saves the authentication questions.

Setting up Email Notifications
You can configure PaymentNet so email notifications are sent to you once certain 
action items are complete or require further attention. For example, you might want 
to receive an email notification each time a recurring payment is successfully 
processed. 

You can configure email notifications on the General Information tab.

To set up email notifications:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Complete this field:

E-Mail Address Enter your email address. The email address you enter is used for 
PaymentNet notifications.
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3. Select the checkbox next to the email notifications you want to receive. You can 
elect to receive email notifications for different action items and modules:
 Reports
 Transactions for Review
 Transactions for Approval
 Import Files
 Export Files
 Payments
 Mappers
 Unreconciled Orders

Note: PaymentNet is sending Single-Use Account unreconciled orders email 
notifications even though non reconciled orders exist.

 Orphaned Transactions
 Account Request Errors
 Mass Update Completion
 Receipt Images Attached
 Compliance Monitoring

Note: Available email notification options vary based on your assigned user role.

4. Click the Save button.
PaymentNet saves the email settings and displays a confirmation message.

Note: Email notifications sent from PaymentNet use “http” instead of “https” in the 
address link to PaymentNet. In specific situations, the browser may not redirect 
to the “https” address and you may be unable to log on.
If you are unable to log on to PaymentNet after clicking the address in a 
PaymentNet email notification, complete the following:
1. Enter the following address in your browser address bar: 
https://www.paymentnet.jpmorgan.com
2. Enter your Organization ID, User ID, and Password.
3. Click Log On.
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Bank Account Information
You can configure and edit bank account information using the Bank Information tab. 
When you configure bank account information, you provide the bank account from 
which to withdraw funds. 

Bank information includes your ABA Routing Number, Bank Account Type, and Bank 
Account Number.

This task explains the following items:
 Setting Up Bank Account Information
 Editing Bank Account Information
 Deleting Bank Account Information

Setting Up Bank Account Information
In order to create and manage online payments through PaymentNet, you must 
provide the bank account from which to withdraw funds.

To set up bank account information:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Bank Information tab.
PaymentNet displays the Bank Information tab.

3. Click the Add Bank button.
PaymentNet displays the Add Bank screen.

4. Complete these fields:

ABA Routing Number Enter your ABA Routing Number. This is a nine digit bank code 
that appears on the bottom of a deposit slip or a check. The ABA 
Routing Number identifies your financial institution.

Bank Account Type Select your bank account type, such as Checking or Savings, from 
this drop-down list.
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5. Click Save. 
PaymentNet saves the bank information and displays the bank on the Bank 
Information tab.

Editing Bank Account Information
You can edit bank information, including the ABA Routing Number, Bank Account 
Type, Bank Account Number, and other account details.

To edit bank account information:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Bank Information tab.
PaymentNet displays the Bank Information tab.

3. In the Account Number column, click the link to the account you want to edit.
PaymentNet displays the Account Detail screen.

4. Edit these fields as necessary:

ABA Routing Number Edit your ABA Routing Number. This is a nine digit bank code that 
appears on the bottom of a deposit slip or a check. The ABA 
Routing Number identifies your financial institution.

Bank Account Type Select your bank account type, such as Checking or Savings, from 
this drop-down list.

Bank Account Number Edit your ten digit bank account number. Your bank account 
number is your complete account number that appears at the 
bottom of a deposit slip or a check, next to the ABA Routing 
Number.

Description Edit a description of the account.

5. Click Save.
PaymentNet saves the bank settings and displays a confirmation message.

Bank Account Number Enter your 10 digit bank account number. Your bank account 
number is your complete account number that appears at the 
bottom of a deposit slip or a check, next to the ABA Routing 
Number.

Description Enter a description of the account.
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Deleting Bank Account Information
You can delete bank account information as needed.

To delete bank account information:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Bank Information tab.
PaymentNet displays the Bank Information tab.

3. In the Account Number column, click the link to the account you want to 
delete.
PaymentNet displays the Account Detail screen.

4. Click the Delete button.
PaymentNet deletes the bank information.

Screen Views
Use the Screen Views tab to determine which columns you want to display on the 
PaymentNet module List screens. The List screens available for configuration vary 
based on your assigned PaymentNet user role.

To configure screen views:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Screen Views tab.
PaymentNet displays the Screen Views tab.

3. From the Screen to Configure drop-down list, select the screen you want to 
configure. You can configure any one of these List screens:
 Account List
 Employee List
 MCC List
 Merchant List
 Transaction List
117



2 | Configuring PaymentNet

118
4. Complete this field:

Number of items per page Enter the number of line items that you want to display for each 
List screen.

5. Move fields from the Available Columns box to the Selected Columns box using 
the arrows that display. Use these buttons: 

Add > Click this button to move highlighted fields from the Available 
Columns box to the Selected Columns box. 

Add All > Click this button to move all the fields from the Available 
Columns box to the Selected Columns box.

< Remove Click this button to move highlighted fields from the Selected 
Columns box to the Available Columns box. 

<< Remove All Click this button to move all the fields from the Selected 
Columns box to the Available Columns box.

 

6. As necessary, remove columns that you do not want to display on the List screen 
by moving them from the Selected Columns box to the Available Columns box. 

7. Configure the column display order.

In the Selected Columns box, select the column you want to move and click one 
of these arrows:
 Click the first up arrow key to move a column to the top of the list.
 Click the second up arrow key to move a column up one level.
 Click the first move down arrow key to move a column down one level.
 Click the second down arrow key to move a column to the bottom of the 

list.

8. Click Save.
PaymentNet saves the screen view settings and displays a confirmation 
message.

Accounts
Use the Accounts tab to access a snap-shot view of your card account profile, 
including your current balance, available credit, hierarchy ID, credit limit, and 
address information. 
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You can also use the Accounts tab to view your card account profile, select your 
statement delivery preference, and manage your convenience checks.

This task explains the following items:
 Viewing Payment Information
 Viewing Card Account Profile Information
 Selecting Statement Delivery Preference
 Viewing Statement Information
 Managing Convenience Checks

Viewing Payment Information
Access the Accounts tab to view completed and recurring payments. For additional 
payment information, see Chapter 12, “Statements and Payments” on page 327.

To view your payment information:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Accounts tab.
PaymentNet displays the Accounts tab.

3. In the Payment column, click the icon that corresponds to the account for which 
you want to view payments.
PaymentNet displays the payment history and, if applicable, the recurring 
payment schedule.

Viewing Card Account Profile Information
You can view your card account profile, including your current balance, available 
credit, hierarchy ID, credit limit, and address information.

To view your card account profile:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.
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2. From the Accounts tab, you can view or access payment, card status, statement 
delivery method, and statement information. To view more detailed card 
account profile information, click the Account Number link.

Note: PaymentNet users may see the Application Error screen when attempting to 
view a replacement account from the Accounts tab in the My Profile screen. This 
occurs for a replacement account when the user has a scope of view of “Self” 
and the lost or stolen account is not assigned to any user.

Selecting Statement Delivery Preference
When you select your statement delivery preference, you determine if you want to 
receive electronic or mailed statements. For additional statement information, see 
Chapter 12, “Statements and Payments” on page 327.

To select your statement delivery preference:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.

2. Click the Accounts tab.

3. For each account, select one of the following delivery preference options from 
the Statement Delivery drop-down list:
 Electronic
 Electronic With Reminder
 Mailed

4. Click Save.
PaymentNet saves the statement delivery settings and displays a confirmation 
message.

Viewing Statement Information
You can view and download your statement activity for current and past statements.

To view your statement information:

1. Click the My Profile icon.
PaymentNet displays the General Information tab.
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2. Click the Accounts tab.
PaymentNet displays the Accounts tab.

3. In the Statement column, click the icon that corresponds to the account for 
which you want to view statements.
PaymentNet displays the Statement Detail screen.

4. To modify the statement in view, select a different billing date from the Billing 
Date drop-down menu.
PaymentNet displays the statement that corresponds to the selected billing 
date.

Managing Convenience Checks
If your organization uses convenience checks, and your program administrator has 
granted you permission, you can order new checks and stop payment on existing 
checks. Otherwise, contact your program administrator for assistance with these 
tasks. For program administrator instructions, see Chapter 14, “Convenience 
Checks” on page 347.

To manage convenience checks:

1. Click the My Profile icon.
PaymentNet displays the General Information tab on the My Profile screen.

2. Click the Accounts tab.
PaymentNet displays the Accounts tab.

3. In the Account Number column, click the account number of the account for 
which you want to manage your convenience checks.
PaymentNet displays the My Profile - Account Detail screen.

4. Do one of the following:
 To order new convenience checks:

a. Select Order New Checks from the Convenience Check drop-down 
list.

b. Click the Go button.
PaymentNet displays the Convenience Checks - Order New Checks 
screen.
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c. Verify that the Account Number and Account Name are correct for the 
checks you want to order and then click the Continue button.
PaymentNet submits the order and displays the My Profile - Account 
Detail screen.

Note: Checks are shipped within five business days of the order date. If you 
need a more immediate response or would like the checks mailed to a 
different address, contact your program administrator.

 To stop payment on an existing convenience check:

a. Select Stop Payment from the Convenience Check drop-down list.

b. Click the Go button.
PaymentNet displays the Convenience Checks - Stop Payment screen.

c. Verify that the Account Number and Account Name are correct for the 
check on which you want to stop payment and then complete the 
following fields:

Check Range/Number
Enter the check number, or the range of numbers, of the check(s) on 
which you want to stop payment.

Check Date
Enter the date the check was written. Dates must be entered in the 
mm/dd/yyyy format. Alternately, click the Check Date link and select 
the date from the calendar that displays.

Check Amount $
Enter the dollar amount for which the check was made.

Payee Name
Enter the name of the individual or business to which the check was 
made.

d. Click the Continue button.
PaymentNet submits the stop order and displays the My Profile - 
Account Detail screen.

Note: Stop payments take effect eight business days after the stop is issued. 
If you need a more immediate response, contact your program 
administrator.
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 Hierarchy Structure
A hierarchy is a defined structure of parent and child entities. When you create a 
hierarchy, you customize settings for selected transactions, accounts, and users. 

You can also use hierarchy controls to personalize PaymentNet for each area of your 
organization. For more information, see “Managing Hierarchy Settings” on page 40.

This chapter explains the following sections:
 Viewing Hierarchy Information
 Managing Hierarchy IDs

Viewing Hierarchy Information
You can view the current hierarchy organization or review the history of changes 
made to the hierarchy.

This section explains the following topics:
 Viewing your Organizational Hierarchy
 Viewing the Hierarchy History
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Viewing your Organizational Hierarchy
You can view the current hierarchy organization from the Manage Hierarchy screen.

To view your organizational hierarchy:

1. Select Administration > Hierarchy > Manage. 
The Manage Hierarchy screen displays. 

2. Click a hierarchy folder name to select, expand, or collapse the hierarchy.

Viewing the Hierarchy History
You can view changes made to the hierarchy structure of your organization by 
reviewing the Hierarchy Manage - History screen. Audit data may take up to twenty-
four hours to update.Therefore, changes made in PaymentNet may not display on 
this screen until the next day.

To view the hierarchy history:

1. Select Administration > Hierarchy > Manage. 
The Manage Hierarchy screen displays. 

2. Click the History link. 
The Hierarchy Manage - History screen displays.

3. Review the following history information:
 Change Date. Displays the date that the change was made.
 Change Time. Displays the time that the change was made.
 Hierarchy ID. Displays the hierarchy ID where the change took place.
 Field Name. Displays the hierarchy item that was changed.
 Previous Value. Displays the setting of the hierarchy item before the 

change was made.
 New Value. Displays the setting of the hierarchy setting after the change 

was made.
 Modified By. Displays the user ID of the individual that made the change.
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Managing Hierarchy IDs
The Manage Hierarchy ID screen allows you to create and position a new Hierarchy 
ID. You can add, rename and move hierarchy levels from this screen.

This section explains the following topics:
 Creating a New Hierarchy
 Adding a Hierarchy ID to a Hierarchy
 Renaming a Hierarchy ID
 Moving a Hierarchy ID

Creating a New Hierarchy
You can create a hierarchy for selected transactions and accounts. After you create a 
hierarchy, you define common settings for transactions and accounts, and you assign 
employees to the hierarchy. For example, you might create your hierarchy IDs based 
on a region, division, or business unit. For more information, see “Managing 
Hierarchy Settings” on page 40.

Note: Tasks related to unassigned and deleted hierarchies can be found in Chapter 7, 
“Exports and Imports” on page 187. The unassigned hierarchy exists for accounts that 
are opened but not yet attached to a hierarchy, or for accounts where transaction 
defaults have not been applied. The deleted hierarchy houses all historical data that 
is no longer in use.

To create a new hierarchy:

1. Select Administration > Hierarchy > Manage. 
PaymentNet displays the Manage Hierarchy screen. 

2. Click the Add button and complete the following fields:

Hierarchy ID
Enter a unique hierarchy ID to identify the new hierarchy level. An example may 
include a number to represent a specific cost center or department in your 
organization. 

Hierarchy Description
Enter a description of the new hierarchy ID.
125



3 | Hierarchy Structure

126
3. Click Save. 
PaymentNet saves the hierarchy settings and displays a confirmation message.

Adding a Hierarchy ID to a Hierarchy
You can add a hierarchy ID to an existing hierarchy.

To add a hierarchy ID:

1. Select Administration > Hierarchy > Manage. 
PaymentNet displays the Manage Hierarchy screen. 

2. Click the name of the hierarchy ID folder to which you want to add a hierarchy 
ID.

3. Click the Add button and complete the following fields:

Hierarchy ID
Enter a unique hierarchy ID to identify the new hierarchy level. An example may 
include a number to represent a specific cost center or department in your 
organization.

Hierarchy Description
Enter a description of the new hierarchy ID.

4. Click Save.
PaymentNet saves the hierarchy ID and displays a confirmation message.

Renaming a Hierarchy ID
The Manage Hierarchy ID screen allows you to modify existing Hierarchy IDs and 
descriptions.

To rename a hierarchy ID:

1. Select Administration > Hierarchy > Manage. The Manage Hierarchy screen 
displays.

2. Select the Hierarchy ID that you want to rename.

3. Click Rename and modify the following fields as necessary:
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4. Modify the following fields as necessary:

Hierarchy ID
Enter a unique hierarchy ID to identify the new hierarchy level. An example may 
include a number to represent a specific cost center or department in your 
organization.

Hierarchy Description
Enter a description of the hierarchy ID.

5. Click Save.

Moving a Hierarchy ID
The Manage Hierarchy ID screen allows you to move existing Hierarchy IDs. When you 
move a parent hierarchy ID, any child entities or sub-hierarchies associated with the 
hierarchy ID move with the parent hierarchy ID.

To move a hierarchy ID:

1. Select Administration > Hierarchy > Manage. The Manage Hierarchy screen 
displays. 

2. Select the Hierarchy ID that you want to move.

3. Click Move. PaymentNet displays the Hierarchy ID field.

4. Do one of the following:
 Enter the name of the hierarchy ID folder to which you want to move the 

selected hierarchy ID.
 Click the Hierarchy ID link and select the hierarchy ID folder to which you 

want to move the selected hierarchy ID.

5. Click Save.
PaymentNet moves the hierarchy ID folder and displays a confirmation 
message.
127





4
 Working with Accounting 
Codes and Chart of Accounts
PaymentNet provides you with accounting tools that help you streamline how your 
organization manages transaction data. These tools include the chart of accounts 

and accounting code features.

A chart of accounts is a predefined accounting structure, or template, that is used to 
classify accounting codes. Your organization can use this feature to categorize and 
identify how funds are spent.

A chart of accounts is made up of segments, or accounting fields. These fields serve 
as placeholders for accounting codes. For example, you might add a Cost Center 
segment and then assign accounting code 3487 to that segment.

Accounting codes identify the type of product or service purchased. They can be 
entered directly or automatically assigned to a transaction based on default 
accounting codes defined for employees, merchants, accounts, merchant category 
codes (MCCs), customer codes, and transactions.

When you assign a chart of accounts and accounting codes to an entity, you create 
default accounting codes. 

This chapter describes how to create and modify charts of accounts and manage 
accounting codes.

This chapter explains the following sections:
 Chart of Accounts
 Managing Default Accounting Codes
 Customer Code Defaults
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Chart of Accounts
A chart of accounts is a predefined accounting structure, or template, that is used to 
classify accounting codes. This feature helps organizations categorize and identify 
how funds are spent. 

For example, your J.P. Morgan implementation manager might configure a chart of 
accounts with three segments, or groups: Cost Center, Project, and Fund. Your 
implementation manager can then select the accounting code values the user can 
enter for each segment.

Once a chart of accounts is configured, you can assign a chart of accounts and the 
corresponding accounting codes to an employee, a merchant, an MCC, a hierarchy, 
or a customer code. The values you assign are known as the default accounting codes 
and are associated with the transaction data loaded into PaymentNet.

For example, you might have a cardholder, Jane Smith, who belongs to Project 3546. 
You can create a chart of accounts and accounting codes for Project 3546 and assign 
them to Jane Smith. This way, Jane Smith’s transactions are automatically assigned 
to Project 3546 when they are loaded into PaymentNet.

For more information on how to assign a chart of accounts and accounting codes to 
organization entities, refer to “Managing Default Accounting Codes” on page 135.

This section explains the following topics:
 Viewing Chart of Account Information
 Configuring a Chart of Accounts

Viewing Chart of Account Information
The Chart of Accounts List screen is used to review Charts of Accounts and initiate 
adding a new or modifying an existing Chart of Accounts. 

This topic explains the following tasks:
 Viewing the Chart of Accounts List
 Viewing Chart of Accounts Detail
 Viewing Chart of Accounts History
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Viewing the Chart of Accounts List
The Chart of Accounts List allows authorized users to view and manage all existing 
Charts of Accounts.

To view the chart of accounts list:

1. Select Administration > Chart of Accounts > Manage.
PaymentNet displays the Chart of Accounts List screen.

Viewing Chart of Accounts Detail
You can view the details of the chart of accounts including segments and values.

To view the chart of accounts detail:

1. Select Administration > Chart of Accounts > Manage. 
PaymentNet displays the Chart of Accounts List screen.

2. Click a chart of accounts record of which you want to view details. 
PaymentNet displays the Structure tab of the Chart of Accounts Detail screen. 
The Structure tab displays all of the segments in the chart of accounts.

3. Click the Values tab. 
The Values tab defines the values that can be entered for each segment.

Viewing Chart of Accounts History
You can view a record of all modifications that have been made to the selected chart 
of accounts.

To view the chart of accounts history:

1. Display the Chart of Accounts Detail screen for the chart of accounts record of 
which you want to view the history. For instructions, see “Viewing Chart of 
Accounts Detail” on page 131.

2. Click the History link on the upper left of the screen.
PaymentNet displays the Chart of Accounts - History screen. 
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Configuring a Chart of Accounts

This section explains these topics:
 Creating a Chart of Accounts
 Adding Values to a Chart of Accounts
 Creating Chart of Accounts Constraints

Creating a Chart of Accounts

To set up a chart of accounts:

1. Select Administration > Chart of Accounts > Create.

2. On the Structure tab of the Chart of Account Detail screen, enter the Chart 
Name. 

3. Add the new chart segment details:
 Length - Specifies the length of the field (maximum 50 alphanumeric 

characters).
 Description - The segment field name.
 Dependent - Specifies another field with which the current field is cross-

validated.
 Field Type - Select either DropDownList or TextBox.

 Drop-Down List - Selection box that contains your choice of drop-down 
values. Values are added on the Values tab.

 Text Box - Text input field.
 Validate - For text boxes, indicates whether or not the segment value 

entered will be validated with the list defined on the Values tab.
 Required - Indicates the field as required on the Transaction Detail screen.

4. Click Save.

Note: Chart segments cannot be deleted once they have been saved.
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Adding Values to a Chart of Accounts

To add values to a chart of accounts:

1. Select the Values tab.

2. Select the Segment to add the list of values that will display in a segment 
drop-down list or that will be used to validate a text entry.

3. Click Add Segment Value.

4. On the Chart of Accounts Value Detail screen:
 Enter the segment Value.
 Enter the segment Description. 
 If the segment is dependent on another field, select the Dependent Value 

from the drop-down list. 

5. Click Save. 
PaymentNet saves the Accounting Code Value.

6. Click Return to Value List to define additional Chart of Accounts Values. 
Repeat these steps, as needed.

Creating Chart of Accounts Constraints
You can link specific charts of accounts to hierarchies. The link between a chart of 
accounts and a hierarchy is known as a constraint.

Constraints allow an organization to limit the chart of account values a user can 
assign based on their hierarchy, role, account, or User ID. Constraints of different 
types can be combined to fine-tune access to accounting code values. For example, 
you might belong to a hierarchy named Organization Personnel. Your J.P. Morgan 
implementation manager can assign specific charts of accounts—such as Project and 
Fund—to the Organization Personnel hierarchy. This way, you can only access the 
Project and Fund charts of accounts.
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To set up constraints:

1. Select Administration > Chart of Accounts > Constraints to view the 
Constraints List.

Note: The chart of accounts Constraints List screen is not displaying constraints 
correctly; the screen may not display all constraints in the list or it may display 
duplicate constraints. This is an issue with displaying constraints on the 
Constraints List screen and does not affect actual constraints stored in the 
system.
Click any sortable column on the Constraints List screen. Sortable columns are 
indicated by an underlined column title. Sorting the screen by a column may 
display the constraints correctly. If constraints still do not display correctly, 
contact a J.P. Morgan program coordinator for assistance.

2. Click Add New Constraint to view the Constraint Details screen.

3. Select the type of Constraint that you wish to create. The different types of 
constraints that can be created include the following:
 Account - Sets up constraint for a specific account
 Employee - Sets up constraint for a specific employee

Note: If an employee constraint is created for a chart of account, the constraint 
is not applied on the Transaction Detail screen for the associated 
employee. For example, if an “Include” employee constraint is created for 
John Doe to include COA Segment 1, that constraint is not be applied and 
John Doe is not be able to see Segment 1 on the Transaction Detail screen.
Create an account constraint that is similar to the employee constraint 
that will be applied to all accounts assigned to John Doe. For example, 
create an “Include” account constraint for an account assigned to John Doe 
to include COA Segment 1. This allows John Doe to see Segment 1 on the 
Transaction Detail screen for this account. This account constraint must be 
created for all new accounts assigned to John Doe.

 Hierarchy - Sets up constraint for a specific Hierarchy ID
 Role - Sets up constraint for a specific role

4. Select the value of the Constraint that you are using.
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5. Select one of the following options for the constraints:
 Include - Only defined users will have access to the specified values.
 Exclude - Defined users will not have access to the specified values.
 Read-Only - Defined users will be able to view but not select all values.

6. Select the Chart of Accounts for which you want to set up the constraint.

Note: The Accounting Code drop-down list on the Constraint Details screen lists only 
the first 10 values in the segment.
If your organization has more than 10 accounting code values, and the one you 
need to select is not displaying, enter either part or all of the accounting code 
value in the field. The type-ahead feature displays results matching your entry 
so that you can select the necessary accounting code value.

7. For each segment of the Chart of Account, choose whether the constraint will 
apply to none of the segment values, all of the segment values, or to a specific 
segment value.

8. Click Save.

Managing Default Accounting Codes
Accounting codes identify the type of product or service purchased and can be 
configured for employees, merchants, accounts, MCCs, transactions, and customer 
codes.

For example, your organization might have one set of accounting codes for a Product 
chart of accounts segment and another set of accounting codes for a Fund chart of 
accounts segment.

The charts of accounts and accounting codes that can be assigned vary based on the 
constraints set up by your J.P. Morgan implementation manager. For more 
information on constraints, see “Creating Chart of Accounts Constraints” on 
page 133.

When you assign a chart of accounts and accounting codes to an entity, you create 
default accounting codes. This way, PaymentNet automatically allocates accounting 
codes to transactions. 

This section describes how to assign accounting codes to organization entities. For 
instructions on how to import accounting codes, see “Managing Import Files” on 
page 191.
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This section explains the following topics:
 Assigning Default Accounting Codes to a Hierarchy
 Assigning Default Accounting Codes to Accounts
 Assigning Default Accounting Codes to Employees
 Assigning Default Accounting Codes to Merchant Category Codes
 Assigning Default Accounting Codes to Merchants
 Assigning Default Accounting Codes to a Customer Code
 Assigning Default Accounting Codes to Single-Use Account Orders
 Creating Merchant Defaults by Hierarchy
 Creating Merchant Category Code Defaults by Hierarchy

Assigning Default Accounting Codes to a Hierarchy

To assign default accounting codes to a hierarchy:

1. Select Administration > Hierarchy > Settings > Transaction.
PaymentNet displays the Hierarchy Settings screen.

2. In the Hierarchy ID field, enter the name of the hierarchy. Alternately, you can 
click the Hierarchy ID link and select a hierarchy from the pop-up window.

3. Select the Override Inheritance checkbox.
PaymentNet activates the chart of accounts fields.

4. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

5. Select the accounting code values that you want to be the default for the 
hierarchy.

6. Click Save. 
PaymentNet saves the default accounting codes and displays a confirmation 
message.
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Assigning Default Accounting Codes to Accounts

To assign default accounting codes to accounts:

1. Select Accounts > Manage.
PaymentNet displays the Account List screen.

2. Click the name of the account to which you want to assign default accounting 
codes.
PaymentNet displays the Account Detail: General Information tab.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Assigning Default Accounting Codes to Employees

To assign default accounting codes to employees:

1. Select Employee > Manage. 
PaymentNet displays the Employee List screen.

2. Click the name of the employee to which you want to assign default accounting 
codes.
PaymentNet displays the Employee Detail: General Information tab.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting code values that correspond 
to the selected chart of accounts.
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4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Assigning Default Accounting Codes to Merchant 
Category Codes

To assign default accounting codes to merchant category codes:

1. Select Administration > Merchant Category Codes.
PaymentNet displays the Merchant Category Code List screen.

2. Click the merchant category code to which you want to assign default 
accounting codes.
PaymentNet displays the Merchant Category Code Detail screen.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Assigning Default Accounting Codes to Merchants

To assign default accounting codes to merchants:

1. Select Administration > Merchants.
PaymentNet displays the Merchant List screen.
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2. Click the name of the merchant to which you want to assign default accounting 
codes.
PaymentNet displays the Merchant Detail: General Information tab.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Assigning Default Accounting Codes to a Customer 
Code

To assign default accounting codes to a customer code:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.

2. Click the customer code to which you want to assign default accounting codes.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.
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Assigning Default Accounting Codes to Single-Use 
Account Orders

This feature is only available if Single-Use Accounts are enabled for your 
organization.

To assign default accounting codes to a single–use account order:

1. Select Orders > Manage.
PaymentNet displays the Order List screen.

2. Click the order to which you want to assign default accounting codes.

3. In the Transaction Defaults box, click the Chart of Accounts drop-down menu 
and select the chart of accounts that contains the accounting codes you want to 
assign.
PaymentNet displays the segments and accounting codes that correspond to the 
selected chart of accounts.

4. Select the accounting code values that you want to be the default for the 
hierarchy.

5. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Creating Merchant Defaults by Hierarchy
Specific hierarchy IDs might require that accounting codes be allocated to specific 
merchants. To accommodate these circumstances, you can create merchant defaults 
by hierarchy.

For example, your organization might default all purchases at an office supply 
merchant to a certain accounting code. However, one hierarchy group might need to 
default office supply purchases to another accounting code.

To create merchant defaults by hierarchy:

1. Select Administration > Merchants.
PaymentNet displays the Merchant List screen.
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2. Click the name of the merchant for which you want to set defaults.
PaymentNet displays the Merchant Detail screen.

3. In the Transaction Defaults button section, click the Advanced button. 
The Advanced Transaction Defaults List for the selected merchant displays.

4. Click the Add button.

5. In the Hierarchy ID field, enter the name of the hierarchy. Alternately, you can 
click the Hierarchy ID link and select a hierarchy from the pop-up window.

6. Select the Override Inheritance checkbox.
PaymentNet activates the chart of accounts fields.

7. In the Accounting Codes section, select the appropriate chart of accounts and 
then select the default accounting codes.

8. Click Save.
PaymentNet saves the default accounting codes and displays a confirmation 
message.

Creating Merchant Category Code Defaults by 
Hierarchy

You can configure merchant category code (MCC) defaults by hierarchy. This way, you 
can accommodate specific hierarchy IDs that require different merchant defaults.

For example, your organization might default all purchases at electrical contractors 
to a certain accounting code: 4687. However, one group in your hierarchy might need 
the purchases at electrical contractors to default to another accounting code: 2153.

To create merchant category code defaults by hierarchy:

1. Select Administration > Merchant Category Code List.
PaymentNet displays the Merchant Category Code List screen.

2. In the MCC column, click the link to the MCC you want to view.
PaymentNet displays the Merchant Category Code Detail screen.

3. In the Transaction Defaults box, click the Advanced... button.
PaymentNet displays the Advanced Transaction Defaults List screen.
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4. Click the Add button. 
PaymentNet displays the transaction default fields.

5. In the Hierarchy ID field, enter the hierarchy ID. Alternately, click the 
Hierarchy ID link and select the hierarchy ID from the pop-up window options.
PaymentNet activates the Override Inheritance checkbox.

6. Select the Override Inheritance checkbox.
PaymentNet activates the Accounting Codes fields.

7. From the Chart of Accounts drop-down menu, select the default chart of 
accounts and accounting codes. 

8. Click Save.
PaymentNet saves the merchant category code defaults and displays a 
confirmation message.

Customer Code Defaults
Customer codes are organization-defined values that correspond to an identifier the 
cardholder enters at the point of sale. When a Customer Code is loaded with a 
transaction in to PaymentNet, PaymentNet looks to see if there is a corresponding 
Customer Code for the organization. PaymentNet then attaches any default 
accounting codes specified for that Customer Code to the transaction.

Customer codes are set on the Administration-Customer Code Defaults screen.

This section explains the following topics:
 Viewing the Customer Code Defaults List
 Viewing Customer Code Defaults Detail
 Creating Customer Code Defaults
 Editing Customer Code Defaults
 Deleting Customer Code Defaults

Viewing the Customer Code Defaults List
The Customer Code Defaults List provides the ability to view details of Customer 
Code Defaults, add a new Customer Code Defaults, and to create an export file.
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To view the customer code defaults list:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.

2. Do one of the following:
 Review the Customer Code Defaults list.
 Click the Code link of the Customer Code Defaults for which you want to 

view details. For more information, see “Viewing Customer Code Defaults 
Detail” on page 143.

 Click Add Customer Code to create new Customer Code Defaults. For more 
information, see “Creating Customer Code Defaults” on page 144.

 Click Create Export File to create an export file of all the Customer Codes 
currently in the organization’s system. For more information, see 
“Configuring an Export File” on page 188.

Viewing Customer Code Defaults Detail
You can view the details of a Customer Code Defaults. The Details screen also allows 
you to add new, edit, or delete Customer Code Transaction Defaults.

Custom Fields are dynamically built based on the Custom Fields that have been 
defined as Customer Codes for the Organization and are formatted according to the 
Custom Fields setup.

To view customer code defaults detail:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.

2. Click the Code link of the Customer Code Defaults for which you want to view 
details.
PaymentNet displays the Advanced Customer Code Defaults Detail screen.

3. Review the following:
 Customer Code. Displays the customer code.
 Hierarchy ID. Displays the Hierarchy ID where the Customer Code Defaults 

are set.
 Accounting Codes. These fields are the combined values of the Chart of 

Accounts and Transaction Defaults defined for Customer Codes for this 
organization.
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Creating Customer Code Defaults
You can create new Customer Code Defaults.

To create customer code defaults:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.

2. Click Add Customer Code.
PaymentNet displays the Advanced Customer Code Defaults Detail screen.

3. Complete the following fields and options:
 Customer Code. Enter the name or number that will be used to identify the 

new Customer Code in this field.
 Hierarchy ID. Enter the Hierarchy ID where the Customer Code Defaults will 

be set. You can also click the Hierarchy ID link to select the ID from a list.
 Override Inheritance. Select this checkbox to edit the remainder of the 

fields on the screen. When this box is checked, the fields are editable and 
pre-populated with the inherited values.

 Chart of Accounts. If applicable, select the chart of accounts for the 
organization from the drop-down list.

 Accounting Codes. This field is dynamically built based on which 
Accounting Code Segments have been defined for the Chart of Accounts 
above. If necessary, you may edit this field or leave it blank.

 Custom Fields. These fields are dynamically built based on the Custom 
Fields defined for Transactions for the Organization. They are formatted 
according to the Custom Fields setup. If necessary, you may edit this field 
or leave it blank.

4. Click Save.

Editing Customer Code Defaults
You can edit Customer Codes.

To edit customer code defaults:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.
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2. Click the Code link of the Customer Code Defaults that you want to edit.
PaymentNet displays the Advanced Customer Code Defaults Detail screen.

3. Edit the following fields and options as necessary:
 Customer Code. Enter the name or number that will be used to identify the 

new Customer Code in this field.
 Hierarchy ID. Enter the Hierarchy ID where the Customer Code Defaults will 

be set. You can also click the Hierarchy ID link to select the ID from a list.
 Override Inheritance. Select this checkbox to edit the remainder of the 

fields on the screen. When this box is checked, the fields are editable and 
pre-populated with the inherited values.

 Chart of Accounts. If applicable, select the chart of accounts for the 
organization from the drop-down list.

 Accounting Codes. This field is dynamically built based on which 
Accounting Code Segments have been defined for the Chart of Accounts 
above. If necessary, you may edit this field or leave it blank.

 Custom Fields. These fields are dynamically built based on the Custom 
Fields defined for Transactions for the Organization. They are formatted 
according to the Custom Fields setup. If necessary, you may edit this field 
or leave it blank.

4. Click Save.

Deleting Customer Code Defaults
You can delete customer codes that are no longer needed.

To delete customer code defaults:

1. Select Administration > Customer Code Defaults.
PaymentNet displays the Customer Code Defaults List screen.

2. Click the Code link of the Customer Code Defaults that you want to edit.
PaymentNet displays the Advanced Customer Code Defaults Detail screen.

3. Click Delete.
PaymentNet deletes the existing set of Advanced Transaction Defaults and sets 
the customer code to the inherited Advanced Transaction defaults.
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 Managing Card Accounts
T his chapter describes how to set up a card account and manage account details. 
These tasks include defining account holder details, associating Merchant 

Category Code Groups (MCCGs) with a card account, configuring spend controls and 
limits, and setting up a central bill account. This chapter also provides specifics on 
how to change a card hierarchy, manage the status of an account, and how to issue a 
new card. Additionally, it provides details on other program administrator tasks such 
as applying a rush delivery to a card account, and reviewing account status reasons. 
Use the Accounts menu to manage card account details.

This chapter explains the following sections:
 Managing a Card Account
 Viewing Account List Information
 Managing a Rush Card Delivery
 Managing a Central Bill Account

Managing a Card Account
Card account management includes the tasks of defining a cardholder’s billing and 
mailing address, and setting card spend controls and account limits. 

In some cases, program administrators may need to apply a rush delivery for a lost or 
stolen, or replacement card. For complete details about the Rush Card Delivery 
option, see “Managing a Rush Card Delivery” on page 168.
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This section explains the following topics:
 Creating a Card Account
 Editing a Card Account
 Setting Temporary Spending Limits
 Removing Temporary Spending Limits
 Changing a Card Hierarchy
 Changing Card Status
 Issuing a New Card
 Reassigning an Account
 Running a Mass Update for Multiple Accounts

Creating a Card Account
If the functionality is enabled, you can create a card account using an existing 
account as a template. This way, you can duplicate account settings, limits, and 
Merchant Category Code Groups (MCCGs) as necessary. The account template saves 
you time on data entry and promotes standardized card configuration. 

When you apply a rush delivery for a new card, you must select the Rush Card 
Delivery checkbox on any of the Account Detail tabs prior to saving the new card. For 
complete details about the Rush Card Delivery option, see “Managing a Rush Card 
Delivery” on page 168.

When you create a card account, you define settings based on an employee. An 
employee is a PaymentNet user with a configured profile. For more information on 
how to configure an employee in PaymentNet, Chapter 6, “Managing Employees” on 
page 175.

To create a card account:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account number you want 
to use as a template for the new card account. 
PaymentNet displays the Account Detail screen.
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3. Click the Create New Account button, if enabled. 
PaymentNet displays the New Account window and automatically populates the 
data in the Hierarchy ID field with the account template hierarchy.
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4. In the drop-down list above the User ID field, select the option that applies to 
this new account. 

New Employee
If the card account is for a new employee, select this option. This option is 
applicable if the card is being created for an employee that does not currently 
exist in PaymentNet. A new employee profile is created for the account holder.

Existing Employee
If the card account is for an existing employee, select this option. This option is 
applicable if the card is being created for an existing employee that already 
exists in PaymentNet. As program administrator, you are responsible for 
providing the user ID of the that employee to ensure the account is assigned to 
the correct account holder.

Same Employee
If the card account is for the same employee on the account template, select 
this option.If you select this option, the General Information fields 
automatically populate with the employee information.

No Employee
If the card account is not being created for any employee, select this option. 
This option is applicable if the card is not being created for an existing 
employee and, as program administrator, you do not intend to have a new 
employee profile created for the account holder.

5. Complete the fields that display in the General Information screen. For a 
complete list of fields, see List 7: “General Information Fields” on page 152.

Note: For TSYS accounts, the cardholder address and the statement address must 
match.
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Note: When you create a new account and user via import or the user interface, 
ensure that the user ID is not the same as the first four characters of the last 
name specified and the last four characters of the government identification 
number.

6. If applicable, select a chart of accounts and complete any custom fields in the 
Transaction Defaults section.

7. Click the Continue button. 
PaymentNet displays the Controls screen.

8. Complete the fields that display in the Controls screen. For a complete list of 
fields, see List 8: “Controls Fields” on page 154.

Note: The VIP checkbox is not being selected when an executive account is created 
from an executive account template for HP accounts. The VIP checkbox controls 
the packaging of the card for executives. If the VIP checkbox is not selected, 
the card is mailed in a normal envelope instead of in the executive card 
packaging.
After creating a new executive account, contact a J.P. Morgan program 
coordinator to have the VIP checkbox selected.

 

9. Click the Continue button. 
PaymentNet displays the MCC Group Controls screen.

10. Complete the fields that display in the MCC Group Controls screen. For a 
complete list of fields, see List 9: “Merchant Category Code Group Controls 
Fields” on page 156.

11. Optionally, you can add MCC Groups by clicking the plus (+) icon. You can add up 
to nine MCC Groups to the card account. To remove an MCC Group, click the 
trash can icon.

12. Click Save.
PaymentNet saves the card account settings and displays a confirmation 
message.
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 List 7: General Information Fields 

Rush Card Delivery Optionally, to apply a rush delivery, you must select the Rush Card 
Delivery checkbox on any of the Account Detail screens prior to saving the 
card account. For complete details about the rush card feature, see 
“Managing a Rush Card Delivery” on page 168.

User ID Enter the account holder’s User ID. The User ID must be between 6-20 
characters. (This field is only required when selecting New Employee or 
Existing Employee.)
Note: When you create a new account and user via import or the user 
interface, ensure that the user ID is not the same as the first four 
characters of the last name specified and the last four characters of the 
government identification number.

Generate Login 
Information

For New Employee only, select this checkbox to automatically create and 
configure the new employee profile for the account holder. This option 
assigns a new account to the new employee profile. A temporary 
password is generated for the new employee and consists of the first four 
letters of the account holder’s last name (lowercase), plus the last four 
digits of the account holder’s Social Security Number. Any special 
characters are removed. Because the password must be at least six 
characters, PaymentNet automatically adds an extra number from the SSN 
if only a single letter is entered for a last name. See the following 
examples: 
 Smith (SSN: 123-456-789) = smit6789
 Lee (SSN: 123-456-789) = lee6789
 Ba (SSN: 123-456-789) = ba6789
 L (SSN: 123-456-789) = l56789

Prefix If applicable, enter a prefix for the account holder, such as Ms., Mrs., or 
Mr.

First Name Enter the account holder’s first name.
 HP accounts: Maximum of 25 characters combined (including spaces) 

for the First Name, Middle Initial, Last Name, and Suffix fields.
 TSYS accounts: Maximum of 23 characters combined for the First 

Name, Middle Initial, and Last Name fields.

Middle Initial If applicable, enter the account holder’s middle initial.

Last Name Enter the account holder’s last name.
 HP accounts: Maximum of 25 characters combined (including spaces) 

for the First Name, Middle Initial, Last Name, and Suffix fields.
 TSYS accounts: Maximum of 23 characters combined for the First 

Name, Middle Initial, and Last Name fields.

Suffix If applicable, enter a suffix for the account holder.
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Second Row of Embossing If applicable, enter up to 21 (for MasterCard) or 19 (for Visa) 
alphanumeric characters that you want embossed or displayed on the 
second row of the credit card. This could be, for example, a department 
name or business unit name that would display below the cardholder 
name.

Birth Date Enter the account holders’ birth date.

SSN/ID Enter the account holder’s social security number.

Employee ID Enter the account holder’s Employee ID.

Expiration Date This field automatically populates with the card expiration date. To 
modify this field value, enter a new card expiration date in MM/YYYY 
format.

Card Delivery Select the delivery method from the drop-down list.

Address 1 Enter the first line of the account holder’s address.
Note: For TSYS accounts, the cardholder address must match the 
statement address.

Address 2 Enter the second line of the account holder’s address.

City Enter the account holder’s city. If your card program uses the TSYS 
processor and the account has a Canadian address, you can enter up to 
nine characters in this field. Also, you must verify the Zip/Postal Code 
using the  Canada Post website. 

State/Province Select the account holder’s state or province from the drop-down list.

ZIP/Postal Code Enter the account holder’s zip code or postal code. If the account has a 
Canadian address, you must verify the Zip/Postal Code using the  Canada 
Post website. 

Country Select the account holder’s country from the drop-down list.

(Statement address is the 
same as cardholder 
address)

Mark this checkbox to automatically populate the Statement Address 
section with the field values in the Cardholder Address section.

Address 1 Enter the first line of the account holder’s address.
Note: For TSYS accounts, the statement address must match the 
cardholder address.

Address 2 Enter the second line of the account holder’s address.

 List 7: General Information Fields (continued)
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City Enter the account holder’s city. If your card program uses the TSYS 
processor and the account has a Canadian address, you can enter up to 
nine characters in this field. Also, you must verify the Zip/Postal Code 
using the  Canada Post website. 

State/Province Select the account holder’s state or province from the drop-down list.

ZIP/Postal Code Enter the account holder’s zip code or postal code. If the account has a 
Canadian address, you must verify the Zip/Postal Code using the  Canada 
Post website. 

Country Select the account holder’s country from the drop-down list.

E-Mail Address Enter the account holder’s email address. 
Note: This field is required only when a new employee is created while 
creating a new account.
Note: For clients on the HP processor, the creation of a new account will 
fail at the processor if the employee email address is longer than 33 
characters in length.
In this situation, use one of the following options:
 Enter an alternate email address that is 33 characters or less in length
 Create the new account using the No Employee option. Then, create 

the employee account and assign the account to the employee.

Business Phone Enter the account holder’s business phone number.

Mobile Phone Enter the account holder’s mobile phone number.

Mothers Maiden Name Enter the account holder’s mother’s maiden name (10 character limit).

Notes If applicable, enter any notes specific to the card account.

 List 7: General Information Fields (continued)

 List 8: Controls Fields 

Rush Card Delivery Optionally, to apply a rush delivery, you must select the Rush Card 
Delivery checkbox in the Controls tab prior to saving the card account. For 
complete details about the rush card feature, see “Managing a Rush Card 
Delivery” on page 168.

Cost Center Enter the account holder’s cost center.

VIP If the card account is VIP, select this checkbox.

International If the card account is International, select this checkbox.
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Convenience Checks If you want to order convenience checks for the account holder, select 
this checkbox. Once you select this checkbox, select Order New Checks 
from the drop-down list. Then click the Go button.

Group If you want to associate a Merchant Category Code (MCC) Group with the 
card account, select a group from this drop-down list. To add another MCC 
Group, click the plus (+) icon. To remove an MCC Group, click the trash 
can icon.

Action To include or exclude an MCC Group on the card account, select a value 
from this drop-down list.

Credit Limit Enter the account holder’s credit limit.

Cash Advance Limit Enter the percentage of the credit limit you want to make available as a 
cash advance. Once you enter a value in this field, select the Cycle or 
Month option, based on how frequently you want the percentage to reset.

Transaction Limit Enter the card transaction limit.

Amount Limit $ Enter the card amount limit.

Daily Amount Limit $ Enter the daily card amount limit.

Daily Transaction Limit Enter the daily card transaction limit.

Single Amount Limit $ Enter the single card amount limit. This is also known as the transaction 
single purchase limit.

Other Transaction Limit Enter the other transaction limit. You might have a specific transaction 
limit defined by your program.

Other Amount Limit $ Enter the other amount limit.

Other Number of Days Enter the duration, in days, for the Other Transaction Limit and Other 
Amount Limit $ values. 
For example, if you enter $300 in the Other Amount Limit field and 7 in 
the Other Number of Days field, then $300 are available every 7 days.

Other Refresh Date Click this link to open a calendar and select the card limit refresh date. 
Once you select a date, click the Close button.

 List 8: Controls Fields (continued)
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 List 9: Merchant Category Code Group Controls Fields 

Rush Card Delivery Optionally, to apply a rush delivery, you must select the Rush Card 
Delivery checkbox in the Merchant CCG tab prior to saving the card 
account. For complete details about the rush card feature, see “Managing 
a Rush Card Delivery” on page 168.

MCC Group 1 From this drop-down list, select the first MCC Group that you want to 
associate with the card account. Once you select an MCC Group, you can 
determine how you want transactions with the selected MCC Group 
accounted for by selecting a value from the Action drop-down list.

Action Select a value from this drop-down list to determine how you want to 
account for transactions with the selected MCC Group.

Cycle/Monthly If you want card limits to refresh after each card billing cycle, select the 
Cycle option. If you want card limits to refresh after each month, select 
the Monthly option.

Transaction Limit Enter the MCC Group transaction limit.

Amount Limit Enter the MCC Group amount limit.

Other Transaction Limit Enter the MCC Group other transaction limit. You might have a specific 
transaction limit defined by your program.

Other Amount Limit $ Enter the MCC Group other amount limit.

Daily Transaction Limit Enter the MCC Group daily transaction limit.

Daily Amount Limit $ Enter the MCC Group daily amount limit.

Other Number of Days Enter the duration, in days, for the Other Transaction Limit and Other 
Amount Limit $ values. 
For example, if you enter $300 in the Other Amount Limit field and 7 in 
the Other Number of Days field, then $300 are available every 7 days for 
the selected MCC Group.

Daily Amount Limit $ Enter the MCC Group daily amount limit.

Other Refresh Date Click this link to open a calendar and select the card limit refresh date. 
Once you select a date, click the Close button.

Single Amount Limit $ Enter the MCCG Group single amount limit.
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Editing a Card Account
You can edit card account details, including the cardholder’s billing address and 
statement mailing address, card account limits, Merchant Category Code Groups 
(MCCGs), and other details. 

Note: You can only edit a card account with an account status of Active or Suspended (user-
initiated). You cannot edit a card account with a status of Closed, Suspended (bank-
initiated), or Lost or Stolen.

To edit a card account:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account you want to edit.
PaymentNet displays the Account Detail screen.

3. Modify the fields as necessary. For a description of the fields, see List 7: 
“General Information Fields” on page 152, List 8: “Controls Fields” on page 154, 
and List 9: “Merchant Category Code Group Controls Fields” on page 156.

Note: For TSYS accounts, the cardholder address and the statement address must 
match.

 

Note: The PaymentNet menu bar may become unresponsive when viewing the General 
Information tab on the Account Details screen. This can occur when the account 
you are viewing has the same international address (outside of the United States 
and Canada) for the cardholder and statement address and the “Statement 
Address is the same as Cardholder Address” option is selected.
If this occurs, click either the Control tab, MCC Group Control tab, or the 
History link on the Account Detail screen. After doing so, the menu bar will 
become active and can again be used. 

4. Click Save.

Setting Temporary Spending Limits
Set temporary limits to increase or decrease card spending options for a specific 
time period. For example, you might need to increase a credit limit to accommodate 
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travel expenses for a cardholder who normally doesn’t travel. In other instances, you 
might need to increase a credit limit for a cardholder purchasing materials to 
support an annual meeting.

Temporary limits override permanent card limits. Once the temporary limit end date 
arrives, card limits return to permanent limits.

To change permanent limits, access the Account Detail screen. For instructions on 
how to modify permanent limits, see “Editing a Card Account” on page 157.

Note: When you set the temporary limit Cash Advance Amount to $0, you might 
receive an error message stating that the temporary limit cash advance amount 
must be entered in increments of $100.
Contact a J.P. Morgan program coordinator to set the temporary limit Cash 
Advance Amount to $0.

Note: Temporary credit limits are not returning to the original limit amount when the 
temporary credit limit end date is reached. this occurs if the temporary credit 
limit is changed when the loaders run between 10 p.m. and 3 a.m. ET.
If you have to change the limit between 10 p.m. and 3 a.m. ET, set the 
temporary credit limit amount to the same amount as the original credit limit 
when the end date is reached.

To set temporary spending limits:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account you want to edit.
PaymentNet displays the Account Detail screen.

3. Click the Controls tab.
PaymentNet displays the Controls screen.

4. Click the Set Temporary Limit link.
PaymentNet displays the Temporary Limits - Accounts screen.

5. Complete the fields that display on the Temporary Limits - Accounts screen. 
For a complete list of fields, see List 8: “Controls Fields” on page 154.
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6. Click Save.
PaymentNet displays the Account Detail screen. A confirmation message 
indicates that the temporary limit is submitted for processing. Temporary 
limits are batch processed every 20 minutes.

 List 10: Temporary Limit Fields

Temporary Limit Enter the temporary limit value.

Limit Begin Date Enter the date when the temporary limit will take effect. 

Limit End Date Enter the date when the temporary limit will end. The 
end date cannot be the current date and must be after 
the begin date. For example, if you set a temporary limit 
to start on 10/08/2012, then the earliest the temporary 
limit can end is 10/09/2012.

Removing Temporary Spending Limits
Remove temporary spending limits to restore permanent card limits. 

To remove temporary spending limits:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account you want to edit.
PaymentNet displays the Account Detail screen.

3. Click the Controls tab.
PaymentNet displays the Controls screen.

4. Click the Set Temporary Limit link.
PaymentNet displays the Temporary Limits - Accounts screen.

5. Select the Remove Temp Limit checkbox next to the temporary limit to 
remove.

6. Click Save.
PaymentNet displays the Account Detail screen and the restored permanent 
limits.
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Changing a Card Hierarchy
You can change a card hierarchy. For example, if the account holder has a new 
reporting structure, a new manager, or a new assignment, you might need to change 
the assigned card hierarchy.

To change a card hierarchy:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account number for which 
you want to change the card hierarchy. 
PaymentNet displays the Account Detail screen.

3. In the Hierarchy ID field, enter the name of the new hierarchy. Alternately, you 
can click the Hierarchy ID link and select a new hierarchy from the pop-up 
window.

4. Click Save. 
PaymentNet moves the card account to the new hierarchy and displays a 
confirmation message.

Changing Card Status
You can edit the status of an existing card. For example, you might need to mark a 
card account as Lost or Stolen, Closed, or Suspended.

To apply a rush delivery, first select the Status of Lost or Stolen, for example, and 
then select the Rush Card Delivery checkbox prior to saving. For complete details 
about the Rush Card Delivery option, see “Managing a Rush Card Delivery” on 
page 168.

To change card status:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account number for which 
you want to change the card status. 
PaymentNet displays the Account Detail screen.
PaymentNet User Guide



Managing a Card Account
3. From the Status drop-down list, select the card status. You can select from 
these options: 

Active
Select this status to activate the card. For example, if you are issuing a 
Replacement card due to damage, select this option and click the Issue New 
Card button to have a new card sent. 

Lost or Stolen
Select this value if the card is lost or stolen. When you select this field, the Date 
of Last Seen field displays. In this field, enter the date when the card was last 
seen. This status closes the account and automatically creates a new card with a 
new account number. 

Note: If you place a temporary suspension on a card that has been lost or stolen and 
then the card is found, make sure to remove the temporary suspension in 
PaymentNet. If the suspension is removed at the processor, the temporary 
suspension is not automatically removed in PaymentNet.

 

Suspended 
Select this value to temporarily suspend the card.

Note: When you set a temporary suspension, PaymentNet displays the Remove Temp 
Suspension checkbox next to the Status drop-down list. If the temporary 
suspension occurs in the future, the Status drop-down field remains set to 
Active. Once the temporary suspension begin date is reached, PaymentNet 
changes the Status drop-down list to Suspended.

Closed 
Select this card status to permanently close the card. Once you select this 
option, a drop-down list displays reasons for closing the account. Select a value 
from this drop-down list that describes why the card is permanently closed. For 
more information on reviewing Account Status and Status Reason, see “Viewing 
Account List Information” on page 166.

4. Optionally, if you need to apply a rush delivery, select the Rush Card Delivery 
checkbox on the Account Detail screen. For complete details about the rush 
card option, see “Managing a Rush Card Delivery” on page 168.

5. Click Save.
PaymentNet saves the card status and displays a confirmation message.
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Issuing a New Card
Only issue a new card if the existing card no longer works. This feature does not 
create a new account or an account number. Once you complete the required steps, 
a new card is mailed to the account holder’s mailing address. Do not use this feature 
for Lost or Stolen accounts. 

Note: Even though PaymentNet indicates that a new card request was successful, you 
cannot issue a new card for a suspended account; the new card request fails at the 
processor.
To issue a new card, first remove the suspension.

When you apply a rush delivery for a new card, you must select the Rush Card 
Delivery checkbox on any of the Account Detail tabs prior to saving the new card. For 
complete details about the rush card feature, see “Managing a Rush Card Delivery” 
on page 168.

To issue a new card:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account number for which 
you want to issue a new card. 
PaymentNet displays the Account Detail screen.

3. Click the Issue New Card button. 
PaymentNet displays a confirmation message.

Reassigning an Account
You can reassign a card account from one PaymentNet employee profile to another. 
For example, you may need to reassign an account when an employee leaves your 
organization and the account has remaining transactions that must be reviewed and 
approved before you close the account.

As another example, an executive may want their administrative assistant to handle 
all items related to their card account in PaymentNet. In this situation, the card 
account can be reassigned to a separate user.
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Finally, a department may have a card account they use to purchase goods and 
services. The card account can be reassigned as needed to the individual responsible 
for managing their department card account.

When reassigning an account from one PaymentNet employee profile to another, you 
have the option of reassigning the account to an existing employee or to a new 
employee profile. In addition, you can choose to reassign an account to no 
employee. This option is useful if a card account is used seasonally and no one needs 
to manage the account when it is not in use.

When an account is reassigned, PaymentNet does not issue a new card. Further, you 
are limited to the card account information that you can change when reassigning 
the account to another employee profile.

To reassign an account:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.

2. In the Account Number column, click the link to the account number that you 
want to reassign. 
PaymentNet displays the Account Detail screen.

3. Click the Reassign Account link located directly below the User ID field.
PaymentNet displays a drop-down list directly above the User ID field.

4. Select one of the following options from the drop-down list:

New Employee
Select this option to reassign the existing card account to an employee that does 
not currently exist in PaymentNet. PaymentNet creates a new employee profile 
for the account.

Existing Employee
Select this option to reassign the existing card account to an existing employee. 
You must enter a user ID that already exists in PaymentNet. It is important to 
verify that user ID you enter is for the correct individual to whom the account is 
being reassigned.

No Employee
Select this option to reassign the existing card account to no employee. This 
option is applicable if the account is not being reassigned to an existing 
employee and you do not intend to create a new employee for the account.
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5. Complete or edit the following for the selected employee type:

New Employee User ID
Enter a unique user identification name. The User ID must be between six 
and 20 character in length and cannot contain any special characters.

Generate Login Information
If desired, select this checkbox to automatically create a temporary 
password for the new employee. The temporary password consists of the 
first four letters in the Last Name field (in all lowercase), plus the last four 
digits of the existing Social Security Number. If only a single letter is entered 
for the last name, PaymentNet uses the last five digits of the existing SSN.
Note: When you assign a new or existing account to a new employee and 
select the Generate Login Information checkbox on the Account Detail: 
General Information screen, PaymentNet generates a password for the new 
employee based on the first four letters in the Last Name field and the last 
four digits in the Social Security Number field. 
If the Last Name field has non-alphabetic or numeric characters, then 
PaymentNet will not create the employee profile. 
To successfully assign an account to a new employee, ensure that alphabetic 
characters (A-Z) populate the first four characters of the Last Name field. 
This way, you can select the Generate Login Information checkbox and 
PaymentNet will create the employee profile and generate a password based 
on the Last Name and Social Security number fields.

Last Name
Enter the last name of the new user.

E-mail Address
Enter the email address of the new user.

Hierarchy ID
If necessary, edit the name of the hierarchy. Alternately, click the Hierarchy 
ID link and select a hierarchy from the pop-up window.

Existing Employee User ID
Enter an existing and valid PaymentNet user ID.

E-mail Address
If necessary edit the email address of the existing user.

Hierarchy ID
If necessary, edit the name of the hierarchy. Alternately, click the Hierarchy 
ID link and select a hierarchy from the pop-up window.

No Employee When the No Employee option is selected, all fields are not editable.

6. Click Save.
PaymentNet saves the changes and displays a confirmation message.
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Running a Mass Update for Multiple Accounts
You can update up to 100 accounts at once using a mass, or batch, update. For 
example, you might want to modify all the chart of accounts for accounts in a 
specific department.

To update multiple accounts, it is a good idea to run a query for the accounts you 
want to update. This reduces the number of records in the list making it easier for 
you to locate the accounts you want to update.

Account mass update requests are batch processed every 20 minutes. You will 
receive a confirmation message when the request is received. Once the request is 
complete you will receive a separate email message.

Note: While the Mass Update feature of PaymentNet does not prevent you from doing so, 
you should never move closed accounts to the Unassigned hierarchy.

To run a mass update for multiple accounts:

1. Select Accounts > Manage.

2. From the Accounts List screen, do one of the following:
 To complete a Quick Query:

a. From the New Query drop-down list, select the query value you want 
to search by. You can select one of these values:

Account Number
Cardholder First Name
Cardholder Last Name
Diverted To
Hierarchy ID
User ID

b. Enter the field value by which you want to search.

c. Click the Go button.
 To complete an Advanced Query:

a. Navigate to the Advanced Query - Accounts screen.
Select Accounts > Query. Alternately, you can navigate to the Account 
List screen and click the Advanced link.
PaymentNet displays the Advanced Query - Accounts screen.
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b. Click the plus icon to add search criteria to the Criteria, Hierarchy, 
and Order By sections.

c. Click the Process button.

3. Use the multi-select options to select the records that you want to update. For 
more information, see “Using Multi-Select” on page 35.

4. Click the Mass Update button.

5. Edit the corresponding fields.

Note: When selecting a chart of account Segment Name, you must also select at least 
one Segment Value. If you do not select at least one Segment Value, 
PaymentNet sets the chart of accounts to “None”.

6. Click Save. 
PaymentNet displays an icon on the Transaction List screen next to transactions 
included in the mass update.

Note: PaymentNet does not list error messages for individual accounts with a Lost/
Stolen, Closed, or Suspended status on the Mass Update - Account screen. This 
may lead you to believe that a submitted change to these types of accounts was 
successful for all accounts in the mass update.
Use the Account Request List screen (Accounts > Status) to determine whether 
the update failed or was successful for each account in the mass update.

Viewing Account List Information
Use the Account List and Account Detail screens to access cardholder account details 
to review general information about an account and its status. 

In the Account List screen, you can see account details and the reason why a card 
account was closed. Also, many of the PaymentNet standard reports include the 
account status and the account status reason.

In the Account Detail screen, you can review account details and make changes if 
necessary. 

This section explains the following topics:
 Viewing the Account List
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 Viewing a Card Account Details 

Viewing the Account List
You can review the account status and a status reason in the Account List screen. 
This is helpful, for example, when a cardholder contacts you to find out why their 
card was denied.

Note: The email address and phone number are not displaying for some accounts on the 
Account List screen.
Use the Account Detail screen to view the email address and phone number for 
affected accounts.

The Status Reason column displays specific explanations such as, blocked account 
with fraud, temporary closure of account privileges online by admin, or suspicious 
activity identified. The status reasons to close an account are set up in your 
processor. There are additional reasons that can be applied by your organization’s 
program coordinator. See Figure 4: “Account Status Reason for a Closed Account” on 
page 167 which highlights a Closed account status and the reason it was closed.

You set the account status in the Account Detail screen. To change account status, 
refer to “Changing Card Status” on page 160. 

Figure 4: Account Status Reason for a Closed Account

Viewing a Card Account Details
You can view a card account and review account details.

To view a card account:

1. Select Accounts > Manage. 
PaymentNet displays the Account List screen.
167



5 | Managing Card Accounts

168
2. Do one of the following to locate the account number:
 Use the New Query field, and click the Go button.

PaymentNet displays the query results in the Account List screen.

 Scroll the Account List pages, and in the Account Number column, click the 
link to the account you want to view.
PaymentNet displays the Account Detail screen.

3. Review the appropriate information for the account. For a description of the 
fields for General Information screen, Controls screen, and Merchant Category 
Group Controls screen, refer to these field definition lists: List 7: “General 
Information Fields” on page 152, List 8: “Controls Fields” on page 154, and List 
9: “Merchant Category Code Group Controls Fields” on page 156.

Managing a Rush Card Delivery
When sending a card to the client, you can use either the standard delivery or a rush 
delivery. You can apply rush delivery when creating a new account, if a card is lost or 
stolen, or if a card is damaged and a replacement card is requested. 
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When you apply a rush delivery for a new card, you must select the Rush Card 
Delivery checkbox on any of the Account Detail tabs prior to saving the new card. For 
information on how to apply a rush delivery, see “Creating a Card Account” on 
page 148 or “Issuing a New Card” on page 162.

There is a $25 fee charged to the client and, depending on your contract with J.P. 
Morgan, the delivery time frames vary. All rush deliveries must be mailed to a street 
address.

A rush delivery cannot ship to PO (post office) boxes or APO (army post office) boxes. 

Shipping time frame varies based on the type of card. A request for a new card, or a 
lost or stolen card that is submitted by 4:00 p.m. ET arrives in three to four business 
days. Replacement cards that are submitted by 4:00 p.m. ET arrive in one to two 
business days. For rush shipping details and shipping address policies, see Table 2, 
“Shipping Address Requirements for Rush Card Delivery,” on page 169. 

 Table 2: Shipping Address Requirements for Rush Card Delivery

You can apply Rush 
Card Delivery

Rush Shipping Days Address Requirements 

to new card accounts 3 - 4 business days Shipment can only go to 
address on file

if a card is lost or 
stolen

3 - 4 business days Shipment can go to an 
alternate address

if a card is damaged 1 - 2 business days Shipment can go to an 
alternate address

The Rush Card Delivery checkbox is always at the top right of the screen. As an 
example, the New Account screen highlights the Rush Card Delivery checkbox in 
Figure 5: “Location of Rush Card Delivery Checkbox” on page 170. The Rush Card 
Delivery checkbox displays on every page and carries over from one tab to the next. 
When you apply a rush delivery for a new card, you must select the Rush Card 
Delivery checkbox on any of the Account Detail tabs prior to saving the new card.
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Figure 5: Location of Rush Card Delivery Checkbox

When you click Save on a new card, a message alerts you to acknowledge the 
applicable $25 fee charged to the client. Once you click OK to accept the message, 
then the Rush Card Delivery screen displays for you to confirm rush or standard 
delivery. For lost or stolen, or replacement cards when you click Save, the Rush Card 
Delivery screen displays. Refer to a replacement card rush screen shown in Figure 6: 
“Replacement Card Example of Rush Card Delivery Screen” on page 170.

Note: In certain instances, specific clients may not be charged the $25 fee when requesting 
a rush card delivery. For these clients, please ignore the alert message about the fee.

Figure 6: Replacement Card Example of Rush Card Delivery Screen 
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To verify if a card was ordered using the Rush Card Delivery option, locate the 
account and go to the History link on the Account Detail screen. The History link is 
located in the top right of the screen. Review the History detail screen for the Field 
Name column which displays the Rush Card Delivery event such as, the request for 
the delivery, address, and fee charged. An example of the History screen is in Figure 
7: “History Screen Example of Rush Card Delivery Activities” on page 171.

Figure 7: History Screen Example of Rush Card Delivery Activities

Managing a Central Bill Account
A central bill account, or managing account, consolidates individual card activity 
into a single billing statement. This allows organizations to make a single payment 
for multiple individual card accounts. 

For example, multiple Purchase cards might be attached to a central bill account. In 
this example, all transactions made using the Purchase cards are directly billed to 
the government for payment.

Before you can create a central bill account, your organization’s J.P. Morgan 
implementation manager must configure the Central Bill Account Request settings.
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To create a central bill account:

1. Select Accounts > Create Central Bill Request. 
PaymentNet displays the Central Bill Account Request screen.

2. Complete the fields that display in the Central Bill Account screen. For a 
complete list of fields, see List 11: “Central Bill Account Fields” on page 173.

3. Click the Submit Request button. 
PaymentNet submits the central bill account request and displays a 
confirmation message.
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 List 11: Central Bill Account Fields 

Requestor Phone # Enter the central bill account requestor’s phone number.

Requestor E-mail address Enter the central bill account requestor’s email address. Email addresses 
must contain a single ‘@’ sign and one or more periods. Email addresses 
must not include spaces or any of these characters: \|/,;<>.

Account Name Enter the central bill account name.

Primary Contact Enter the primary contact for the central bill count. For example, you 
might enter your organization program coordinator’s name in this field.

Address Line 1 Enter the first line of the account holder’s address.

Address Line 2 If applicable, enter the second line of the account holder’s address.

City Enter the account holder’s city.

State/Province Select the account holder’s state or province from the drop-down list.

ZIP/Postal Code Enter the account holder’s zip code or postal code.

Country Select the account holder’s country from the drop-down list.

Bank Corp/Company 
Number

Select the bank corp/company number from the drop-down list.

Product Type Select the product type for which the central bill credit cards will be 
used. You can select from Purchase, Travel, Fleet, Integrated, and 
Other.

Credit Limit Request Enter the credit limit request.

Number of Cards Enter the number of cards you want issued under the central bill account.

Average Card Limit Enter the average card limit for the central bill account.

Bulk Ship Select this checkbox if you want the central bill cards to ship in bulk.

Alternate Shipping 
Instructions

If applicable, enter any alternate shipping instructions.

Use existing card design Mark this check box if you want to use the existing card design.

Card design comments If applicable, enter any special instructions about the card design.
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Central Bill to mirror (is 
there a Central Bill you 
would like mirrored 
exactly to create this new 
account?)

If you want the new central bill account to mirror an existing central bill, 
enter the name of the central bill account you want to mirror.

Additional comments/
special instructions

Enter any related comments or special instructions.

Hierarchy string for billing 
account

Enter the hierarchy string for the billing account.

 List 11: Central Bill Account Fields (continued)
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 Managing Employees
T his chapter describes how to manage employee details within PaymentNet. An 
employee is any PaymentNet user, such as a Cardholder, a Manager, an Auditor, 

or a Program Administrator. You can assign one of these user roles to an employee 
when you configure an employee profile.

You can also enable or disable employee access to PaymentNet. This way, you can 
maintain site security.

For example, if an employee takes a temporary leave of absence, you might want to 
disable his or her access. Similarly, if an employee gets locked out of PaymentNet, a 
Program Administrator or Manager might want to re-enable the employee’s account 
and set up a new password.

Also, if your organization needs to manage its own certificates, you can upload a 
public-key certificate for use with the Single-Use Account Web Service through the 
Employees menu.

Use the Employees menu to manage employee details.

This chapter explains the following sections:
 Creating an Employee
 Managing an Existing Employee
 Managing Certificates
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Creating an Employee
You can create an employee in PaymentNet. When you create an employee, you 
define the employee’s contact information and user access role. 

A user access role is a set of permissions assigned to an employee. For example, if 
you assign an employee an access role of Transaction Approver, then the employee 
can view and approve transactions within his or her assigned hierarchy and scope.

To create an employee:

1. Select Employees > Create. 
PaymentNet displays the Employee Detail: General Information screen.

2. In the User ID field, enter a unique user identification name. The User ID must 
be between six and 20 character long and cannot contain any special characters.

3. In the Hierarchy ID field, enter the name of the hierarchy. Alternately, you can 
click the Hierarchy ID link and select a hierarchy from the pop-up window.

4. Complete the fields that display. For a complete list of fields, see List 12: 
“Employee General Information Fields” on page 177. 

5. Click the Save button. 
PaymentNet saves the employee settings and displays a confirmation message.

6. Click the User Access tab. 
PaymentNet displays the User Access screen.

7. Enter the user’s initial temporary password in the Password and Confirm 
Password fields.

8. Set the user’s role, hierarchy, and scope. Complete these fields:

Role Name
Enter a unique name for the user role.

Role
Select a user role from this drop-down list. For example, based on the user role 
and permission levels, you might select Cardholder, Manager, or Program 
Administrator from this drop-down list. For a complete list of the options 
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available in this drop-down list, see List 13: “Role Fields” on page 178.

Hierarchy ID
In the Hierarchy ID field, enter the name of the hierarchy. Alternately, you can 
click the Hierarchy ID link and select a hierarchy from the pop-up window. The 
hierarchy you select should correspond to the user role and scope.

Scope
Select a value from this drop-down list. The value you select determines the 
user viewing rights for his or her assigned role name, role, and hierarchy. For a 
complete list of the options available in this drop-down list, see List 14: “Scope 
Fields” on page 178.

9. Click Save. 
PaymentNet saves the user access settings and displays a confirmation message. 

 List 12: Employee General Information Fields 

Prefix If applicable, enter a prefix for the user, such as Mr., Mrs., or Ms.

First Name Enter the user’s first name.

Middle Initial Enter the user’s middle initial.

Last Name Enter the user’s last name.

Suffix If applicable, enter a suffix for the user.

Title If applicable, enter the user’s title.

E-mail Address Enter the user’s email address.

cc E-mail Address If you want to send a carbon copy of user email notifications to additional 
email address, you can enter up to five additional email addresses in this 
field. Use a comma or semicolon to separate multiple email addresses. All 
email notifications are sent to the user’s email address and the additional 
email addresses.

bcc E-Mail Address If you want to send a blind carbon copy of user email notifications to 
additional email address, you can enter up to five additional email 
addresses in this field. Use a comma or semicolon to separate multiple 
email addresses. All email notifications are sent to the user’s email 
address and the additional email addresses.

Business Phone Enter the user’s business phone number.

Optimize Website for 
Accessibility

Mark this checkbox to optimize the user’s accessibility when viewing 
online help files.
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Unmask Exports/Reports Select this checkbox if you want to give the user the option to view 
unmasked sensitive data in reports and export files.

Notes If applicable, enter any notes. For example, you might want to add notes 
that describe the user’s role or scope.

Transaction Defaults Click the Chart of Accounts drop-down menu and select the chart of 
accounts that contains the accounting codes you want to assign to the 
user.

Unmask Exports/Reports Select this checkbox if you want to give the user the option to view 
unmasked sensitive data in reports and export files.

 List 13: Role Fields 

Auditor A read-only role that can view all PaymentNet settings, transactions, 
employees (users), accounts and Single Use account orders (if applicable) 
within the auditor's hierarchy and scope. Auditors can also run reports.

Cardholder Users with this role can review and edit transactions within the 
cardholder's hierarchy and scope.

Custom Roles Specialized roles created by your organization.

Manager Users with this role can view and edit all transactions, manage employees 
(user access) and Single-Use Account orders (if applicable) within their 
hierarchy and scope.

Order Requestor For programs using Single Use accounts, users with this role can create, 
view, modify and reconcile orders within their hierarchy and scope.

Program Administrator Users with this role can view and configure all PaymentNet settings, 
transactions, employees (users), accounts and Single Use account orders 
(if applicable) within their hierarchy and scope.

Transaction Approver Users with this role can view and approve transactions within their 
hierarchy and scope.

 List 14: Scope Fields 

Hierarchy ID Scope includes only the current hierarchy level. Does not include the 
current user or hierarchy levels below the current user.

Hierarchy ID and Children Scope includes the entire hierarchy level and all levels of hierarchy below 
the selected level. Does not include the current user.

 List 12: Employee General Information Fields (continued)
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Managing an Existing Employee
This section describes how to manage existing employees, or users, within 
PaymentNet. You can modify existing employee details as necessary, including 
employee details, user access roles, and passwords.

For example, if an employee takes a temporary leave of absence, you might want to 
disable his or her PaymentNet access. Similarly, if an employee gets locked out of 
PaymentNet, a Program Administrator or Manager might want to re-enable the 
employee’s account and set up a new password.

This section explains the following topics:
 Searching for an Employee
 Viewing Employee Information
 Editing Employee Information
 Changing an Employee User Access Role
 Changing an Employee Password
 Enabling or Disabling Employee Access
 Reassigning an Employee to Another Hierarchy

Searching for an Employee
You can conduct a search, or query, for an employee. For example, you might want 
to find all the employees who have a Transaction Approver role and modify their 
hierarchy settings.

To search for an employee:

1. Select Employees > Query. 
PaymentNet displays the Advanced Query - Employee screen.

Hierarchy ID, Self and 
Children

Scope includes the entire hierarchy level, all levels of hierarchy below the 
selected level and the current user.

Hierarchy ID and Self Scope includes only the current hierarchy level and the current user.

Self Scope includes only the current user.

 List 14: Scope Fields (continued)
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2. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
Select the operation that you want to use to measure the Field value. You can 
select from Is Equal To and Is Not Equal To.

Value
If you want to search for an exact field value, then enter the value. For 
example, if you want to search for an employee whose first name is Kate, then 
enter the name Kate in this field.

3. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 
PaymentNet displays the Hierarchy section fields.

4. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

5. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section. 
PaymentNet displays the Order By section fields.

6. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

7. Click the Process button. 
PaymentNet processes the search and displays the results that match your 
search criteria.
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Viewing Employee Information
You can view employee details, including general employee information, user access 
roles, and assigned card accounts. You can also view a history of the last 20 changes 
made to an employee’s profile.

To view employee information:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.

2. In the User ID column, click the link to the employee whose information you 
want to view. 
PaymentNet displays the Employee Detail: General Information screen.

3. Optionally, you can view a history of the last 20 changes made to an employee’s 
profile. To view a history of general information, user access, or account 
changes, click the related tab and then click the History button. PaymentNet 
displays the last 20 changes. For a complete list of fields that display, see List 
15: “History Fields” on page 181.

 List 15: History Fields

Change Date This column displays the date the employee record was changed. The 
date displays in the MM/DD/YYYY format.

Change Time This column displays the time the employee record was changed. The 
time displays in the HH:MM:SS format.

Field Name This column displays the name of the employee field that was modified.

Previous Value This column displays the previous value.

New Value This column displays the new value.

Modified By This column displays the PaymentNet User ID of the individual who 
modified the employee record.
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Editing Employee Information
You can edit employee information as necessary. For example, you might need to 
update an employee’s email address or phone number. Additionally, you might need 
to modify an employee’s access role, scope, or assigned hierarchy.

To edit employee information:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.

2. In the User ID column, click the link to the employee whose information you 
want to edit. 
PaymentNet displays the Employee Detail: General Information screen.

3. Complete one of these options:
 To edit the fields on the Employee Detail: General Information screen: 

a. Edit the fields as necessary. For a complete list of fields, see List 12: 
“Employee General Information Fields” on page 177.

 To edit the fields on the Employee Detail: User Access screen.

a. Click the User Access tab. PaymentNet displays the Employee Detail: 
User Access screen.

b. Edit the fields as necessary. For a complete list of fields, see List 13: 
“Role Fields” on page 178 and List 14: “Scope Fields” on page 178.

4. Click Save. 
PaymentNet saves the changes and displays a confirmation message.

Changing an Employee User Access Role
You can change an employee user access role as necessary. For example, you might 
need to change an employee’s access role from Manager to Auditor.

To change an employee user access role:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.
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2. In the User ID column, click the link to the employee for whom you want to 
assign an access role. 
PaymentNet displays the Employee Detail screen.

3. Click the User Access tab. 
PaymentNet displays the Employee Detail: User Access screen.

4. Complete the fields that display. For a complete list of fields, see List 13: “Role 
Fields” on page 178 and List 14: “Scope Fields” on page 178.

5. Click Save. 
PaymentNet saves the changes and displays a confirmation message.

Changing an Employee Password
You can change an employee’s password as necessary. For example, you might need 
to reset a password for an employee who is locked out of PaymentNet. The password 
you assign is a temporary password that can only be used once and must be changed 
the first time the employee logs on to PaymentNet.

To change an employee password:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.

2. In the User ID column, click the link to the employee for whom you want to 
change a password. 
PaymentNet displays the Employee Detail screen.

3. Click the User Access tab. 
PaymentNet displays the Employee Detail: User Access screen.

4. Click Change Password to expand the content and show the details.
PaymentNet displays the Password fields.

5. Complete these fields:

Temporary Password
Enter a new password for the employee. This temporary password is case 
sensitive, must be at least six but no more than eight characters in length, must 
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contain at least one alpha and one numeric character, and must not contain any 
special characters.

Confirm Temporary Password
Re-enter the new password for the employee.

6. Click Save. 
PaymentNet saves the new password and displays a confirmation message.

Note: The phrase PASSWORDEXPIRED displays in the User Status field until the user 
changes their temporary password. Once the user changes their temporary 
password, the phrase changes to ACTIVE.

Enabling or Disabling Employee Access
You can enable or disable employee access to PaymentNet. For example, if an 
employee takes a temporary leave of absence, you might want to disable his or her 
access. Similarly, if an employee gets locked out of PaymentNet, a Program 
Administrator or Manager might want to re-enable the employee’s account and set 
up a new password.

To enable or disable employee access to PaymentNet:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.

2. In the User ID column, click the link to the employee for whom you want to 
enable or disable PaymentNet access. 
PaymentNet displays the Employee Detail screen.

3. Click the User Access tab. 
PaymentNet displays the Employee Detail: User Access screen.

4. Do one of the following:
 To disable PaymentNet access:

a. Select the Login Disabled checkbox.
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b. Complete these fields:

Disabled as of Date
Click this link and select the calendar date when you want the 
employee’s PaymentNet access disabled.

 To enable PaymentNet access:

a. Deselect the Login Disabled checkbox.

b. Clear the date in the Disabled as of Date field. 

5. Click Save. 
PaymentNet saves the settings and displays a confirmation message.

Reassigning an Employee to Another Hierarchy
You can reassign an employee to a different hierarchy as needed. For example, an 
employee may transfer to another division of the company and would therefore need 
to be assigned to a new hierarchy.

To reassign an employee to another hierarchy:

1. Select Employees > Manage. 
PaymentNet displays the Employee List screen.

2. In the User ID column, click the link to the employee for whom you want to 
enable or reassign to another hierarchy. 
PaymentNet displays the Employee Detail screen.

3. In the Hierarchy ID field, enter the name of the hierarchy. Alternately, you can 
click the Hierarchy ID link and select a hierarchy from the pop-up window.

4. Click Save.
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Managing Certificates
Use the Employee Detail: Certificate Management tab to upload, view, and delete 
public-key certificates for use with the Single-Use Account Web Service. When 
installing a certificate, please allow 15 days for the certificate to be fully installed.

Note: Error messages are not being generated and sent for certain Web service certificate 
issues.

To load a certificate:

1. Ensure this public-key certificate will only be for use with the Single-Use 
Account Web Service. 

2. Ensure that the certificate was created using these requirements:
 Must be a valid DER-encoded X.509 certificate.
 Must be supplied in either binary or printable (Base4) encoding.
 Must support 2048-bit encryption.
 Private keys should not be provided.
 File should not be password protected.
 Validity period must be specified and cannot be greater than two years.
 Specified subject in the certificate must be unique to this employee, such 

as their email address.

3. Locate the public-key file for the employee by clicking the Browse... button 
under the Public keys field. Be certain that the certificate follows the 
requirements.
The Certificate Management screen lists the file.

4. Click Save.
The Certificate Management screen displays the certificate file with the date it 
was uploaded in the Public Keys column and the Upload Date column, 
respectively.
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P aymentNet offers data management solutions that allow you to transfer 
information via an export or import file. Export and import files give you the 

flexibility to efficiently move significant amounts of data and ensure data accuracy.

To transfer data from PaymentNet to an external file, use an export file. An export 
file is a text file report of information as it appears in PaymentNet. Once you create 
an export file, you can download the file to your local machine and view the file 
details.

For example, you might want to export account details for specific account holders. 
You can create an export file that includes the relevant account data and then 
download the export file to your local machine. For more information on export 
files, see “Managing Export Files” on page 188.

To transfer data to PaymentNet from an external file, use an import file. An import 
file is a text file of information that corresponds to a specific PaymentNet module. 

For example, you might need to create multiple new accounts. To efficiently add 
new accounts to PaymentNet, you can use the Account Import file to import the 
account data. You can complete similar import tasks for the Chart of Accounts, 
Employee, Hierarchy, Merchant Category Code, Merchant, and Transaction Default 
modules. For more information on import files, see “Managing Import Files” on 
page 191.

This chapter explains the following sections:
 Managing Export Files
 Managing Import Files
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Managing Export Files
You can transfer PaymentNet information outside of the system using an export file. 
Once you create an export file, you can download the file to your local machine and 
view the file details.

For example, you might want to export transaction data for a specific date range. 
You can create an export file that includes the relevant transaction data and then 
download the export file to your local machine.

This section explains the following topics:
 Configuring an Export File
 Downloading an Export File
 Deleting an Export File

Configuring an Export File
You can configure an export file that includes data from the PaymentNet modules 
available to your organization, including the Accounts, Chart of Accounts, 
Employees, MCC (Merchant Category Code), Merchants, and Transactions modules. 
The modules you can view are based on the configuration completed in your My 
Profile menu.

When you create an export file, it is a good idea to run a query for the records you 
want to include. This reduces the number of records in the list making it easier for 
you to locate the data you want to export. You can then specify the data you want to 
include in the file, along with the output file format.

To configure an export file:

1. Navigate to the List screen that contains the category of data you want to 
export, such as the Transaction List screen or the Accounts List screen.
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2. Find the data you want to export. Do one of the following:
 Perform a quick query by selecting a value from the New Query drop-down 

list, located at the top of the screen.
 Perform an advanced query by clicking the Advanced link, located at the 

top of the screen.

Note: When exporting the results of an advanced query that spans multiple 
pages, the export file may be blank. This occurs if you leave any of the 
criteria fields empty in the advanced query.
Either export each page of the advanced query results separately or rerun 
the advanced query, making sure to not leave any value field blank, before 
exporting multiple pages.

 Select an existing default query from the drop-down list next to the Set as 
Default Query link.

Note: PaymentNet can display up to 10,000 records at a time. If your query includes 
more than 10,000 records, PaymentNet notifies you that only 10,000 records will 
be displayed.

 

Note: All MCCGs ever assigned to an account, even MCCGs removed from an account, 
are displaying in reports, mappers, and exports.
Use the Account Detail screen to verify the MCCGs assigned to an account. 

 

Note: If your organization has a chart of accounts with more than 1,000 segment 
values, the export file for the chart of accounts may contain missing values for 
some segments and duplicate values for others.

3. Use the multi-select options to select the records that you want to export. For 
more information, see “Using Multi-Select” on page 35.

Note: Even though a maximum of 10,000 records display at one time on the 
Transaction List screen, when you click the Select All Pages link, and more than 
10,000 records exist, PaymentNet exports the total number of records and not 
just the 10,000 that display.

4. Click the Create Export File button.
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5. Complete these fields:

File format
Select the export file format from the drop-down list.

Name
Enter a name for the export file.

Compress output file
This option is read-only. By default, all export files are compressed.

6. Click the Process button. 

Downloading an Export File
You can download an export file to your local machine. When you download an 
export file, you view the file based on its file output settings.

To download an export file:

1. Select Reports> Downloads. The Available Downloads screen displays.

2. As necessary, filter the file display on the Available Downloads screen. Select 
this filter option from the drop-down list:

Export
Select this option to view all the export files available for download.

3. Click the file you want to view.

4. In the File Download dialog box, click one of these buttons:

Open
Click this button to open a file.

Save
Click this button to save a file to your local machine.

Cancel
Click this button to return to the Available Downloads screen.

Deleting an Export File
You can delete an export file as needed.
PaymentNet User Guide



Managing Import Files
To delete an export file:

1. Select Reports> Downloads. 
The Available Downloads screen displays.

2. Select the checkbox next to the file you want to delete. 

3. Click the Delete Selected button.

Managing Import Files
You can transfer information to PaymentNet from outside of the system using an 
import file. Once you create an import file, you can pull the import file contents into 
PaymentNet and avoid the task of manually entering large amounts of data. Use 
import files to simultaneously update multiple records.

This section provides step-by-step instructions on how to prepare import files for a 
clean import into PaymentNet.

There are many different types of import files. Import file types include:
 Account Import. Used to create or modify a group of accounts.
 Chart of Accounts Import. Used to create, modify, remove, or replace Chart of 

Account values.
 Employee Import. Used to create or modify employees and delete user 

authority.
 Hierarchy Import. Used to create, modify, or remove Hierarchy Nodes.
 Merchant Category Code Import. Used to manage the Merchant Category Code 

(MCC) Type and the Travel and Entertainment Type of Merchant Category Codes.
 Merchant Import. Used to modify specific merchant information.
 Transaction Defaults Import. Used to create, modify, remove, or replace the 

defaults for Employees, Accounts, Merchant Category Codes, Merchants, 
Hierarchy, and Customer Codes.

Your team is responsible for preparing import files and developing a list of import 
files for ongoing maintenance purposes. Consult your internal technical and 
accounting staff for any technical questions.

During the implementation phase, your J.P. Morgan implementation team is available 
to discuss your import file needs and provide input on the files appropriate for your 
organization’s card program. Following implementation, your J.P. Morgan 
relationship management team can assist you as needed.
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If you need more information about the import file process, please contact your J.P. 
morgan implementation or relationship management team.

This section explains the following topics:
 Configuring an Import File
 Import File Layouts
 Importing a File Into PaymentNet
 General Import File Tips
 Troubleshooting Import Errors

Configuring an Import File
You can configure an import file using a J.P. Morgan import template. J.P. Morgan 
provides template for the Accounts, Chart of Accounts, Employees, MCC (Merchant 
Category Code), Merchants, and Transactions modules. The modules you can view 
are based on the configuration completed in your My Profile menu.

Note: J.P. Morgan import file templates are Microsoft® Excel® worksheets. To open and 
work with a template, you must have Microsoft Excel 2003 or later.

To configure an import file:

1. Open the import file template for which you want to import information.

2. Enter the data in the file template. You can manually enter the data or import 
the data.

3. Verify that the data is consistent with the import file layout requirements. For a 
complete description of the import file layout requirements for each module, 
see “Import File Layout Requirements” on page 193.

4. Save the file template. If you plan to add data to the file template again before 
you import the file into PaymentNet, you can save the file template in .xls or 
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.xlsx format. However, once you are ready to import the file into PaymentNet, 
you must save the file in Unicode Text (*.txt) format. 

 Table 3: Import File Layout Requirements 

Import File Type Import File Layout Requirements

Accounts For more information on the Accounts import file type 
requirements, see “Account Import” on page 194.

Chart of Accounts For more information on the Chart of Accounts import file type 
requirements, see “Chart of Accounts Import” on page 210.

Employee For more information on the Employees import file type 
requirements, see “Employee Import” on page 212.

Merchant Category Code For more information on the Merchant Category Code import file 
type requirements, see “Merchant Category Code Import” on 
page 220.

Merchant For more information on the Merchants import file type 
requirements, see “Merchant Import” on page 223.

Transaction Defaults For more information on the Transactions import file type 
requirements, see “Transaction Defaults Import” on page 225.

Import File Layouts
This section describes the import file layout requirements for each import file type. 
When you configure an import file, refer to the topics in this section to ensure a 
successful import into PaymentNet. 

Note: When you create or edit an import file using a file template, you can save the file in 
.xls or .xlsx format. However, once you are ready to import the file into PaymentNet, 
you must save the file in Unicode text (*.txt) format. Unicode text is a tab-delimited 
text file format that is compatible with PaymentNet.

This section explains the following topics:
 Account Import
 Chart of Accounts Import
 Employee Import
 Hierarchy Import
 Merchant Category Code Import
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 Merchant Import
 Transaction Defaults Import

Account Import
Use the Account Import file to create and modify multiple accounts using a single 
file. With this import file, you can create, suspend, reactivate and close accounts, 
update cardholder information, update account limits and settings, and update 
account hierarchy and MCC Groups. The Account Import file can contain up to 10,000 
records.

If you receive a line item error during the account import process, copy each line 
containing an error to a new import file, update the lines to fix the error, and then 
import the new file (containing only the fixed line items) to PaymentNet. If you fix 
the line items in the original file and then import that same file again, you will open 
duplicate accounts for each line that did not originally contain an error.

 Table 4: Account Import File Layout 

Column  Name Description Required Valid Codes

A Account 
Number

For new accounts, this 
refers to the template 
account or the account 
that is being replicated. 
For an account update, 
the account number 
indicates the account 
being updated.

Yes  16 digit account code

B Employee 
Type

Employee Type indicates 
that the account is 
created for either a new 
or existing user.
Note that PaymentNet 
does not require a User 
ID for every account. For 
example, you might 
issue a card to an 
individual who is not 
going to log in to 
PaymentNet or require a 
User ID. In this case, you 
would add a User ID of 
“None.”

Yes for Add
No for Update

Valid fields include:
 New
 Existing
 None (This means that 

no User ID is associated 
with the account)
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C User ID Refers to the 
PaymentNet User ID tied 
to the new account 
being created

Yes for Add
No for Update

 Alphanumeric
 When you create or 

modify an account, the 
User ID must be 
between 6-20 
characters.

 No special characters 
allowed

 PaymentNet does not 
require a User ID for 
every account. This 
means that a User ID 
type of “None” must be 
added.

Note: When you create a 
new account and user via 
import or the user 
interface, ensure that the 
user ID is not the same as 
the first four characters of 
the last name specified 
and the last four 
characters of the 
government identification 
number.

D Generate 
Login 
Information 
(the previous 
heading was 
Cardholder)

Generates login 
information to send to 
SiteMinder. SiteMinder is 
a third-party application 
that validates login 
information. SiteMinder 
stores and maintains the 
required user 
information associated 
with each account and 
passes that information 
to the appropriate 
PaymentNet application 
section.
Once a request is sent to 
SiteMinder, it cannot be 
sent again.

No Valid fields include:
 0: No action required.
 1: User ID has login 

information generated 
and sent to SiteMinder

E Hierarchy ID Refers to the Hierarchy 
defined in PaymentNet 
to which an account is 
associated

Yes for Add
No for Update

 Alphanumeric
 15 characters max

 Table 4: Account Import File Layout (continued)
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F Status Refers to account status No Valid fields include:
 Active
 Suspend
 Close
When Card Delivery is 
specified, account status is 
one of these values:
 New
 Active
 Suspended

G Reason Reason associated with 
the “Closed” account 
status

No for Add
Yes for Update 
with Status of 
“Close”

Valid EDS fields include:
 1: Cardholder no longer 

employed.
 2: Account not needed
Valid TSYS fields include:
 1: Account closed 

online by APC/Admin

H Prefix Prefix associated with 
the cardholder’s name

No for Add.
Not allowed 
for Update

 Alphanumeric
 4 characters max

I First Name Cardholder’s first name Yes for Add 
(New TSYS 
accounts 
require first 
name or last 
name only)
Not allowed 
for update

 Alphanumeric
 HP accounts: Maximum 

of 25 characters 
combined (including 
spaces) for the First 
Name, Middle Initial, 
Last Name, and Suffix 
fields.

 TSYS accounts: 
Maximum of 23 
characters combined 
for the First Name, 
Middle Initial, and Last 
Name fields.

 First Name must be 
upper case

J Middle Initial Cardholder’s middle 
initial

No for add
Not allowed 
for update

 Alphanumeric
 2 characters max
 Middle Name must be 

upper case

 Table 4: Account Import File Layout (continued)

Column  Name Description Required Valid Codes
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K Last Name Cardholder’s last name Yes for add 
(New accounts 
require first 
name or last 
name only)
Not allowed 
for Update if 
the First Name 
is not included 
on the account

 Alphanumeric
 HP accounts: Maximum 

of 25 characters 
combined (including 
spaces) for the First 
Name, Middle Initial, 
Last Name, and Suffix 
fields.

 TSYS accounts: 
Maximum of 23 
characters combined 
for the First Name, 
Middle Initial, and Last 
Name fields.

 Last Name must be 
upper case

L Suffix Suffix associated with 
the account holder’s 
name

No  Alphanumeric
 4 characters max

M Second Row 
of Embossing

Information embossed 
on the credit card 
plastic below the name 
If left blank, this value 
defaults from the 
template account

No
Not allowed 
for Update

 Alphanumeric
 21 characters max for 

MasterCard
 19 characters max for 

Visa

N Date of Birth Cardholder’s date of 
birth (must be at least 
18 years of age)

Yes for Add 
(either Date of 
Birth or 
Mother’s 
Maiden Name 
required)
No for Update

 mm/dd/yyyy format for 
TSYS

 mm/yy format for EDS 

O SSN/ID Cardholder’s Social 
Security Number

Yes for Add
No for Update

 Numeric
 9 characters exactly (no 

dashes)
 For Joint & Several or 

Corporate Liability 
programs, only the last 
4 SSN/ID digits are 
required; however, 9 
digits total must be 
entered. In these 
instances, use the 
format 900-00-1234, 
where 1234 are the last 
four digits of the SSN/
ID.

 Table 4: Account Import File Layout (continued)
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P Mother’s 
Maiden 
Name

Denotes the maiden 
name of the cardholder’s 
mother

Yes for Add 
(either Date of 
Birth or 
Mother’s 
Maiden Name 
required)
No for Update

 Alphanumeric
 4 characters max for 

TSYS processor
 10 characters max for 

EDS processor

Q Cardholder 
Address Line 
1

Cardholder Address Line 
1

Yes for Add.
No for Update

 Alphanumeric
 25 characters max
Note: For TSYS, 
Cardholder Address must 
match the Statement 
Address.

R Address Line 
2

Cardholder Address Line 
2

No  Alphanumeric
 25 characters max

S City Cardholder’s City Yes for Add
No for Update

 Alphanumeric
 25 characters max

T State/
Province

Cardholder’s State/
Province

Yes for Add
No for Update

 Alphabetic
 2 characters exactly

U ZIP/Postal 
Code

Cardholder’s Zip/Postal 
Code

Yes for Add
No for Update

 If Country is USA, 
exactly 5 or 9 numeric 
characters.

 If Country is CAN, up to 
9 alphanumeric 
characters.

V Country Cardholder’s Country Yes for Add
No for Update

 Alphanumeric
 3 characters exactly
 USA for United States
 CAN for Canada

W Statement 
Address Line 
1

Represents Statement 
Address Line 1, where 
the Statement is mailed

Yes for Add
No for Update

 Alphanumeric
 For an EDS account, the 

characters cannot 
exceed 25.

 For a TSYS account, the 
characters cannot 
exceed 36 and must 
match the Cardholder 
Address.

X Address Line 
2

Represents the 
Statement Address Line 
2

No  Alphanumeric
 25 characters max

 Table 4: Account Import File Layout (continued)
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Y City Represents the City 
associated with the 
Statement Address.

Yes for Add
No for Update

 Alphanumeric
 25 characters max

Z State/
Province

Represents the State/
Province associated with 
the Statement Address

Yes for Add
No for Update

 Alphabetic
 2 characters exactly

AA ZIP/Postal 
Code

Represents Zip/Postal 
Code associated with 
the Statement Address

Yes for Add
No for Update

 If Country is USA, 
exactly 5 or 9 numeric 
characters

 If Country is CAN, up to 
9 alphanumeric 
characters

AB Country Represents the Country 
where the statement is 
mailed

Yes for Add
No for Update

 Alphanumeric
 Exactly 3 characters.
 For the United States, 

enter USA
 For Canada, enter CAN

AC E-Mail 
Address

Cardholders email 
address
Note: For clients on 
the HP processor, the 
creation of a new 
account will fail at the 
processor if the 
employee email address 
is longer than 33 
characters in length.
In this situation, use one 
of the following options:
 Enter an alternate 

email address that is 
33 characters or less 
in length

 Create the new 
account using the No 
Employee option. 
Then, create the 
employee account 
and assign the 
account to the 
employee.

Yes for new 
accounts.

 Alphanumeric
 50 characters max
 Must contain the @ sign
 No spaces allowed
 Supported special 

characters include < > / 
| space \

 Table 4: Account Import File Layout (continued)
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AD Business 
Phone

Cardholder’s business 
phone number

No  Numeric
 When you create or 

modify an account using 
the ########## format, 
you must enter exactly 
10 characters.

 When you create or 
modify an account using 
the ###-###-#### 
format, you must enter 
exactly 12 characters.

AE Mobile Phone Cardholder’s mobile 
phone number

No  Numeric
 When you create or 

modify an account using 
the ########## format, 
you must enter exactly 
10 characters.

 When you create or 
modify an account using 
the ###-###-#### 
format, you must enter 
exactly 12 characters.

AF Custom Field 
1| Custom 
Field 2| 
Custom Field 
3

Represents account 
custom fields defined by 
the user that can be 
associated with an 
account
The header row needs to 
be updated with the 
names of the Account 
Custom fields.
Custom fields need to be 
updated to reflect the 
Account custom fields 
setup in PaymentNet.

No
If custom 
fields are not 
used, the 
column header 
row and each 
cell in the 
column must 
be left blank.

 Pipe delimited
 Unlimited
Note: If you are not 
providing a value for the 
custom fields, you must 
enter a dash (-) for each 
blank value separated by 
the pipe character (|). For 
example: -|-|-

AG Notes Refers to the notes/
comments entered by 
the user associated with 
a given account

No  Alphanumeric
 2000 characters max

 Table 4: Account Import File Layout (continued)
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AH Employee ID Employee ID is sent to 
the processor

No  Alphanumeric
 EDS accounts: Maximum 

length is 22 characters. 
Supported special 
characters include: ‘ \ , 
/, -, &

 TSYS accounts: 
Maximum length is 20 
characters. Supported 
special characters 
include: ~ ‘ ! @ # $ % ^ 
& * () - _ = + \ | } ] { [ ‘ “ 
; : / ? . ,

AI Cost Center Represents the Cost 
Center ID associated 
with an account

No  Alphanumeric
 10 characters max

AJ VIP Designates if an account 
has VIP status

No Valid fields include:
 0: VIP checkbox not 

selected.
 1: VIP checkbox 

selected.

AK International Designates if an account 
is an International 
account

No Valid fields include:
 0: International 

checkbox not selected.
 1: International 

checkbox selected.

AL Credit Limit Indicates credit limit for 
account
If left blank, this value 
defaults from the 
template account.
When you create or 
modify an account, the 
individual credit limit 
must not exceed 
9999999 for TSYS and 
99999999 for EDS.

Yes for new 
accounts

 Numeric
 8 characters max
 No spaces or commas

 Table 4: Account Import File Layout (continued)
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AM Cash 
Advance 
Limit

Indicates cash advance 
limit
If left blank, this value 
defaults from the 
template account.
When you create or 
modify an account, the 
individual credit limit 
must not exceed 
9999999 for TSYS and 
99999999 for EDS.

No  Numeric
 8 characters max
 No spaces or commas

AN Monthly 
Transaction 
Limit

Indicates monthly 
transaction limit
If left blank, this value 
defaults from the 
template account.

No
Applies only to 
TSYS accounts

 Numeric
 5 characters max
 No spaces or commas

AO Monthly 
Amount 
Limit

Indicates monthly 
amount limit

No  Numeric
 11 characters max
 No spaces or commas

AP Cycle 
Transaction 
Limit

Indicates cycle 
transaction limit
If the Monthly 
Transaction Limit is 
entered, the Cycle 
Transaction Limit is not 
allowed.

No
Applies only to 
TSYS accounts

 Numeric
 8 characters max
 No spaces or commas
 Value must be greater 

than zero

AQ Cycle 
Amount 
Limit

Indicates cycle amount 
limit
If the Monthly Amount 
Limit is entered, the 
Cycle Amount Limit is 
not allowed.

No
Applies only to 
TSYS accounts

 Numeric
 14 characters max
 No spaces or commas
 Value must be greater 

than zero
 Value must be less than 

or equal to the Central 
Bill Credit Limit

AR Daily 
Amount 
Limit

Indicates daily amount 
limit
If left blank, this value 
defaults from the 
template account.

No  Numeric
 11 characters max
 No spaces or commas

 Table 4: Account Import File Layout (continued)
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AS Daily 
Transaction 
Limit

Indicates daily 
transaction limit
If left blank, this value 
defaults from the 
template account.

No  Numeric
 5 characters max
 No spaces or commas

AT Single 
Amount 
Limit

Indicates single amount 
limit
If left blank, this value 
defaults from the 
template account.

No  Numeric
 11 characters max
 No spaces or commas

AU Other 
Transaction 
Limit

Indicates other 
transaction limit
Either the Other 
Transaction Limit is 
specified or the Other 
Amount Limit and the 
Other Refresh Date are 
specified.

No
Applies only to 
TSYS accounts

 Numeric
 8 characters max
 No spaces or commas

AV Other 
Amount 
Limit

Indicates other amount 
limit
Either the Other 
Transaction Limit is 
specified or the Other 
Amount Limit and the 
Other Refresh Date are 
specified.

No
Applies only to 
TSYS accounts

 Numeric
 14 characters max
 No spaces or commas
 Value must be greater 

than zero (TSYS only)
 Must specify valid Other 

Refresh Date and Other 
Number of Days values

AW Other 
Number of 
Days

The number of days 
variable velocity checks 
can be used

Yes, if the 
Other 
Transaction 
Limit or Other 
Amount Limit 
are used
Applies only to 
TSYS accounts

 Numeric
 3 characters max
 Value must be greater 

than zero

AX Other 
Refresh Date

The date that variable 
(Other) velocity counter 
starts.
Either the Other 
Transaction Limit is 
specified or the Other 
Amount Limit and the 
Other Refresh Date are 
specified.

Yes, if Other 
Transaction 
Limit or Other 
Amount Limit 
are used

 mm/dd/yyyy format
 TSYS accounts only
 Value must be greater 

than zero (TSYS only)
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AY MCC Group 1 Represents the Merchant 
Category Code Group 
associated with the 
credit card account. A 
maximum of up to nine 
MCC Groups can be 
associated with an 
account. Each MCC 
Group is treated as an 
individual field in the 
input file. 
If left blank, this value 
defaults from the 
template account.

No for EDS 
accounts
Yes for TSYS 
accounts

 Numeric
 Maximum length: 3 

characters for EDS; 10 
characters for TSYS 

 Exists in the 
organization

 Unique in the import 
file

 Unique for the account
 Positive integer only for 

EDS

AZ MCC Group 
Action 1

Denotes if the specified 
MCC Groups is either 
included in the credit 
card account or 
excluded from the credit 
card account. Each MCC 
Group has a MCC Group 
Action associated with 
it. Each MCC Group 
Action is treated as an 
individual field in the 
input file.
If left blank, this value 
defaults from the 
template account.

Yes, if a MCC 
Group is 
included in the 
file

Alphabetic
1 characters max
Valid fields include:
 I: Include
 E: Exclude
 B: Blank

BA MCC Group 2 See AX See AX See AX

BB MCC Group 
Action 2

See AY See AY See AY

BC MCC Group 3 See AX See AX See AX

BD MCC Group 
Action 3

See AY See AY See AY

BE MCC Group 4 See AX See AX See AX

BF MCC Group 
Action 4

See AY See AY See AY

BG MCC Group 5 See AX See AX See AX
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BH MCC Group 
Action 5

See AY See AY See AY

BI MCC Group 6 See AX See AX See AX

BJ MCC Group 
Action 6

See AY See AY See AY

BK MCC Group 7 See AX See AX See AX

BL MCC Group 
Action 7

See AY See AY See AY

BM MCC Group 8 See AX See AX See AX

BN MCC Group 
Action 8

See AY See AY See AY

BO MCC Group 9 See AX See AX See AX

BP MCC Group 
Action 9

See AY See AY See AY

BQ TSYS 
Expiration 
Date

Users can specify the 
Expiration Date for the 
account. 
The Expiration Date 
cannot be greater than 
24 months or less than 
three months from the 
account creation date.

No mm/yyyy format

BR Card 
Delivery

Used to specify the 
address ID/code where 
the card is shipped

No  Numeric
 Maximum length: 5 

characters only for TSYS 
accounts
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Account Import Best Practices include:
 Creating a New Account
 Updating an Existing Account

Creating a New Account
Account Imports can be used to create new accounts in PaymentNet for Corporate 
Liability accounts. To make an Individual Liability request, call your J.P. Morgan 
relationship management team.

Before you add a new card, look up an existing account to use as a template account 
for the new card. That account number is used in the account number field in the 
account batch file. 
 When creating a new account using the Account Import file or Account Batch 

FTP file, the following key scenarios exist:
 Add/Update field = “Add”

BS Add/Update This flag is used to 
indicate if the record 
included in the input file 
is for creating a new 
account or for updating 
an existing account.

Yes Valid fields include:
 Add: Represents a new 

account
 Update: Represents 

updating an existing 
account

BT Blank 
Override

Indicates if a blank 
override is applicable on 
a field. 
Blank Override is 
applicable on these 
fields:
 Custom Fields
 Notes
 E-mail
 Business Phone
 Mobile Phone
 Cost Center
 Employee ID
 Cash Advance Limit
 Monthly Transaction 

Limit
 Daily Amount Limit
 Daily Transaction 

Limit
 Single Amount Limit

Yes Valid fields include:
 0: Default to existing 

value if field left blank
 1: Default to overwrite 

all old code

 Table 4: Account Import File Layout (continued)
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 Employee Type = “New” (If an employee does not have a PaymentNet User 
ID)

 Employee Type = “Existing” (If an employee does have a PaymentNet User 
ID)

 Employee Type = “None” (If an employee will not log in to PaymentNet)
 When creating a new account, the value for the following fields are defaulted 

from the template account unless a new value is specified in the request:
 Second Row of Embossing
 Credit Limit
 Cash Advance Limit
 Monthly Transaction Limit
 Daily Amount Limit
 Daily Transaction Limit
 Single Amount Limit
 MCC Group
 MCC Group Action

Note: Unless specified, all MCC Groups and MCC Group Actions copy over from the 
template account. If any changes need to be made to these fields, all of the 
MCC Groups and their associated actions should be added to the file.
Any limits to the MCC Groups must be added or changed on the MCC Group 
Controls tab of the Account Detail screen within PaymentNet.

 When creating a new account, either the Date of Birth or a Mother’s Maiden 
Name is required.

Note: As a best practice, when you create a new account, use a template account that 
has unlimited amount and transaction limits.

 If a TSYS account is being added, the cardholder address and the statement 
address must be identical (including address lines 1 and 2, City, State/Province, 
Zip/Postal Code and Country). For EDS, a statement address is required.

 If there is an existing Custom Field (or Custom Fields) for the organization, the 
Blank Override is 0 or left blank (no value specified) and there is no value 
specified for the new account Custom Field, then the existing template value(s) 
are copied as the value(s) for the account Custom Field for the new account. 
This applies only to the Account Import file.

 After submitting the Account Import file or Account Batch FTP file, all the 
relevant fields (such as First Name, Middle Initial, Last Name, Hierarchy ID, 
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Business Phone Number, E-mail Address, etc.) for an employee are populated in 
PaymentNet.

Note: If the Account Import file loads successfully with errors, account creation has 
occurred. Do not re-submit the import file; this creates a second, new account.

 

 Once the Account Import file or Account Batch FTP file has been successfully 
submitted, the new account can take up to 48 hours to be processed, added to 
PaymentNet and become available for use.

 If a new employee profile (User ID) is created, a default password is assigned. 
The generated password consists of the first four letters of the last name plus 
the last four digits of the Social Security Number/ID. The User ID and password 
can be automatically sent to the cardholder once the Login Credentials - Auto 
Email module is enabled for your organization. Refer to “Enabling Modules” on 
page 49; it explains each module in List 2: “PaymentNet Modules” on page 50.

Updating an Existing Account
 When updating, reassigning or modifying accounts using the Account Import file 

or Account Batch FTP file, the following key scenarios exist:
 Add/Update field = “Update”
 Employee Type = “New” (If employee does not have a PaymentNet User ID)
 Employee Type = “Existing” (If employee does have a PaymentNet User ID)

 When the Hierarchy ID is changed to another Hierarchy ID for an existing User ID 
in the account update request, the account is assigned to the new hierarchy 
level. 

 If a TSYS account is updated, the cardholder address and the statement address 
(including address lines 1 and 2, City, State/Province, Zip/Postal Code, and 
Country) must be identical. For EDS, a statement address is required.

 If there is an existing Custom Field (or Custom Fields) with the account being 
modified, the Blank Override is 0 or is left blank (no value specified) and there 
is no value specified for the Custom Field, then there is no impact on the value 
that exists in PaymentNet for the account custom field. This is applicable to 
Account Import only.

 When updating an account and the Single Amount Limit is left blank and the 
Blank Override is set to “1,” then the current value for the Single Amount Limit 
is changed to blank.

 When a MCC Group is updated for an account, the update overwrites any 
existing MCC Groups that have an action value of Include, Exclude or Blank.
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 When an account is updated and the User ID already is associated with the 
account, PaymentNet ignores the request. If the User ID is different than the 
User ID associated with the account and the Employee Type is specified as 
“Existing,” then PaymentNet completes these validation steps:
 Perform the account validations and scope of view validations applicable to 

an account modify request and also validate that the User ID exists in 
PaymentNet for that organization.

 Perform the scope of view validations on the request.
 When an account is reassigned to a different User ID and the Employee Type 

equals “Existing”:
 If the account is reassigned to a User ID that had zero (0) accounts before 

the reassignment, then the account becomes the user’s default.
 If the account is reassigned to a User ID that had one or more accounts 

before the reassignment, then account is not marked as the user’s default 
account.

 When an account is reassigned to a different User ID and the Employee Type 
equals “New” PaymentNet completes these validation steps:
 Perform the account validations and scope of view validations applicable to 

an account modify request and also validate that the User ID does not exist 
in PaymentNet.

 If the request passes step 1 then PaymentNet re-assigns the account to the 
specified User ID and creates the new employee in PaymentNet.

 The account becomes the user’s default account.

You can modify the Account List screen view to show the authorization limit fields. 
Then, you can export the template account data and copy/paste the fields into the 
Account Import file. This process helps ensure that these limits are updated 
accurately when modifying accounts.
 The Credit Limit for an account cannot be greater than the agency credit limit.
 The Cash Advance Limit or the Daily Amount Limit cannot be greater than the 

Credit Limit. 
 The Cash Advance Limit can not be greater than the agency Cash Advance Limit.
 The Daily Transaction Limit cannot be more than the Monthly Transaction Limit.
 The Single Amount Limit cannot be greater than the Daily Amount Limit.
 Users can set of Cycle Limits or Monthly limits, but not both. If both 

authorization limits are included in the file, PaymentNet ignores the Monthly 
Limits.
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Chart of Accounts Import
The Chart of Accounts import file is used to manage your Chart of Accounts values. 
This import file is set up for management of these values only and cannot be used for 
the structure of a Chart of Accounts. The structure of a Chart of Accounts is created 
within PaymentNet. 

With this import file, you can add, update, and delete Chart of Accounts segment 
values.

Note:  The Chart of Accounts import provides a Replace function. This function deletes all 
existing segment values in the system and adds the new values provided in the import 
file.
If a Chart of Accounts segment value is deleted, any transaction defaults linked to a 
deleted segment value are also deleted. This might include Employee, Account, 
Hierarchy, MCC, Merchant, or Customer Code transaction defaults.
When you use the Replace function in a Chart of Accounts import, you must also 
complete a Transaction Default import to recreate all the transaction defaults for the 
related chart of accounts.

Please note the following characteristics of importing:
 Create the Chart of Accounts import file from the top-down, and establish the 

lowest numbered segments first.
 If you have dependencies in the Chart of Accounts import file, you must have 

dependencies selected (or turned on) within PaymentNet before you import the 
Chart of Accounts import file.

 If you use an import file to delete values that correspond to default Chart of 
Account values, you must reconfigure the default values.

 Spaces in the Add/Update/Delete Flag field of the import file cause the import 
to fail. Verify that only the words Add, Update, or Delete are listed in this 
column.

 When you complete an import, you have the option on the Import Detail screen 
to replace values. If you replace your Chart of Accounts, you need to re-import 
all your default values. Replace does not use the Add/Update/Delete Flag.
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 Table 5: Chart of Accounts Import File Layout 

Column Name Description Required Valid Codes

A Chart of Accounts Chart name that you plan 
to edit
The name you enter must 
match PaymentNet Chart 
of Accounts name exactly.

Yes  Alphanumeric
 Length must be less 

than or equal to the 
maximum length 
defined for the 
corresponding Chart 
of Accounts segment

 Spaces are allowed

B Segment Segment where the value 
is found.

Yes  Numeric

C Value Actual Chart of Accounts 
value

Yes  Alphanumeric, 
length based on 
Chart of Accounts 
definition

 No spaces allowed

D Description Description of the Chart 
of Accounts value

Yes  Alphanumeric
 25 characters max

E Key Segment Dependency segment No  Numeric

F Key Value Dependency value Required if 
Key Segment 
(Column E) 
is not blank

 Alphanumeric, 
length based on 
Chart of Accounts 
definition
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Employee Import
Use the Employee import file to manage employees and employee profiles within 
PaymentNet, including bank information. Use this import file to create and update 
employees within your scope of view. 

Note: You must define a User ID, Role, Hierarchy, and Scope for each employee you import 
into PaymentNet.

Please note the following:

G Add/Update/
Delete Flag

Action code passed for 
each record

Yes Valid fields include: 
 Add: for new rows 

containing data 
 Update: for existing 

rows to be updated
 Delete: for rows to 

be removed
Note: Chart of 
Account imports may 
not process successfully 
when you include Add, 
Update, and Delete 
actions in a single 
import file.
Submit three separate 
import files with Add 
only, Update only, and 
Delete only actions.

H Blank Override Overwrite action code 
passed for each record
Blank Override is only 
used where the Add/
Update/Delete Flag is set 
to “Update” and only 
affects the “Description” 
field.
Best Practice: Keep Blank 
Override equal to “0.”

Yes Valid fields include: 
 0: Indicates that the 

old code 
(description) is to 
remain the same 
when fields are left 
blank

 1: Indicates that all 
old code 
(description) are to 
be overwritten.

 Blank override is 
only used where 
Add/Update/Delete 
Flag is set to 
“Update.”

 Table 5: Chart of Accounts Import File Layout (continued)

Column Name Description Required Valid Codes
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 The combination of the Role Name, Role, Hierarchy ID, and Scope fields 
constitute a User Authority. These four fields are not required; however, if one 
field (either Role Name, Role, Hierarchy ID, or Scope) is included, then all four 
fields need to be included. If not, the row fails and an error is generated. 
Additionally, if these fields are not populated, then the employee with the 
corresponding User ID cannot log in to PaymentNet because they do not have a 
defined user access role.

 The maximum number of User Authorities per employee per import is six; 
however, there is no limit to the number of User Authorities that can exist in the 
database for any employee. To add more than six user authorities, you can 
import the employee a second time with their additional authorities.

 User Authorities can only be added and updated, not deleted. Program 
Administrators can manually delete roles in PaymentNet.

 When you add more than one account number for an employee, you must add a 
new row for each additional account number. The first row for the employee is 
the default account number and “Add” should be entered in the “Add/Update/
Delete Flag” field. On the next row, enter the User ID and account number. 
Then, enter “Update” in the “Add/Update/Delete Flag” field, and use “0” in 
the “Blank Override” field.

 If no employee custom fields are used (Column AP), the custom field column 
header must be entirely blank. Any value in the header causes the import to 
fail.

 Table 6: Employee Import File Layout 

ID Column Name Description Required Valid Codes

A User ID Enter a unique User ID 
for each employee.

Yes  Alphanumeric
 Between 6-20 

characters
 No special 

characters allowed

B Password Users have 30 days from 
the initial Employee 
import to log in to 
PaymentNet. Otherwise, 
Program Administrators 
must re-import the users 
that do not log in within 
30 days. If users are re-
imported, Program 
Administrators can use 
the same password used 
for the initial import.

 Required for 
Add only 

 Upon first login, 
new users must 
change their 
password.

 Alphanumeric
 Must have a 

minimum of one 
number and one 
letter

 Between 6-8 
characters

 Case-sensitive
213



7 | Exports and Imports

214
C First Name Yes  Alphanumeric
 23 characters max 

D Middle Name  Alphanumeric
 1 character max

E Last Name Yes  Alphanumeric
 23 characters max 

F Email Yes  Alphanumeric
 50 characters max
 Must enter at least 

one ‘@’ symbol and 
one ‘.’ in the email 
address

 No spaces are 
allowed

 Email address must 
end with .com or 
.net or .org

G Cc Carbon copy email 
address

 Alphanumeric
 254 characters max
 You can enter up to 

five email 
addresses. Ensure 
that each email 
address is separated 
by a comma or 
semicolon.

H Bcc Blind carbon copy email 
address

 Alphanumeric
 254 characters max
 You can enter up to 

five email 
addresses. Ensure 
that each email 
address is separated 
by a comma or 
semicolon.

I Disable Login Disables the user from 
logging in to 
PaymentNet

Yes Valid fields include:
 0: Enable login
 1: Disable login

J Role Name 1 Unique name per role 
for a User ID that 
defines user authority.

Yes, if Role 1, Hier 
ID 1, and Scope 1 
are included.

20 characters max
Invalid fields include:
 <, >, /, \, |, or 

space

 Table 6: Employee Import File Layout (continued)

ID Column Name Description Required Valid Codes
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K Role 1 Roles define the user 
authority (scope and 
node) of each user. Up 
to six roles are available 
to each user.

Yes, if Role Name 
1, Hier ID 1, and 
Scope 1 are 
included.

30 characters max
Valid fields include:
 Auditor
 Program 

Administrator (must 
include a space 
between “Program” 
and 
“Administrator”)

 Card Holder (must 
include a space 
between “Card” and 
“Holder”)

 Manager
 Transaction 

Approver (must 
include a space 
between 
“Transaction” and 
“Approver”)

 Order Requestor 
(must include a 
space between 
“Order” and 
“Requestor”)

 Any custom role 
created for your 
organization

L Hier ID 1 Hierarchy location 
associated with role

Yes, if Role Name 
1, Role 1, and 
Scope 1 are 
included

 Alphanumeric
 15 characters max

M Scope 1 Scope associated with 
role

Yes, if Role Name 
1, Role 1 and Hier 
ID 1 are included.

Valid fields include:
 NodeAndChildren
 Node
 Self
 NodeAndSelfAndChild

ren
 NodeandSelf

N Role Name 2 Same as Column J Same as Column J Same as Column J

O Role 2 Same as Column K Same as Column K Same as Column K

P Hier ID 2 Same as Column L Same as Column L Same as Column L

Q Scope 2 Same as Column M Same as Column M Same as Column M

 Table 6: Employee Import File Layout (continued)

ID Column Name Description Required Valid Codes
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R Role Name 3 Same as Column J Same as Column J Same as Column J

S Role 3 Same as Column K Same as Column K Same as Column K

T Hier ID 3 Same as Column L Same as Column L Same as Column L

U Scope 3 Same as Column M Same as Column M Same as Column M

V Role Name 4 Same as Column J Same as Column J Same as Column J

W Role 4 Same as Column K Same as Column K Same as Column K

X Hier ID 4 Same as Column L Same as Column L Same as Column L

Y Scope 4 Same as Column M Same as Column M Same as Column M

Z Role Name 5 Same as Column J Same as Column J Same as Column J

AA Role 5 Same as Column K Same as Column K Same as Column K

AB Hier ID 5 Same as Column L Same as Column L Same as Column L

AC Scope 5 Same as Column M Same as Column M Same as Column M

AD Role Name 6 Same as Column J Same as Column J Same as Column J

AE Role 6 Same as Column K Same as Column K Same as Column K

AF Hier ID 6 Same as Column L Same as Column L Same as Column L

AG Scope 6 Same as Column M Same as Column M Same as Column M

AH Employee 
Hierarchy ID

Hierarchy location for 
the new employee.

Yes  Alphanumeric
 15 characters max

AI Account Number Account number 
associated with the 
employee.

 Numeric
 16 characters max

AJ Account 
Hierarchy ID

Hierarchy location 
associated with the 
account number.

Required if Blank 
Override is “1”

 Alphanumeric
 15 characters max

 Table 6: Employee Import File Layout (continued)

ID Column Name Description Required Valid Codes
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AK ABA Routing 
Number

If you enter an ABA 
Routing Number, 
then you must 
populate Columns 
AL - AO.
If any bank 
information is 
incorrect and 
causes an error on 
import, the 
banking fields are 
not imported.

 Numeric
 9 characters max

AL Bank Account 
Number

Required if ABA 
Routing Number is 
entered

 Numeric
 17 characters max

AM Bank Account 
Type

Required if ABA 
Routing Number is 
entered

Valid fields include:
 Checking
 Savings

AN Bank Name Required if ABA 
Routing Number is 
entered

 Alphanumeric
 25 characters max

AO Account Name Required if ABA 
Routing Number is 
entered

 Alphanumeric
 25 characters max

AP Custom Field 1|
Custom Field 2|
Custom Field 3

Represents Custom 
Fields associated with 
the user

Yes, when the 
header row is 
defined and 
corresponding 
Custom Fields are 
configured to be 
“Required” for 
Employee.
If custom fields are 
not used, the 
column header row 
and each cell in 
the column must 
be left blank.

 Pipe delimited
 Unlimited
 The header row 

needs to be updated 
with the names of 
the Employee 
Custom Fields.

 The Custom Field 
column header must 
be left blank when 
the Custom Fields 
are not defined.

 When Employee 
Custom Fields are 
defined in the 
header, 
corresponding null 
custom field values 
shall be specified by 
a hyphen (-).

 Table 6: Employee Import File Layout (continued)

ID Column Name Description Required Valid Codes
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Hierarchy Import
The Hierarchy import file provides easy access for management of the hierarchy 
structure. You can add, update, and delete hierarchy nodes using the Hierarchy 
import file.

Please note the following:
 In Hierarchy Import files, the following additional characters are not allowed: 

[%,‘, “, #, ..=, +, @, (, ), !, *, $ ].

AQ Unmask Exports/
Reports

This option allows the 
user to see sensitive 
information unmasked.

Valid fields include: 
 Y: Sensitive 

information 
included in exports 
and reports 
generated by this 
user appear 
unmasked.

 N or <blank>: 
Sensitive 
information 
included in exports 
and reports 
generated by this 
user appear 
masked.

AR Add/Update/
Delete Flag

Action code passed for 
each record

Yes Valid fields include: 
 Add: For new rows
 Update: For existing 

rows to be updated

AS Blank Override Default overwrite action 
passed for each record
Blank Override is only 
used where the Add/
Update Flag is set to 
“Update” and only 
affects the “E-Mail 
address” field.
Best Practice: Keep 
Blank Override equal to 
“0”

Yes Valid fields include:
 0: Default to 

existing value if 
field left blank. 
When adding 
multiple account 
numbers, set this 
field to 0.

 1: Default to 
overwrite all old 
code.

Do not use the Delete 
flag.

 Table 6: Employee Import File Layout (continued)

ID Column Name Description Required Valid Codes
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 Create the Hierarchy nodes from the top level down, establishing the highest 
nodes first (i.e. Node 1 then Node 2, etc.).

 Delete Hierarchy nodes from the bottom level up. You cannot delete a hierarchy 
node with dependents.

 When you delete hierarchy nodes that have objects associated with them 
(Accounts, Employees, MCCs, etc.), you need to reassign all objects to a 
different hierarchy before you delete the hierarchy node or they are moved to 
the “Deleted” hierarchy node.

 Table 7: Hierarchy Import File Layout 

Column Column Name Description Required Valid Codes

A Hierarchy Type Name of the current 
hierarchy

Yes 20 characters max
Alphanumeric
 Valid fields include: 

OrgHierarchy (name 
found on the Manage 
Hierarchy screen)

B Hierarchy ID Name of the node Yes  15 characters max
 Alphanumeric

C Description Description of the 
Hierarchy ID (Column B)

Yes  30 characters max
 Alphanumeric

D Parent Hierarchy 
ID

Yes  The default value for 
this field is “Root.”

 If you change the 
name of the Root 
level, enter the new 
name in this field.

 15 characters max
 Alphanumeric
219



7 | Exports and Imports

220
Merchant Category Code Import
Merchant Category Codes (MCCs) are primarily used for travel transactions. The 
Merchant Category Code import file is used to manage “Type” (Purchase, Travel, and 
Fleet) and “Travel” only. 

Please note the following:
 Merchant Category Codes are pre-loaded into the system with default Types and 

Travel types.

E Add/Update/
Delete Flag

Action code passed for 
each record

Yes Valid fields include:
 Add: for new rows 

containing data 
 Update: for existing 

rows to be updated
 Delete: for rows to be 

removed
Note: Hierarchy 
imports may not process 
successfully when you 
include Add, Update, and 
Delete actions in a single 
import file.
Submit three separate 
import files with Add 
only, Update only, and 
Delete only actions.

F Blank Override Default overwrite action 
passed for each record
Blank Override is only 
used where Add/
Update/Delete Flag is 
set to “Update”
Best Practice: Keep 
Blank Override equal to 
“0.”

Yes Valid fields include:
 0: Default to existing 

value if field left 
blank.

 1: Default to 
overwrite all old code.

When adding multiple 
account numbers, enter 
“0.”

 Table 7: Hierarchy Import File Layout (continued)

Column Column Name Description Required Valid Codes
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 Table 8: Merchant Category Code Import File Layout 

Column Name Description Required Valid Codes

A MCC ID Can be exported from the 
system with predefined 
defaults of Type and T&E 
Type

Yes  Four digit code

B Type Yes Valid fields include:
 Purchase
 Travel and 

Entertainment
 Fleet

C T&E Type Valid fields include:
 Airline
 CarRental
 Lodging
 Other
 Restaurant
 Travel

D Custom 
Field 1| 
Custom 
Field 2| 
Custom 
Field 3

Represents Merchant 
Category Code custom 
fields defined by the user 
that can be associated with 
a merchant category code
Custom fields need to be 
updated to reflect the 
Merchant Category Code 
custom fields setup in 
PaymentNet.
The header row needs to 
be updated with the names 
of the Merchant Category 
Code Custom fields.

Yes, when the 
header row is 
defined and 
corresponding 
custom fields 
are configured 
to be 
“Required” for 
Merchant 
Category Codes
If custom fields 
are not used, 
the column 
header row and 
each cell in the 
column must be 
left blank.

 Pipe delimited
 Unlimited
Note: If you are not 
providing a value for 
the custom fields, you 
must enter a dash (-) 
for each blank value 
separated by the pipe 
character (|). For 
example: -|-|-
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E Add/
Update/
Delete Flag

Action Code passed for 
each record

Yes Valid fields include:
 Update: For existing 

rows to be updated.

F Blank 
Override

Default overwrite action 
passed for each record
Best Practice: Keep Blank 
Override equal to “0”

Yes Valid fields include:
 0: Default to 

existing value if 
field left blank. 
When you add 
multiple account 
numbers, set this 
field to 0.

 1: Default to 
overwrite all old 
code.

 Table 8: Merchant Category Code Import File Layout (continued)

Column Name Description Required Valid Codes
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Merchant Import
The Merchant import file is used to update specific merchant information. You can 
only update merchants; you cannot add or delete merchants. Merchants are loaded 
into the system as transactions tied to a merchant. You can run an export file first to 
obtain a valid Merchant ID.

 Table 9: Merchant Import File Layout 

Column Name Description Required Valid Codes

A Association Credit card type Yes Valid fields include:
 Visa
 Mastercard

B Merchant ID Unique ID for the 
merchant
Obtained by running an 
export file

Yes  Numeric

C Parent 
Merchant

The name of the parent 
merchant into which 
the merchant rolls up

No  Alphanumeric

D Automatically 
Update This 
Merchant

Flag corresponding to 
the checkbox of the 
same name on the 
Merchant Detail screen

Valid fields include:
 0: No or 

unchecked
 1: Yes or 

unchecked.
This flag must be 
either unchecked in 
PaymentNet or set to 
“0” in the import 
file in order to load 
values in the 
remaining import 
columns. If not, the 
import row (not the 
whole file) fails.

E Taxpayer ID Unique Merchant Tax ID Yes.  Alphanumeric
 20 characters max

F 1099 
Indicator

Valid fields include:
 0: No or Off.
 1: Yes or On.

G Sales Tax 
Exempt

Valid fields include:
 0: No or Off.
 1: Yes or On.
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H Preferred 
Indicator

Indicates merchant is 
preferred

Valid fields include:
 0: No or Off.
 1: Yes or On.

I Address 1  Alphanumeric
 25 characters max

J Address 2  Alphanumeric
 25 characters max

K Phone 
Number

 Numeric
 10 characters max 

without other 
symbols

 No dash “-” 
allowed

L Fax Number  Numeric
 10 characters max 

without other 
symbols

 No dash “-” 
allowed

M Contact  Alphanumeric
 25 characters max

N Custom Field 
1| Custom 
Field 2| 
Custom Field 
3

Represents merchant 
custom fields defined 
by the user that can be 
associated with a 
merchant
Custom fields need to 
be updated to reflect 
the Merchant custom 
fields set up in 
PaymentNet.
The header row needs 
to be updated with the 
names of the Merchant 
Custom fields.

No
If Merchant custom 
fields are not 
defined, the Custom 
Field column header 
should be left blank.
If Merchant custom 
fields are defined in 
the header, but a 
specific value in a 
row of the import 
does not contain a 
value, the value of 
null should be 
indicated by a 
hyphen (-).

 Pipe delimited
 Unlimited

 Table 9: Merchant Import File Layout (continued)

Column Name Description Required Valid Codes
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Transaction Defaults Import
Use the Transaction Defaults import file to set the Chart of Account default values.

Please note the following:
 You must create Chart of Accounts values before you load defaults. If you try 

and load defaults before the Chart of Accounts, your Transaction Defaults 
import fails.

 The number of Transaction Custom Fields is variable, depending on how the 
system is configured for the organization. All Transaction Custom Fields are 
required in the header of the Import file; however it is NOT required that all 
Transaction Custom Fields in the Import file have a value. Unused Custom Fields 
should be left blank.

 The Hierarchy ID is only relevant for those Objects which use a Hierarchy ID. If 
the Hierarchy ID is left blank the system should make these globally available 
(i.e., put them in the top node in the Hierarchy.)

 Accounting code segments must be combined or linked together (concatenated) 
into a single column, with individual segments divided by the pipe (|) delimiter.

 You must use a hyphen in place of a value in the Chart of Account column in the 
case where accounting code segments are not being imported. If no value is 
imported, a dash “-” should be used in the cell. For example, if the accounting 

O Add/Update/
Delete Flag

Action code passed for 
each record

Yes Valid fields include:
 Update: For new 

rows containing 
new data.

Only allowed to 
“Update” 
merchants.

P Blank 
Override

Overwrite action passed 
for each record
Blank Override is only 
be used when Add/
Update/Delete Flag is 
set to Update.
Best Practice: Keep 
Blank Override equal to 
“0”

Valid fields include:
 0: default to 

existing value if 
field left blank. 
When adding 
multiple account 
numbers, set this 
field to 0

 1: default to 
overwrite all old 
code.

 Table 9: Merchant Import File Layout (continued)

Column Name Description Required Valid Codes
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code is specified as “12|1200|-”, then the code is parsed as three chart of 
account segments:
 Segment Number = 1, value = 12
 Segment Number = 2, value = 1200
 Segment Number = 3, value = - (hyphen is used when the segment value is 

blank).
 When replacing a Transaction Defaults import, it replaces all existing default 

types.
 If you are validating Chart of Account values (validation checkbox is selected), 

you must create the Chart of Accounts prior to loading defaults. If you try and 
load defaults before creating the Chart of Accounts, the import fails.

 Table 10: Transaction Defaults Import File Layout 

Column Name Description Required Valid Codes

A Default Type Import default type Yes Valid fields include:
 Account
 MCC
 Merchant
 Employee
 Customer code
 Hierarchy

B Object ID Code to be updated Yes Valid fields include:
 Account Number
 MCC ID
 Merchant ID
 Employee ID (User ID)
 Customer Code (17 

characters max)
 Hierarchy ID

C Hierarchy ID Applicable if 
hierarchy is used

Yes for 
Hierarchy, 
Merchant & 
MCC

 Alphanumeric
 15 characters max

D Chart of Accounts Chart of Accounts 
name

 Alphanumeric
 20 characters max
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E Accounting Code Segments must be 
concatenated into a 
single column, with 
individual segments 
delimited by the 
pipe symbol (“|”). 
Accounting Code 
must consist of 
segment values 
separated by pipe 
symbol (“|”) as 
delimiters and 
concatenated in the 
ascending order of 
segment number.

Yes, if the 
Chart of 
Accounts 
(Column D) is 
populated.

 Alphanumeric, 
Example: 
“12|1200|1220”

F Custom Field 1| 
Custom Field 2| 
Custom Field 3

Custom Field Names
The header row 
needs to be updated 
with the names of 
the Transaction 
Default custom 
fields.

Yes, when the 
header row is 
defined and 
corresponding 
custom fields 
are configured 
to be 
“Required” 
for 
Transaction 
Defaults.
If custom 
fields are not 
used, the 
column 
header row 
and each cell 
in the column 
must be left 
blank.

 Pipe delimited
 Unlimited
Note: If you are not 
providing a value for the 
custom fields, you must 
enter a dash (-) for each 
blank value separated by 
the pipe character (|). For 
example: -|-|-

 Table 10: Transaction Defaults Import File Layout (continued)

Column Name Description Required Valid Codes
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Importing a File Into PaymentNet
Once you configure an import file and verify the file layout requirements, you can 
import the file into PaymentNet.

To import a file:

1. Select Administration > Imports. 
The Import List screen displays.

2. Click the Import New File button.

3. From the Import Name drop-down list, select one of these import file types:

Account
Chart of Accounts
Employee
Hierarchy
Merchant 
Merchant Category Code
Transaction Defaults

G Add/Update/
Delete

Action code passed 
for each record.

Yes Valid fields include:
 Add: For new rows
 Update: For existing 

rows to be updated
 Delete: For rows to be 

removed

H Blank Override Default overwrite 
action passed for 
each record
Blank Override is 
used where Add/
Update/Delete Flag 
is set to “Update”
Best Practice: Keep 
Blank Override equal 
to “0”

Yes  0: Default to existing 
value if field left blank 
When adding multiple 
account numbers, set 
this value to 0

 1: Default to overwrite 
all old code

 Table 10: Transaction Defaults Import File Layout (continued)

Column Name Description Required Valid Codes
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4. Select one of the Import Type options below. 

Add/Update 
Add/Update is used to add data for the first time, append data to an existing 
table, replace existing data with new data for corresponding rows, or delete 
existing individual rows of data. 
This indicator is used in conjunction with the Add/Update/Delete flag found on 
each row of the import file. If an existing row is not represented in the import 
file, it is not changed.

Replace 
Replace is only available for the Chart of Accounts and Transaction Defaults 
import files.
The Chart of Accounts import file replaces existing Chart of Account description 
fields where the Segment, Value, Key Segment, and Key Value fields match 
import entries. Load all entries in the import file as if their Add/Update/Delete 
flags are set to Add. 
Add any rows found in the import file which are not already in the database. 
Remove database entries which do not have corresponding entries (Segment, 
Value, Key Segment and Key Value) in the import file.
The Transaction Defaults import file completely removes all transaction defaults 
in all objects, along with any subordinate relationships. It also loads all entries 
in the import file as if their Add/Update/Delete flags are set to Add (although 
the replace process ignores this flag). The system then loads all rows found in 
the import file, indicating any errors.

5. Click the Browse button.
A Windows dialog box displays.

6. Enter the path of the file to be imported. The file must be a Unicode text file 
(.txt).

7. Click the Submit button.
PaymentNet displays the import file results on the Import List screen.

General Import File Tips
This section describes general tips that help you ensure the accuracy of import files. 

Note: You must use Microsoft Excel 2003 or later to create and modify import files.

Follow these tips to ensure that your import files are successful:
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 Format the Excel worksheet as text. To do this:

a. Click the blank square located to the left of the A column and above the 
first row of the worksheet. This highlights the entire worksheet.

b. From the Format menu, select Cells.

c. On the Number tab, click Text.

d. Click OK.
 Certain characters can interfere with a successful import, depending on the 

import file. As a general rule, files should not include double-spaces, 
apostrophes [‘], double quotes [“], commas [,] or ampersands [&]. Carefully 
review the instructions for each import file as there may be more stringent 
requirements on the file you are creating. In Hierarchy Import files, the 
following additional characters are not allowed: [%, #, =, +, @, (, ), !, *, $].

 For all import files except the Account Import, phone numbers should be a 
straight series of ten (10) digits, with no formatting or embedded special 
characters (xxxxxxxxxx format). Phone numbers in the Account Import file 
should be a series of twelve (12) digits with hyphens included (xxx-xxx-xxxx 
format).

 Import files must be formatted as tab-delimited text files. When your file is 
ready to import, choose Save As from the File menu. Name your file and select 
Unicode Text in the “Save as type” drop-down box. Unicode text is a tab-
delimited text file format and is required for import files. It is not necessary to 
save the file as a Unicode text file until you are ready to import. While you are 
making modifications, you can save it as an Excel workbook.

 Blank fields should be blank. A space causes the import to fail. Blank rows in the 
import file also cause the import to fail. The column headers must be present in 
the first row, exactly the way that they appear in the “Import File Layouts” on 
page 193.

 Avoid errors in imports by looking at your import file in a text editor, such as 
Notepad, included with Microsoft Windows. Verify that the file is tab-delimited, 
that there are no blank rows in or at the end of the file, and that there are no 
spaces in blank fields or at the end of fields. All of these issues can cause an 
import to fail.

 You can also verify that there are no blank rows in Microsoft Excel by using the 
CTRL+END key to move to the last row. If there are blank rows, delete the blank 
rows and close Microsoft Excel.

 Import files must be free of password protection.
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Troubleshooting Import Errors
When you import files into PaymentNet, two general types of errors can occur. These 
errors include:
 File Failures
 Line Item Failures

This topic of the Import File section lists error messages that you might receive with 
an import and possible reasons for the errors. Understanding the requirements of 
each import file type is the best way to avoid import file errors. 

For further help with errors, contact your J.P. Morgan implementation or relationship 
management team.

This topic explains the following tasks:
 Viewing Import Errors
 Tips for Resolving Import Errors
 File Failures
 Line Item Failures

Viewing Import Errors
If the import file is Successful with Errors or has Failed, it is listed on the Import List.

To display the Import Error List:

1. Select Administration > Imports.

2. Click the Import Name. 

Tips for Resolving Import Errors
 Imports must be tab-delimited text files, using Unicode text.
 Blank fields should be empty; a space causes the import to fail.
 Blank rows in the import file cause the import to fail. 
 The column headers must be present in the first row, exactly the way that they 

show up in the file layouts.
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File Failures
File failures are serious errors that cause the entire import file to fail and are 
indicated by a status of Failed. File failures are generally caused by not having the 
correct header items in Row 1 of an import file or having blank rows within or at the 
end of an import file. 

Table 11: “Import File Failures” on page 232 describes file failure error messages you 
can receive, common error causes, and error resolutions.

 Table 11: Import File Failures

Error Possible Cause Resolution

DTSExecutionFailedFileLoad
 Blank lines are not 

allowed

 Blank rows are at the end 
of the file or within the 
file.

 Open the import file in a text editor 
and look for blank rows, especially at 
the end of the file.

 Delete all blank rows.

DTSExecutionFailedFileLoad
 The actual number of 

fields does not match the 
expected number of 
field.s

 The number of headers 
does not match the 
required number of 
headers for the file type.

 Spaces are at the end of a 
field, especially the Add/
Update/Delete flag field.

 Review the sample import file and 
make sure you have all the headers 
listed exactly as in the file.

 Check for spaces after the text in a 
field, especially required fields.

Line Item Failures
Line item failures can be caused by numerous things but are most common with bad 
data in the row that failed. If a line item error occurs after an import, the import 
status is “Successful with errors.” You can view the line item errors by clicking on 
the import name on the Import List page. The Import Error List page displays the line 
of the import file that had the error and the actual error message.

To fix a line item failure, you should go to the line in the import file indicated on the 
Import Error List and fix the problem. It is possible to import the whole file into 
PaymentNet again after fixing the lines with errors as long as you know the result.
 If you are adding lines, the lines that imported successfully the first time return 

an error stating that the item already exists. Only fixed or new items in the file 
are successfully imported.

 If you are performing an update, new errors should not occur by importing the 
file in its entirety. All rows update, even if the information is not changed.
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 If you are deleting lines, you receive an error stating that the item does not 
exist. Only rows that were fixed are deleted with the import file.

If you do not want to receive the additional line item errors, you can import just the 
items you fix. It may then be easier for you to find any new errors that occurred on 
items you fixed.

The following table lists errors, possible causes for the errors and how to fix the 
errors. Some errors are listed with the word ITEM to indicate the error could happen 
on various types of imports. This error could apply to Accounting Codes, Hierarchies, 
Employees, Merchants, Merchant Category Codes or Transaction Defaults.

 Table 12: Line Item Failures 

Error Possible Cause Resolution

ITEM already exists  Adding a row that already 
exists

 Do not include the item in the 
import file as it has already been 
entered into PaymentNet.

ITEM does not exist  Updating a row that does not 
exist

 Change the import flag to Add 
instead of Update.

 Do not include the item in the 
import file as it does not exist in 
PaymentNet.

Defaults that are no longer 
in ITEM are set to None

 Choosing to do a Replace of 
the file when accounting code 
defaults exist in PaymentNet

 Set the flag to Update on the 
rows and do not choose Replace 
when importing the file.

 Re-import your defaults after the 
replace is complete.

Dependencies exist  Trying to delete an ITEM that 
has dependencies

 Delete the dependencies before 
you delete the item in the error.

Hierarchy Node Value Too 
Long

 Segment Value is too long  Verify that the hierarchy value 
listed in the row is not longer 
than the segment value listed in 
PaymentNet.

Invalid Action Specified  Add/Update/Delete flag field 
has an invalid value

 Verify that the Add/Update/
Delete flag field lists either Add, 
Update, or Delete.

Invalid Chart of Accounts  Chart of Accounts in import 
file doesn’t exist in 
PaymentNet

 Make sure the Chart of Accounts 
listed in the import file is spelled 
exactly as it is in PaymentNet.
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InvalidHierarchyNodeName  Deleting a row with values that 
don’t exist in PaymentNet

 Verify the value is listed exactly 
as it is in PaymentNet.

Reference Accounting 
Code Does Not Exist

 Key Value is missing in import 
file when PaymentNet shows 
dependency is required

 Key Value and Segment are 
listed in import file when no 
dependency is required

 Importing segment with 
dependency when segment 
that is depended on does not 
exist

 Verify the dependencies listed in 
PaymentNet to make sure your 
import file is set up the same, 
i.e., correct segment 
dependencies, dependencies do 
or don’t exist, etc.

 Import lower numbered segments 
before higher numbered 
segments, i.e., Segment 1 before 
Segment 2, etc.

 Table 12: Line Item Failures (continued)

Error Possible Cause Resolution
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 Flex Mappers
Y ou can utilize a flex mapper to move data between PaymentNet and your 
organization’s accounting system, such as a general ledger (GL) or enterprise 

resource planning (ERP) system. Flex mappers are data export files in a specific 
layout and format, usually a limited or fixed-length text file. 

Unlike reports, a flex mapper gives you the option to mark transactions as export. 
Once a transaction is marked as exported, you cannot edit any information tied to 
the transaction and the flex mapper will not extract the transaction data again. This 
feature ensures that a transaction will not be fed to your internal system more than 
once. 

For example, you run a flex mapper for a billing cycle and request that only 
approved transactions be included in the output file. Those transactions that are not 
approved at the time the flex mapper is run will not be included in the file. When 
you go back and the run the same flex mapper for the same billing cycle, the output 
file will provide you with only transactions that have been approved since the last 
flex mapper run; it will exclude any previously exported transaction.

Flex mappers give you the option to set the mapper criteria by selecting fields from 
a predefined list. You can also use flex mappers to define the file layout and file 
format. You can manually run a flex mapper or schedule it on demand. 

Whether you run a mapper manually or automatically, you can mark transactions as 
exported. When you mark a transaction as exported, PaymentNet locks the 
transaction from additional editing and prevents other mappers from pulling the 
transaction into a flex mapper file.

If after running a flex mapper you still require data beyond its scope then review the 
“Standard File Options” on page 502 and select one of the file layouts. Each of the 
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Standard File Options are transaction-based files with account information that can 
be used to access transaction and account information. After you choose a standard 
file, contact your J.P. Morgan representative for more information.

This chapter explains the following sections:
 Creating a Flex Mapper
 Editing a Flex Mapper
 Deleting a Flex Mapper
 Running a Flex Mapper
 Changing the Status of a Mapper to Successful or Unsuccessful
 Downloading a Flex Mapper

Creating a Flex Mapper
You can create a flex mapper to transfer accounting data from PaymentNet to your 
organization’s accounting system.

For example, you might need to move transaction records from PaymentNet into 
your organization’s ERP system. You can set mapper criteria to pick transaction 
records for the current period within the billing cycle. You can then run and 
download the mapper. Once you download the mapper, you can verify that the 
mapper data is correct. 

Also, a flex mapper gives you the option to lock transactions in PaymentNet. When a 
transaction is locked, you cannot edit any information tied to the transaction and 
the flex mapper does not extract the transaction data again. This prevents 
redundancy. 

When you configure a mapper file, you have the option to select the Mark Records as 
Exported? checkbox. When you select this checkbox and run the mapper, all the 
transactions included in the mapper file are placed in an interim state and cannot be 
edited. This option is shown in Figure 8: “Mapper Detail: General Information 
Screen” on page 237.

The Mark Records as Exported? checkbox is one of multiple criteria that influence 
the status of the transactions included in a mapper.

For example, if you select both the Mark Records as Exported? checkbox and the 
Automatically mark records as successful checkbox, then the transactions included 
in the mapper are automatically marked as Exported and cannot be edited.
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Alternately, if you do not select the Automatically mark records as successful 
checkbox, or if you manually run a mapper, then you can change the mapper status 
to Successful or Unsuccessful. This way, you can validate the transaction data before 
you load it into your organization’s accounting system. 

Note: To reverse the export status on an entire mapper that was generated in the past 365 
days, please contact Client Application Support.

 Figure 8: Mapper Detail: General Information Screen

For a description of possible mapper configuration criteria and transaction editing 
options, see Table 13: “Mapper Criteria and Transaction Editing Options” on 
page 251. For more information about how to change the status of a mapper, see 
“Changing the Status of a Mapper to Successful or Unsuccessful” on page 255.

Note: To ensure that chart of account values and custom fields at the split level of a 
transaction are included in your mapper, make sure the following Line Item Level 
Accounting options are selected in the transaction:
 Chart of accounts on child records (splits)
 Custom fields
In addition to ensuring that the correct Line Item Level Accounting options in the 
transaction are selected, the Include in Line Item checkbox in the Custom Fields 
Setup screen must also be selected.
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For more information on how to edit a flex mapper, see “Editing a Flex Mapper” on 
page 253.

Note: All MCCGs ever assigned to an account, even MCCGs removed from an account, are 
displaying in reports, mappers, and exports.
Use the Account Detail screen to verify the MCCGs assigned to an account. 

 

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

To create a flex mapper:

1. Select Administration > Mappers.
Payment displays the Mapper List screen.
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2. Click the Add New Mapper button.
PaymentNet displays the General Information screen.

3. Complete the fields that display. 

For a complete list of fields, see List 16: “General Information Fields” on 
page 242.

4. Click the Continue button.
PaymentNet displays the Query screen.

5. Click the Plus icon (+) to add query settings to the Criteria, Hierarchy, or Order 
By sections.
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6. Complete the fields that display in the Criteria, Hierarchy, and Order By 
sections.

For a complete list of the fields that display in the Criteria section, see List 17: 
“Query Criteria Fields” on page 243. 

For a complete list of the fields that display in the Hierarchy section, see List 
18: “Query Hierarchy Fields” on page 244. 

For a complete list of the fields that display in the Order By section, see List 19: 
“Query Order By Fields” on page 244.

Note: You cannot order the mapper file by the Accounting Code Values field in 
PaymentNet. Once the mapper has run, use a spreadsheet program such as 
Microsoft Excel to sort the file.

 

Note: When the transaction Post Date is specified in a mapper query for multiple 
criteria (e.g., cardholders, accounts), PaymentNet includes all records with a 
post date in the mapper for any criteria following the AND operator.
For example, if the mapper query criteria includes:
 Post Date is between 10/21/2011 and 11/21/2011
 AND Cardholder Last Name contains DOE
 OR Cardholder Last Name contains JONES
 OR Cardholder Last Name contains SMITH
The mapper file produced from the criteria specified above would include 
transactions with a post date between 10/21/2011 and 11/21/2011 only for 
cardholders with the last name DOE. For cardholders with the last name of 
JONES or SMITH, all transactions with a post date would be included.
To obtain a mapper file with only the transactions between 10/21/2011 and 11/
21/2011for all three cardholders, the mapper query criteria should include:
 Post Date is between 10/21/2011 and 11/21/2011
 AND Cardholder Last Name contains DOE
 OR Post Date is between 10/21/2011 and 11/21/2011
 AND Cardholder Last Name contains JONES
 OR Post Date is between 10/21/2011 and 11/21/2011
 AND Cardholder Last Name contains SMITH

 

7. Click the Continue button.
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8. From the Available Columns list, select the column(s) you want to include in 
the mapper file. To select multiple columns, hold down the CTRL key and click 
the column name.

For a complete list of the Available Columns and the field length for each 
column, see List 20: “List of Available Columns and Field Lengths” on page 245.

9. Use the selection arrows to add or remove columns to or from the Selected 
Columns list. Selection arrows include:
 Add >: Click this arrow to add a column(s) to the Selected Columns list.
 Add All >>: Click this arrow to add all the columns in the Available Columns 

list to the Selected Columns list.
 < Remove: Click this arrow to remove columns from the Selected Columns 

list.
 << Remove All: Click this arrow to remove all the columns from the 

Selected Columns list.

10. Complete the other fields that display. 

For a complete list of fields, see List 21: “Output Fields” on page 250.

11. Click Save.
PaymentNet saves the flex mapper file settings and displays a confirmation 
message. 
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 List 16: General Information Fields 

Name Enter a unique name for the flex mapper.

Hierarchy ID The Hierarchy ID you select determines who can access the Mapper List 
screen and view or edit a mapper. PaymentNet users must be assigned the 
Program Administrator role in order to access the Mapper List screen.

Transaction Types to 
Include

Select one of the following options. By default, Transactions Only is 
selected. 

Transactions Only
Select this option if you want to include transaction records in the mapper 
file.

Transactions and Payments
Select this option if you want to include transaction and payment records 
in the mapper file. Once you run the mapper file, the included 
transactions are locked from further editing and their status is set to 
Exported.
Note: Mapper files containing foreign currency transactions are 
correctly displaying the foreign currency value in the Transaction Line 
field but display the Transaction amount field in US currency. This results 
in a discrepancy between the Transaction Line amount total and the 
Transaction amount total.

Mark Records as 
Exported?

Select this option if you want the status of the transactions included in 
the mapper file to be marked as Exported. Transactions with a status of 
Exported cannot be edited or included in other mapper files. For more 
information about this option, see Table 13: “Mapper Criteria and 
Transaction Editing Options” on page 251.

Automatically mark mapper as successful
Both the Schedule to run automatically checkbox and the Mark records as 
exported checkbox must be checked to enable the Automatically mark as 
successful checkbox. 
Select this checkbox if you want the status of the mapper to be marked as 
Successful once it successfully runs. When a mapper is marked as 
successful, the transactions included in the mapper file are locked from 
further editing. As necessary, you can run the mapper file again and 
include different, unlocked transactions.

Compress Output Select this option if you want to compress the flex mapper output file. By 
default, all mappers are compressed.

Additional Email 
Notification

Enter a valid email address. Once a flex mapper file is ready, an email 
notification is sent to this email address.
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Schedule to run 
automatically?

If you want the selected flex mapper to run on a recurring basis, select 
this checkbox. 
When you select this option, the Frequency and Day drop-down lists 
display. 
Note: Mappers scheduled to run automatically are based on how your 
organization implemented this option. Mappers are processed to start 
after 7 p.m. ET or to complete by 8 a.m. ET.

Frequency Select the frequency with which you want to run the flex mapper. You can 
select from these options: 

Weekly 
If you select this option from the Frequency drop-down list, then you must 
select the weekday on which you want the mapper file to run. Select a 
day from the Day drop-down list.

Cycle

If you select this option from the Frequency drop-down list, then you must 
select when you want the mapper to run during each cycle. Select a value 
from the Cycle drop-down list. Then, select the First day of current 
period or Last day of current period option

Daily
If you select this option from the Frequency drop-down list, then you must 
select the day on which you want the mapper file to run. Select either 
Every Day or Every Week Day from the Day drop-down list.

Monthly 

If you select this option from the Frequency drop-down list, then you must 
select the day of the month on which you want the mapper file to run. 
Select a day of the month from the Day drop-down list. 

Day Select the day of the week you want to run the flex mapper. Each day of 
the week, Monday through Sunday displays in the drop-down list.

 List 16: General Information Fields (continued)

 List 17: Query Criteria Fields 

Field Select the field value that you want to use for the query. 
A list of all of the available criteria Field values are included at 
the end of this list. See “Field items for Criteria:” on page 244.

Operation Select the statement comparison value that you want to use for 
the query.
Note: If a flex mapper contains the “Is Not Equal To” 
operation in the Criteria section for a transaction 
custom field or account code value, a time-out event 
may occur when running the mapper and PaymentNet 
may become unresponsive. 
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Value Enter the query value you want, based on the selected Field 
value.

Field items for Criteria:

Account Number
Accounting Code Values
Addendum Type
Approval Status
Billed to Account
Card Delivery
Cardholder First Name
Cardholder Last Name
Chart of Accounts
Customer Code
Dispute Status
Employee ID
Has Addendum Data
MCC
Merchant City
Merchant Country
Merchant Name
Merchant State/Province
Next Approver Last Name

Order ID
Order Status
Original Amount
Original Currency
Parent Merchant Name
Post Date
Receipt Image Attached
Requestor Name
Settlement Currency
Settlement Method
Total Order Amount
Transaction Amount
Transaction Date
Transaction ID 
Transaction Type
User ID
Waiting for Approval 
Waiting for Review

 List 18: Query Hierarchy Fields

Hierarchy ID Click this link and select the hierarchy you want to include in the query.

Include Children Select this checkbox if you want to include children hierarchies in the 
query.

 List 19: Query Order By Fields 

Field Select the field value in the mapper file by which you want to 
sort the query values. 
A list of all of the available query Field values are included at 
the end of this list. See “Field items for Order By:” on 
page 245.
Note: You cannot order the mapper file by the Accounting 
Code Values field in PaymentNet. Once the mapper has run, use 
a spreadsheet program such as Microsoft Excel to sort the file.

Order Sequence Select the order sequence by which you want the query values 
to display.

 List 17: Query Criteria Fields (continued)
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Field items for Order By:

Account Number
Addendum Type
Billed to Account
Card Delivery 
Cardholder First Name
Cardholder Last Name
Chart of Accounts
Customer Code
Dispute Status
Employee ID
Exported
Has Addendum Data
MCC
Merchant City
Merchant Country
Merchant Name
Merchant State/Province
New Approver Last Name

Order ID
Order Status
Original Amount
Original Currency
Parent Merchant Name
Post Date
Receipt Image Attached
Requestor Name
Settlement Method
Total Order Amount
Transaction Amount
Transaction Date
Transaction ID
Transaction Type
User ID
Waiting for Approval 
Waiting for Review

 List 20: List of Available Columns and Field Lengths 

Available Column Name Field Length Description

Cardholder First Name 50 This is the first name of the account holder, entered on 
the My Profile screen.

Middle Initial 22 This is the middle initial of the account holder, entered 
on the My Profile screen.

Cardholder Last Name 50 This is the last name of the account holder, entered on 
the My Profile screen.

Account Number 16 This is the number identifying the account, appearing 
on the front of the credit card.

Account Pool Description 50 This field is the description of a pool of account 
numbers that are available for use with orders; the pool 
from which single-use account numbers are drawn.

Account Pool ID 50 This is the code used to identify a particular account 
pool. One account pool per hierarchy node is allowed by 
PaymentNet.

Cardholder State/Province 22 This is the state or province listed for the address of the 
account holder.

 List 19: Query Order By Fields (continued)
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Accounting Code Values 100 This field details where a transaction has been 
allocated within a Chart of Accounts, listing each chart 
segment separated by a backslash (\).

Approval Status 50 This field indicated whether a transaction has made it 
through the review/approval process.

Authorization Number 20 This field contains the number assigned to a 
transaction, used to track it through the authorization 
process. After a transaction is authorized, it is posted.

Billed to Account 19 This field contains the account number of the account 
to which the transaction was billed. If the transaction is 
billed to the account used to make it, this field will be 
blank.

Card Delivery 13 This field contains information on which address a 
replacement card will be sent.

Chart Of Accounts 100 This field contains the name of the Chart of Accounts 
associated with the transaction.

Convenience Check 
Number

24 This field contains the check number of a convenience 
check transaction. If the transaction type is not 
“Convenience Check,” this field will be blank.

Customer Code 25 This field contains a code entered at the point of sale 
by the cardholder, and is used to allocate transactions 
and assign custom fields.

Dispute Status 25 This field contains the current status of disputed 
transactions.

Diverted To 16 This field lists the account number of the account to 
which a transaction was diverted. The diversion account 
is responsible for payment.

Employee ID 20 This field will display the identification number of the 
employee.

Employee Hierarchy ID 100 This field will display where within the PaymentNet 
hierarchy structure the employee ID is located.

Export Status Name 18 This field identifies those transactions that have already 
been exported from PaymentNet.

Cardholder Hierarchy ID 100 This field contains the location within the PaymentNet 
hierarchy where the cardholder is located.

 List 20: List of Available Columns and Field Lengths (continued)

Available Column Name Field Length Description
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MCC 4 This field contains the Merchant Category Code.

MCC Description 100 This is the text description of the MCC code associated 
with the merchant; it may be a general category or a 
specific franchise, depending on the code.

Merchant City 100 This is the city where the merchant involved in the 
transaction is located.

Merchant Country 16 This is the country where the merchant involved in the 
transaction is located.

Merchant DBA Name 100 This field lists the name the merchant commonly uses in 
nonofficial venues. DBA stands for "Doing Business As."

Merchant ID 18 This field contains the code used to track an individual 
merchant in the PaymentNet system.

Merchant Name 100 This is the name of the merchant who made the sale in 
the transaction.

Merchant State/Province 23 This is the state or province where the merchant 
involved in the transaction is located.

Merchant Tax Payer ID 21 This is the ID number used by the government to track 
the merchant involved in the transaction.

Merchant Women Owned 
Business Indicator

35 This field indicates whether the merchant involved in 
the transaction is registered as woman-owned.

Merchant Zip/Postal Code 19 This is the ZIP/Postal code where the merchant involved 
in the transaction is located.

Reference Number 23 This is the reference number used to record information 
about this transaction at the association (VISA/
Mastercard) level.

Merchant Minority Code 20 This code indicated whether the merchant is registered 
as a minority-owned business.

Next Approver Last Name 25 This is the last name of the next approver in the 
Transaction Approval process.

Transaction Notes 100 This is a field containing user-entered notes on the 
transaction.

 List 20: List of Available Columns and Field Lengths (continued)

Available Column Name Field Length Description
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Order Begin Date 22 This is the date on which an account number for an 
order becomes active and may have transactions 
recorded against it.

Order End Date 22 This is the date on which an account number for an 
order becomes inactive, and transactions may no longer 
be made on it.

Order Entry Date 22 This is the date on which an order was created in 
PaymentNet.

Order Estimated Freight 23 This field contains the estimated amount paid for 
freight, if an order involved shipping.

Order Estimated Tax % 20 This field contains the estimated percentage of the 
transaction total that was paid for taxes.

Order ID 18 This field contains the identification number used to 
track an order through PaymentNet.

Order Merchant Name 50 This field contains the name of the merchant at which 
an order was fulfilled.

Order Requestor Name/ID 102 This is the name or the identification number of the 
user who created the order.

Order Status 25 This field contains a distinct code which depicts the 
possible statuses of the associated order (e.g., Activate, 
Deactivated, Manually Reconciled, Automatically 
Reconciled, Not Reconciled).

Original Amount 18 This field contains the transaction amount before taxes, 
fees, and other miscellaneous expenses are added.

Original Currency 17 This field contains a code identifying the currency in 
which the transaction was initially made (e.g., USD as 
US Dollars).

Original Merchant Name 100 This field contains the original name of the merchant 
where the transaction took place, as it was passed form 
the processors to J.P. Morgan.

Over Tolerance % 16 This field contains the user-entered percentage over 
the order amount that will be allowed.

Parent Merchant Name/
Merchant Group Name

100 This field contains the name of the parent company for 
the merchant at which the transaction took place, if 
available.

 List 20: List of Available Columns and Field Lengths (continued)

Available Column Name Field Length Description
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Post Date 22 This field contains the date at which the transaction 
was posted to the account.

Settlement Currency 19 This field contains a code identifying the currency in 
which the transaction was settled.

Settlement Method 100 This field reflects how the transaction was settled.

Sales Tax 18 This is the actual amount of sales tax applied to the 
transaction.

Total Order Amount 18 This is the total amount of transactions that may be 
made against this order.

Transaction Amount 18 This is the amount, in USD, of the transaction.

Transaction Date 22 This is the date on which the transaction took place.

Transaction ID 18 This is the reference number used within PaymentNet to 
track transactions.

Transaction Line Amount 23 This is the amount, in USD, of the transaction line item. 
This amount is entered by the user when a transaction is 
split, and the sum of all line item amounts in a 
transaction will show the amount listed in the field 
"Transaction Amount."

Transaction Line 
Description

100 This is a description of a transaction line item, or "split," 
and is entered by the user when a split transaction is 
created.

Transaction Line Taxable 24 This field indicates whether an individual line item 
within a split transaction is subject to tax.

Transaction Line Unit Price 27 This field indicates what the per-unit price of each item 
purchased in a particular transaction line item.

Transaction Line Units 22 This field indicates the number of items purchased in a 
particular transaction line item.

Under Tolerance % 17 This field contains the user-entered percentage under 
the order amount that will be allowed.

User ID 40 This field displays the unique identification number 
associated with a specific user in PaymentNet.

 List 20: List of Available Columns and Field Lengths (continued)

Available Column Name Field Length Description
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Waiting For Approval 20 This field indicates whether a transaction is still waiting 
for approval from the cardholder's manager or 
transaction approver.

Waiting For Review 18 This field indicates whether a transaction must be 
reviewed by the cardholder.

Custom Fields For 
Merchant

Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

Custom Fields for 
Transactions

Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

Custom Fields For Order Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

Custom Fields For MCC Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

Custom Fields For Account Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

Custom Fields for 
Employees

Dynamic; 
based on 
custom field 
properties

These fields will appear on the Flexmapper Available 
field list under the name they were given when created. 
What is contained in each one is controlled by the 
program administrators.

 List 20: List of Available Columns and Field Lengths (continued)

Available Column Name Field Length Description

 List 21: Output Fields 

Include Header Fields Select this checkbox to include generic header fields in the mapper file. 
Header fields include Date of Generation (DDMMYYYY), Time of 
Generation (HH.MM.SS), Organization ID, and Export Name.

File Type Select the mapper file type delimiter from this drop-down list.
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Unicode/ASCII Select the mapper file type: Unicode or ASCII.

Include Footer Fields Select this checkbox to include generic footer fields in the mapper file. 
Footer fields include Debit Count, Debit Total, Credit Count, Credit 
Total, and Total Record Count.

Include line item as 
individual transaction

Select this checkbox to include a line item as an individual transaction.

Available Columns This list displays all the available PaymentNet data fields that can be 
exported in a mapper file. Refer to the available columns and field length 
in List 20: “List of Available Columns and Field Lengths” on page 245.
Note: When Chart of Accounts are included in the mapper file, 
PaymentNet uses the forward slash (\) sub-delimiter between chart of 
account segments.

Selected Columns This list displays all the PaymentNet data fields includes in the flex 
mapper file.

 List 21: Output Fields (continued)

 Table 13: Mapper Criteria and Transaction Editing Options 

Mapper Scheduling 
Method

Mark Records as 
Exported?

Automatically 
mark mapper 
as successful

Option to Edit 
Transaction Data

Mapper is scheduled to 
run automatically.

When the mapper is 
configured, this 
checkbox is selected. 
This checkbox along with 
the Schedule to run 
automatically checkbox 
activates the 
Automatically mark 
mapper as successful 
checkbox.

When the mapper 
is configured, this 
checkbox is 
selected.

Once the mapper 
automatically runs, the 
transactions included in 
the mapper file are 
marked as Exported 
and cannot be modified. 

Mapper is scheduled to 
run automatically.

When the mapper is 
configured, this 
checkbox is not selected.

This checkbox 
does not display.

Once you run the 
mapper, you must 
change the mapper file 
status to Unsuccessful 
before you can unlock 
the transactions for 
editing and run the 
mapper again.
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Mapper is run manually. When the mapper is 
configured, this 
checkbox is selected. 
This checkbox activates 
the Automatically mark 
mapper as successful 
checkbox.

When the mapper 
is configured, this 
checkbox is 
selected.

Once the mapper 
automatically runs, the 
transactions included in 
the mapper file are 
marked as Exported 
and cannot be modified. 

Mapper is run manually. When the mapper is 
configured, this 
checkbox is not selected.

This checkbox 
does not display.

Once you run the 
mapper, you must 
change the mapper file 
status to Unsuccessful 
before you can unlock 
the transactions for 
editing and run the 
mapper again.

 Table 13: Mapper Criteria and Transaction Editing Options (continued)

Mapper Scheduling 
Method

Mark Records as 
Exported?

Automatically 
mark mapper 
as successful

Option to Edit 
Transaction Data
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Editing a Flex Mapper
You can edit a flex mapper as needed. For example, you might need to change the 
scheduled mapper run date.

These steps describe how to edit flex mappers.

To edit a flex mapper:

1. Select Administration > Mappers.
PaymentNet displays the Mapper List screen.

2. Review the following Mapper List information:
 Mapper Name: This column displays the name of the mapper.
 Hierarchy ID: This column displays the hierarchy ID to which the mapper 

belongs.
 Schedule: This column displays the schedule and frequency at which the 

mapper is set to run.

3. Click the name of the mapper you want to view.
PaymentNet displays the General Information screen.

4. Review and edit the flex mapper fields as needed.

For a complete list of fields that display on the General Information screen, see 
List 16: “General Information Fields” on page 242.

For a complete list of fields that display on the Query screen, see List 17: 
“Query Criteria Fields” on page 243, List 18: “Query Hierarchy Fields” on 
page 244, and List 19: “Query Order By Fields” on page 244. 

For a complete list of fields that display on the Output Fields screen, see List 
21: “Output Fields” on page 250.
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Deleting a Flex Mapper
You can delete a flex mapper as needed.

To delete a flex mapper:

1. Select Administration > Mappers.
PaymentNet displays the Mapper List screen.

2. Click the name of the flex mapper you want to delete.

3. Click the Delete button. 
PaymentNet deletes the flex mapper and displays a confirmation message.

Running a Flex Mapper
You can manually run a flex mapper that has not been scheduled to run 
automatically. When you run a flex mapper, all the configured account details are 
packaged based on the mapper settings.

Once you run a flex mapper, the mapper file is available on the Available Downloads 
screen and the transactions included in the mapper are locked from further editing.

These steps describe how to run flex mappers.

Note: If a mapper is scheduled to automatically run, then you must unschedule the mapper 
run date before you can manually run the mapper.

To run a flex mapper:

1. Select Administration > Mappers.
PaymentNet displays the Mapper List screen.

2. Click the name of the mapper you want to run.

3. Click the Run button. 
PaymentNet runs the mapper and displays the mapper file on the Available 
Downloads screen. 
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4. Download the mapper. For instructions on how to download a mapper, refer to 
“Downloading a Flex Mapper” on page 256.

Note: The balance in a mapper does not match the statement balance.

You should base your payment on the statement balance and not the mapper 
balance. 

 

Note: When the No Tax Applied option is not selected on the Transaction Detail screen, 
the No Tax Applied column in the mapper should display “False”. Instead, the 
No Tax Applied column in the mapper is blank.

Changing the Status of a Mapper to Successful 
or Unsuccessful

You can change the status of a flex mapper based on the mapper configuration.

To change the status of a mapper, you must not select the Automatically mark as 
successful checkbox when you configure a mapper. When you select this checkbox 
and run a mapper, PaymentNet automatically marks the status of the mapper as 
Successful, and you cannot edit the mapper status.

If you manually run a mapper or schedule a flex mapper to run automatically, you 
can change the mapper status as long as the Automatically mark as successful 
checkbox is deselected. This feature gives you the flexibility to validate the mapper 
data before you download it to your accounting system.

For example, you might download a flex mapper file and, after reviewing the file, 
realize that some of the transaction allocations are incomplete. You can change the 
status of the transaction in PaymentNet to Unsuccessful. This unlocks the 
transactions for editing.

Once the transaction allocations are complete, you can run the mapper again and 
mark the mapper as Successful. When you mark the status of the mapper as 
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Successful, the transactions included in the mapper file are locked and cannot be 
modified. 

Note: Once you change the status of a mapper, you cannot change it again. For example, 
you might change the status of a mapper to Unsuccessful. Once you select this 
option, you must run the mapper again in order to update the mapper status.
If you mistakenly change the status of a mapper to Successful when it should be 
Unsuccessful, contact Client Application Support (CAS).

To change the status of a flex mapper:

1. Select Reports> Download.
PaymentNet displays the Available Downloads screen.

2. Select Mapper from the drop-down list.

3. Find the mapper for which you want to update the status. 

4. Select one of the following values:
 Successful: If you are ready to load transaction data into your accounting 

system, mark a mapper as Successful. Once you mark a mapper as 
Successful, the transactions included in the mapper file are exported and 
cannot be edited.

 Unsuccessful: If you need to modify the transactions included in the mapper 
file before you download the mapper file to your accounting system, mark a 
mapper as Unsuccessful. Once you mark a mapper as Unsuccessful, the 
transactions included in the mapper file revert to an unexported state and 
can be edited. You must run a mapper file again in order to get a new file 
output.

Downloading a Flex Mapper
Once you successfully run a flex mapper, you can download a flex mapper file to your 
local machine.

These steps describe how to download flex mappers.

To download a flex mapper:

1. Select Reports> Download.
PaymentNet displays the Available Downloads screen.
PaymentNet User Guide



Downloading a Flex Mapper
2. Select Mapper from the drop-down list.

3. Click the file you want to view.

4. In the File Download dialog box, click one of these buttons:
 Open. Click this button to open a file.
 Save. Click this button to save a file to your local machine.
 Cancel. Click this button to return to the Available Downloads screen.

5. If you click the Open or Save button, click the file name.
PaymentNet extracts the compressed file.

6. Save the flex mapper file to your machine.
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Y ou can use the Query feature to quickly identify and sort the data relevant to 
your workflow and management tasks. 

There are two types of queries available in PaymentNet: 
 Quick Query: A Quick Query allows you to perform a basic search for 

information using system-defined fields. Quick Queries provide a fast way to 
complete a basic search.

 Advanced Query: Advanced Queries allow you to create complex filters using 
additional criteria. You can save an advanced query for future use or set an 
advanced query as a default query. This way, you can avoid the task of creating 
a new query each time you want to find specific PaymentNet data.

This chapter describes how to manage quick queries and advanced queries within 
each PaymentNet module, including the Accounts, Employees, Merchant Category 
Codes, Merchants, Single-Use Account Orders, and Transactions modules.

This chapter explains the following sections:
 Creating a Quick Query
 Creating an Advanced Query
 Managing Advanced Queries
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Creating a Quick Query
A quick query allows you to perform a basic search for information using system-
defined fields. 

This section describes how to create a quick query within each PaymentNet module, 
including the Accounts, Employees, Merchant Category Codes, Merchants, and 
Single-Use Account Orders, and Transactions modules.

This section explains the following topics:
 Creating a Quick Query - Accounts
 Creating a Quick Query - Employees
 Creating a Quick Query - Merchant Category Codes
 Creating a Quick Query - Merchants
 Creating a Quick Query - Single-Use Account Orders
 Creating a Quick Query - Transactions

Creating a Quick Query - Accounts
You can perform a basic search for card account information using pre-selected 
fields and values.

Note: In specific situations, PaymentNet is not displaying the Quick Query option on the 
Account List screen used to view transaction authorizations and declines 
(Transactions > Authorizations/Declines). This occurs when a PaymentNet user is 
assigned both a non-cardholder (excluding Program Administrator) and a cardholder 
role with only one active account.
Users should run the Declines Report to view declined transactions within their scope 
of view.

To create a quick query for accounts:

1. Select Accounts > Manage. 
The Account List screen displays.
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2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Account List screen include:

Account Number
Cardholder First Name
Cardholder Last Name
Diverted To
Hierarchy ID
User ID

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.

Creating a Quick Query - Employees
You can perform a basic search for employee user information using pre-selected 
fields and values.

To create a quick query for employees:

1. Select Employees > Manage. 
The Employee List screen displays.

2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Employee List screen include:

User ID
Employee Last Name
Employee Hierarchy ID

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.

Creating a Quick Query - Merchant Category Codes
You can perform a basic search for merchant category code information using pre-
selected fields and values.
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To create a quick query for merchant category codes:

1. Select Administration > Merchant Category Codes. 
The Merchant Category Code List screen displays.

2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Merchant Category Code List screen 
include:

MCC
MCC Description
Type
T&E Type

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.

Creating a Quick Query - Merchants
You can perform a basic search for merchant information using pre-selected fields 
and values.

To create a quick query for merchants:

1. Select Administration > Merchants. 
The Merchant List screen displays.

2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Merchant List screen include:

Merchant Name
MCC
Merchant ID
Parent Merchant

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.
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Creating a Quick Query - Single-Use Account Orders
You can perform a basic search for information on Single-Use Account orders using 
pre-selected fields and values.

To create a quick query for Single-Use Account orders:

1. Select Orders > Manage. 
The Order List screen displays.

2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Order List screen include:

Order ID
Account Number
Merchant Name
Order Status

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.

Creating a Quick Query - Transactions
You can perform a basic search for transaction information using pre-selected fields 
and values.

To create a quick query for transactions:

1. Select Transactions > Manage. 
The Transaction List screen displays.
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2. Select the appropriate query field from the New Query drop-down list. Quick 
Query options that are available from the Transaction List screen include:

Account Number
Approval Status
Cardholder Last Name
Diverted To
Merchant Name
Parent Merchant Name
Post Date
Transaction ID

3. In the text box, enter the characters or digits of the search criteria.

4. Click the Go button.

Creating an Advanced Query
You can perform complex searches and create custom filters using an advanced 
query.

This section describes how to create an advanced query within each PaymentNet 
module, including the Accounts, Employees, Merchant Category Codes, Merchants, 
Single-Use Account Orders, and Transactions modules.

Once you create an advanced query, you can save the query for future use or set it as 
a default query. For instructions on how to manage advanced queries, see “Managing 
Advanced Queries” on page 276.

This section explains the following topics:
 Creating an Advanced Query - Accounts
 Creating an Advanced Query - Employees
 Creating an Advanced Query - Merchant Category Codes
 Creating an Advanced Query - Merchants
 Creating an Advanced Query - Single-Use Account Orders
 Creating an Advanced Query - Transactions
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Creating an Advanced Query - Accounts
You can perform complex searches for card account information using advanced 
search options.

To create an advanced query for accounts:

1. Navigate to the Advanced Query - Accounts screen.

Do one of the following:
 To navigate using the Query menu option:

a. Select Accounts > Query.
 To navigate using the Manage menu option:

a. Select Accounts > Manage.

b. Click the Advanced link.

2. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
Select the operation that you want to use to measure the Field value. The 
operations that display vary based on the Field value you select. Possible 
operation values include: Begins With, Contains, Is Equal To, Is Greater Than, 
Is Greater Than or Equal To, Is Less Than, Is Less Than or Equal To, and Is Not 
Equal To.

Value
If you want to search for an exact field value, then enter the value.
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3. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

4. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 2.

5. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 

6. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

7. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.

8. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

9. Click the Process button.
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Creating an Advanced Query - Employees
You can perform complex searches for employee user account information using 
advanced search options.

To create an advanced query for employee user accounts:

1. Navigate to the Advanced Query - Employees screen.

Do one of the following:
 To navigate using the Query menu option:

a. Select Employees > Query.
 To navigate using the Manage menu option:

a. Select Employees > Manage.

b. Click the Advanced link.

2. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
Select the operation that you want to use to measure the Field value. The 
operations that display vary based on the Field value you select. Possible 
operation values include: Begins With, Contains, Is Equal To, Is Greater Than, 
Is Greater Than or Equal To, Is Less Than, Is Less Than or Equal To, and Is Not 
Equal To.

Value
If you want to search for an exact field value, then enter the value. 
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3. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

4. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 2.

5. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 

6. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

7. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.

8. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

9. Click the Process button.
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Creating an Advanced Query - Merchant Category 
Codes

You can perform complex searches for merchant category code information using 
advanced search options. 

To create an advanced query for merchant category codes:

1. Select Administration > Merchant Category Codes. 
The Merchant Category Code List screen displays.

2. Click the Advanced link.

3. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
Select the operation that you want to use to measure the Field value. The 
operations that display vary based on the Field value you select. Possible 
operation values include: Begins With, Is Between, Is Equal To, Contains, and 
Is Not Equal To.

Value
If you want to search for an exact field value, then enter the value. 

4. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

5. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 3.

6. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 
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7. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

8. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.

9. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

10. Click the Process button.

Creating an Advanced Query - Merchants
You can perform complex searches for merchant information using advanced search 
options.

To create an advanced query for merchants:

1. Select Administration > Merchants. 
The Merchant List screen displays.

2. Click the Advanced link.
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3. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
By default, this value displays Is Equal To.

Value
If you want to search for an exact field value, then enter the value. 

4. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

5. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 3.

6. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 

7. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

8. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.
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9. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

10. Click the Process button.

Creating an Advanced Query - Single-Use Account 
Orders

You can perform complex searches for information on Single-Use Account orders 
using advanced search options.

To create an advanced query for Single-Use Account orders:

1. Navigate to the Advanced Query - Orders screen.

Do one of the following:
 To navigate using the Query menu option:

a. Select Orders > Query.
 To navigate using the Manage menu option:

a. Select Orders > Manage.

b. Click the Advanced link.

2. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.
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Operation
Select the operation that you want to use to measure the Field value. The 
operations that display vary based on the Field value you select. Possible 
operation values include: Begins With, Contains, Is Equal To, Is Greater Than, 
Is Greater Than or Equal To, Is Less Than, Is Less Than or Equal To, and Is Not 
Equal To.

Value
If you want to search for an exact field value, then enter the value. 

3. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

4. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 2.

5. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 

6. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

7. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.
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8. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

9. Click the Process button.

Creating an Advanced Query - Transactions
You can perform complex searches for transaction information using advanced 
search options.

To create an advanced query for transactions:

1. Navigate to the Advanced Query - Transactions screen.

Do one of the following:
 To navigate using the Query menu option:

a. Select Transactions > Query.
 To navigate using the Manage menu option:

a. Select Transactions > Manage.

b. Click the Advanced link.

2. Complete the Criteria section fields:

Field
Select a value from this drop-down list that identifies the field by which you 
want to search.

Operation
Select the operation that you want to use to measure the Field value. The 
operations that display vary based on the Field value you select. Possible 
operation values include: Begins With, Contains, Is Equal To, Is Greater Than, 
Is Greater Than or Equal To, Is Less Than, Is Less Than or Equal To, and Is Not 
Equal To.

Value
If you want to search for an exact field value, then enter the value. 
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3. Optionally, click the plus icon in the Criteria section to add criteria.

Note: When performing an advanced query using the Or condition between criteria 
lines, PaymentNet is only returning the results for the first part of the query if 
the first criteria item is an account field.
For example, if you run a transaction advanced query for the following criteria:
 Cardholder Last Name Is Equal To ABC
OR
 Merchant Name Is Equal To XYZ
PaymentNet only returns data for cardholders with the last name of ABC. 

4. If you add one or more additional rows of criteria, complete the Criteria section 
fields described in step 2.

5. Optionally, click the plus icon in the Hierarchy section to add a hierarchy. 

6. Complete the Hierarchy section fields:

Hierarchy ID
Enter the name of the hierarchy by which you want to search. Alternately, you 
can click the Hierarchy ID link and select a hierarchy from the pop-up window.

Include Children
If you want to include hierarchy children in the search, select this checkbox. 
When you select this checkbox, all users under the selected hierarchy point are 
included in the search.

7. Optionally, if you want to sort the search results, click the plus icon in the Order 
By section.

8. Complete the Order By section fields:

Field
Select a value from this drop-down list to determine how you want the search 
results to display.

Order Sequence
Select the order display from this drop-down list. You can select either 
Ascending or Descending.

9. Click the Process button.
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Managing Advanced Queries
You can save an advanced query for future use, create a default query for quick 
reference, or delete a query as needed. 

Before you can complete the tasks described in this section, you must create an 
advanced query. For instructions on how to create an advanced query, see “Creating 
an Advanced Query” on page 264.

This section explains the following topics:
 Saving a Query
 Setting a Default Query
 Editing a Query
 Deleting a Saved Query

Saving a Query
You can save a query for future use. This way, you can avoid the task of creating a 
new query each time you want to find specific PaymentNet data.

Once you save a query, you can access the query from the Query drop-down list.

To save a query:

1. Create an advanced query. For instructions, see “Creating an Advanced Query” 
on page 264.

2. On the List screen where the query results display, click the Save Query link.

3. In the text box, enter a unique name for the query.

4. Click the Save button.

Setting a Default Query
You can set a default query by saving an advanced query. For example, you might 
want to save an advanced query in the Transactions module that filters transactions 
conducted on a specific date.
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The query you set as the default automatically filters the data that display on the 
corresponding List screen. Set a default query to quickly sort through and identify 
the data you want to review.

Before you can set a default query, you must create an advanced query and save an 
advanced query. For instructions on how to create an advanced query, see “Creating 
an Advanced Query” on page 264. For instructions on how to save an advanced 
query, see “Saving a Query” on page 276.

To set a default query:

1. Navigate to the List screen where you want to create a default query.

2. Select the query you want to set as the default from the Query drop-down list.

3. Click the Default Query link. 

Editing a Query
You can edit or update a query as needed.

To edit a query:

1. Navigate to the appropriate List screen.

2. Click the Advanced link.

3. From the Query drop-down list, select the saved query.

4. Edit the query fields as needed.

5. Click the Process button.

Deleting a Saved Query
You can delete a saved query as needed.

To delete a saved query:

1. Navigate to the appropriate List screen.

2. From the Query drop-down list, select the query you want to delete. 
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3. Click the Delete Query link. 

4. Click the OK button.
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10
 Transactions
T he Transactions module in PaymentNet allows you to manage transaction details 
and settings and make real-time updates. For example, you can identify and 

update default transaction accounting codes for one or multiple transactions. You 
can also use the Transactions module to review and approve transactions, download 
transaction statements, attach receipts, review flagged transactions, and view 
transaction authorization and decline reasons.

As a program administrator, you can manage your individual transactions and 
cardholder transactions. In order to manage your individual transactions, you must 
have an account that is tied to your User ID. In order to manage cardholder 
transactions, cardholders must be within your hierarchy and scope of view. 

This chapter explains the following sections:
 Managing Transactions
 Managing Transaction Receipts
 Viewing Flagged Transactions
 Understanding Fraudulent Transactions
 Disputing Transactions
 Viewing Transaction Authorizations and Declines
 Reviewing and Approving Transactions
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Managing Transactions
The topics in this section describe how to manage transaction details, including 
vendor addendum details and reconciliation data.

Transaction data is stored for 24 months. After 24 months, transaction data is 
deleted from PaymentNet and basic transaction information is stored in a separate 
database for an additional five years. To obtain transaction data after 24 months, 
contact your J.P. Morgan program coordinator or relationship manager.

This section explains the following topics:
 Viewing a Transaction
 Editing a Transaction
 Reviewing Vendor Addendum Details
 Running a Mass Update for Multiple Transactions
 Reviewing Transaction Audit History

Viewing a Transaction
As a Program Administrator, you can view your individual transactions and cardholder 
transactions. In order to view cardholder transactions, cardholders must be assigned 
to your hierarchy and within your scope of view.

When you view a transaction, you can see the transaction date, the merchant, the 
transaction amount, default accounting codes, and other transaction details.

Note: You may receive a ticket error when attempting to access the Transaction Detail 
screen when a new account and its transactions are loaded into PaymentNet on the 
same day. If this occurs, contact your program administrator. Your program 
administrator must contact J.P. Morgan to submit a ticket error requesting that the 
account type for affected transactions be updated.

 

Note: Convenience check transactions for TSYS accounts transferred to a new account from 
a lost or stolen account may not display in PaymentNet. When this occurs, the 
statement amount and the amount in PaymentNet will not match. If convenience 
check transactions are missing from your PaymentNet account, contact your program 
administrator. Your program administrator must contact J.P. Morgan to have the 
missing convenience checks manually loaded to the account.
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Note: If your organization uses a combination of Banks 2235 and 2237 or Banks 2234 and 
2235, the settlement currency will be in Canadian dollars (CAD) instead of United 
States Dollars (USD). 

To view a transaction:

1. Select Transactions > Manage.

2. From the Transaction List screen, in the Transaction Amount column, click the 
transaction amount for the transaction you want to view. 

Note: When additional information is included in the Merchant Name field (e.g., order 
ID, tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” 
the merchant name by removing the additional information. This is done to 
prevent a unique merchant from being created for every transaction from the 
merchant sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the 
user interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

Editing a Transaction
Once a transaction is conducted, most of the transaction details are static and 
cannot be modified; however, PaymentNet gives you the option to edit some 
transaction details, including accounting codes, custom fields, transaction notes. 
This gives you the flexibility to provide additional information as needed.

For example, you might need to investigate why a cardholder conducted a 
transaction with a specific merchant. Once you review the transaction, you can add 
notes to the transaction that explain the outcome. 

You can also divide transaction information into different lines of accounting so costs 
are allocated to the correct cost centers. This is also known as adding lines or 
splitting a transaction. 

Note: If you are a transaction approver and want to review or approve transactions, see 
“Managing Transaction Approvers” on page 314.
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To edit a transaction:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Click the name of the transaction you want to edit.

3. Optionally, you can divide the transaction accounting information into different 
lines of accounting. This is referred to as splitting a transaction. To divide a 
transaction amount, complete these steps:

a. Click the Add Lines button. 

b. Enter the number of lines you want to add to the transaction.

c. Click the Add button.

d. Complete the fields that display. For a complete list of fields, see List 22: 
“Line Item Level Accounting Fields” on page 283.

e. Click Save.

4. Review and modify any of the editable transaction detail fields as needed. For a 
complete list of the fields you can edit, see List 23: “Editable Transaction 
Fields” on page 284.

5. Review the active hyperlinks that display:

Account Number
Click this link to review the Account Detail screen. Once you complete the 
transaction review, click the Return to Transaction Detail link.

MCC
Click this link for more information about the Merchant Category Code (MCC) 
associated with the transaction. Once you complete your review of the MCC, 
click the Return to Transaction Detail link.

Note: PaymentNet users may see an error message when clicking the MCC link on the 
Transaction Detail or Merchant Detail screens. This occurs when an MCC in 
PaymentNet has not been assigned a T&E Type. MCCs that do not have a T&E 
Type display on the Transaction Detail screen but do not display in the Merchant 
Category Code List screen.
Use the Merchant Category Code import file to update the T&E Type field for 
these MCCs in your organization.
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Merchant
Click this link for more information about the merchant. Once you complete 
your review of the merchant, click the Return to Transaction Detail link.

Note: When additional information is included in the Merchant Name field (e.g., order 
ID, tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” 
the merchant name by removing the additional information. This is done to 
prevent a unique merchant from being created for every transaction from the 
merchant sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the 
user interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

6. Click Save. 

 List 22: Line Item Level Accounting Fields 

Item This field displays the accounting line item number and is not editable.

Description This field displays a default description of the transaction. If you want to 
customize the line item description, enter text in this field.

# of Units Enter the number of units purchased.

Unit Price Enter the unit price for the purchased item.

Taxable If the purchased item is taxable, select this checkbox.

% Enter the percentage of the item value that is taxable.

Total This field displays the total cost of the line item. The total item cost is 
calculated by multiplying the value in the # of Units field by the value in 
the Unit Price fields.
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 List 23: Editable Transaction Fields 

Approval If you are a transaction approver and want to review and approve 
transactions, refer to “Reviewing and Approving Transactions” on 
page 314.

Accounting Codes You can use the fields in this section to change the default accounting to a 
custom code. 
Note: PaymentNet may display an error message if the Windows® paste 
feature (CTRL + v) is used to enter information in the chart of account 
segment value description field on the Transaction Detail screen.
Use the drop-down list or the type-ahead feature to select the chart of 
account segment value description.
Note: PaymentNet is incorrectly displaying the “Information was saved 
successfully” message when a user selects a Chart of Accounts on the 
Transaction Detail screen, but does not specify a value for the 
corresponding chart of accounts segments. The user believes that the 
change to the chart of accounts was successful when in reality the change 
was not made because the Accounting Codes segments were not entered. 
This occurs for Chart of Accounts segments that do not have the Validate 
option selected on the Chart of Accounts Detail screen.
PaymentNet users must enter a value in the Accounting Codes segment 
fields before saving Chart of Account changes.
For more information on working with accounting codes, see Chapter 4, 
“Working with Accounting Codes and Chart of Accounts” on page 129.

Transaction Custom Fields If your organization has defined custom drop-down lists or text boxes for 
transactions, then the custom settings display in this section.
You can restrict the user roles that can edit the Transaction custom field 
values, see “Creating Custom Fields for Transactions” on page 82.

Transaction Notes Enter any notes related to the transaction.

Reviewing Vendor Addendum Details
If a vendor, or merchant, attaches addendum details to a transaction, then you can 
view the addendum details. For example, an office supply vendor might attach an 
addendum to a transaction that specifies the items purchased, such as a stapler and 
paper.

If a vendor does not provide addendum details, then the Addendum tab is inactive 
and cannot be accessed.

Depending on the merchant, additional or addendum detail for a transaction may be 
passed on to J.P. Morgan. If addendum detail is available, a small icon displays in the 
Transaction ID column on the Transaction List screen.
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To review vendor addendum details:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Click the addendum icon for the transaction. For a description of each icon, see 
Table 14 on page 285.
PaymentNet displays the Addendum screen with the merchant details.

3. Review the addendum details as needed. 

 Table 14: Addendum Icons 

Icon Icon Name Description

Purchase Detail Displays detailed purchase information.
Note: For organizations on the HP 
processor, the Duty Amount purchase 
addendum data field for a transaction 
displays as $0.00 instead of the correct 
amount. This occurs in the user 
interface, reports, and mappers.

Rental Car Detail Displays detailed car rental information.

Airline Detail Displays detailed flight information.

Shipping Services Detail Displays detailed shipping services 
information.

Fuel Detail Displays detailed fuel purchase 
information.

Temporary Services Detail Displays detailed temporary services 
information.

Lodging Detail Displays detailed hotel information.

Running a Mass Update for Multiple Transactions
You can update up to 10,000 transactions at once using a mass, or batch, update. For 
example, you might want to modify the accounting codes for all the transactions in a 
specific cost center.
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To update multiple transactions, it is a good idea to run a query for the transactions 
you want to update. This reduces the number of records in the list making it easier 
for you to locate the transactions you want to update.

Transaction mass update requests are batch processed every 20 minutes. You will 
receive a confirmation message when the request is received. Once the request is 
complete you will receive a separate email message.

To run a mass update for multiple transactions:

1. Select Transactions > Manage.

2. From the Transaction List screen, do one of the following:
 To complete a Quick Query:

a. From the New Query drop-down list, select the query value you want 
to search by. You can select one of these values:

Account Number
Approval Status
Cardholder Last Name
Diverted To
Merchant Name
Parent Merchant Name
Post Date
Transaction ID

b. Enter the field value by which you want to search.

c. Click the Go button.
 To complete an Advanced Query:

a. Navigate to the Advanced Query - Transactions screen.

Select Transactions > Query. Alternately, you can navigate to the 
Transaction List screen and click the Advanced link.
PaymentNet displays the Advanced Query - Transactions screen.

b. Click the plus icon to add search criteria to the Criteria, Hierarchy, 
and Order By sections.

c. Click the Process button.
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3. Use the multi-select options to select the records that you want to update. For 
more information, see “Using Multi-Select” on page 35.

4. Click the Mass Update button.

5. Edit the corresponding fields. For a complete list of fields, see List 24: “Mass 
Update - Transaction Fields” on page 287.

6. Click Save. 
PaymentNet displays an icon on the Transaction List screen next to transactions 
included in the mass update.

 List 24: Mass Update - Transaction Fields

Chart of Accounts Select this checkbox if you want to update the accounting codes tied to 
the transactions. Once you select this checkbox, you can select new 
accounting codes from the drop-down list.

Transaction Custom Fields Select this checkbox if you want to update any custom fields associated 
with the transactions. Update the corresponding fields as needed.
You can restrict the user roles that can edit the Transaction custom field 
values, see “Creating Custom Fields for Transactions” on page 82.

Approval Status Select this checkbox if you want to update the approval status. Select a 
new status value from the drop-down list.

Reviewing Transaction Audit History
You can review audit history of the last 20 changes made to your transactions within 
PaymentNet. This allows you to monitor transaction modifications, including the 
date, time, description of the transaction change, user who initiated the change, 
and other important details.

Audit data can also be compiled and reviewed in the Transaction Audit report 
(#R068). For instructions on how to run a report, see Chapter 11, “Reports” on 
page 317.

To review transaction audit history:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.
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2. Find the transaction for which you want to review audit history and click the 
transaction link.
PaymentNet displays the Transaction Detail screen.

3. Click the History link.
PaymentNet displays the Transaction Detail - History screen for receipts.

4. Review the data in the fields that display. For a complete list of fields, see List 
25: “Transaction Audit Fields” on page 288.

5. Once you complete your review, click the General Information tab to return to 
the Transaction Detail screen. Alternately, click the List link to return to the 
Transaction List screen.

 List 25: Transaction Audit Fields 

Change Date This field displays the date when the transaction was modified.

Change Time This field displays the time when the transaction was modified.

Field Name This field displays a description of the transaction modification. For 
example, Line Item Total is a possible description.

Previous Value This field displays the previous audited value.

New Value This field displays the new audited value.

Modified By This field displays the PaymentNet user identification number of the 
individual who made the change. If a customer service representative 
makes a transaction change, then Customer Service displays as the value.

Managing Transaction Receipts
You can use Receipt Imaging to attach a receipt to a transaction. This allows you to 
manage receipts electronically and provides a quick reference point for PaymentNet 
users who complete transaction approvals and audits.

PaymentNet provides two methods you can use to attach receipts. The first method 
is to upload a scanned receipt. For example, you can upload a JPG, GIF, TIFF, or PDF 
file. Once you upload a receipt, PaymentNet saves the file in PDF format.

The second method is to fax a receipt. When you select the option to fax a receipt, 
PaymentNet automatically generates a fax cover sheet that identifies the related 
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transaction details, the Organization ID, your Employee Name and ID, and the date 
the cover sheet was generated.

Before you can attach receipts to transactions, your J.P. Morgan implementation 
manager must enable the Receipt Imaging option for the Transactions module. For 
more information, contact your J.P. Morgan implementation manager.

If you enable the Receipt Images Attached email notification, PaymentNet sends an 
automatic notification once your receipts are successfully loaded and available for 
review. For instructions on how to enable email notifications, see “Setting up Email 
Notifications” on page 113.

Additionally, if you print a fax cover sheet, an automatic notification is sent if the 
cover sheet and related receipts are not faxed within 48 hours. This email 
notification does not require any PaymentNet configuration.

When you create transaction reports, you can filter transactions by receipt data. 
Similarly, as a program administrator, you can run the Receipt Imaging Volume 
report. This report summarizes the total number of receipt image files attached to 
transactions within an organization. 

For more information on how to include Receipt Imaging data in reports, see 
“Receipt Imaging Volume (Report # R063)” on page 468 for a report sample and 
available fields. See Chapter 11, “Reports” on page 317 to create a report instance.

The topics in this section describe how to attach, review, and delete receipts for 
transactions in PaymentNet.

This section explains the following topics:
 Attaching a Receipt to a Transaction
 Attaching Receipts to Multiple Transactions
 Reviewing Transaction Receipts
 Reviewing Transaction Receipt Audit History
 Deleting a Receipt from a Transaction

Attaching a Receipt to a Transaction
You can attach a receipt to a transaction within PaymentNet. For example, your 
organization might require that you attach receipts to transactions that exceed a 
specific dollar amount.

PaymentNet provides two methods you can use to attach receipts. The first method 
is to upload a scanned receipt. When you upload a scanned receipt, the file size can 
be any size up to 20 MB (megabytes). Additionally, you can upload five files at one 
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time, but there is no limit to the total number of files attached to a transaction. 
PaymentNet supports JPG, GIF, TIFF, and PDF file formats.

The second method is to fax a receipt. When you select the option to fax a receipt, 
PaymentNet automatically generates a fax cover sheet that identifies the related 
transaction details and your PaymentNet user information. The cover sheet also 
includes a barcode that enables PaymentNet to identify the transaction to which the 
receipt will be attached.

When you send a fax message, the PaymentNet fax cover sheet must be the first 
page of your fax transmission, followed by your receipt.

You can attach a receipt to a transaction at any time, regardless of the transaction 
approval or export status.

This topic describes how to add a receipt to a transaction. For instructions on how to 
add multiple receipts to multiple transactions, see “Attaching Receipts to Multiple 
Transactions” on page 293.

To attach a receipt to a transaction:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.
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2. Click the transaction to which you want to attach a receipt. Alternately, you can 
run a query to find the transaction you want to work with.
PaymentNet displays the General Information screen.

3. Click the Receipts tab.
PaymentNet displays the Receipts screen.

4. Click the Attach Receipts button.
PaymentNet displays the Attach Receipts window. The image below displays the 
options to upload and fax receipts; however, these options might vary based on 
your organization’s settings. 
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5. Do one of the following:
 To upload a scanned receipt:

a. Click the Browse button.
A Windows Explorer window displays.

b. Select the file(s) you want to upload. You can only upload five files at 
once.

c. Click the Open button.
PaymentNet displays the file name in the Receipt section.

d. Click Save.
PaymentNet displays a confirmation message that indicates the images 
will be available in a few hours. If applicable, you will receive an 
e-mail notification once the receipt images are available.

 To fax in a receipt:

a. Click the Print Fax Cover Sheet button.
PaymentNet displays a fax cover sheet. The cover sheet automatically 
populates with your employee information and transaction details.
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b. Review the fields that display on the cover sheet and ensure that you 
selected the correct transactions. If the transactions are incorrect, 
close the window, select the correct transactions and generate a new 
fax cover sheet. For a complete list of fields that display, see List 26: 
“Fax Cover Sheet Fields” on page 293.

c. Print the cover sheet.

d. Fax your receipts to the number indicated on the cover sheet. The first 
page of your fax transmission must be the cover sheet. If receipts are 
not faxed within 48 hours of when you print the cover sheet, 
PaymentNet sends you a reminder email indicating that the cover sheet 
has not been received. 

 List 26: Fax Cover Sheet Fields 

Organization ID This field displays your Organization ID.

Employee Name This field displays your Employee Name.

Generated Date This field displays the date when the fax cover sheet is generated.

Coversheet ID This field displays an automatically generated coversheet ID.

Employee ID This field displays your Employee ID.

Posted Date This field displays the date when the transaction was posted to Payment-
Net.

Transaction ID This field displays the transaction ID.

Merchant This field displays the identification number of the merchant where the 
transaction was conducted.

Amount This field displays the transaction amount.

Attaching Receipts to Multiple Transactions
You can attach receipts to multiple transactions using the multi-select feature.

For example, you might want to upload multiple receipts for expenses incurred 
during business travel. When you upload multiple receipts, you can quickly create an 
electronic record of related expenses.
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Receipts are available for viewing two hours after you upload or fax images.

If the related email notification is enabled, PaymentNet sends you an email 
confirmation once receipts are available for review. 

For instructions on how to configure email notifications, see “Setting up Email 
Notifications” on page 113.

To attach receipts to multiple transactions:

1. Navigate to the Transaction List screen.

Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Find the transactions to which you want to attach receipts. You can run a query 
to find the transactions you want to work with.
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3. Select the checkbox next to the transaction to which you want to attach 
receipts.
PaymentNet activates the Attach Receipts button on the Transaction List 
screen.

4. Click the Attach Receipts button.
PaymentNet displays the Attach Receipts window.

5. Do one of the following:
 To upload scanned receipts as images:

a. Click the Browse button.
A Windows Explorer window displays.

b. Select the files you want to upload. You can only upload five files at 
once.
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c. Click the Open button.
PaymentNet displays the files in the Receipt section.

d. Click Save.
PaymentNet displays a confirmation message that indicates the images 
will be available in a few hours. If applicable, you will receive an 
email notification once the receipt images are available.

 To fax in receipts:

a. Click the Print Fax Cover Sheet button.
PaymentNet displays a fax cover sheet. The cover sheet automatically 
populates with your employee information and transaction details. 

b. Review the fields that display on the cover sheet and ensure that you 
selected the correct transactions. If the transactions are incorrect, 
close the window, select the correct transactions and generate a new 
fax cover sheet. For a complete list of fields that display, see List 26: 
“Fax Cover Sheet Fields” on page 293.

c. Print the cover sheet.

d. Fax your receipts to the number indicated on the cover sheet. The first 
page of your fax transmission must be the cover sheet. If receipts are 
not faxed within 48 hours of when you print the cover sheet, 
PaymentNet sends you an email notification indicating that the cover 
sheet has not been received. (If email notifications are configured.)

Reviewing Transaction Receipts
You can review receipts that have been attached to a transaction. When you review 
a transaction receipt, the receipt displays in PDF format and the fax cover sheet 
displays as the first page.

If you find that you uploaded or faxed in an incorrect receipt, you can delete the 
receipt from the transaction. For instructions on how to delete a receipt from a 
transaction, see “Deleting a Receipt from a Transaction” on page 300.
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To review transaction receipts:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Do one of the following:
 To access a transaction receipt via the receipt icon:

a. Click the receipt icon for the transaction receipt you want to view.
PaymentNet displays the receipt in PDF format. If you review a receipt 
that was faxed in, the fax cover sheet displays as the first page of the 
PDF.

 To access a transaction receipt via the Transaction Detail screen:

a. Find the transactions that has the receipts you want to review. You can 
run a query to find transactions with attached receipts.
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b. Click the name of the transaction for which you want to review a 
receipt.
PaymentNet displays the General Information screen.

c. Click the Receipts tab.
PaymentNet displays the Receipts screen.

d. Click the link to the receipt you want to review.
PaymentNet displays the receipt in PDF format. If you review a receipt 
that was faxed in, the fax cover sheet displays as the first page of the 
PDF.

Reviewing Transaction Receipt Audit History
You can review an audit history of all the changes made to transaction receipts 
within PaymentNet. This allows you to track the sequence of changes and identify 
when receipts were uploaded or faxed to PaymentNet.
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To review transaction receipt audit history:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Find the transaction for which you want to review receipt audit history.
PaymentNet displays the General Information screen.

3. Click the Receipts tab.
PaymentNet displays the Receipts screen.

4. Click the History link.
PaymentNet displays the Transaction Detail - History screen for receipts.

5. Review the data in the fields that display. For a complete list of fields, see List 
27: “Transaction Receipt Audit Fields” on page 299.

6. Once you complete your review, click the Receipts tab to return to the Receipts 
screen.
PaymentNet displays the Receipts screen. 

 List 27: Transaction Receipt Audit Fields 

Change Date This field displays the date when a receipt was modified in PaymentNet.

Change Time This field displays the time when PaymentNet registered a receipt modifi-
cation. For example, this field might display when PaymentNet received a 
faxed receipt.

Field Name This field displays a description of the receipt modification. 

Previous Value This field displays the previous number of receipts associated with the 
selected transaction.
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Deleting a Receipt from a Transaction
You can delete a receipt attached to a transaction. For example, you might 
mistakenly fax in an incorrect receipt. In this instance, you can easily delete the 
receipt associated with the transaction and upload or fax the correct receipt.

The option to delete a receipt varies based on a transaction’s approval status. For 
example, a receipt cannot be deleted from a transaction once the transaction has 
been exported.

For a description of configuration settings required to delete a receipt from a 
transaction, see Table 15: “Configuration Settings to Delete a Receipt from a 
Transaction” on page 300. 

 Table 15: Configuration Settings to Delete a Receipt from a Transaction 

User Role Transaction 
Approval Status

Transaction Export 
Status

Remove Receipt 
Images from a 
Transaction

Cardholder New Not Exported Yes

Manager New Not Exported Yes

Transaction Approver Reviewed or In Process Not Exported Yes

Auditor Read-Only Read-Only Yes

Order Requestor Read-Only Read-Only Yes

Program Administrator Any Not Exported Yes

 

To delete a receipt from a transaction:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

New Value This field displays the new number of receipts associated with the trans-
action.

Modified By This field displays the PaymentNet user name of the individual who modi-
fied the receipt.

 List 27: Transaction Receipt Audit Fields (continued)
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2. Click the name of the transaction for which you want to delete an associated 
receipt.
PaymentNet displays the General Information screen.

3. Click the Receipts tab.
PaymentNet displays the Receipts screen.

4. Click the Delete button (trash can) next to the receipt you want to delete.
PaymentNet deletes the receipt and displays a confirmation message.

Viewing Flagged Transactions
As a program administrator, you can review transactions flagged for Compliance 
Monitoring. PaymentNet offers four monitor types: Single Transaction Amounts, Split 
Transactions, Questionable Merchant Category Codes (MCCs), and Questionable 
Merchants.

To review flagged transactions, you can navigate to the Transaction List screen and 
set up an advanced query or use one of three saved transaction flag queries. The 
query options allow you to quickly find and review relevant transactions.

You can also review flagged transactions on the Transaction List screen using the 
columns that display. Four Compliance Monitoring columns are available: Monitor 
Detail, Monitor Name, and Monitor Type. Add these columns to the Transaction List 
screen by modifying your screen view. For more information on how to edit screen 
views, see “Setting Up Screen Views” on page 54.

Before you can review flagged transactions, your J.P. Morgan implementation 
manager must enable the Compliance Monitoring option at the Organization level. 
For more information, contact your J.P. Morgan implementation manager.

Once Compliance Monitoring is enabled, you can set up monitor rules. This 
configuration is completed in the Hierarchy Settings module. For instructions on how 
to configure compliance monitor rules, see “Configuring Compliance Monitoring” on 
page 66.
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To view flagged transactions:

1. Select Transactions > Manage.
PaymentNet displays the Transaction List screen.

2. Do one of the following:
 Using the saved query drop-down list, select one of the following 

Transaction Flag queries:

Transaction Flags (30 days) Displays flagged transactions from the past 30 days.

Transaction Flags (7 days) Displays flagged transactions from the past 7 days.

Transaction Flags (most recent) Displays flagged transactions from the most recent 
transaction load.
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 Perform an advanced query by completing the following:

a. Click the Advanced link.
PaymentNet displays the Advanced Query - Transactions screen.

b. Complete the Date Range fields:

Field Select a value from this drop-down list that identifies the field by 
which you want to search.

Operation Select the operation that you want to use to measure the field value. 
You can select either Cycle Is, Is Between, Is Equal To, or Is Relative.

Value The values that display vary based on the operation. Select the value 
by which you want to search.

c. Optionally, to add another date range, click the Add (+) button.

d. Complete the Date Range fields.

e. Complete the Criteria section fields:

Field Select Compliance Monitor Flag, Monitor Type, or Monitor Name 
from this drop-down list.

Operation Select the operation that you want to use to measure the field value. 
You can select Is Equal To or Is Not Equal To.

Value The values that display vary based on the selected field. Select the 
value by which you want to search.

f. Optionally, to add another row of criteria, click the Add (+) button.
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g. Complete the Criteria section fields.

h. Optionally, click the plus icon in the Hierarchy section to add a 
hierarchy. 

i. Complete the Hierarchy section fields:

Hierarchy ID Enter the name of the hierarchy by which you want to search. 
Alternately, you can click the Hierarchy ID link and select a 
hierarchy from the window.

Include Children If you want to include hierarchy children in the search, select 
this checkbox. When you select this checkbox, all users under 
the selected hierarchy are included in the search.

j. Optionally, if you want to sort the search results, click the plus icon in 
the Order By section.

k. PaymentNet displays the Order By section fields.

l. Complete the Order By section fields:

Field Select a value from this drop-down list to determine how you 
want the search result to display.

Order Sequence Select the order display from this drop-down list. You can 
select either Ascending or Descending.

m. Click the Process button.
PaymentNet processes the query and displays the results that match 
your query criteria.

3. On the Transaction List screen, find the transaction you want to view.
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Understanding Fraudulent Transactions
4. Hover over the transaction flag icon.
PaymentNet displays the Type, Name, and Detail of the flagged transaction.

Understanding Fraudulent Transactions
On rare occasions, a fraudulent transaction may occur. Unauthorized transactions 
made with a lost, stolen, or counterfeit card/number are considered fraud. 
Unauthorized activity by the merchant, or unexpected/unintended use by the 
merchant, is considered misuse.

This section topic explains the following topics:
 Understanding Types of Fraud
 Preventing Fraud

Understanding Types of Fraud
You can take action and guard against fraud by learning the methods perpetrators 
often use to commit fraud.

Some types of fraud include the following:
 Merchant network or processor weakness. Vulnerable merchant networks are 

accessed using malicious software, or some other tool, to identify files and 
credit card information. Unsecured wireless networks at retail stores are 
particularly vulnerable.
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 Skimming. A card reading device placed on a merchant terminal captures 
magnetic strip data. Skimming most commonly occurs at hotels, restaurants, 
ATMs, and unattended gas pumps. Cameras can also be used to collect key-
entered information, such as a user’s PIN.

 Theft at the merchant. Stolen merchant computer equipment, or pilfered 
receipts/transaction records, can occur.

 Phishing/Social Engineering. Perpetrators gain access to critical systems by 
tricking the merchant or cardholder into providing confidential security 
credentials via fraudulent email, phone, or text messages that appear 
legitimate.

 Credit master. Perpetrators use an algorithm to generate and test valid account 
numbers and expiration dates. This process usually begins with the thief 
obtaining one or more valid account number and expiration date pairs.

Preventing Fraud
Product controls, adhering to best practices, and investigations/recovery efforts all 
play a part in preventing fraud.

Your organization, for example, may implement product controls to place card 
restrictions on a program. Controls may include specific credit limit amounts, exact 
authorization limits, client deactivation periods, approved MCCs, limits on high 
dollar transactions, even velocity restrictions.

Once controls are determined and in place, you and your organization can adhere to 
those controls, review transactions and transaction reports for exceptions and 
declines, and then take action to investigate, dispute, and recover fraudulent 
transactions. See “Disputing a Transaction” on page 307.

Disputing Transactions
As a program administrator, you can dispute transactions tied to your individual 
account or transactions for cardholders within your hierarchy and scope of view. 
Reasons for disputing a transaction can vary. For example, you may want to dispute a 
transaction because of a simple transaction amount billing error, or you may want to 
dispute transactions because of unauthorized transactions due to fraud. See 
“Transaction Dispute Reasons and Additional Steps” on page 308.
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This section describes how to dispute a transaction and cancel a transaction dispute.

Note: Before you dispute a transaction, you must first contact the merchant and attempt to 
resolve the conflict.

This section explains the following topics:
 Disputing a Transaction
 Cancelling a Disputed Transaction

Disputing a Transaction
You can dispute a transaction up to 60 days after the transaction date. For example, 
if today is December 23, 2010, then you can dispute transactions that took place on 
or after October 23, 2010.

A yellow icon displays next to the transaction on the Transaction List screen when 
you submit a transaction dispute. The yellow icon indicates that a dispute has been 
submitted but not yet processed by J.P. Morgan.

A red icon displays next to the transaction to indicate that the dispute is in process.

A green indicator displays next to the transaction to indicate that the dispute is 
resolved.

This section describes how to dispute a transaction, the dispute chargeback 
lifecycle, and dispute procedures that take place outside of the PaymentNet 
interface.

To dispute a transaction:

1. Select Transactions > Manage.

2. Click the transaction you want to dispute.

3. Click the Dispute button.

4. Enter your email address in the E-mail Address field.

5. Select a dispute reason from the Dispute Reason drop-down list. For a complete 
list of dispute reasons and additional steps, see Table 16: “Transaction Dispute 
Reasons and Additional Steps” on page 308.

6. Click the Submit button.
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 Table 16: Transaction Dispute Reasons and Additional Steps 

Dispute Reason Additional Steps

Above-mentioned charge is not recognized. If you select this dispute reason, the Additional 
Information text box displays. As needed, you can add 
other transaction details to this text box.

Billed for an incorrect amount. If you select this dispute reason, you must complete this 
field:

Receipt Amount
Enter the transaction amount indicated on the receipt 
you received from the merchant. The amount you were 
charged displays in the Statement Amount field.

Billed more than once by the same 
merchant.

If you select this dispute reason, you must indicate 
whether the card was in possession at the time of the 
transaction. Mark Yes or No.

Canceled: Merchant/Service/Airline Ticket/
Hotel Reservation

If you select this dispute reason, the Type of Transaction 
drop-down list displays. From the drop-down list, select 
the type of transaction that was canceled: Airline ticket, 
Hotel reservation, Merchandise, or Service.

Charged for purchase that was paid by 
other means.

If you select this dispute reason, the Additional 
Information text box displays. As needed, you can add 
other transaction details to this text box.

I did not authorize this charge. If you select this dispute reason, the Additional 
Information text box displays. As needed, you can add 
other transaction details to this text box. See 
“Understanding Fraudulent Transactions” on page 305.

Merchandise not received that was to be 
shipped.

If you select this dispute reason, complete these 
additional fields:

Merchandise Description
Enter a description of the merchandise that was not 
received.

Date Expected
Enter the date when you expected to receive the 
merchandise.

Date Merchant Contacted
Enter the date when you contacted the merchant.

Explanation of Attempt to Resolve with Merchant
Enter a description that highlights how you attempted to 
resolve the charge with the merchant.
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Understanding the Dispute Chargeback Lifecycle
Most chargebacks begin when a cardholder reports a problem to the card issuer 
(e.g., J.P. Morgan). The acquirer (e.g., the merchant bank, merchant’s financial 
institution) and the merchant may also be involved.

 Figure 9: The Dispute Chargeback Lifecycle

Merchandise/Service was received 
damaged or not as described.

If you select this dispute reason, the Type of Transaction 
drop-down list displays. From the drop-down list, select 
Merchandise or Service.

No credit issued for merchandise returned 
to store.

If you select this dispute reason, the Additional 
Information text box displays. As needed, you can add 
other transaction details to this text box.

Other: Detailed information attached 
describing dispute.

If you select this dispute reason, the Additional 
Information text box displays. As needed, you can add 
other transaction details to this text box.

 Table 16: Transaction Dispute Reasons and Additional Steps (continued)

Dispute Reason Additional Steps
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Following Dispute Procedures
As a program administrator, you can submit a dispute in PaymentNet; however, to 
complete the comprehensive dispute process, additional steps may be required that 
are outside the scope of what must be completed within the PaymentNet interface. 
The steps below include many of the expanded dispute procedures you should follow 
to resolve a disputed transaction. These procedures are primarily designed for 
cardholders and program administrators. For details on VISA and MasterCard 
chargeback timeframes, see Table 17: “VISA Chargeback Timeframe” on page 311 
and Table 18: “MasterCard Chargeback Timeframes” on page 312.

Dispute procedures include the following:

1. Per the cardholder statement, notification of a disputed charge should be 
received within 60 days of the credit card account posting date. As a cardholder, 
you should first contact the merchant in an attempt to resolve the dispute 
before contacting J.P. Morgan.

You can contact the J.P. Morgan Dispute Department at the following address:

Commercial Card Disputes Chase 
OH1-0553 
PO BOX 182918 
Columbus, OH 43272-5543 
Fax: 1-866-865-2298

2. If you cannot resolve the dispute with the merchant, you must send a dispute 
notification to the Dispute Department. Any attempt to resolve the dispute with 
the merchant should be included in the dispute letter, as well as reference to 
the account number, disputed amount, transaction and post date, merchant 
name, and a detailed reason for the dispute.

3. The Dispute Department has five business days upon receipt of the dispute 
notification to start the research process.

4. Some disputes require the merchant to provide a sales draft prior to 
chargeback. J.P. Morgan allows the merchant 30 days to provide the requested 
sales draft.

5. In most cases, a credit is placed on the account once a chargeback is processed. 
As a cardholder, you may receive a temporary dispute credit once the dispute is 
received. If the merchant contests the chargeback, J.P. Morgan forwards the 
merchant’s rebuttal back to you for review and request that you respond to 
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J.P. Morgan about the merchant’s rebuttal, if you continue to dispute the 
charge.

6. J.P. Morgan cannot reverse a chargeback once it has been keyed. Once keyed, 
the chargeback is now in the merchant’s hands. If the merchant does not 
contest the chargeback, regardless of whether the charge is valid, J.P. Morgan 
will post the chargeback credit to your account. Consequently, you must be 
certain the charge is invalid before sending the dispute notice.

7. If the dispute is in regard to tax, you must remember that you are responsible to 
ensure your tax exempt ID number is provided to the merchant at the time of 
the sale. If you fail to inform the merchant that no tax should be charged, then 
the merchant is indeed authorized to post the full amount, including tax, and 
J.P. Morgan has no dispute rights. If you sign the receipt for the full amount, 
including tax, J.P. Morgan has no dispute rights. If the tax ID number was 
provided but you were still charged the tax, then you must include that 
information in the dispute letter.

8. While J.P. Morgan investigates the dispute, the charge remains in dispute status. 
If you require a temporary credit, you will receive a credit when the dispute is 
received. Placing a charge in dispute does not take that amount from the 
outstanding balance; it simply keeps the disputed amount from finance charge 
and payment calculations. 

 Table 17: VISA Chargeback Timeframe

Days Explanation

120 For issuer to key first chargeback

45 For acquirer to re-present

30 For issuer to key pre-arbitration

30 For acquirer response to pre-arbitration

60 For issuer to file arbitration case
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 Table 18: MasterCard Chargeback Timeframes

Days Explanation

120 For issuer to key first chargeback

45 For acquirer to re-present

45 For issuer to key re-presentment chargeback

45 For acquirer to file arbitration case

Cancelling a Disputed Transaction
You can cancel a disputed transaction up until a transaction is resolved.

To cancel a disputed transaction:

1. Select Transactions > Manage.

2. From the Transaction List screen, click the name of the transaction for which 
you want to cancel a dispute.

3. Do one of the following:
 If the square indicator is yellow, click to open that transaction and click the 

Cancel/Undo.
 If the square indicator is red, click to open that transaction and click the 

Mark As Resolved.

4. Click Save. 

Viewing Transaction Authorizations and 
Declines

You can view transaction authorizations and declines for an account in real time and 
efficiently troubleshoot any questions. For example, you might want to find out why 
a cardholder’s transaction is declined. If a transaction is declined due to an 
insufficient credit limit, you might want to access the cardholder’s account and 
increase the credit limit.
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As a Program Administrator, you can view your individual authorizations and declines 
and cardholder authorizations and declines. In order to view cardholder 
authorizations and declines, cardholders must be assigned to your hierarchy and 
within your scope of view.

To view transaction authorizations and declines:

1. Do one of the following:
 View transaction authorizations and declines by scrolling through the list:

a. Select Transactions > Authorizations/Declines.

b. As necessary, find the cardholder authorizations and declines you want 
to view. 

 View transaction authorizations and declines by querying:

a. Select a query value from the New Query drop-down list. As needed, 
enter any related information in the text box.

b. Click the Go button.

c. Click the account number for which you want to view authorizations 
and declines.

d. Review the fields that display. For a complete list of the fields that 
display, see List 28: “Authorizations and Declines Fields” on page 313. 

 List 28: Authorizations and Declines Fields 

AccountId This fields displays the account identification number.

Type This field displays the transaction type values.

TextId This field displays the text identification.

Organization This field displays the organization identification.

Type This field displays the transaction type.

Amount This field displays the transaction amount.

Date/Time This field displays the date and time when the merchant swiped the card.

Merchant This field displays the merchant where the transaction was conducted.
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Reviewing and Approving Transactions
As a Program Administrator, you can manage the approval rules for PaymentNet users 
who are assigned the Transaction Approver role. Additionally, if your User ID is 
assigned the Transaction Approver role, you can review and approve transactions.

Note: When you review and approve transactions on the Transaction List screen, 
PaymentNet does not validate the required accounting code segments for codes that 
cannot be edited. In these instances, transactions are reviewed and approved 
without validation. This causes incomplete allocation and results in account report 
inaccuracies. 
Access to edit accounting codes on the Transaction List screen is set on the Hierarchy 
Settings: Transaction screen. If the “Accounting Code entry on list screen” checkbox 
is cleared, then accounting codes cannot be edited on the Transaction List screen and 
accounting code segments will not be validated. 
To enable accounting code edits on the Transaction List screen, navigate to 
Administration > Hierarchy > Settings > Transaction and select the “Accounting Code 
entry on list screen” checkbox.

This section explains the following topics:
 Managing Transaction Approvers
 Reviewing a Transaction
 Approving Transactions

Managing Transaction Approvers
As a Program Administrator, you can define the transaction approval rules for 
PaymentNet users. When you define approval rules, you specify the settings for users 
within a selected hierarchy. 

For example, you can configure how many levels of approval each transaction 
requires, specify when additional approval levels are required for transactions that 

MCC This field displays the Merchant Category Code (MCC).

Number This field displays the transaction number.

Reason This field displays the reason why the transaction was declined.

 List 28: Authorizations and Declines Fields (continued)
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exceed a certain amount, and set up an email notification schedule. For more 
information on how to configure transaction approval rules, see “Setting Up 
Transaction Approval Rules” on page 60.

Reviewing a Transaction
If you are assigned a Cardholder role, you can review transactions within your 
Hierarchy ID and scope. Using multi-select, you can review up to 100 transactions at 
the same time.

To review a transaction:

1. Select Transactions > Manage.

2. On the Transaction List, do one of the following:
 Click the transaction you want to review.
 Use the multi-select tool to select the transactions you want to review and 

then click the Reviewed button. For information about multi-select, see 
“Using Multi-Select” on page 35.

Note: Although you can select up to 100 individual records on the page to review, 
the total number of records you can select is dependant on the number of 
records displayed. In the My Profile section of PaymentNet, you can choose 
to display 20, 50, or 100 records on a page at a time. To change the number 
of records that display, see “Setting Up Screen Views” on page 54.

3. Review the transaction to make necessary changes. 

4. Select the Reviewed checkbox on the Transaction Detail: General Information 
tab. 

5. Click Save. 
The transaction will be marked as reviewed and, if applicable, forwarded to 
the appropriate approver.
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Approving Transactions
If your User ID is assigned the Transaction Approver role, you can approve 
transactions. Using multi-select, you can approve up to 100 transactions at the same 
time. Once you approve a transaction, it is no longer available for editing. 

Note: Users assigned to the Card Holder and Transaction Approver roles are able to review 
but unable to approve transactions. This occurs if the transaction is reviewed and 
approved at different times.
If the user has the appropriate approver scope of view over the transaction he or she 
reviewed, he or she should approve the transaction at the same time it is reviewed.

To approve a transaction:

1. Select Transactions > Approve.

2. On the Transaction List, do one of the following:
 Click the transaction you want to approve.
 Use the multi-select tool to select the transactions you want approve and 

then click the Approved button. For information about multi-select, see 
“Using Multi-Select” on page 35.

Note: Although you can select up to 100 individual records on the page to 
approve, the total number of records you can select is dependant on the 
number of records displayed. In the My Profile section of PaymentNet, you 
can choose to display 20, 50, or 100 records on a page at a time. To change 
the number of records that display, see “Setting Up Screen Views” on 
page 54.

3. On the Transaction List, click the transaction you want to approve. 

4. Review the transaction to make necessary changes. 
PaymentNet displays the General Information screen.

5. Select the Approval checkbox.

6. If additional levels of approval are required, select the next approver from the 
drop-down box. 

7. Click Save. 
The transaction is marked as Approved and locked from further editing.
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 Reports
A wide range of PaymentNet’s reporting options provide your company or 
organization access to the data needed to manage your accounts, budgets, 

monitor spending compliance, support vendor negotiations, and develop business 
forecasts.

You can customize reports based on the available report criteria, hierarchy, and 
sorting options. You can also schedule reports to run on demand or on a recurring 
basis. These robust features allow you to efficiently create timely reports. Program 
administrators can determine user access to each report. For instructions on how to 
configure report access, see “Setting Up Reports” on page 89.

To create a report that meets your needs, review these steps and use the references 
to learn how to locate, generate, and schedule a report.

Start by using the “PaymentNet Report Matrix” on page 370; this spreadsheet helps 
you to identify the reports that meet your needs. This matrix lists all available 
reports and provides column filtering. This allows you to sort by multiple views, such 
as card program, user role, category, optimized output format, and similar reports, 
to quickly identify and assess which report will meet your needs. You can then use 
the “Report Samples” on page 371 to look up the specific report to review a sample 
of the output and its fields.

Once you know what report you want, follow the steps in “Creating a Report 
Instance”, “Running a Report”, and “Downloading a Report” starting on page 325 to 
page 325 to create and run a report. You can also set up a report to run on a regular 
basis.

If you determine that you want to move data between PaymentNet and your 
organization’s accounting system, such as a general ledger (GL) or enterprise 
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resource planning (ERP) system, use Chapter 8, “Flex Mappers” on page 235 to 
create and run the flex mapper. If the flex mapper meets your needs, schedule it on 
demand. 

If after running a flex mapper you still require data beyond the scope of a flex 
mapper, then review the table in “Standard File Options” on page 502 and select one 
of the file layouts. After you choose a standard file, contact your J.P. Morgan 
representative for more information.

This chapter explains the following sections:
 Creating a Report Instance
 Editing a Report Instance
 Running a Report
 Downloading a Report
 Deleting a Report

Creating a Report Instance
You can narrow the scope of an existing report or create a custom report. You can 
then save the report with a unique name. This is known as a report instance, or 
template. Multiple report outputs can be generated from one report instance.

For example, you might want to customize the Delinquency History report to only 
include the cardholders assigned to your hierarchy and within your scope of view. 
You can open the Delinquency History report, define the hierarchy settings, and save 
the report with a unique name. You can then generate the report as necessary. This 
allows you to efficiently filter and capture data for cardholders within your 
hierarchy who have past-due accounts.

All PaymentNet reports can be customized and saved based on the report criteria. 
You can define different criteria for a report and save multiple versions of the report 
instance.

Once you create a report instance, you can access the report on the Report List 
screen. 

Note: To view only your report instances on the Report List screen, select My Saved Reports 
to filter the display.
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To create a report instance:

1. Select Reports > Create. 
The Report List screen displays.

2. Find the report you want to generate. 

You can narrow your search by clicking the Report Type drop-down and 
selecting the report category. This displays only those reports in that category. 

3. Click the name of the report you want to generate.

4. In the Name field, enter a unique name for the report.

5. From the Report Format drop-down list, select one of the following options:
 Adobe PDF
 MS Excel. The MS Excel report format displays all columns at a width 

necessary to fully display report data on one line. As a best practice, before 
printing the report, you should manually adjust the width of the columns to 
ensure that all report columns will print on the width of one page.

Note: PaymentNet reports optimized for Microsoft Excel are instead defaulting to 
the Adobe® PDF format.
Users must select MS Excel from the Report Format drop-down list when 
running reports optimized for Excel to obtain the report in the correct 
format.

 CSV. When opening the CSV format in Microsoft Excel, Excel may display 
account numbers in scientific notation (e.g., "1.23457E+15" instead of 
"1234567890123456"). This can be corrected by using the Import Wizard and 
formatting the Account column as text.

6. If necessary, select the Compress Output checkbox. If the report contains 
sensitive information, the Compress Output checkbox is automatically 
selected. For reports that do not contain sensitive data, you can compress the 
output.

7. Complete the other fields that display. For a complete list of fields, see List 30: 
“Report Criteria Fields” on page 320, List 31: “Report Hierarchy Fields” on 
page 320, and List 32: “Report Order By Fields” on page 320.
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8. Click Save.

 List 29: Date Range Fields (Post Date Required for Most Transaction Reports 
Only) 

Field A post date is required for all Transaction reports.

Operation Select the value that you want to use to filter the report criteria. Options 
include: Cycle Is, Is Between, Is Equal To, or Is Relative To.

Value Enter the criteria value you want to include in the report. 

 List 30: Report Criteria Fields 

Field Select the fields that correspond to the criteria you want to include in the 
report.

Operation Select the statement comparison value that you want to use to filter the 
report criteria.

Value Enter the criteria value you want to include in the report. This value is 
based on the selected Field value. Users filtering on Payments should 
understand that this filter includes Payment Reversals.

  

 List 31: Report Hierarchy Fields 

Hierarchy ID If you want to narrow the PaymentNet user data included in the report, 
click this link and select the hierarchy you want to include in the report.

Include Children Select this checkbox if you want to include children hierarchies and 
accounts in the report.

  

 List 32: Report Order By Fields 

Field Select the field value by which you want to sort report data.

Order Sequence Select the order sequence in which you want the report data to display. 
You can select either Ascending or Descending.
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Editing a Report Instance
You can edit a report instance as necessary. For example, you might need to add 
criteria to an existing report instance or change the report hierarchy.

Once you edit a report instance, you can access the report on the Report List screen.

To edit a report instance:

1. Select Reports > Create. 
The Report List screen displays.

2. Find the report you want to edit. 

You can narrow your search by clicking the Report Type drop-down and 
selecting the report category. This displays only those reports in that category. 

3. Click the name of the report you want to edit.

Schedule to Run 
Automatically

If you want the selected report to run, select this checkbox. If you select 
this checkbox, fields for Frequency and Day display.

Frequency Select the frequency with which you want to run the report. You can 
select from these options: 

Weekly 
If you select this option from the Frequency drop-down list, then you 
must select the weekday on which you want the report to run. Select a 
day from the Day drop-down list.

Monthly
If you select this option from the Frequency drop-down list, then you
must select the date of the month on which you want the report to run.
Select a date of the month from the Day drop-down list. You can select a
numeric value from 1 to 28 or you can select Last Day of Month.

Daily
If you select this option from the Frequency drop-down list, then you
must select the day on which you want the report to run. Select either
Every Day or Every Week Day from the Day drop-down list.

Cycle
If you select this option from the Frequency drop-down list, then you
must select when you want the report to run during each cycle. Select a
value from the Cycle drop-down list. Then, select the First day of
current period or Last day of current period option.

 List 32: Report Order By Fields (continued)
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4. Modify the fields that display. For a complete list of fields, see List 30: “Report 
Criteria Fields” on page 320, List 31: “Report Hierarchy Fields” on page 320, and 
List 32: “Report Order By Fields” on page 320.

5. Click Save.

Running a Report
You can run a report in real time or you can schedule a report to run on a recurring 
basis. This feature is available for default reports and custom reports.

An email notification can be sent once a report is run. To configure an email 
notification for reports, navigate to the My Profile settings screen and enable the 
report email notification.

This section explains the following topics:
 Running a Report in Real Time
 Scheduling a Report to Run Automatically

Running a Report in Real Time
You can run a default or custom report in real time. This means that you can 
immediately process a report.

Once a report is processed and the report status is Successful, you can download the 
report from the Available Downloads screen.

To run a report in real time:

1. Select Reports > Create. 
The Report List screen displays.

2. Find the report you want to generate. 

You can narrow your search by clicking the Report Type drop-down and 
selecting the report category. This displays only those reports in that category. 

3. Click the name of the report you want to generate.
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4. Select one of the following report out put types from the Report Format 
drop-down list:
 Adobe PDF
 MS Excel. The MS Excel report format displays all columns at a width 

necessary to fully display report data on one line. As a best practice, before 
printing the report, you should manually adjust the width of the columns to 
ensure that all report columns will print on the width of one page.

Note: PaymentNet reports optimized for Microsoft Excel are instead defaulting to 
the Adobe® PDF format.
Users must select MS Excel from the Report Format drop-down list when 
running reports optimized for Excel to obtain the report in the correct 
format.

 CSV. When opening the CSV format in Microsoft Excel, Excel may display 
account numbers in scientific notation (e.g., "1.23457E+15" instead of 
"1234567890123456"). This can be corrected by using the Import Wizard and 
formatting the Account column as text.

5. If you want to customize the report, modify the fields that display. For a 
complete list of fields, see List 30: “Report Criteria Fields” on page 320, List 31: 
“Report Hierarchy Fields” on page 320, and List 32: “Report Order By Fields” on 
page 320. If you customize the report, you must enter a unique report name.

6. Optionally, if you customized the report settings, click the Save button to save 
the report instance.

7. Click the Process Report button.
The Available Downloads screen opens. The report you have just processed is 
displayed, as are any past reports. You can click the Refresh button to update 
what is listed in the Status column. When you first process the report, the 
status moves from Processing, to Submitted, to Successful. You can open the 
report once the status is set to Successful.

Scheduling a Report to Run Automatically
You can schedule a report to automatically run on a recurring date and time. When 
the specified date and time arrive, the report is processed.

Once a report is processed and the report status is Successful, you can download the 
report from the Available Downloads screen.
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If you schedule a report to run automatically but do not log on for a specified time 
frame or change status, PaymentNet cancels the scheduled report.

A scheduled report is canceled when:
 A daily report is scheduled by a user who has not logged on to PaymentNet for 60 

calendar days
 A weekly, monthly, or cycle report is scheduled by a user who has not logged on 

to PaymentNet in 120 calendar days or more
 A program administrator changes a user’s status to Disabled

When a scheduled report is canceled, the saved report instance is still retained in 
PaymentNet.

To schedule a report to run automatically:

1. Select Reports > Create. 
The Report List screen displays.

2. Find the report you want to generate. Do one of the following: 
 If you saved a report, you can select My Saved Reports from the Report 

Type drop-down list and then select the report.
 Click the name of the report that needs to be scheduled.

3. Select the Schedule to Run Automatically checkbox.

4. Select one of these options from the Frequency drop-down menu:

Weekly 
If you select this option from the Frequency drop-down list, then you must 
select the weekday on which you want the report file to run. Select a day from 
the Day drop-down list.

Monthly
If you select this option from the Frequency drop-down list, then you must 
select the day of the month on which you want the report to run. Select a day of 
the month from the Day drop-down list.

Daily
If you select this option from the Frequency drop-down list, then you must 
select the day on which you want the report to run. Select either Every Day or 
Every Week Day from the Day drop-down list.

Cycle
If you select this option from the Frequency drop-down list, then you must 
select when you want the report to run during each cycle. Select a value from 
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the Cycle drop-down list. Then, select the First day of current period or Last day 
of current period option.

5. Click Save. 

Downloading a Report
Once a report is run manually or automatically and displays with a status of 
Successful on the Available Downloads screen, you can download the report to your 
local machine and review the report contents.

To download a report:

1. Select Reports > Download. 
The Available Downloads screen displays.

2. Click the name of the report you want to download.

Note: You can click the Refresh button to update what is listed in the Status column. 
When you first process the report, the status moves from Processing, to 
Submitted, and finally to Successful. You can open the report once the status is 
set to Successful.

3. In the File Download dialog box, click one of these buttons:

Open
Click this button to open the report.

Save
Click this button to save the report to your local machine.

Cancel
Click this button to return to the Available Downloads screen.

Deleting a Report
You can delete a report instance, or template, as well as a report output. 

When you delete a report instance, you can no longer generate a report output using 
the criteria from the report instance; you must create a new report instance. 
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However, when you delete a report output, the report instance is not affected and 
you can still generate a new report output using the report instance. 

This section explains the following topics:
 Deleting a Report Instance
 Deleting a Report Output

Deleting a Report Instance
You can delete a report instance as necessary.

To delete a report instance:

1. Select Reports > Create. 
The Report List screen displays.

2. Click the name of the report instance that you want to delete.

3. Click the Delete button.

Deleting a Report Output
You can delete a report output as necessary. When you delete a report output, the 
report instance, or template, is still available on the Report List screen. This way, 
you can generate a new report output from the existing report instance.

To delete a report output:

1. Select Reports > Download. 
The Available Downloads screen displays. 

2. Select the checkbox(es) next to the report(s) you want to delete.

3. Click the Delete Selected button.
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 Statements and Payments
PaymentNet offers convenient options that allow cardholders to make payments 
and review statements online. This reduces paperwork and allows cardholders to 

promptly submit payments.

Refer to this chapter to learn how to set up payments and review statements.

This chapter explains the following sections:
 Statements
 Payments

Statements
You can view and print your account statement directly from PaymentNet. 
Statements are available 48 hours after the close of the cycle. 

An example of a statement is displayed below in Figure 10: “Statement Example” on 
page 328.
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 Figure 10: Statement Example

This section explains the following topics:
 Viewing a Statement
 Printing a Statement
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 Viewing and Printing a Central Bill Statement

Viewing a Statement
Cardholders can view statements for their PaymentNet account. Program 
Administrators may have rights to view individual statements for other users.

To view a statement:

1. Do one of the following:
 To access your statement via the Statement Detail screen:

a. Select Transactions > Statement. PaymentNet displays the Statement 
Detail screen.

 To access your statement via the My Profile menu:

a. Click the My Profile icon. PaymentNet displays the General Information 
tab.

b. Click the Accounts tab. PaymentNet displays the Accounts tab.

c. In the Statement column, click the icon that corresponds to the 
statement you want to view. PaymentNet displays the Statement Detail 
screen.

2. To modify the statement in view, select a different billing date from the Billing 
Date drop-down menu. PaymentNet displays the statement that corresponds to 
the selected billing date.

Note: In specific situations, the Statement Detail screen may not display information 
for the following PaymentNet user roles:
 Users assigned to the Custom PA role with a scope of view of “Hierarchy ID 

and Children”.
 Users assigned to PA or Auditor roles with a scope of view of “Hierarchy ID, 

Self and Children” at the same hierarchy as that of a central bill account.
Affected PaymentNet users should instead download the statement and view the 
statement details in the PDF or printed version.

Printing a Statement
Cardholders can print an account statement for their PaymentNet account.
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To print a statement:

1. Do one of the following:
 To access your statement via the Statement Detail screen:

a. Select Transactions > Statement. PaymentNet displays the Statement 
Detail screen.

 To access your statement via the My Profile menu:

a. Click the My Profile icon. PaymentNet displays the General Information 
tab.

b. Click the Accounts tab. PaymentNet displays the Accounts tab. In the 
Statement column, click the icon that corresponds to the statement 
you want to view. PaymentNet displays the Statement Detail screen.

2. On the Statement Detail screen, click Download Statement. 
Your statement opens in your default PDF viewer or the Print Request 
Statement screen displays.

3. Optionally, if the Print Request Statement screen displays, then the PDF is over 
40 pages in length. There are two ways to view the pages, you can either click 
the pages links, or you can enter the page range in the Start and End page fields 
and click the Submit button. These page range fields are also limited to 40 
pages total.

4. Using your PDF viewer, print the statement.

Viewing and Printing a Central Bill Statement
You can view and print a statement for a central bill account in PaymentNet.

To view and print a central bill statement:

1. Select Accounts > Manage.

2. Query or locate the central bill account name or number.

3. In the Account List screen, click the Statement icon for the central bill account 
you want to view or print.
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4. Click Download Statement. 
The Adobe PDF file opens in your PDF viewer or the Print Request Statement 
screen.

5. Optionally, if the Print Request Statement screen displays, then the PDF is over 
40 pages in length. Either click the pages links, or enter the page range in the 
Start and End page fields and click the Submit button. These page range fields 
are also limited to 40 pages total.

6. Using your PDF viewer, print or save the statement.

Payments
Before making a payment, you must first set up your bank account information. Once 
complete, you can make a one-time payment or schedule recurring payments. You 
can also view your payment history.

You can also send your payment to J.P. Morgan by mail. Payments can be sent to the 
following address:

J.P. Morgan 
Commercial Card Solutions 
P.O. Box 4471 
Carol Stream, IL 60197-4471

This section explains the following topics:
 Setting Up Bank Account Information
 One-Time Payment
 Recurring Payments
 Viewing the Payment History

Setting Up Bank Account Information
Administrators can assist cardholders with the tasks of setting up bank information 
for a PaymentNet account and making payments online. This configuration must be 
completed by individual cardholders under the My Profile tab; administrators cannot 
configure these settings on behalf of cardholders.
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Cardholders can associate more than one bank account with their PaymentNet 
account. This gives cardholders the flexibility to choose from different accounts 
when making a payment.

To set up bank account information:

1. Click the My Profile icon. 
PaymentNet displays the My Profile screen. By default, the General Information 
tab displays.

2. Click the Bank Information tab.

3. Click the Add Bank button.

4. Complete these fields:

ABA Routing Number
Enter your ABA Routing Number. This is a nine digit bank code that appears on 
the bottom of a deposit slip or a check. The ABA Routing Number identifies your 
financial institution.

Bank Account Type
Select your bank account type from the drop-down list. You can select Checking 
or Savings.

Bank Account Number
Enter your bank account number. Your bank account number is your complete 
account number that appears at the bottom of a deposit slip or a check, next to 
the ABA Routing Number.

Description
Enter a description of the account.

5. Click Save. 
PaymentNet saves the bank information and displays the bank on the Bank 
Information tab.
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One-Time Payment
You can schedule and view a one-time payment.

This topic explains the following tasks:
 Scheduling a One-Time Payment
 Viewing a One-Time Payment
 Canceling a Scheduled One-Time Payment

Scheduling a One-Time Payment
Cardholders can schedule a one-time payment directly from PaymentNet.

Note: Cardholders bank accounts are being debited the full statement amount by their 
recurring payment set up even when a one-time payment for the current statement 
is made.
If a cardholder has scheduled a one-time payment and wants to set up recurring 
payments, the cardholder should first cancel any scheduled one-time payments 
before scheduling a recurring payment.
If a cardholder has set up recurring payments and wants to make a one-time 
payment, the cardholder should first cancel their recurring payment set up before 
making the one-time payment. In addition, the cardholder should verify, on the 
History tab of the Payment List screen, whether a recurring payment is already 
scheduled for the current statement cycle. If there is a recurring payment for the 
cycle, the recurring payment should be canceled.
Cardholders must reestablish recurring payments the following month to continue 
automatic payments.

To schedule a one-time payment:

1. Select Payments > Create. 
PaymentNet displays the Payment Detail screen.

2. From the Account Number drop-down list, select the account for which you are 
making a payment.

3. Optionally, if more than one bank is configured, you must select a bank 
description from the Bank Description drop-down list. 
PaymentNet populates the bank fields based on the selected bank.
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4. Complete these fields:

Payment Amount
Enter the payment amount.

Payment Date
Enter the payment date in MM/DD/YYYY format.

5. Click the Submit button. 
PaymentNet displays a message asking you to verify the payment information.

6. Click the OK button to continue with the payment. 
PaymentNet processes the payment and displays a confirmation message that 
includes a payment reference number.

Viewing a One-Time Payment
Cardholders can view a one-time payment. When a cardholder views a one-time 
payment, he or she can see the bank account used for the payment, the payment 
amount, the payment date, whether or not the payment has been processed, and 
the payment confirmation number.

To view a one-time payment:

1. Select Payments > Manage. 
PaymentNet displays the Payment List screen.

2. In the Number column, click the name of the account for which you want to 
view a one-time payment. 
PaymentNet displays the Payment Detail screen.
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Canceling a Scheduled One-Time Payment
Cardholders can cancel a scheduled one-time payment that has not been processed. 
Cardholders must cancel a scheduled one-time payment at least 48 hours (two days) 
in advance of the next payment.

Note: Cardholders bank accounts are being debited the full statement amount even after 
deleting a previously scheduled recurring payment set up.
When a cardholder cancels their recurring payment setup, they should also verify, on 
the History tab of the Payment List screen, whether a recurring payment is already 
scheduled for the current statement cycle. If there is a recurring payment for the 
cycle, the recurring payment should also be canceled.
Cardholders must reestablish recurring payments the following month to continue 
automatic payments. 

To cancel a one-time payment:

1. Select Payments > Manage. 
PaymentNet displays the Payment List screen.

2. In the Number column, click the name of the account for which you want to 
cancel a one-time payment. 
PaymentNet displays the Payment Detail screen.

3. Click the Delete button.
PaymentNet displays a confirmation message.

4. Click OK to cancel the scheduled one-time payment.
PaymentNet cancels the scheduled one-time payment and displays the Payment 
List screen.
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Recurring Payments
You can schedule and view recurring payments.

This topic explains the following tasks:
 Scheduling a Recurring Payment
 Viewing a Recurring Payment
 Canceling a Recurring Payment

Scheduling a Recurring Payment
Cardholders can schedule a recurring payment. For example, a cardholder might 
want to set up a recurring payment so that the full statement balance is paid each 
month on the payment due date. 

Note: You should cancel any scheduled one-time payments before scheduling a recurring 
payment. If both a recurring and a one-time payment are scheduled for the same 
month, your bank account will be debited twice, once for each scheduled payment. 
For help, see “Canceling a Scheduled One-Time Payment” on page 335.

To schedule a recurring payment:

1. Select Payments > Manage. 
PaymentNet displays the Payment List screen.

2. Click the Recurring tab. 
PaymentNet displays the Recurring tab.

3. Click the Schedule New Recurring button. 
PaymentNet displays the Payment Recurring Detail screen.

4. From the Account Number drop-down list, select the account number for which 
you want to make a payment. 
PaymentNet populates the bank fields based on the selected account.

5. Optionally, if more than one bank is configured, you must select a bank 
description from the Bank Description drop-down list. 
PaymentNet populates the bank fields based on the selected bank.
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6. Select one of these options:

Pay in full on due date
If you want to make the full payment on the payment due date, select this 
option.

Pay on last day of
If you want to make the full payment outside of the payment due date, select 
this option and then select the payment cycle from the drop-down list. Payment 
cycles are configured specifically for your organization.

7. Click Save. 
PaymentNet displays a message asking you to verify that payments will be made 
on an ongoing basis.

8. Click the OK button. 
PaymentNet saves the recurring payment settings and displays the payment on 
the Recurring tab.

Viewing a Recurring Payment
Cardholders can view their recurring payment schedules. When a cardholder views a 
recurring payment, he or she can see the bank account used for the payment, the 
payment amount, and the payment schedule.

To view a recurring payment:

1. Select Payments > Manage.
PaymentNet displays the Payment List screen.

2. Click the Recurring tab.
PaymentNet displays the Recurring tab.

3. In the Account Number column, click the name of the account for which you 
want to view a recurring payment.
PaymentNet displays the Payment Recurring Detail screen.

Canceling a Recurring Payment
Cardholders can cancel their scheduled recurring payment. For a canceled recurring 
payment to take immediate effect, cardholders must cancel a recurring payment at 
least 48 hours (two days) in advance of the next payment.
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To cancel a recurring payment:

1. Select Payments > Manage. 
PaymentNet displays the Payment List screen.

2. Click the Recurring tab. 
PaymentNet displays the Recurring tab.

3. In the Account Number column, click the name of the account for which you 
want to delete a recurring payment. 
PaymentNet displays the Payment Recurring Detail screen.

4. On the Payment Recurring Detail screen, click Delete. 
PaymentNet displays a confirmation message indicating that pending payments 
are not impacted by deleting the recurring payment.

5. Click OK. 
PaymentNet deletes the recurring payment and displays the Payment List 
screen.

Viewing the Payment History
You can view your payment history.

To view the payment history:

1. Select Payments > Manage. 
PaymentNet displays the Payment List screen.

2. Click the History tab. 
PaymentNet displays a summary of past payments on the History tab.

3. Select the payment for which you want to view history details. 
PaymentNet displays the Payment Detail screen.
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 Single-Use Account Orders
S ingle-Use Accounts are based on a purchasing card platform that uses a virtual 
credit card instead of a traditional plastic credit card. This is an electronic 

card-based payment solution well-suited for larger, single purchases.

Each Single-Use Account has a unique account number that allows an individual 
Single-Use Account to be tied to a specific transaction or purchase document, such 
as a purchase order or invoice. For example, each individual payment you make is 
assigned a virtual card (i.e. a Single-Use Account) just as a check is written for an 
individual payment, and the credit card controls such as the credit limit and 
merchant category code group (MCCG) are tailored to that specific payment. This 
allows you to use the electronic payment method of credit cards with less worry 
about fraud and misuse.

You can provide your specific reconciliation information like a Purchase Order 
number, invoice number, and payment ID to J.P. Morgan when the account is 
requested. Then as a transaction posts against that account, PaymentNet updates 
that transaction with your specific information. This simplifies client reconciliation 
so you do not need to use precious resources trying to track to whom and for what 
the purchase was made.

Single-Use Accounts combines the control of checks, the convenience and rebate 
revenue of a card, and the efficiency of electronic payment.

Aa a point of reference on Orders, know that each Order represents a request for a 
Single-Use Account number, specifying the controls that will be applied to the Single 
Use Account number being requested, such as the credit limit, duration that the 
account will be active, Merchant Category Code Groups (MCCG), etc. An order can 
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also serve as a place to house any other data that needs to be associated with the 
merchant/vendor payment, such as a client's reconciliation data.

Use the Orders module to create a new order or modify an existing Single-Use 
Account order.

This chapter explains the following sections:
 Creating a Single-Use Account Order
 Viewing Single-Use Account Order Information
 Editing a Single-Use Account Order
 Manually Reconciling Single-Use Account Orders
 Creating Merchant Single-Use Account Order E-mail Messages

Creating a Single-Use Account Order
Users must be given access to create Single-Use Account orders online. Only users 
with an Order Requestor role can create an order. To give an employee the role of 
Order Requestor, see “Changing an Employee User Access Role” on page 182.

To create a Single-Use Account order:

1. Select Orders > Create.

2. Select the Account Pool from the drop-down menu.

3. Complete the Single-Use Account order fields, as required. See List 33: “Single-
Use Account Order Fields” on page 340.

4. Click Save. 
The new Single-Use Account number and expiration date appear in the Account 
Number field. 

 List 33: Single-Use Account Order Fields 

Requestor Name This field is a read only field that defaults to the Name (Last, First) of the 
Order Requestor for created orders.

Interface This field is a read only field. This field is a label used to display the 
interface in which the Order was created.
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Settlement Method This field displays the pre-defined settlement method. It displays Single-
Use Account by default.

Account Number This is a required field that displays a system assigned Account Number 
associated with the Order. Because Single-Use Account is the only 
Settlement Method, this field will remain blank and read only until users 
click the Save button and submits the Order. Then the screen will refresh 
and the system will display the newly generated account number here. 
Once the user saves the Order, this field is read only and cannot be 
edited. The Account Number field label is a hyperlink to the account 
details screen when the Order status is Active or Not Reconciled.

Security Code This field contains the CVV/CVC value (Card Verification Value or Code) 
and account security information.

Account Pool This field is a required field that identifies the Account Pool ID and the 
Account Pool description for the order. When a user is creating a new 
order, the drop-down list contains the Account Pool ID values available to 
the user based on the user's Role and Scope of View. Upon selecting a 
single Account Pool ID value from list, the screen automatically refreshes 
and updates the Account Pool information for the order. Once the order is 
saved and an account number and order ID are assigned to the Order, the 
Account Pool field is a read only field and the Account Pool ID and 
Description are unchangeable.

Begin Date This is a required field and indicates the date that the order will become 
active. The field accepts numbers in the MM/DD/YYYY format only. When 
the Settlement Method is a Single Use Account this is the activation date 
of the account number. Once the user has saved the Order, this field 
remains editable for Order in Active and Not Reconciled status.

End Date This is a required field indicating the date that the order will no longer be 
Active. The date entered must be after the Begin Date. The field accepts 
numbers in a MM/DD/YYYY format only. When the Settlement Method is 
Single Use Account, this is the date that the account is no longer available 
for use and will be recycled. Once the user has saved the Order, this field 
remains editable for Order in Active and Not Reconciled status.

Merchant This field displays the Merchant name for the Order. The field accepts up 
to 20 alphanumeric characters.

Merchant Email This field displays the Merchant Email address for the Order. This field is 
only enabled if Merchant notification is enabled at the order's Account 
Pool hierarchy.

MCC Group This is a required field. When user clicks on MCC Group, a new pop-up 
window is opened, where user can select a MCC Group. This MCC Group 
shall be visible in the text box from which it can be transferred to list 
box. MCC Group shall be enabled only after selection of the Account Pool. 
MCCGs are used to determine what types of vendors are authorized to use 
the account number. Up to nine MCCGs can be associated to an order. 

 List 33: Single-Use Account Order Fields (continued)
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Estimated Freight $ This field is used to enter the estimated amount of any freight charges 
that will be applied to the order. Once the user has saved the Order, this 
field remains editable for Order in Active and Not Reconciled status.

Estimated Tax % This field is used to enter the expected tax percentage rate that will be 
applied to the order. Once the user has saved the Order, this field remains 
editable for Order in Active and Not Reconciled status.

Order Tolerance % (+) This is a required field. It is a percentage value by which the merchant is 
allowed to overcharge the expected credit limit, but still be able to 
successfully use the account number. This field is grayed out if user is 
requesting account from Exact Authorization enabled Account Pool.

Order Tolerance % (-) This is a required field. It is a percentage value by which the merchant is 
allowed to undercharge the total order amount, but still be able to 
successfully use the account number. This field is grayed out if user is 
requesting accounts from Exact Authorization enabled Account Pools.

Order Line-Item 
Description

This is a required field. It is used to enter the description of the item/
service being purchased. Once the user has saved the Order, this field 
remains editable for Order in Active and Not Reconciled status.

Order Line-Item # of Units This is a required field. It is used to enter the number of items being 
purchased. Once the user has saved the Order, this field remains editable 
for Order in Active and Not Reconciled status.

Order Line-Item $ Unit 
Price

This is a required field. It is used to enter the cost of each item/service 
being purchased. Once the user has saved the Order, this field remains 
editable for Order in Active and Not Reconciled status. You can enter a 
negative amount in this field as a credit amount as long as the Order Total 
amount is greater than zero.

Transaction Default - 
Chart of Accounts

This field displays the chart of account values that will be defaulted to 
any transactions that match to an order.

Transaction Custom Field This field displays the transaction custom field values for an order that 
will be defaulted/added to any transactions that match that particular 
order.

Order Custom Field This field is used for adding additional information a client might need 
associated with an order, but that does not need to be defaulted/added 
to transactions. 

Notes This is used to store any notes that may need to be associated with the 
order. 

 List 33: Single-Use Account Order Fields (continued)
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Viewing Single-Use Account Order Information
The Order List screen displays all created orders within your scope-of-view. The 
Order List screen also allows you to initiate creating a new order.

This section explains the following topics:
 Viewing the Single-Use Account Order List
 Reviewing Single-Use Account Order Details

Viewing the Single-Use Account Order List
The Orders List displays all created orders that the user has access to view. 

To view the Single-Use Account order list:

1. Select Orders > Manage. 
PaymentNet displays the Order List screen.

Reviewing Single-Use Account Order Details
The Order Detail screen displays additional information regarding a specific order. 
Existing orders may be modified using the Order Detail page. From this screen, you 
may also access orders that have been successfully saved and are eligible for 
reconciliation. To view reconciliation data, see “Manually Reconciling Single-Use 
Account Orders” on page 345.

To view Single-Use Account order details:

1. Select Orders > Manage. 
PaymentNet displays the Order List screen.

2. Select an existing order. 
PaymentNet displays the Order Detail screen.

3. Click the Order tab.

4. Review the Single-Use Account order fields that displays. For a list of fields, see 
List 33: “Single-Use Account Order Fields” on page 340.
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Editing a Single-Use Account Order
If an order is still active or has not been reconciled, you can adjust the values on the 
Order Detail page. The user may create orders or make manual changes to the order 
using this page.

The Order Detail page for existing orders is similar to the page for creating an order 
but many of the fields and options change once an order is created and saved. The 
Reconciliation tab is enabled for existing orders.

Note: An order cannot be modified once it has been automatically reconciled, manually 
reconciled, or deactivated.

To edit a Single-Use Account order:

1. Select Orders > Manage. 
PaymentNet displays the Order List screen.

2. Select an existing order. 
PaymentNet displays the Order Detail screen.

3. Edit the following fields, as needed.
 Order Status
 Begin Date
 End Date 
 Merchant
 MCC Group
 Estimated Freight $
 Estimated Tax %
 Order Tolerance % (+) and (-)
 Description
 # of units
 $ Unit price
 Transaction Default - Chart of Accounts
 Order Custom Fields
 Notes
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Manually Reconciling Single-Use Account 
Orders

PaymentNet attempts to automatically reconcile order transactions and credits. 
Manual order reconciliation is used to reconcile orders that have not been previously 
reconciled by the automated process.

Reconciling will close out an order and suspend the account attached to that order. 
After an order has been reconciled, you will no longer be able match transactions to 
the order.

To manually reconcile a Single-Use Account order:

1. Select Orders > Reconcile. 
PaymentNet displays a list of orders that have not been reconciled to date. 

Note: You can manually reconcile Single-Use Account orders in different ways, all of 
which produce the same final result. The step above lists the most common 
method users follow when manually reconciling a Single-Use Account order. 

2. On the Order List, do one of the following:
 Click the Order ID for an individual order you want to manually reconcile.
 Use the multi-select tool to select the orders you want to manually 

reconcile then click the Reconcile button. For information about multi-
select, see “Using Multi-Select” on page 35.

3. Click the Order ID for the order you want to manually reconcile. 
PaymentNet displays the Order Detail screen.

4. Click the Reconciliation tab.

5. Select Reconcile from the Order Status drop-down menu.

6. Click Save.

7. Click OK to continue to manually reconcile the order. 
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Creating Merchant Single-Use Account Order 
E-mail Messages

If email functionality is enabled, you can manually send a merchant email 
notification to your merchant. 

Merchant reminder email messages include “Reminder:” in the subject line to 
distinguish them from new payment email messages.

To manually send a merchant Single-Use Account Order email notification:

1. Select Orders > Manage.

2. Select the Order ID for which you want to send an email message.

3. Select the Merchant Notification tab.

4. In the To field, enter the email address for each recipient.

Note: You can send email messages to multiple recipients by separating e-mail 
addresses with a semicolon.

5. Click Send Now.
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14
 Convenience Checks
C onvenience checks can be issued to PaymentNet cardholders and used to 
complete transactions. Generally, convenience checks are used for merchants 

who do not currently accept a card product. This feature provides cardholders with 
an alternative way to make account payments. 

If your J.P. Morgan implementation manager enables the Convenience Checks 
module at the Organization level, then the Convenience Checks module is available 
for configuration at the Hierarchy level and, by default, is enabled for all hierarchies 
in your organization. Note that the Convenience Checks module is only available for 
Purchase Card programs.

In hierarchies where the Convenience Checks module is enabled, cardholders can 
manage their convenience checks, including ordering new checks and stopping 
payment on existing checks. For cardholder instructions on managing convenience 
checks, see “Managing Convenience Checks” on page 121.

For instructions on how to disable the Convenience Checks module at the Hierarchy 
level to prevent cardholders from managing their convenience checks, see “Setting 
Up Modules” on page 48.

This chapter describes the program administrator tasks related to the Convenience 
Check features.

This chapter explains the following sections:
 Enabling or Disabling the Convenience Checks Module
 Ordering Convenience Checks
 Stopping Payment on Convenience Checks
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Enabling or Disabling the Convenience Checks 
Module

In order for you to control the Convenience Checks module at the hierarchy level, 
your J.P. Morgan implementation manager must first enable the Convenience Checks 
module at the Organization level. Note that the Convenience Checks module is only 
available for Purchasing Card programs and, once enabled at the organization level, 
is enabled for all hierarchies in your organization by default. Once the convenience 
checks module for a cardholder is enabled, cardholders will be able to order 
convenience checks.

As a program administrator, you can control whether cardholders can manage their 
convenience checks by enabling or disabling the Convenience Checks module for a 
cardholder’s Hierarchy ID on the Hierarchy Settings: Modules screen. For instructions 
on how to enable or disable a module, see “Setting Up Modules” on page 48.

Ordering Convenience Checks
As a program administrator, you can order new convenience checks for cardholders. 
Checks are shipped within five business days of the order date. If you need a more 
immediate response or would like the checks mailed to a different address, call 
Customer Service.

Note: Once you complete an order for convenience checks, you cannot cancel the order. To 
cancel an order for convenience checks, call Customer Service.

For cardholder instructions on ordering convenience checks, see “Managing 
Convenience Checks” on page 121.

To order convenience checks:

1. Select Accounts > Manage.
PaymentNet displays the Account List screen.

2. Click the name of the account for which you want to order convenience checks.
PaymentNet displays the Account Detail screen.

3. Click the Controls tab.
PaymentNet displays the Controls tab.
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4. Select the Convenience Checks checkbox.

5. From the Convenience Checks drop-down list, select Order New Checks.

6. Click the Go button.
PaymentNet displays the Convenience Checks - Order New Checks screen.

7. Do one of the following:
 To complete the check order, click the Continue button.

PaymentNet submits the order and displays a confirmation message.
 To cancel the check order, click the Cancel button.

PaymentNet cancels the order and displays the Account Detail screen.

Stopping Payment on Convenience Checks
As a program administrator, you can cancel the payment on a cardholder’s 
convenience check. Stop payments take effect eight business days after the stop is 
issued. If you need a more immediate response, call Customer Service.

For cardholder instructions on stopping payment on convenience checks, see 
“Managing Convenience Checks” on page 121.

To stop payment on a convenience check:

1. Select Accounts > Manage.
PaymentNet displays the Account List screen.

2. Click the name of the account for which you want to stop payment on a 
convenience check.
PaymentNet displays the Account Detail screen.

3. Click the Controls tab.
PaymentNet displays the Controls tab.

4. Select the Convenience Checks checkbox.

5. From the Convenience Checks drop-down list, select Stop Payment.

6. Click the Go button.
PaymentNet displays the Convenience Checks - Stop Payment screen.
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7. Complete these fields:

Check Range/Number Enter the check number or range of checks.

Check Date Click this link to select the calendar date when the check was 
written. Alternately, you can enter the date in MM/DD/YYYY 
format.

Check Amount $ Enter the check amount.

Payee Name Enter the name on the check.

8. Do one of the following:
 To stop payment on the check, click the Continue button.

PaymentNet submits the stop order and displays a confirmation message.
 To cancel the stop payment request, click the Cancel button.

PaymentNet cancels the stop order and displays the Account Detail screen.
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 Account Request Manager
T he Account Request Manager is a powerful PaymentNet enhancement that 
enables users to automate the credit card application, submission, approval, 

and fulfillment process.

Use the Account Request Manager to set up application templates with the help of 
your J.P. Morgan implementation manager to meet the specific needs of your 
organization. Refer to Figure 11: “Account Request Manager Screen” on page 351. As 
a Program Administrator, you can then modify templates as your organization needs 
change. All information is then captured electronically and stored in one central 
location. Once an application request is complete, it then enters the automated 
approval process flow before ultimately requiring your approval.

Figure 11: Account Request Manager Screen
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This appendix explains the following sections:
 Managing Templates
 Managing Users and User Settings
 Managing Applications

Managing Templates
After the initial template setup is complete (usually performed by your 
implementation manager), you have the ability to manage templates and adjust 
templates according to the evolving needs of your organization. Refer to Figure 12: 
“The Account Request Manager Template Tab” on page 352.

Column headings (e.g., Status, Program) at the top of the screen provide information 
related to that topic. You can click the drop-down next to each heading to pull up 
and manage sorting and filtering options. You can also define which headings show 
up in your default view. If you want to rearrange column order, you can drag a 
heading and place it in a different order.

Figure 12: The Account Request Manager Template Tab

Opening a specific template displays the Values, Settings, and History menu items on 
the left of your screen. Each of these menu items contains the fields and information 
you need for each template. For example, the Values menu item may contain fields 
for the cardholder’s name and address; whereas, the History menu item shows a list 
of past changes for a particular template.
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This section explains the following topics:
 Viewing the List of Templates
 Viewing Template Details
 Editing a Template
 Saving a Draft Template
 Publishing a Template
 Previewing an Application Template

Viewing the List of Templates
As a Program Administrator, you can view a list of all templates that belong to your 
organization.

To view the list of templates in the Account Request Manager:

1. Click the Templates tab.
The list of available templates for your organization is displayed.

Viewing Template Details
Template details provide all of the information you want to know about a particular 
template. 

To view template details:

1. Click the Templates tab.

2. Perform one of the following:

a. From the list of available templates, locate and click the name of the 
template in the Template Name column. 

b. Click the drop-down icon next to the template you want to view and click 
View.
The View/Edit Application Template screen appears with Values, Settings, 
and History tabs down the left of your screen.

3. Click any of the tabs (e.g., Values tab) on the left of your screen to view details 
pertaining to the tab information. You also have the ability to preview the 
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template as an approver or as an applicant; however, you cannot actually submit 
an application when you preview as an applicant.

Editing a Template
As Program Administrator, you can edit any template as needed. During the editing 
process, you can preview the template with the latest edits. (You can preview the 
template while in Draft or Published mode.) When all revisions are complete, you 
can then publish the template or save it as a draft.

Templates with a “Published” status must be placed into “Draft” status before they 
can be edited. When the edit action is performed on a published template, a 
warning message is displayed to alert you that the application that uses that 
template becomes inactive until the template is published again. Applicants are 
unable to fill out an application while the template for that application is in “Draft” 
status. Templates with a “Draft” status can be edited directly because they are not 
yet available for general use by applicants.

You can edit a template in one of the following ways depending on the status of the 
application and the screen you are in.
 From the List of Templates
 From the View Template Details screen

After you have opened a template for editing, you can also adjust some labels. For 
example, you may want to change the field label from Hierarchy ID to Cost Center. 
Changing the original labels to custom labels, however, is not recommended in most 
cases. Fields that are underlined may show help or a custom label. Hovering over a 
custom field displays the original label. If you are editing a template and 
double-click an underlined field/custom field, you, as Program Administrator, can 
edit the field name and help text. You can even revert back to the original label by 
selecting the Revert checkbox.

To edit an application template from the List of Templates:

1. Click the Templates tab.

2. Check the status of an application by looking at the value in the Status column.

3. Do one of the following:
 If the status displays as Published:

a. Click the Actions drop-down to the left of the template name.
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b. Click Edit.
The Edit Published Template window opens and asks for confirmation 
to proceed to editing the template.

c. Click OK.
 If the status is in Draft, click the name of the template or select the View 

Template action from the Actions drop-down.

Note: A template in Draft status does not require an edit confirmation.

4. Make your edits, as needed.

5. Click the Save as Draft or the Publish button. See “Saving a Draft Template” on 
page 355 or “Publishing a Template” on page 356.

To edit an application template from the View/Edit Template Details screen:

1. Click the Edit button at the bottom of your screen.
The Edit Published Template window opens and asks for confirmation to 
proceed to editing the template.

Note: If the template is in Draft, the content is already editable.

2. Click OK.

3. Make your edits, as needed.

4. Click the Save as Draft or the Publish button. See “Saving a Draft Template” on 
page 355 or “Publishing a Template” on page 356.

Saving a Draft Template
While editing a template, you may find that you need to save the template as a draft 
and come back and complete the template at a later time.

To save a draft template:

1. Complete the steps for editing a template. See “Editing a Template” on 
page 354.
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2. During the editing process, click the Save as Draft button on the bottom of your 
screen. 
The application link remains active and all changes are saved and remain visible 
when you return to edit the template. You are redirected to the List of 
Templates screen.

Publishing a Template
You have the option to publish a template during the editing process, assuming edits 
have just been completed.

To publish a template during the editing process:

1. Complete the steps for editing a template. See “Editing a Template” on 
page 354.

2. Click the Publish button at the bottom of your screen.
The application validates the core fields to ensure everything is set up 
correctly. If the application meets the validation check, a display window with 
two URLs opens. The first URL links directly to the specific application. This 
link can now be shared with cardholders so they can request new accounts using 
the newly published template. The second URL links lists all of the application 
links associated to the purchasing or corporate program. If the application link 
should be excluded from this list, the checkbox should be deselected.
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Previewing an Application Template
During the template creation or editing process, you may want to preview the look 
and feel of your form. You can preview an application in “Draft” and in “Published” 
status.

To preview an application template:

1. Open the View/Edit Application screen. See “Editing a Template” on page 354.

2. Click the Preview Application As... drop-down button.

3. Select to view as an Applicant or as an Approver.
The Applicant Preview screen opens and displays a preview of the application 
template from the view of the applicant or approver. 

Note: A previewed application cannot be submitted.

Managing Users and User Settings
As Program Administrator, you have the ability to manage users that belong to your 
organization. From the Users tab, you can view imported PaymentNet users, manage 
their settings as related to the Account Request Manager, import new users from 
PaymentNet, and adjust permissions as needed. See the Users tab as shown in Figure 
13: “The Account Request Manager Users Tab” on page 358.
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Figure 13: The Account Request Manager Users Tab

This section explains the following topics:
 Viewing a List of Users
 Editing User Permissions
 Importing a User

Viewing a List of Users
As Program Administrator, you can view a list of all users that have been imported 
into the Account Request Manager and belong to your organization.

To view the list of users in the Account Request Manager:

1. Click the Users tab.
The list of users that have been imported for your organization is displayed.

Editing User Permissions

To edit a user’s permission settings:

1. Click the Users tab.

2. Locate the user for whom you want to modify permission settings.
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3. Select the View/Edit Templates, View/Edit Applications, or View/Edit Users 
checkboxes to grant the user permissions for the corresponding functionality. To 
revoke permissions, deselect the corresponding checkbox.

Note: You are not required to click a Save button to apply changes to the permission 
settings. Permission changes are instantly saved when you select or deselect a 
checkbox.

Importing a User
Before you can import a user, you must first confirm the user is an active 
PaymentNet user, has a Program Administrator or Custom Program Administrator 
role, and belongs to the same organization as the logged-on user. 

To import a user:

1. Click the Users tab.

2. Click the Import User button.
The Import User window opens.

3. Click Find.

4. Enter the user name in the User ID field. After you enter a user name that 
matches an existing user in PaymentNet, the name appears next to the User 
Name field.

Note: If the user name does not match an existing user in PaymentNet, the field will 
turn red and an error message may display.

5. Click Save.
A message displays at the top of your screen indicating the user has been 
imported successfully. The user also now displays in the list of users.

6. Click Save.
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Managing Applications
As Program Administrator, you have the ability to manage applications for your 
organization. From the Applications tab, you can view, edit, approve existing 
applications, and more.

Column headings (e.g., Applicant Last Name, Applicant First Name) at the top of the 
screen provide information related to that topic. You can click the drop-down next 
to each heading to pull up and manage sorting and filtering options. You can also 
define which headings show up in your default view. And if you want to rearrange 
column order, you can drag a heading and place it in a different order. See the 
Application tab in Figure 14: “The Account Request Manager Application Tab” on 
page 360.

Figure 14: The Account Request Manager Application Tab

The status options may include the following:

Awaiting Approval  The application has been submitted to the Account Request 
Manager pending Approvers’ review and approval.

Stalled  The application is waiting for an Approver to approve.
 The system has sent out all reminders (quantity determined by 

template email approval workflow settings).
 The assigned Approver has not approved or rejected the 

application.
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This section explains the following topics:
 Viewing the List of Applications
 Previewing an Application
 Viewing Application Details
 Viewing Application History
 Editing an Application
 Sending Application Approval Reminders
 Approving an Application
 Reassigning Approvers
 Rejecting an Application
 Processing an Application

Viewing the List of Applications
As Program Administrator, you can view a list of all submitted applications that 
belong to your organization.

Awaiting PA Approval  The Application has been approved.
 The Application is waiting for the Program Administrator to 

submit it to processor via PaymentNet.

Creating  Application has been sent to PaymentNet by the program 
administrator/implementation manager in the Account Request 
Manager.

Partial Complete  This status is returned from PaymentNet.
 TSYS only status.
 The account has been created but there were errors (that did not 

prevent the account from being created).

Completed  This status is returned from PaymentNet.
 The account has been successfully created.

Rejected  An approver or a Program Administrator rejected the application.

Failed  This status is returned from PaymentNet.
 The application creation action failed at the processor.
 You can reset to Awaiting PA Approval and potentially fix issues, 

then process the application again.

Unknown  The Account Request Manager called PaymentNet to check the 
account status. PaymentNet could not find the account 
information.
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To view the list of applications in the Account Request Manager:

1. Click the Applications tab.
The list of submitted applications are displayed by grouped application status.

2. Click the Plus sign icon next to a group to expand the group.

Previewing an Application
An application preview displays relevant-to-processing information relating to each 
application. The preview shows past and current approvers, and other application-
specific data.

To preview an application:

1. Click the Applications tab.

2. Locate the application you want to preview from the list provided.

3. Click the Actions drop-down and click Preview.

Viewing Application Details

To view application details:

1. Click the Applications tab.

2. Locate the application for which you want to view details.

3. Do one of the following to see details:
 Click the application last name.
 Click the Actions drop-down and click View Application.
 Open the preview application window and click View Application.

The Application Details screen opens.
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Viewing Application History

To view application history:

1. Open the Application Details screen. See “Viewing Application Details” on 
page 362.

2. Click the View History button at the bottom of your screen.

Editing an Application
As Program Administrator, you can only edit applications with an “Awaiting PA 
Approval” status.

To edit an application:

1. Open the Application Details screen. See “Viewing Application Details” on 
page 362.

2. When viewing application details, modify any field by typing in a new value. You 
can also select a new value from a drop-down menu, where available.

3. Click Save.

Note: The save button is only available for an application marked with an “Approval PA 
Approval” status.

Sending Application Approval Reminders

You can send a reminder to the current pending approver of an application 
in one of two ways:

1. From the Applications List tab.

a. Click the Actions drop-down next to the application for which you want to 
send an application approval reminder.

b. Click Send Reminder.

c. Click OK.
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2. From the Application Detail screen.

a. Scroll to the Approval section, which lists all current and past approvers.

b. Click the Send Reminder link.

c. Click OK.

Note: Sending a reminder only works for applications with an “Awaiting PA 
Approval,” “Awaiting Approval,” or “Stalled” status; an enabled workflow; 
and for applications that have an assigned approver who has not yet 
responded.

Approving an Application
The approval process is automated and usually begins with the approver receiving an 
email notification stating that a new application has been created and requires 
approval. Even if the application requires multiple levels of approval, the Program 
Administrator has the ultimate responsibility for final processing.

To approve an application:

1. From the application approval requested email that you receive, click the 
application link in the body of the email.

2. Update any information in the application, as needed.

3. Complete the email approval workflow section, if visible.

4. Under the approval section, complete the fields below to forward the 
application for additional approvals, if needed:
 First Name
 Last Name
 E-Mail Address

5. Click Approve.
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Reassigning Approvers
You can reassign a new approver for an application from the Applications List screen 
or the Applications Details screen. The reassign action is only available for 
applications with an “Awaiting Approval,” “Stalled,” or “In Process” status.

To reassign an application to another approver:

1. From the Applications List screen:

a. Click the Actions drop-down for the desired application.

b. Click Reassign.

c. On the Send to Another Approver window that opens, enter the following:
 First Name
 Last Name
 Email Address

d. Click Continue.

2. From the Application Details screen:

a. Scroll to the Approval section that lists all current and past approvers.

b. Click the Send to Another Approver link next to the last approver in the list.

c. On the Send to Another Approver window that opens, enter the following:
 First Name
 Last Name
 Email Address

d. Click Continue.

Rejecting an Application
You can reject an application from the Applications List screen or the Application 
Details screen. As an Approver, you can also reject an application by clicking the link 
directly from the notification email. The reject action is only available for 
applications with a “Pending,” “Awaiting PA Approval,” and “Awaiting Approval” 
status.
365



a | Account Request Manager

366
To reject an application:
 From the Applications List screen:

a. Click the Actions drop-down for the desired application.

b. Click Reject.
A window opens and requires you, as Program Administrator, to enter a 
note explaining why you are rejecting an application.

c. Enter a note in the field provided.

d. Click OK. 
 From the Application Details screen:

a. Click the Reject button at the bottom of your screen.

b. Click OK.
 From the notification email:

a. Open the application notification email.

b. Click the link in the email.
You are taken to the approval screen in the Account Request Manager.

c. Click Reject.

d. Click OK.

Note: If you reject an application, you must also add a note explaining why the application 
is being rejected.

Processing an Application
You can process an application from the Applications List screen or the Applications 
Detail screen.

To process an application:

1. From the Applications List screen:

a. Click the Actions drop-down for the desired application.
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b. Click Process Request.

c. Click OK.

2. From the Application Details screen:

a. Click the Process Request button at the bottom of your screen.

b. Click OK.
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b
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U se this appendix as a reference in conjunction with Chapter 11, “Reports” on 
page 317. The Reports chapter provides the comprehensive set of instructional 

steps to follow to locate, generate, and schedule a report. Some of those steps 
reference sections that are in this appendix. 

The first step in locating a report is to identify the reports you need. Refer to the 
“PaymentNet Report Matrix” on page 370 in this appendix; it lists all available 
reports and provides column filtering. This matrix is a spreadsheet allowing you to 
sort by multiple views, such as card program, user role, category, optimized output 
format, and similar reports to quickly identify and assess which report will meet your 
needs.

If you want to look up the specific report and review a sample of the output and 
know what fields are included, go to the report type section and then locate the 
specific report. See “Report Samples” on page 371 in this appendix.

Once you identify the reports you want, follow the sections in Chapter 11, “Reports” 
on page 317. If you determine that you want to move data between PaymentNet and 
your organization’s accounting system, see Chapter 8, “Flex Mappers” on page 235.

If after running a flex mapper, you still require data beyond the scope of a flex 
mapper, review the “Standard File Options” on page 502 in this appendix. Select one 
of the standard file layouts and contact your J.P. Morgan representative for more 
information.

This appendix explains the following sections:
 PaymentNet Report Matrix
 Report Samples
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 Standard File Options

PaymentNet Report Matrix
To get started with creating a report, you can quickly identify your requirements by 
filtering specific data in the report matrix spreadsheet. The data is organized into 
nine columns.

Click the paperclip to open the PaymentNet Report Matrix spreadsheet (in Excel).

Using the report matrix, you can filter the data in these nine columns by these 
views:

Category
Sort by report type: account, administration, merchant, merchant MasterCard, 
merchant Visa, order, and transaction.

Report name
Identify the name of the report as it appears in the Reports module of 
PaymentNet.

Card program
Sort by fleet, purchase card, single-use account, and travel & entertainment.

Recommended users
Identify what audience or user will most likely require this data for their 
analysis and review.

User role
Sort by approver, card holder, manager, and program administrator.

Optimized output format
Each report is typically optimized for better viewing in either Adobe PDF or 
Microsoft Excel output format. The reports with a report number ending in an 
“E” are best viewed in Excel. See Report number below.

Note: PaymentNet reports optimized for Microsoft Excel are instead defaulting to the 
Adobe® PDF format.
Users must select MS Excel from the Report Format drop-down list when running 
reports optimized for Excel to obtain the report in the correct format.
PaymentNet User Guide


Category

						PaymentNet4 Reports Matrix  By Category

				Report #		Report Name		Category		Program		User(s)		Optimized Format		Description		See Also

				R001		30 and 60 Day		Account		T&E		PA		Adobe		The report can be used to monitor accounts that are 30 and/or 60 days past due.		R004, R011, R014, R016

				R002		Account Limit - MS Excel		Account		T&E, Pcard, SUA		PA		Excel		Use this report to monitor limits assigned to accounts. Including credit, cash advance, monthly and MCCG limits.		R011

				R003, R003E		Account Audit (MS Excel)		Account		T&E, Pcard, SUA		PA, A		Adobe, Excel		This report identifies all changes made to accounts over the selected date range.

				R004, R004E		Account Delinquencies (MS-Excel)		Account		T&E		PA, A		Adobe, Excel		This report can be used to monitor past due amounts across all delinquency categories. The Adobe version also provides total delinquencies for the hierarchy selected or the entire organization.		R001, R011, R014,R016

				R005		Account Suspension/Cancellations		Account		T&E, Pcard, SUA		PA, A		Adobe		The report identifies accounts that are suspended or cancelled. The report is organized by Hierarchy.		R011

				R006, R006E		Account and Employee Hierarchy (MS Excel)		Account		T&E, Pcard		PA		Adobe, Excel		This report shows the account, employee and role hierarchies for all employees - both cardholders and non-cardholders.

				R007		Accounts with Low Available Credit		Account		T&E, Pcard, SUA		PA		Adobe		This report can be used to monitor accounts with low available credit and adjust as appropriate. Only accounts that have available credit  that is less than 20% of the their total credit limit will appear in the report.		R011

				R008		Cardholder Accounts and Limits by Hierarchy		Account		T&E, PCard		PA		Adobe		Accounts in the report are organized by hierarchy. The report shows credit limit, cash advance limit, single transaction limit, account open date, account closed date and account current status.		R011

				R009		Cardholder Default Account Codes and Custom Fields		Account		T&E, Pcard		PA		Adobe		Use this report to monitor the default accounting codes and custom fields assigned to each account. The report also displays the credit limit, daily amount limit, monthly/cycle limit and other limits.		R011

				R010		Cardholder Listing with Addresses		Account		T&E, Pcard		PA		Adobe		This report displays the address and business phone for each account. Data is organized by hierarchy.		R011

				R011, R011E		Cardholder Profile (MS Excel)		Account		T&E, Pcard		PA		Adobe, Excel		This comprehensive report displays most account related information. Including address, phone numbers, e-mail address, accounting codes, custom fields, account status,  last transaction date and account limits. The Excel version of the report contains more data elements than the Adobe version.		R001,R002, R004, R005,R007, R008, R009, R012, R013, R014

				R012, R012E		Cardholder Status (MS-Excel)		Account		T&E, Pcard		PA, A		Adobe, Excel		The report shows current account statuses and limits.		R011

				R013		Cardholder with Account and MCCG Group Limits		Account		T&E, Pcard		PA, A		Adobe		The report displays account and Merchant Category Code (MCC) Limits.		R011

				R014		Charge Off		Account		T&E		PA		Adobe		This report can be used to monitor total charged-off amounts by account. Individual transactions can not be tracked.		R004, R011, R016

				R015		Rush Delivery Card Requests		Account		T&E, Pcard		PA		Adobe		This report displays accounts with rush card delivery requests. Accounts are grouped by hierarchy.

				R016		Write-Off		Account		T&E		PA, A		Adobe		The report displays accounts with write-off balances, primarily due to fraud		R004, R011, R014

				R017		Chart of Accounts Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any chart of account creation or change made to an existing chart of account over the requested time period.

				R018		Employee Audit		Admin		T&E, Pcard		PA, A		Adobe		This report displays any creation or change made to an existing employee record over the requested period of time.

				R019E		Employee Profile - MS Excel		Admin		T&E, Pcard		PA		Excel		This report displays all employee related attributes. Including account status, account balance, last transaction date, hierarchy assignment, and account limits.

				R020		Hierarchy Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any hierarchy creation or changes made to existing hierarchy over the requested period of time.

				R021		Hierarchy List by Level		Admin		T&E, Pcard		PA		Adobe		This report displays the company hierarchy tree structure. The levels and IDs of the hierarchy are ordered by how they report up to the top level of the hierarchy.

				R022		Login Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any login attempt to PaymentNet. The report displays all login attempts over the requested period of time.

				R023		Unusual Activity Analysis		Admin		T&E, Pcard		PA, A		Adobe		This report can be used to monitor unusual activity and determine if the transactions are business-related. Subtotals are provided for each MCC, as well as grand total for the report. The report displays transaction associated with the following MCCs: 5681, 5944, 7230, 7273, 7297, 7298, 7299, 7631, 7995.

				R024		1099 Merchant		Merchant		T&E, Pcard, SUA		PA		Adobe		This report can be used to analyze purchase made from 1099 merchants.		R041, R045

				R025		Airline City Pairs Summary by Merchant		Merchant		T&E		PA		Adobe		This report can be used to identify the most traveled airline routes by merchant. The data provided can be used to negotiate rates with air travel providers. The report is sorted by merchant name followed by number of trip legs per origination and destination (with the most frequently traveled trip legs displayed first).		R026, R074

				R026		Airline Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend and total number of transactions with each airline provider. The information can be used in negotiating rates with airline companies.		R025, R074

				R027		Car Rental Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend and total number of transactions with car rental agencies. The information can be used to negotiate rates with car rental agencies.		R074

				R028		Lodging Spending Analysis by City		Merchant		T&E		PA		Adobe		This reports summarizes the cities and lodging establishments for your program. The information can be used to negotiate rates with hotel chains.		R029, R077

				R029		Lodging Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		The report summarizes the total spend and total number of transactions for each lodging establishment. The information can be used to negotiate rates with hotel chains.		R028, R077

				R030		MCC with Default Account Codes		Merchant		T&E, Pcard		PA		Adobe		This report shows the default account codes assigned to MCCs.

				R031		Merchant Profile - MS Excel		Merchant		T&E, Pcard, SUA		PA		Excel		This report provides detailed information about merchants. Including location, diversity status, Chart of Account Segments, Custom Fields, and incorporation status. The report also includes the total sales volume with each merchant for the time period of the report.		R024, R032, R033, R043, R047,

				R032		Merchant Profile with Custom Fields		Merchant		T&E, Pcard		PA		Adobe		This report can be used to review the custom fields that have been associated with specific merchants. In addition to merchant information, the report displays each custom field's classifications, type and value.		R031

				R033		Merchant Rankinig		Merchant		T&E		PA		Adobe		The report provides merchant rankings for the T&E categories; Airlines, Car Rental, Lodging and Restaurants & Transportation. The report shows the total dollar spend and total number of transactions for each merchant within each T&E category. Non T&E merchants appear under the category of 'Other". Subtotals are provided at the end of each category and a Grand Total at the end of the report.		R031, R073, R074, R076

				R034		Merchants with Default Account Codes		Merchant		T&E, Pcard		PA		Adobe		This report shows any defaulted account codes assigned to each merchant.		R031

				R035		Parent Merchant Ranking		Merchant		T&E		PA		Adobe		The report provides total spend, number of transactions and average transaction size for each Parent Merchant. The Parent Merchants in the report are grouped by  the T&E categories; Airlines, Car Rental , Lodging, Restaurants and Transportation. Subtotals are provide for each T&E category as well as a Grand Total for the entire report.		R036

				R036		Quarterly Merchant Analysis by Parent Merchant Summary		Merchant		T&E, Pcard, SUA		PA		Adobe		This report provides the total spend and total number of transactions for each Parent Merchant within a Merchant Category Code. Subtotals are provided for each MCC and a Grand Total for the entire report. The report can be run for time periods other than Quarters.

				R037		Restaurant Spending Analysis by Top Restaurant		Merchant		T&E		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for each restaurant. Grant Totals are provided at the end of the report.

				R038		Spending Analysis by Merchant Type		Merchant		T&E, Pcard, SUA		PA		Adobe		This report can be used to analyze purchases within the following merchant classifications: Sole-Proprietorship, Partnership and Unincorporated.  Subtotals for service related and non-service related industries are provided within each merchant classification.		R024, R041, R045

				R039		Summary Quarterly MCC		Merchant		T&E, Pcard, SUA		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for each Merchant Category Code. The report can be generated for time periods other than Quarter.		R036

				R040		Transportation Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for merchant that is classified as Airline or Travel. Grand totals are provided at the end of the report.		R026

				R041		MasterCard 1099 Transaction Detail		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report can be used to review transactions at merchants to understand whether or not to include each specific transaction in the total spend for 1099 reporting. This data will aid in resolving questions such as if a transaction or specific merchant needs to be included for 1099 reporting. This report will be limited to merchants that have merchandise and service transactions.		R024

				R042		MasterCard 1099 Vendor Information		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099-MISC and socio-economic (Form 1057) reporting needs. It includes the most current MasterCard merchant information and is filtered by the list of 1099-reporable MCCs provided by the IRS.		R031

				R043		MasterCard Enhanced Merchant Data		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099 and Socio-Economic reporting needs.		R031

				R044		MasterCard Socio-Economic		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report provides the actual and percentage spend in dollars, transactions and number of vendors segmented by the various Socio-Economic statuses collected by MasterCard.		R031

				R045		Visa 1099 Transaction Detail		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report can be used to review transactions at merchants to understand whether or not to include each specific transaction in the total spend for 1099 reporting. This data will aid in resolving questions such as if a transaction or specific merchant needs to be included for 1099 reporting. This report will be limited to merchants that have merchandise and service transactions.		R024

				R046		Visa 1099 Vendor Information		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099-MISC and socio-economic (Form 1057) reporting needs. It includes the most current MasterCard merchant information and is filtered by the list of 1099-reporable MCCs provided by the IRS.		R031

				R047		Visa Merchant		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099 and socio -economic reporting needs. It includes the most current merchant information provided by Visa.		R031

				R048		Visa Socio-Economic		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report provides the actual and percentage spend in dollars and number of vendors segmented by the various socio-economic statuses collected by Visa.		R031

				R049		Order Audit		Order		SUA		PA, A		Adobe		This report display any creation or changes made to an existing order over the requested period of time.		R050

				R050, R050E		Order Transaction Detail (MS Excel)		Order		SUA		PA (Orders)		Adobe, Excel		This report can be used to monitor the transaction for each Single Use Account against the order. Subtotals are provided in the Adobe version showing the total transaction amount for each order, as well as a Grant Total for the entire report.		R049

				R051,R051E		Air Travel Activity (MS-Excel)		Transaction		T&E		PA		Adobe, Excel		This report summarizes each airline transaction; including each trip leg. The report can be used to analyze airline spend by account and hierarchy. Subtotals are provided for each hierarchy and a Grand Total for the report.		R025, R026, R052R053,R073

				R052		Air Travel Summary by Hierarchy		Transaction		T&E		PA		Adobe		This report summarizes the total dollars spent on airline travel for each account within each level of the hierarchy. Subtotals are provided for each hierarchy level, as well as a Grand Total for the entire report.		R025, R026, R051, R053,R073

				R053		Air Travel Summary for CTA		Transaction		T&E		PA		Adobe		This report provides a consolidated overview of transactions that occur through a Central Travel Account. The report provides passenger name, ticket numbers and transaction amount for each purchase.		R025, R026, R051, R052, R073

				R054		Airline Ticket Credit Summary		Transaction		T&E		PA, A, M, CH		Adobe		This report identifies credits issued by Airlines for purchased tickets. The report includes information about the ticket number, passenger name, credit amount and travel agent name.		R069, R074

				R055		Cash Advance Detail by Hierarchy		Transaction		T&E		PA, TA, M, CH		Adobe		This report is used to analyze cash transactions for each cardholder.		R069

				R056, R056E		Central Bill Reconciliation (MS-Excel)		Transaction		Pcard, SUA		PA		Adobe, Excel		This report provides detailed transaction, account and merchant data for all charges to a Central Bill Account. The Adobe version of the report provides Subtotals for all CBAs and a Grant Total for the report.		R057

				R057		Central Bill Reconciliation Summary (MS-Excel)		Transaction		Pcard, SUA		PA		Adobe, Excel		This report summarizes the total spend and number of transaction for each account linked to a Central Bill Account. The Adobe version provides totals for each Central Bill Account Number and a Grand Total for the report.		R056

				R058, R058E		Declines (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, TA, M, CH		Adobe, Excel		This report identifies occurrences and reasons why cardholder accounts have been declined. You can use this information to analyze spend compliance and account restriction trends.

				R059		Diversion Detail by Cardholder		Transaction		T&E		PA, M, CH		Adobe		This report can be used to identify transactions that have posted to Diversion Accounts. Subtotals are provided for each Diversion Account and a Grand Total for the entire report.

				R060		Foreign Currency		Transaction		T&E, Pcard		PA		Adobe		This report can be used to identify transaction that occurred outside the United States. Currency and exchange rate are displayed for each transaction. Subtotals are provided for each account as well as Grand Total for the entire report.		R069

				R061, R061E		Fuel Purchase Detail Summary (MS-Excel)		Transaction		Fleet		PA, M, CH		Adobe, Excel		This report provides detailed information for transactions that occurred at fuel merchants with a Fleet Card product.

				R062		Level III Temporary Services		Transaction		Pcard		PA, M, CH		Adobe		This report be used to analyze information for Temporary Services. Total transaction are provided for each supervisor as well as Grand Total for the report		R076, R078

				R063		Receipt Imaging Volume		Transaction		T&E, Pcard		PA		Adobe		This report summarizes the total number of receipt images files attached to transactions for your organization.

				R064		Statement of Account		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report provides a listing of the previous cycles transaction information and when available; Accounting Code Allocations, Transaction Notes, Custom Fields and Transaction Addendum Detail. The report includes signature lines for the Cardholder and Supervisor, to assist with the reconciliation process. The report is not an official bank billing statement and cannot be used for remittance purposes.		R069

				R065		T&E Expense by Cardholder		Transaction		T&E		PA, CH		Adobe		This report can be used to analyze at the cardholder level, the total and average dollar amount spent on each of the following travel and entertainment types: airlines, lodging, car, mass transportation, transportation, restaurant, cash, and other. Subtotals are provided for each cardholder, as well as a grand total for the entire report.		R066, R069, R074, R075, R076, R077

				R066		T&E Transaction Activity		Transaction		T&E		PA, CH		Adobe		This report travel and entertainment transactions which are group by Cardholder.		R069, R074, R075, R076, R077

				R067		T&E Activity by Industry		Transaction		T&E		PA		Adobe		This report can be used to analyze account activity with each merchant within the following travel & entertainment industries; airline, lodging, car rental, transportation, restaurants, cash and other. Subtotals are provided for each type of industry.		R069, R074, R075, R076, R077

				R068, R068E		Transaction Audit  (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, A		Adobe, Excel		This report will provide all transaction changes made over the selected date range.

				R069, R069E		Transaction Detail (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe, Excel		This report can be used to monitor the purchases for each account. Transaction as well as line items are included and payments are excluded for this report.		R064

				R070		Transaction Detail by Central Bill Account		Transaction		Pcard, SUA		PA		Adobe		Use this report to review the transaction and account that have been charged to central bill accounts. Subtotals are provided for each cardholder and central bill account as well as grand total for the entire report.		R064, R069

				R071		Transaction Detail by Hierarchy		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report summarizes the number of transaction and total dollar amount for each account and hierarchy level. Transactions as well as line items are included and payments are excluded from the report. Subtotals are provided for each account and hierarchy level, as well a grand total for the entire report.		R069

				R072		Transaction Detail by Parent Merchant		Transaction		T&E, Pcard, SUA		PA		Adobe		This report groups transactions by parent merchant. It provides a sub-total of dollar spend and number of transaction for each Parent Merchant.		R035, R036, R069

				R073		Transaction Detail with Accounting Codes and Notes		Transaction		T&E, Pcard		PA, TA, CH		Adobe		Use this report to review transaction with their accounting codes, notes and custom fields. Transaction as well as line items are included. Payments are excluded.		R069

				R074		Transaction Detail with Level III Airline Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction details and the associated airline addendum data (Level III). When viewing Level III airline data, columns for all Level III airline data are visible, but data is only populated for the addendum information provided by the processor.		R025, R026, R051, R052, R053, R054

				R075		Transaction Detail with Level III Car Rental Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction detail and the associated car rental addendum data (Level III). When viewing Level III car rental data, columns for all Level III car rental data are visible, but data is only populated for the addendum information provided by the processor.		R027, R040

				R076		Transaction Detail with Level III Data		Transaction		T&E, Pcard, SUA		PA, M, CH		Excel		Use this report to review transaction detail and the associated addendum (Level III). When viewing Level III data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.		R062, R074, R075, R077, R078

				R077		Transaction Detail with Level III Lodging Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction detail and the associated Lodging addendum (Level III). When viewing Level III Lodging data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.		R028, R029

				R078		Transaction Detail with Level III Purchasing Data		Transaction		Pcard		PA, M, CH		Excel		Use this report to review transaction detail and the associated Purchasing addendum (Level III). When viewing Level III Purchasing data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.

				R079		Transaction Detail with Page Breaks		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		Use this report to review all purchases made for each account. Since the each account's activity is detailed on a separate page, this report can be printed and given to cardholders who do not have access to PaymentNet to review their transactions. Transaction as well as line items are included. Payments are excluded from this report.		R064, R069

				R080		Transaction Detail with Payments		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report is used to the review the purchase and payments for each account.		R064, R069

				R081		Transaction Detail with Purchase Addendum		Transaction		Pcard, SUA		PA, CH		Adobe		Use this report to view transaction with purchasing addendum. The report groups the transaction by cardholder.		R076, R078

				R082		Transaction Disputes by Hierarchy		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe		Use this report to view the status of disputed transactions.

				R083, R083E		Transaction Summary by Hierarchy (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe, Excel		Use this report to review the number of transaction and total dollar amount for each account by hierarchy.

				R084		Transaction Summary by Parent Merchant		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe		Use this report to review the number of transaction and total dollar for each parent merchant.		R032, R035, R0336

				R085		Transaction Pending Review/Approval		Transaction		T&E, Pcard		PA, TA, M, CH		Adobe		Use this report to review transaction that need to be reviewed or approved. The report shows transaction information as well as those who are responsible marking the transactions reviewed or approved. This report will show both types of transactions by default.		R069



Recommended Users
PA - Program Administrator
TA - Transaction Approver
M - Manager
A - Auditor
CH - Cardholder

Programs
T&E - Travel & Entertainment
Pcard - Purchasing Card
SUA - Single Use Account

Report Name
(MS -Excel) indicates  both
Adobe & Excel version of 
report
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						PaymentNet4 Reports Matrix  By Report Name

				Report #		Report Name		Category		Program		User(s)		Optimized Format		Description		See Also

				R024		1099 Merchant		Merchant		T&E, Pcard, SUA		PA		Adobe		This report can be used to analyze purchase made from 1099 merchants.		R041, R045

				R001		30 and 60 Day		Account		T&E		PA		Adobe		The report can be used to monitor accounts that are 30 and/or 60 days past due.		R004, R011, R014, R016

				R006, R006E		Account and Employee Hierarchy (MS Excel)		Account		T&E, Pcard		PA		Adobe, Excel		This report shows the account, employee and role hierarchies for all employees - both cardholders and non-cardholders.

				R003, R003E		Account Audit (MS Excel)		Account		T&E, Pcard, SUA		PA, A		Adobe, Excel		This report identifies all changes made to accounts over the selected date range.

				R004, R004E		Account Delinquencies (MS-Excel)		Account		T&E		PA, A		Adobe, Excel		This report can be used to monitor past due amounts across all delinquency categories. The Adobe version also provides total delinquencies for the hierarchy selected or the entire organization.		R001, R011, R014,R016

				R002		Account Limit - MS Excel		Account		T&E, Pcard, SUA		PA		Excel		Use this report to monitor limits assigned to accounts. Including credit, cash advance, monthly and MCCG limits.		R011

				R005		Account Suspension/Cancellations		Account		T&E, Pcard, SUA		PA, A		Adobe		The report identifies accounts that are suspended or cancelled. The report is organized by Hierarchy.		R011

				R007		Accounts with Low Available Credit		Account		T&E, Pcard, SUA		PA		Adobe		This report can be used to monitor accounts with low available credit and adjust as appropriate. Only accounts that have available credit  that is less than 20% of the their total credit limit will appear in the report.		R011

				R051,R051E		Air Travel Activity (MS-Excel)		Transaction		T&E		PA		Adobe, Excel		This report summarizes each airline transaction; including each trip leg. The report can be used to analyze airline spend by account and hierarchy. Subtotals are provided for each hierarchy and a Grand Total for the report.		R025, R026, R052R053,R073

				R052		Air Travel Summary by Hierarchy		Transaction		T&E		PA		Adobe		This report summarizes the total dollars spent on airline travel for each account within each level of the hierarchy. Subtotals are provided for each hierarchy level, as well as a Grand Total for the entire report.		R025, R026, R051, R053,R073

				R053		Air Travel Summary for CTA		Transaction		T&E		PA		Adobe		This report provides a consolidated overview of transactions that occur through a Central Travel Account. The report provides passenger name, ticket numbers and transaction amount for each purchase.		R025, R026, R051, R052, R073

				R025		Airline City Pairs Summary by Merchant		Merchant		T&E		PA		Adobe		This report can be used to identify the most traveled airline routes by merchant. The data provided can be used to negotiate rates with air travel providers. The report is sorted by merchant name followed by number of trip legs per origination and destination (with the most frequently traveled trip legs displayed first).		R026, R074

				R026		Airline Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend and total number of transactions with each airline provider. The information can be used in negotiating rates with airline companies.		R025, R074

				R054		Airline Ticket Credit Summary		Transaction		T&E		PA, A, M, CH		Adobe		This report identifies credits issued by Airlines for purchased tickets. The report includes information about the ticket number, passenger name, credit amount and travel agent name.		R069, R074

				R027		Car Rental Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend and total number of transactions with car rental agencies. The information can be used to negotiate rates with car rental agencies.		R074

				R008		Cardholder Accounts and Limits by Hierarchy		Account		T&E, PCard		PA		Adobe		Accounts in the report are organized by hierarchy. The report shows credit limit, cash advance limit, single transaction limit, account open date, account closed date and account current status.		R011

				R009		Cardholder Default Account Codes and Custom Fields		Account		T&E, Pcard		PA		Adobe		Use this report to monitor the default accounting codes and custom fields assigned to each account. The report also displays the credit limit, daily amount limit, monthly/cycle limit and other limits.		R011

				R010		Cardholder Listing with Addresses		Account		T&E, Pcard		PA		Adobe		This report displays the address and business phone for each account. Data is organized by hierarchy.		R011

				R011, R011E		Cardholder Profile (MS Excel)		Account		T&E, Pcard		PA		Adobe, Excel		This comprehensive report displays most account related information. Including address, phone numbers, e-mail address, accounting codes, custom fields, account status,  last transaction date and account limits. The Excel version of the report contains more data elements than the Adobe version.		R001,R002, R004, R005,R007, R008, R009, R012, R013, R014

				R012, R012E		Cardholder Status (MS-Excel)		Account		T&E, Pcard		PA, A		Adobe, Excel		The report shows current account statuses and limits.		R011

				R013		Cardholder with Account and MCCG Group Limits		Account		T&E, Pcard		PA, A		Adobe		The report displays account and Merchant Category Code (MCC) Limits.		R011

				R055		Cash Advance Detail by Hierarchy		Transaction		T&E		PA, TA, M, CH		Adobe		This report is used to analyze cash transactions for each cardholder.		R069

				R056, R056E		Central Bill Reconciliation (MS-Excel)		Transaction		Pcard, SUA		PA		Adobe, Excel		This report provides detailed transaction, account and merchant data for all charges to a Central Bill Account. The Adobe version of the report provides Subtotals for all CBAs and a Grant Total for the report.		R057

				R057		Central Bill Reconciliation Summary (MS-Excel)		Transaction		Pcard, SUA		PA		Adobe, Excel		This report summarizes the total spend and number of transaction for each account linked to a Central Bill Account. The Adobe version provides totals for each Central Bill Account Number and a Grand Total for the report.		R056

				R014		Charge Off		Account		T&E		PA		Adobe		This report can be used to monitor total charged-off amounts by account. Individual transactions can not be tracked.		R004, R011, R016

				R017		Chart of Accounts Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any chart of account creation or change made to an existing chart of account over the requested time period.

				R058, R058E		Declines (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, TA, M, CH		Adobe, Excel		This report identifies occurrences and reasons why cardholder accounts have been declined. You can use this information to analyze spend compliance and account restriction trends.

				R059		Diversion Detail by Cardholder		Transaction		T&E		PA, M, CH		Adobe		This report can be used to identify transactions that have posted to Diversion Accounts. Subtotals are provided for each Diversion Account and a Grand Total for the entire report.

				R018		Employee Audit		Admin		T&E, Pcard		PA, A		Adobe		This report displays any creation or change made to an existing employee record over the requested period of time.

				R019		Employee Profile - MS Excel		Admin		T&E, Pcard		PA		Excel		This report displays all employee related attributes. Including account status, account balance, last transaction date, hierarchy assignment, and account limits.

				R060		Foreign Currency		Transaction		T&E, Pcard		PA		Adobe		This report can be used to identify transaction that occurred outside the United States. Currency and exchange rate are displayed for each transaction. Subtotals are provided for each account as well as Grand Total for the entire report.		R069

				R061, R061E		Fuel Purchase Detail Summary (MS-Excel)		Transaction		Fleet		PA, M, CH		Adobe, Excel		This report provides detailed information for transactions that occurred at fuel merchants with a Fleet Card product.

				R020		Hierarchy Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any hierarchy creation or changes made to existing hierarchy over the requested period of time.

				R021		Hierarchy List by Level		Admin		T&E, Pcard		PA		Adobe		This report displays the company hierarchy tree structure. The levels and IDs of the hierarchy are ordered by how they report up to the top level of the hierarchy.

				R062		Level III Temporary Services		Transaction		Pcard		PA, M, CH		Adobe		This report be used to analyze information for Temporary Services. Total transaction are provided for each supervisor as well as Grand Total for the report		R076, R078

				R028		Lodging Spending Analysis by City		Merchant		T&E		PA		Adobe		This reports summarizes the cities and lodging establishments for your program. The information can be used to negotiate rates with hotel chains.		R029, R077

				R029		Lodging Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		The report summarizes the total spend and total number of transactions for each lodging establishment. The information can be used to negotiate rates with hotel chains.		R028, R077

				R022		Login Audit		Admin		T&E, Pcard		PA		Adobe		This report displays any login attempt to PaymentNet. The report displays all login attempts over the requested period of time.

				R041		MasterCard 1099 Transaction Detail		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report can be used to review transactions at merchants to understand whether or not to include each specific transaction in the total spend for 1099 reporting. This data will aid in resolving questions such as if a transaction or specific merchant needs to be included for 1099 reporting. This report will be limited to merchants that have merchandise and service transactions.		R024

				R042		MasterCard 1099 Vendor Information		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099-MISC and socio-economic (Form 1057) reporting needs. It includes the most current MasterCard merchant information and is filtered by the list of 1099-reporable MCCs provided by the IRS.		R031

				R043		MasterCard Enhanced Merchant Data		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099 and Socio-Economic reporting needs.		R031

				R044		MasterCard Socio-Economic		Merchant: MC		T&E, Pcard, SUA		PA		Adobe		This report provides the actual and percentage spend in dollars, transactions and number of vendors segmented by the various Socio-Economic statuses collected by MasterCard.		R031

				R030		MCC with Default Account Codes		Merchant		T&E, Pcard		PA		Adobe		This report shows the default account codes assigned to MCCs.

				R031		Merchant Profile - MS Excel		Merchant		T&E, Pcard, SUA		PA		Excel		This report provides detailed information about merchants. Including location, diversity status, Chart of Account Segments, Custom Fields, and incorporation status. The report also includes the total sales volume with each merchant for the time period of the report.		R024, R032, R033, R043, R047,

				R032		Merchant Profile with Custom Fields		Merchant		T&E, Pcard		PA		Adobe		This report can be used to review the custom fields that have been associated with specific merchants. In addition to merchant information, the report displays each custom field's classifications, type and value.		R031

				R033		Merchant Rankinig		Merchant		T&E		PA		Adobe		The report provides merchant rankings for the T&E categories; Airlines, Car Rental, Lodging and Restaurants & Transportation. The report shows the total dollar spend and total number of transactions for each merchant within each T&E category. Non T&E merchants appear under the category of 'Other". Subtotals are provided at the end of each category and a Grand Total at the end of the report.		R031, R073, R074, R076

				R034		Merchants with Default Account Codes		Merchant		T&E, Pcard		PA		Adobe		This report shows any defaulted account codes assigned to each merchant.		R031

				R049		Order Audit		Order		SUA		PA, A		Adobe		This report display any creation or changes made to an existing order over the requested period of time.		R050

				R050, R050E		Order Transaction Detail (MS Excel)		Order		SUA		PA (Orders)		Adobe, Excel		This report can be used to monitor the transaction for each Single Use Account against the order. Subtotals are provided in the Adobe version showing the total transaction amount for each order, as well as a Grant Total for the entire report.		R049

				R035		Parent Merchant Ranking		Merchant		T&E		PA		Adobe		The report provides total spend, number of transactions and average transaction size for each Parent Merchant. The Parent Merchants in the report are grouped by  the T&E categories; Airlines, Car Rental , Lodging, Restaurants and Transportation. Subtotals are provide for each T&E category as well as a Grand Total for the entire report.		R036

				R036		Quarterly Merchant Analysis by Parent Merchant Summary		Merchant		T&E, Pcard, SUA		PA		Adobe		This report provides the total spend and total number of transactions for each Parent Merchant within a Merchant Category Code. Subtotals are provided for each MCC and a Grand Total for the entire report. The report can be run for time periods other than Quarters.

				R063		Receipt Imaging Volume		Transaction		T&E, Pcard		PA		Adobe		This report summarizes the total number of receipt images files attached to transactions for your organization.

				R037		Restaurant Spending Analysis by Top Restaurant		Merchant		T&E		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for each restaurant. Grant Totals are provided at the end of the report.

				R015		Rush Delivery Card Requests		Account		T&E, Pcard		PA		Adobe		This report displays accounts with rush card delivery requests. Accounts are grouped by hierarchy.

				R038		Spending Analysis by Merchant Type		Merchant		T&E, Pcard, SUA		PA		Adobe		This report can be used to analyze purchases within the following merchant classifications: Sole-Proprietorship, Partnership and Unincorporated.  Subtotals for service related and non-service related industries are provided within each merchant classification.		R024, R041, R045

				R064		Statement of Account		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report provides a listing of the previous cycles transaction information and when available; Accounting Code Allocations, Transaction Notes, Custom Fields and Transaction Addendum Detail. The report includes signature lines for the Cardholder and Supervisor, to assist with the reconciliation process. The report is not an official bank billing statement and cannot be used for remittance purposes.		R069

				R039		Summary Quarterly MCC		Merchant		T&E, Pcard, SUA		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for each Merchant Category Code. The report can be generated for time periods other than Quarter.		R036

				R067		T&E Activity by Industry		Transaction		T&E		PA		Adobe		This report can be used to analyze account activity with each merchant within the following travel & entertainment industries; airline, lodging, car rental, transportation, restaurants, cash and other. Subtotals are provided for each type of industry.		R069, R074, R075, R076, R077

				R065		T&E Expense by Cardholder		Transaction		T&E		PA, CH		Adobe		This report can be used to analyze at the cardholder level, the total and average dollar amount spent on each of the following travel and entertainment types: airlines, lodging, car, mass transportation, transportation, restaurant, cash, and other. Subtotals are provided for each cardholder, as well as a grand total for the entire report.		R066, R069, R074, R075, R076, R077

				R066		T&E Transaction Activity		Transaction		T&E		PA, CH		Adobe		This report travel and entertainment transactions which are group by Cardholder.		R069, R074, R075, R076, R077

				R068, R068E		Transaction Audit  (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, A		Adobe, Excel		This report will provide all transaction changes made over the selected date range.

				R069, R069E		Transaction Detail (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe, Excel		This report can be used to monitor the purchases for each account. Transaction as well as line items are included and payments are excluded for this report.		R064

				R070		Transaction Detail by Central Bill Account		Transaction		Pcard, SUA		PA		Adobe		Use this report to review the transaction and account that have been charged to central bill accounts. Subtotals are provided for each cardholder and central bill account as well as grand total for the entire report.		R064, R069

				R071		Transaction Detail by Hierarchy		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report summarizes the number of transaction and total dollar amount for each account and hierarchy level. Transactions as well as line items are included and payments are excluded from the report. Subtotals are provided for each account and hierarchy level, as well a grand total for the entire report.		R069

				R072		Transaction Detail by Parent Merchant		Transaction		T&E, Pcard, SUA		PA		Adobe		This report groups transactions by parent merchant. It provides a sub-total of dollar spend and number of transaction for each Parent Merchant.		R035, R036, R069

				R073		Transaction Detail with Accounting Codes and Notes		Transaction		T&E, Pcard		PA, TA, CH		Adobe		Use this report to review transaction with their accounting codes, notes and custom fields. Transaction as well as line items are included. Payments are excluded.		R069

				R074		Transaction Detail with Level III Airline Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction details and the associated airline addendum data (Level III). When viewing Level III airline data, columns for all Level III airline data are visible, but data is only populated for the addendum information provided by the processor.		R025, R026, R051, R052, R053, R054

				R075		Transaction Detail with Level III Car Rental Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction detail and the associated car rental addendum data (Level III). When viewing Level III car rental data, columns for all Level III car rental data are visible, but data is only populated for the addendum information provided by the processor.		R027, R040

				R076		Transaction Detail with Level III Data		Transaction		T&E, Pcard, SUA		PA, M, CH		Excel		Use this report to review transaction detail and the associated addendum (Level III). When viewing Level III data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.		R062, R074, R075, R077, R078

				R077		Transaction Detail with Level III Lodging Data		Transaction		T&E		PA, M, CH		Excel		Use this report to review transaction detail and the associated Lodging addendum (Level III). When viewing Level III Lodging data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.		R028, R029

				R078		Transaction Detail with Level III Purchasing Data		Transaction		Pcard		PA, M, CH		Excel		Use this report to review transaction detail and the associated Purchasing addendum (Level III). When viewing Level III Purchasing data, columns for all Level III data are visible, but data is only populated for the addendum information provided by the processor. This report contains data for all transaction that contain any type of addendum data.

				R079		Transaction Detail with Page Breaks		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		Use this report to review all purchases made for each account. Since the each account's activity is detailed on a separate page, this report can be printed and given to cardholders who do not have access to PaymentNet to review their transactions. Transaction as well as line items are included. Payments are excluded from this report.		R064, R069

				R080		Transaction Detail with Payments		Transaction		T&E, Pcard, SUA		PA, TA, CH		Adobe		This report is used to the review the purchase and payments for each account.		R064, R069

				R081		Transaction Detail with Purchase Addendum		Transaction		Pcard, SUA		PA, CH		Adobe		Use this report to view transaction with purchasing addendum. The report groups the transaction by cardholder.		R076, R078

				R082		Transaction Disputes by Hierarchy		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe		Use this report to view the status of disputed transactions.

				R085		Transaction Pending Review/Approval		Transaction		T&E, Pcard		PA, TA, M, CH		Adobe		Use this report to review transaction that need to be reviewed or approved. The report shows transaction information as well as those who are responsible marking the transactions reviewed or approved. This report will show both types of transactions by default.		R069

				R083, R083E		Transaction Summary by Hierarchy (MS-Excel)		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe, Excel		Use this report to review the number of transaction and total dollar amount for each account by hierarchy.

				R084		Transaction Summary by Parent Merchant		Transaction		T&E, Pcard, SUA		PA, M, CH		Adobe		Use this report to review the number of transaction and total dollar for each parent merchant.		R032, R035, R0336

				R040		Transportation Spending Analysis by Merchant		Merchant		T&E		PA		Adobe		This report provides the total spend, total number of transactions and average transaction amount for merchant that is classified as Airline or Travel. Grand totals are provided at the end of the report.		R026

				R023		Unusual Activity Analysis		Admin		T&E, Pcard		PA, A		Adobe		This report can be used to monitor unusual activity and determine if the transactions are business-related. Subtotals are provided for each MCC, as well as grand total for the report. The report displays transaction associated with the following MCCs: 5681, 5944, 7230, 7273, 7297, 7298, 7299, 7631, 7995.

				R045		Visa 1099 Transaction Detail		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report can be used to review transactions at merchants to understand whether or not to include each specific transaction in the total spend for 1099 reporting. This data will aid in resolving questions such as if a transaction or specific merchant needs to be included for 1099 reporting. This report will be limited to merchants that have merchandise and service transactions.		R024

				R046		Visa 1099 Vendor Information		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099-MISC and socio-economic (Form 1057) reporting needs. It includes the most current MasterCard merchant information and is filtered by the list of 1099-reporable MCCs provided by the IRS.		R031

				R047		Visa Merchant		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report is used to support 1099 and socio -economic reporting needs. It includes the most current merchant information provided by Visa.		R031

				R048		Visa Socio-Economic		Merchant: Visa		T&E, Pcard, SUA		PA		Adobe		This report provides the actual and percentage spend in dollars and number of vendors segmented by the various socio-economic statuses collected by Visa.		R031

				R016		Write-Off		Account		T&E		PA, A		Adobe		The report displays accounts with write-off balances, primarily due to fraud		R004, R011, R014



Recommended Users
PA - Program Administrator
TA - Transaction Approver
M - Manager
A - Auditor
CH - Cardholder

Programs
T&E - Travel & Entertainment
Pcard - Purchasing Card
SUA - Single Use Account

Report Name
(MS -Excel) indicates  both
Adobe & Excel version of 
report
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Report Samples
Description
The report description as it appears in the Reports module of PaymentNet.

Report number
Each report has a unique report number. This makes it easier to reference when 
communicating with users and J.P. Morgan. 
Reports that are optimized and best for viewing in Excel have an “E” at the end 
of the number, for example, Account Audit (MS Excel) R003E.
The report numbers in the documentation are for general representation to 
assist you when clarifying a report type or concern with J.P. Morgan. For 
example, this is report number 1: Account Audit (Report # 001). Report numbers 
are not identified within PaymentNet.

Similar reports (see also)
Quickly locate other reports with similar data. 

Report Samples
Each report in PaymentNet is listed under its report type in this section. 

By default, PaymentNet lists reports alphabetically. However, you can locate a report 
more efficiently by choosing its report type. 

To access reports in PaymentNet, click Reports > Create > and see Chapter 11, 
“Reports” on page 317 for specific steps on running a report.

This section explains the following report types:
 Accounts
 Administration
 Merchant
 Merchant: MasterCard
 Merchant: Visa
 Order
 Transaction

Accounts
This section displays an example of each of the Account report types available in 
PaymentNet. A brief description of its purpose, a sample report output, and a list of 
fields included in the report are provided for your reference.
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This section lists the following Accounts report samples: 

 30 and 60 Day Past Due (Report # R001)
 Account Limit - MS Excel (Report # R002E)
 Account Audit (Report # R003)
 Account Audit - MS Excel (Report # R003E)
 Account Delinquencies (Report # R004)
 Account Suspension/Cancellation (Report # R005)
 Account and Employee Hierarchy (Report # R006)
 Account and Employee Hierarchy - MS Excel 

(Report # R006E)
 Accounts with Low Available Credit (Report # 

R007)
 Cardholder Accounts and Limits by Hierarchy 

(Report # R008)

 Cardholders Default Account Codes and Custom 
Fields (Report # R009)

 Cardholder Listing with Addresses (Report # 
R010)

 Cardholder Profile (Report # R011)
 Cardholder Profile - MS Excel (Report # R011E)
 Cardholder Status (Report # R012)
 Cardholder Status - MS Excel (Report # R012E)
 Cardholder with Account and MCC Group Limits 

(Report # R013)
 Charge Off (Report # R014)
 Rush Delivery Card Requests (Report # R015)
 Write-Off (Report # R016)

30 and 60 Day Past Due (Report # R001)

Description

Use this report to monitor accounts that are 30 and/or 60 days past due.

Note: The 30 and 60 Day report is incorrectly including lost or stolen accounts. 

To obtain information on past due accounts, excluding those that are lost or 
stolen, run the Cardholder Profile (Report # R011) report instead.
PaymentNet User Guide



Report Samples
Figure 15: 30 and 60 Day Report

Report Information Includes

 Account Number
 Last Name 
 First Name
 Status
 30 Days

 60 Days
 Days Past
 Last Transaction Date
 Current Balance
 Grandtotal

:
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Account Limit - MS Excel (Report # R002E)

Description

Use this report to monitor limits assigned to accounts. Including credit, cash 
advance, monthly and MCCG limits.

Note: The TSYS processor is sending blank values for account limit value fields where no 
restrictions have been entered. However, these blank values are displaying as zeros 
(0) in the Account Limit report. A zero in the report indicates that these accounts do 
not have any credit available.
Instead of using the report, use the Controls tab on the Account Detail screen to 
verify account limits.

 

Note: All MCCGs ever assigned to an account, even MCCGs removed from an account, are 
displaying in reports, mappers, and exports.
Use the Account Detail screen to verify the MCCGs assigned to an account. 

Figure 16: Account Limit - MS Excel Report
PaymentNet User Guide



Report Samples
Report Information Includes:

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Account Status
 Account Status Reason
 Open Date
 Last Transaction Date
 Hierarchy ID
 Hierarchy Description
 Credit Limit 
 Cash Advance Limit
 Available Limit
 Single Amount Limit

 Daily Amount Limit
 Daily Transaction Limit
 Cycle/Monthly Transaction Limit
 Other Amount Limit
 Other Transaction Limit MCC Group
 MCCG Single Amount Limit
 MCCG Daily Amount Limit
 MCCG Daily Transaction Limit
 MCCG Cycle/Monthly Account Limit
 MCCG Cycle/Monthly Transaction Limit
 MCCG Other Account Limit
 MCCG Other Transaction Limit

Account Audit (Report # R003)

Description

Use this report to identify all changes made to accounts over the selected date 
range. This report is best viewed in PDF format.
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Figure 17: Account Audit Report

Report Information Includes

 Account Number
 Change Date
 Change Time
 Field Name

 Previous Value
 New Value
 Modified by

 

Account Audit - MS Excel (Report # R003E)

Description

Use this report to identify all changes made to accounts over the selected date 
range. This report is best viewed in Excel format.
PaymentNet User Guide



Report Samples
Figure 18: Account Audit - MS Excel Report

Report Information Includes:

 Account Number 
 Change Date
 Change Time
 Field Name

 Previous Value
 New Value
 Modified By

Account Delinquencies (Report # R004)

Description

Use this report to monitor past due amounts across all delinquency categories. The 
Adobe version also provides total delinquencies for the hierarchy selected or the 
entire organization. This report is best viewed in PDF format.

Note:  The Charge Off column in the Account Delinquencies report (#R004) always displays 
$0.00.
For accounts that have been charged off, use the Cardholder Profile report (#R011) 
to obtain the charge-off amount.

 

Note: The Account Delinquencies report is incorrectly including lost or stolen 
accounts. 
To obtain information on past due accounts, excluding those that are lost or 
stolen, run the Cardholder Profile (Report # R011) report instead.
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Figure 19: Account Delinquencies Report

Report Information Includes

 Account Number
 Cardholder Last Name
 Cardholder First Name
 Account Hierarchy
 Employee ID
 1-30 Day past due amount
 31-60 Day past due amount
 61-90 Day past due amount

 91-120 Day past due amount
 121-150 Day past due amount
 151-180 Day past due amount
 Amount Charged Off
 Current Balance
 Sub-Total: Account(s)
 Grand Total: Account(s)

Account Suspension/Cancellation (Report # R005)

Description

Use this report to identify accounts that are suspended or canceled. The report is 
organized by hierarchy. This report is best viewed in PDF format.
PaymentNet User Guide



Report Samples
Figure 20: Account Suspension/Cancellation Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Account Hierarchy

 Account Number
 Account Status
 Current Balance

Account and Employee Hierarchy (Report # R006)

Description

Use this report to show the account, employee and role hierarchies for all employees 
- both cardholders and non-cardholders. This report is best viewed in PDF format.

Note: If the report is run using Hierarchy ID as a criterion, that criterion will apply to the 
employee and not the accounts that belong to the employee.
379



b | Reporting Reference

380
Figure 21: Account and Employee Hierarchy Report

Report Information Includes

 User ID
 Last Name
 First Name
 Employee Hierarchy
 Account Number

 Account Hierarchy
 Account Status
 Role
 Hierarchy - Role
 Scope
PaymentNet User Guide



Report Samples
Account and Employee Hierarchy - MS Excel (Report # 
R006E)

Description

Use this report to show the account, employee and role hierarchies for all employees 
- both cardholders and non-cardholders. This report is best viewed in Excel format.

Note: If the report is run using Hierarchy ID as a criterion, that criterion will apply to the 
employee and not the accounts that belong to the employee.

 

Report Information Includes

 User ID
 Last Name
 First Name
 Employee Hierarchy
 Role

 Hierarchy - Role
 Scope
 Account Number
 Account Hierarchy
 Account Status
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Accounts with Low Available Credit (Report # R007)

Description

Use this report to monitor accounts with low available credit and adjust as 
appropriate. Only accounts that have available credit that is less than 20% of their 
total credit limit will appear in the report. This report is best viewed in PDF format.

Figure 22: Accounts with Low Available Credit Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Current Balance

 Date Effective
 Credit Limit
 Cash Advance Limit
 Available Credit
PaymentNet User Guide



Report Samples
Cardholder Accounts and Limits by Hierarchy (Report # 
R008)

Description

Use this report to show credit limit, cash advance limit, single transaction limit, 
account open date, account closed date and account current status. Accounts in the 
report are organized by hierarchy. This report is best viewed in PDF format.

Figure 23: Cardholder Accounts and Limits by Hierarchy Report
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Report Information Includes

 Hierarchy
 Last Name
 First Name
 Account Number
 Credit Limit
 Available Credit

 Cash Advance Limit
 Single Amount Open Date Limit
 Closed Date
 Status
 Sub-total Accounts
 Grand totals Accounts

Cardholders Default Account Codes and Custom Fields 
(Report # R009)

Description

Use this report to monitor the default accounting codes and custom fields assigned 
to each account. The report also displays the credit limit, daily amount limit, 
monthly/cycle limit and other limits. This report is best viewed in PDF format.

Figure 24: Cardholders Default Account Codes and Custom Fields Report
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Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Account Status
 Credit Limit
 Single Amount Limit
 Daily Amount Limit
 Daily Transaction Limit
 Cycle/Monthly Amount Limit
 Cycle/Monthly Transaction Limit
 Account Number

 Other Amount Limit
 Other Transaction Limit
 Chart of Accounts
 Chart of Accounts Segment Description
 Accounting Code Values
 Segment Value Description
 Transaction Default Custom Field Name
 Transaction Default Custom Field Value
 Account Custom Field Name
 Account Custom Field Value
 Grand total

Cardholder Listing with Addresses (Report # R010)

Description

Use this report to display the addresses and business phone for each account. Data is 
organized by hierarchy. This report is best viewed in PDF format.
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Figure 25: Cardholder Listing with Addresses Report

Report Information Includes

 Last Name
 First Name
 Account Number
 Hierarchy 
 Employee ID
 Status
 Expiration Date
 Address 1

 Address 2
 City
 State/Province
 Zip/Postal
 Country 
 Business Phone
 Sub-total Accounts
 Grand totals Accounts
PaymentNet User Guide



Report Samples
Cardholder Profile (Report # R011)

Description

Use this report to review all card accounts and related information. Program 
administrators can use this report to assist in managing cardholder information. The 
Excel version of the report contains more data elements than the Adobe version. 
This report is best viewed in PDF format. 

Note: All MCCGs ever assigned to an account, even MCCGs removed from an account, are 
displaying in reports, mappers, and exports.
Use the Account Detail screen to verify the MCCGs assigned to an account. 

Note:  For clients on the TSYS processor, please be aware that the Charge Off Date field on 
the Charge Off report (#R014) and the Cardholder Profile reports (#R011 and #R011E) 
will always list the day as "01". This occurs because the TSYS processor only stores 
the month and the year for this field.
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Figure 26: Cardholder Profile Report

Note: The report sample above has been modified for display purposes. 
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Report Samples
Report Information Includes

 Account Number
 Central Bill Account
 Open Date 
 Expiration Date
 Card Reissue Date
 Last Transaction Date
 Closed Date
 Status
 Account Status Reason
 Employee ID
 SSN/ID
 Last Name
 First Name
 Second Row of Embossing
 Address 1
 Address 2
 City
 State/Province
 Zip/Postal
 Country

 Business Phone 
 Email
 CC Email
 BCC Email
 Chart of Accounts Name
 Accounting Codes
 Cash Advance Limit
 Credit Limit
 Available Credit
 Current Balance
 Cycle/Monthly Amount Limit
 Cycle/Monthly Transaction Limit
 Single Amount Limit
 Daily Amount Limit
 Daily Transaction Limit
 Other Amount Limit
 Other Transaction Limit
 MCCG Action
 Hierarchy Level
 Notes

Note: Reports run by PaymentNet users assigned to the Transaction Approver role may not 
contain any data. This occurs when a transaction approver runs a report for a module 
to which they do not have access.
To allow transaction approvers to run these types of report, add them to either the 
Manager or Custom Program Administrator role.

Cardholder Profile - MS Excel (Report # R011E)

Description

Use this comprehensive report to display most account related information, 
including address, phone numbers, email address, accounting codes, custom fields, 
account status, last transaction date and account limits. The Excel version of the 
report contains more data elements than the Adobe version. This report is best 
viewed in Excel format. 

Note: All MCCGs ever assigned to an account, even MCCGs removed from an account, are 
displaying in reports, mappers, and exports.
Use the Account Detail screen to verify the MCCGs assigned to an account. 
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Note:  For clients on the TSYS processor, please be aware that the Charge Off Date field on 
the Charge Off report (#R014) and the Cardholder Profile reports (#R011 and #R011E) 
will always list the day as "01". This occurs because the TSYS processor only stores 
the month and the year for this field.

Figure 27: Cardholder Profile Report - MS Excel

Note: The report sample above has been modified for display purposes. 

Report Information Includes

 Account Number
 Central Bill Account
 Open Date 
 Expiration Date
 Card Reissue Date
 Last Transaction Date
 Closed Date
 Account Status
 Account Status Reason
 Employee ID
 SSN/ID
 Last Name
 First Name
 Second Row of Embossing
 Address 1
 Address 2
 City
 State/Province
 Zip/Postal
 Country
 Business Phone 
 Email
 CC Email

 BCC Email
 Chart of Accounts Name
 Accounting Codes
 Cash Advance Limit
 Credit Limit
 Available Credit
 Current Balance
 Cycle/Monthly Amount Limit
 Cycle/Monthly Transaction Limit
 Single Amount Limit
 Daily Amount Limit
 Daily Transaction Limit
 Other Amount Limit
 Other Transaction Limit
 MCCG Action
 Hierarchy Level
 Notes
 Days Past
 30 Days
 60 Days
 Past Due Amount
 Charge Off Amount
 Charge Off Date
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Cardholder Status (Report # R012)

Description

This report can be used to identify cardholder account status and limits. The report 
is sub-totaled by account status. Account Status options include: Active, Lost or 
Stolen, Suspended, and Closed.

Figure 28: Cardholder Status Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Hierarchy
 Account Number
 Open Date
 Closed Date
 Credit Limit

 Available Credit
 Single Amount Limit
 Cycle/Monthly Amount LImit
 Status
 Account Status Reason
 Sub-total Accounts
 Grand totals Accounts
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Cardholder Status - MS Excel (Report # R012E)

Description

Use this report to show the current account statuses and limits. This report is best 
viewed in Excel format.

Figure 29: Cardholder Status Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Hierarchy
 Account Number
 Open Date
 Closed Date

 Credit Limit
 Available Credit
 Single Amount Limit
 Cycle/Monthly Amount LImit
 Status
 Account Status Reason
PaymentNet User Guide
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Cardholder with Account and MCC Group Limits (Report # 
R013)

Description

Use this report to display account and Merchant Category Code (MCC) Limits. This 
report is best viewed in PDF format.

Figure 30: Cardholder with Account and MCC Group Limits Report
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Report Information Includes

 Last Name
 First Name 
 Account Number
 Status
 Credit Limit
 Cash Advance Limit
 Available Credit

 Single Amount Limit
 Daily Amount Limit
 Daily Transaction Limit
 Cycle/Monthly Amount Limit
 Cycle/monthly Transaction Limit
 Other Amount Limit
 Other Transaction Limit

Charge Off (Report # R014)

Description

Use this report to monitor total charged-off amounts by account. Individual 
transactions cannot be tracked. A charge-off occurs after an account balance has 
moved into collections. Oldest transactions are paid first. This report is best viewed 
in PDF format.

Note:  For clients on the TSYS processor, please be aware that the Charge Off Date field on 
the Charge Off report (#R014) and the Cardholder Profile reports (#R011 and #R011E) 
will always list the day as "01". This occurs because the TSYS processor only stores 
the month and the year for this field.
PaymentNet User Guide



Report Samples
Figure 31: Charge Off Report

Report Information Includes

 Last name 
 First name
 Account Number
 Charge Off Amount 
 Charge Off Date

 Past Due Amount
 Current Balance
 Grand Total
 Accounts

 

395



b | Reporting Reference

396
Rush Delivery Card Requests (Report # R015)

Description

Use this report to display accounts with rush card delivery requests. Accounts are 
grouped by hierarchy.

Note: This report represents PaymentNet Rush Delivery requests only; fee waivers, rush 
delivery fees, or card requests made through your Program Coordinator or Customer 
Application Support outside of PaymentNet will not appear on the report.

Figure 32: Rush Delivery Card Requests Report
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Report Samples
Report Information Includes

 User ID
 Account Number
 Cardholder First Name
 Cardholder Last Name
 Hierarchy
 Date
 Time

 Fee Charge
 Address 1
 Address 2/Attention To
 City
 State/Province
 ZIP/Postal
 Country
 Rush Card Delivery Request Status

 

Write-Off (Report # R016)

Description

Use this report to monitor transactions with write-off balances, primarily due to 
fraud. This report is best viewed in PDF format.

Figure 33: Write-Off Report
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Report Information Includes

 Last Name
 First Name
 Account Number
 Write Off Amount

 Write Off Date
 Past Due Amount
 Current Balance

 

Administration
This section displays an example of each of the Administration report types available 
in PaymentNet. A brief description of each report’s purpose, a sample report output, 
and a list of fields included in each report are provided for your reference.

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

This section lists the following Administration report samples:
 Chart of Accounts Audit (Report # R017)
 Employee Audit (Report # R018)
 Employee Profile - MS Excel (Report # R019E)
 Hierarchy Audit (Report # R020)
 Hierarchy List by Level (Report # R021)
 Login Audit (Report # R022)
 Unusual Activity Analysis (Report # R023)
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Report Samples
Chart of Accounts Audit (Report # R017)

Description

Use this report to display any chart of account creation or any change made to an 
existing chart of account over the requested time period. This report is best viewed 
in PDF format.

Note: The Segment column on the report applies to the Segment Number being changed. 
The Segment Value column applies to the specific value being changed for that 
segment. For example, the report would show changes to the Value’s Description or 
its Dependency.

Figure 34: Chart of Accounts Audit Report

Report Information Includes

 Change Date
 Change Time
 Chart of Accounts
 Accounting Code Value
 Segment Value Description

 Field Name
 Previous Value
 New Value
 Modified Value
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Employee Audit (Report # R018)

Description

Use this report to display any employee creation or any change made to an existing 
employee record over the requested period of time. This report is best viewed in 
PDF format.

Figure 35: Employee Audit Report

Report Information Includes

 Change Date
 Change Time
 Employee ID
 Field Name

 Previous Value
 New Value
 Modified by
PaymentNet User Guide
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Employee Profile - MS Excel (Report # R019E)

Description

This report provides information on employees, including employee name, employee 
ID, employee User ID, employee accounts, hierarchy ID, hierarchy description, and 
other employee related attributes. This report is best viewed in Excel format.

Figure 36: Employee Profile - MS Excel Report

Report Information Includes

 First Name
 Last Name
 Middle Name
 Employee ID
 User ID
 Account Number
 SSN/ID
 Hierarchy ID
 Hierarchy Description
 Login Date
 Suffix Name
 Prefix Name
 Employee Email
 Employee CC Email
 Employee BCC Email
 Business Phone
 Role
 Role Hierarchy ID
 Role Name
 Role Scope
 User Mask Data Export indicator
 Password Change Audit

 Disable As of Date
 User Default Accounting Code Value 1
 User Default Accounting Code Value 2
 User Default Accounting Code Value 3
 User Default Accounting Code Value 4
 User Default Accounting Code Value 5
 User Default Accounting Code Value 6
 User Default Accounting Code Value 7
 User Default Accounting Code Value 8
 User Default Accounting Code Value 9
 User Default Accounting Code Value 10
 Custom Field Value 1
 Custom Field Value 2
 Custom Field Value 3
 Custom Field Value 4
 Custom Field Value 5
 Custom Field Value 6
 Custom Field Value 7
 Custom Field Value 8
 Custom Field Value 9
 Custom Field Value 10
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Hierarchy Audit (Report # R020)

Description

Use this report to display any hierarchy creation or changes made to existing 
hierarchy over the requested period of time. This report is best viewed in PDF 
format.

Figure 37: Hierarchy Audit Report

Report Information Includes

 Change Date
 Change Time
 Hierarchy ID
 Field Name

 Previous Value
 New Value
 Modified By
PaymentNet User Guide
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Hierarchy List by Level (Report # R021)

Description

Use this report to display the company hierarchy structure. The levels and IDs of the 
hierarchy are ordered by how they report to the top level of the hierarchy. This 
report is best viewed in PDF format.

Figure 38: Hierarchy List by Level Report

Report Information Includes

 Hierarchy Level
 Hierarchy ID

 Hierarchy Description

Login Audit (Report # R022)

Description

Use this report to display any login attempt to PaymentNet. The report displays all 
login attempts over the requested period of time. This report is best viewed in PDF.
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Figure 39: Login Audit Report

Report Information Includes

 Login Date
 Login Time

 User ID
 Login Duration
PaymentNet User Guide



Report Samples
Unusual Activity Analysis (Report # R023)

Description

Use this report to monitor unusual activity and determine if the transactions are 
business-related. Subtotals are provided for each MCC, as well as grand total for the 
report. The report displays transaction associated with the following MCCs: 5681, 
5944, 7230, 7273, 7297, 7298, 7299, 7631, 7995. This report is best viewed in PDF.

Figure 40: Unusual Activity Analysis Report
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Report Information Includes

 Last Name
 First Name
 Merchant Name
 Merchant City
 Merchant State/Province

 Transaction Date
 Transaction Amount
 Sub-Total: Transaction(s) 0.00
 Grand Total: Transaction(s) 0.00

Merchant
This section displays an example of each of the Merchant report types available in 
PaymentNet. A brief description of each report’s purpose, a sample report output, 
and a list of fields included in each report are provided for your reference.

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

This section lists the following Merchant report samples:
 1099 Merchant (Report # R024)
 Airline City Pairs Summary by Merchant (Report # R025)
 Airline Spending Analysis by Merchant (Report # R026)
 Car Rental Spending Analysis by Merchant (Report # R027)
 Lodging Spending Analysis by City (Report # R028)
 Lodging Spending Analysis by Merchant (Report # R029)
 MCC with Default Account Codes (Report # R030)
 Merchant Profile - MS Excel (Report # R031)
 Merchant Profile with Custom Fields (Report # R032)
 Merchant Ranking (Report # R033)
 Merchants with Default Account Codes (Report # R034)
 Parent Merchant Ranking (Report # R035)
 Quarterly Merchant Analysis by Parent Merchant Summary (Report # R036)
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Report Samples
 Restaurant Spending Analysis (Report # R037)
 Spending Analysis by Merchant Type (Report # R038)
 Summary Quarterly MCC (Report # R039)
 Transportation Spending Analysis by Merchant (Report # R040)

1099 Merchant (Report # R024)

Description

Use this report to analyze purchases made from 1099 merchants. This report is best 
viewed in PDF format.

Figure 41: 1099 Merchant Report
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Report Information Includes

 Merchant Name
 Merchant City
 Merchant State
 Merchant Zip
 Merchant DBA
 Tax Payer ID

 Total Number of Transactions
 MCC
 MCC Description
 Total Transaction Amount
 Sub-total
 Transaction(s)

Airline City Pairs Summary by Merchant (Report # R025)

Description

Use this report to identify the most traveled airline routes by merchant. The data 
can be used to negotiate rates with air travel providers. The report is sorted by 
merchant name followed by number of trip legs per origination and destination (with 
the most frequently traveled trip legs displayed first). This report is best viewed in 
PDF format.
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Report Samples
Figure 42: Airline City Pairs Summary by Merchant Report

Report Information Includes

 Merchant Name
 Origination
 Destination

 Total Number of Segments
 Sub-total = Segments

 

409



b | Reporting Reference

410
Airline Spending Analysis by Merchant (Report # R026)

Description

Use this report to provide the total spend and total number of transactions with each 
airline provider. The information can be used in negotiating rates with airline 
companies. The report provides a total transaction amount at the end of the report. 
This report is best viewed in PDF format.

Figure 43: Airline Spending Analysis by Merchant

Report Information Includes

 Merchant Name
 Total Transaction Amount
 Total Number of Transactions

 Transaction Average
 Grand total
 Transactions

Car Rental Spending Analysis by Merchant (Report # R027)

Description

Use this report to review the total spend and total number of transactions with car 
rental agencies. The data can be used in negotiating rates with car rental agencies. 
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Report Samples
The report is sorted by merchant name, and lists the grand total at the end of the 
report. This report is best viewed in PDF format.

Figure 44: Car Rental Spending Analysis by Merchant

Report Information Includes

 Merchant Name
 Total Transaction Amount
 Total Number of Transactions

 Transaction Average
 Grand total

 

Lodging Spending Analysis by City (Report # R028)

Description

Use this report to review the cities and lodging establishments for your program. The 
information can be used in negotiating rates with hotel chains. This report is best 
viewed in PDF format.
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Figure 45: Lodging Spending Analysis by City Report

Report Information Includes

 Merchant Name
 Transaction Date
 Transaction Amount

 Sub-Total: Transaction(s) Transaction Average
 Grand Total: Transaction(s) Transaction Average

Lodging Spending Analysis by Merchant (Report # R029)

Description

Use this report to review the total spend and total number of transactions for each 
lodging establishment. The data can be used in negotiating rates with hotel chains. 
The report provides a totals for transaction amounts and for the number of 
transactions. This report is best viewed in PDF format.
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Report Samples
Figure 46: Lodging Spending Analysis by Merchant Report

Report Information Includes

 Merchant Name
 Total Transaction Amount
 Total Number of Transactions

 Transaction Average
 Grand Total: Transaction(s)

 

MCC with Default Account Codes (Report # R030)

Description

Use this report to review the default account codes assigned to merchant category 
codes. It includes individual merchant category codes and shows default account 
codes where appropriate. This report is best viewed in PDF format.
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Figure 47: MCC with Default Account Codes Report

Report Information Includes

 MCC
 MCC Description

 Hierarchy ID
 Hierarchy Description

 

Merchant Profile - MS Excel (Report # R031)

Description

Use this report to review detailed information about merchants, including location, 
diversity status, chart of account segments, custom fields, and incorporation status. 
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Report Samples
The report also includes the total sales volume with each merchant for the time 
period of the report. This report is best viewed in Excel format.

Note:  In the Merchant Profile - MS Excel report (#R031), the Sales Volume column should 
display your organization's total spend at the merchant. Instead, this column is blank 
for all merchants in the report.
Use the Quarterly Merchant Analysis by Parent Merchant Summary report (#R036) to 
obtain the total spend by merchant.

Figure 48: Merchant Profile - MS Excel Report
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Report Information Includes

 Merchant Name
 Merchant Address 1
 Merchant Address 2
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal
 Merchant Country
 Last Transaction Date
 MCC
 MCC Description
 Merchant ID
 Parent Merchant Name
 Business Phone
 Business Fax
 Minority Code
 DUNS Number
 Tax Payer ID
 1099 Indicator
 Woman Owned Indicator
 SBA Registered Indicator
 SBA Disabled Indicator
 HUB Zone Indicator
 Veteran Indicator
 Disabled Veteran Indicator
 Vietnam Veteran Indicator
 Information Refusal Indicator
 Historically Black College 
 Preferred Merchant Indicator
 Organization Sales Tax Exempt Indicator
 Gender of Business Owner
 SBA 8A Certified Business
 Corporate Status Change Date

 Sole Proprietor First Name
 Sole Proprietor Last Name
 Sales Volume
 Employee Count
 Alternate Merchant Name
 Alternate Merchant Address 1
 Alternate Merchant Address 2
 Alternate Merchant City Name
 Alternate State/Province
 Alternate ZIP/Postal
 Franchise Code
 Corporate Status Code
 Merchant Default Accounting Code Value 1
 Merchant Default Accounting Code Value 2
 Merchant Default Accounting Code Value 3
 Merchant Default Accounting Code Value 4
 Merchant Default Accounting Code Value 5
 Merchant Default Accounting Code Value 6
 Merchant Default Accounting Code Value7
 Merchant Default Accounting Code Value 8
 Merchant Default Accounting Code Value 9
 Merchant Default Accounting Code Value10
 Custom Field Value 1
 Custom Field Value 2
 Custom Field Value 3
 Custom Field Value 4
 Custom Field Value 5
 Custom Field Value 6
 Custom Field Value 7
 Custom Field Value 8
 Custom Field Value 9
 Custom Field Value 10

 

Merchant Profile with Custom Fields (Report # R032)

Description

Use this report to review the custom fields that have been associated with specific 
merchants. In addition to merchant information, the report displays each custom 
field's classifications, type and value. Program administrators can also designate 
custom fields according to the requirement of their procurement program. This 
report is best viewed in PDF format.
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Report Samples
Figure 49: Merchant Profile with Custom Fields Report
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Report Information Includes

 Merchant ID
 Merchant Name
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal

 MCC
 Minority Code
 Incorporation Status Code
 Tax Payer ID
 1099 Indicator

 

Merchant Ranking (Report # R033)

Description

Use this report to review merchant ranking for the travel and entertainment (T&E) 
categories; airlines, car rental, lodging, and restaurants and transportation. The 
report shows the total dollar spend and total number of transactions for each 
merchant within each T&E category. Non T&E merchants appear under the category 
of Other. Subtotals are provided at the end of each category and a grand total at the 
end of the report. 

This report groups merchants by T & E type. The data can be used in negotiating 
with merchants. This report is best viewed in PDF format.
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Report Samples
Figure 50: Merchant Ranking Report

Report information Includes

 Merchant Name
 Total Transaction Amount
 Total Number of Transactions)

 Transaction Average
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s
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Merchants with Default Account Codes (Report # R034)

Description

Use this report to review the default account codes assigned to each merchant. This 
report is best viewed in PDF format.

Figure 51: Merchants with Default Account Codes Report

Report Information Includes

 Merchant Name
 Merchant City

 Merchant State/Province
 MCC

Parent Merchant Ranking (Report # R035)

Description

Use this report to review the total spend, number of transactions and average 
transaction size for each parent merchant. The parent merchants in the report are 
grouped by the travel ant entertainment (T&E) categories; airlines, car rental, 
lodging, restaurants and Transportation. Subtotals are provide for each T&E category 
as well as a grand total for the entire report. This report is best viewed in PDF 
format.
PaymentNet User Guide
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Figure 52: Parent Merchant Ranking Report

Report Information Includes

 Parent Merchant Name
 Total Transaction Amount
 Total Number of Transactions

 Transaction Average
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)

Quarterly Merchant Analysis by Parent Merchant 
Summary (Report # R036)

Description

Use this report to review the total spend and total number of transactions for each 
parent merchant within a merchant category code (MCC). Subtotals are provided for 
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each MCC and a grand total for the entire report. The report can be run for time 
periods other than quarters. This report is best viewed in PDF format.

Figure 53: Quarterly Merchant Analysis by Parent Merchant Summary Report

Report Information Includes

 MCC
 Parent Merchant Name
 Total Number of Transactions
 Total Transaction Amount

 Sub-Total: Transaction(s)
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)
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Restaurant Spending Analysis (Report # R037)

Description

Use this report to review the total spend, total number of transactions and average 
transaction amount for each restaurant. Grand totals are provided at the end of the 
report. This report is best viewed in PDF format.

Figure 54: Restaurant Spending Analysis Report

Report Information Includes

 Merchant Name
 Total Transaction Amount
 Total Number of Transactions

 Transaction Average
 Grand Total: Transaction(s) 
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Spending Analysis by Merchant Type (Report # R038)

Description

Use this report to analyze purchases within the following merchant classifications: 
sole-proprietorship, partnership and unincorporated. Subtotals for service related 
and non-service related industries are provided within each merchant classification. 
This report is best viewed in PDF format.

Figure 55: Spending Analysis by Merchant Type Report
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Report Information Includes

 Merchant Name
 Merchant Address 1
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal
 Tax Payer ID

 MCC
 Transaction Amount
 Sub-Total:
 Sub-Total:
 Grand Total:

 

Summary Quarterly MCC (Report # R039)

Description

Use this report to review the total spend, total number of transactions and average 
transaction amount for each merchant category code (MCC). The report can be 
generated for time periods other than quarter. This report is best viewed in PDF 
format.
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Figure 56: Summary Quarterly MCC Report

Report Information Includes

 MCC
 MCC Description
 Total Number of Transactions
 Total Transaction Amount

 Transaction Average
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)
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Transportation Spending Analysis by Merchant  
(Report # R040)

Description

Use this report to review the total spend, total number of transactions and average 
transaction amount for merchant that is classified as airline or travel. Grand totals 
are provided at the end of the report. This report is best viewed in PDF format.

Figure 57: Transportation Spending Analysis by Merchant Report

Report Information Includes

 Merchant Name
 Total Transaction Amount

 Total Number of Transactions
 Transaction Average
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Merchant: MasterCard
This section displays an example of each of the Merchant: MasterCard report types 
available in PaymentNet. A brief description of each report’s purpose, a sample 
report output, and a list of fields included in each report are provided for your 
reference.

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

This section lists the following Merchant: MasterCard report samples:
 MasterCard 1099 Transaction Detail (Report # R041)
 MasterCard 1099 Vendor Information (Report # R042)
 MasterCard Enhanced Merchant Data (Report # R043)
 MasterCard Socio-Economic (Report # R044)

Note: You can also view MasterCard report information directly from MasterCard reports. 
The MasterCard report information is provided by the merchant and is not controlled 
directly by J.P. Morgan.

MasterCard 1099 Transaction Detail (Report # R041)

Description
Use this report to review transactions at merchants to understand whether or not to 
include each specific transaction in the total spend for 1099 reporting. This data will 
aid in resolving questions such as if a transaction or specific merchant needs to be 
included for 1099 reporting. This report will be limited to merchants that have 
merchandise and service transactions. This report is best viewed in PDF format.
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Figure 58: MasterCard 1099 Transaction Detail Report

Report Information Includes

 Last Name
 First Name
 Account Number
 Transaction ID
 Debit Transaction Amount
 Credit Transaction Amount

 Transaction Date 
 Post Date
 Transaction Notes
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)
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MasterCard 1099 Vendor Information (Report # R042)

Description
Use this report to support 1099-MISC and socioeconomic (Form 1057) reporting 
needs. It includes the most current MasterCard merchant information and is filtered 
by the list of 1099-reportable merchant category codes (MCCs) provided by the 
Internal Revenue Service. Due to the large number of fields, this report is best 
viewed in Excel and Text format.

Figure 59: MasterCard 1099 Vendor Information Report
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Report Information Includes

 Parent Merchant Name
 Merchant Name
 1099 Indicator 
 MCC
 MCC Description
 Merchant Address 1
 Merchant City
 Merchant State/Province
 Merchant Zip/Postal
 Business Phone
 Business Fax
 Tax Payer ID
 Corporation Status Code
 Women Owned Indicator

 SBA Registered Indicator
 SBA Disabled Indicator
 SBA 8A Certified Business
 HUBZone Indicator
 Disabled Veteran Indicator
 Veteran Indicator
 Historically Black College
 Gender of Business Indicator
 Ethnicity of Business Owner
 Information Refused Indicator
 Total Number of Transactions
 Total Transaction Amount
 Grand Total: Transaction(s)

MasterCard Enhanced Merchant Data (Report # R043)

Description
Use this report to support 1099 and socioeconomic reporting needs. Due to the large 
amount of information, this report is best viewed in Excel format. It is not suggested 
to run a PDF format.
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Figure 60: MasterCard Enhanced Merchant Data Report

Note: The report sample above has been modified for display purposes. 

Report Information Includes

 Merchant Name
 Merchant Address 1
 Merchant Address 2
 Merchant City
 Merchant State/Province
 Merchant Zip/Postal
 Merchant Country
 Business Phone
 Business Fax
 MCC
 Incorporation Status Code
 Tax Payer ID
 1099 Indicator
 SBA Registered Indicator

 SBA Disabled Indicator
 HUBZone Indicator
 Disabled Veteran Indicator
 Veteran Indicator
 Information Refused Indicator
 Women Owned Business
 Vietnam Veteran Indicator
 Gender of Business Owner
 Ethnicity of Business Owner
 Historically Black College
 SBA 8A Certified Business
 Total Transaction Amount
 Grand Total: Merchant(s)
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MasterCard Socio-Economic (Report # R044)

Description
Use this report to review the actual and percentage spend in dollars, transactions 
and number of vendors segmented by the various socioeconomic statuses collected 
by MasterCard. This report is best viewed in PDF format.

Figure 61: MasterCard Socio-Economic Report

Report Information Includes

 Classification
 Total Number of Transactions
 Percent of Transactions
 Total Transaction Amount

 Percent of Total Transaction Amount
 Total Number of Vendors
 Percent of Vendors
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Merchant: Visa
This section displays an example of each of the Merchant: Visa report types available 
in PaymentNet. A brief description of each report’s purpose, a sample report output, 
and a list of fields included in each report are provided for your reference. 

Note: You can also view Visa report information directly from Visa reports. The Visa report 
information is provided by the merchant and is not controlled directly by J.P. Morgan.

 

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

This section lists the following Merchant: Visa report samples:
 Visa 1099 Transaction Detail (Report # R045)
 Visa 1099 Vendor Information (Report # R046)
 Visa Merchant (Report # R047)
 Visa Socio-Economic (Report # R048)

Visa 1099 Transaction Detail (Report # R045)

Description
Use this report to review transactions at merchants to understand whether or not to 
include each specific transaction in the total spend for 1099 reporting. This data will 
aid in resolving questions such as if a transaction or specific merchant needs to be 
included for 1099 reporting. This report will be limited to merchants that have 
merchandise and service transactions. This report is best viewed in PDF format.
PaymentNet User Guide
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Figure 62: Visa 1099 Transaction Detail Report

Report Information Includes

 Last Name
 First Name
 Account Number
 Merchant Name
 Merchant City
 Merchant City
 Merchant State/Province
 Merchant Zip/Postal
 Merchant Country

 1099 Indicator
 MCC
 MCC Description
 Transaction ID
 Debit Transaction Amount
 Credit Transaction Amount
 Transaction Date
 Post Date
 Transaction Notes
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Visa 1099 Vendor Information (Report # R046)

Description
Use this report to support 1099-MISC and socioeconomic (Form 1057) reporting 
needs. It includes the most current MasterCard merchant information and is filtered 
by the list of 1099-reportable merchant category codes (MCCs) provided by the 
Internal Revenue Service. Due to the large amount of information, this report is best 
viewed in Excel format. It is not suggested to run a PDF format.

Figure 63: Visa 1099 Vendor Information Report
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Report Information Includes

 Parent Merchant Name
 Merchant Name
 MCC
 MCC Description
 Legal Name
 Merchant Address 1
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal
 Merchant Business Phone
 Merchant Business Fax
 Tax Payer ID
 Corporate Status Code
 Corporate Status Change Date
 Sole Proprietor Last Name
 Sole Proprietor First Name

 DUNS Number
 Women Owned Indicator
 SBA Disabled Indicator
 SBA Registered Indicator
 HUB Zone Indicator
 Disabled Veteran Indicator
 Veteran Indicator
 Vietnam Veteran Indicator
 Minority Code
 Franchise Code
 Employee Count
 Sales Volume
 Information Refused Indicator
 Total Number of Transactions
 Total Transaction Amount

 

Visa Merchant (Report # R047)

Description
Use this report is used to support 1099 and socioeconomic reporting needs. It 
includes the most current merchant information provided by Visa. Due to the large 
amount of information, this report is best viewed in Excel format. It is not suggested 
to run a PDF format.
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Figure 64: Visa Merchant Report

Report Information Includes

 Merchant Name
 Merchant Address1
 Merchant Address 2
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal
 Business Phone
 Business Fax
 MCC
 Merchant DBA Name
 Corporate Status Code
 Sole Proprietor First Name
 Sole Proprietor Last Name
 Women Owned Indicator
 SBA Registered Indicator
 SBA Disadvantaged Indicator

 HUB Zone Indicator
 Disabled Veteran Indicator
 Veteran Indicator
 Vietnam Veteran Indicator
 Information Refused Indicator
 Sales Volume
 Employee Count
 Alternate Merchant Name
 Alternate Address
 Alternate City
 Alternate State/Province
 Alternate ZIP/Postal
 Mailing Address
 Franchise Code
 Total Transaction Amount
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Visa Socio-Economic (Report # R048)

Description
Use this report to review the actual and percentage spend in dollars and number of 
vendors segmented by the various socioeconomic statuses collected by Visa.

Figure 65: Visa Socio-Economic Report

Report Information Includes

 Classification
 Total number of Transactions
 Percent of Transactions
 Total Transaction Amount

 Percent of Total Transaction Amount
 Total Number of Vendors
 Percent of Vendors
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Order
This section displays an example of each of the Order report types available in 
PaymentNet that are related to Single-Use Accounts. A brief description of each 
report’s purpose, a sample report output, and a list of fields included in each report 
are provided for your reference.

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.

This section lists the following Order report samples:
 Order Audit (Report # R049)
 Order Transaction Detail (Report # R050)
 Order Transaction Detail - MS Excel (Report # R050E)
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Order Audit (Report # R049)

Description
Use this report to review any creation or changes made to an existing order over the 
requested period of time. This report is best viewed in PDF format.

Figure 66: Order Audit Report

Report Information Includes

 Change Date
 Change Time
 Order ID
 Interface

 Field Name
 Previous Value
 New Value
 Modified By
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Order Transaction Detail (Report # R050)

Description
Use this report to monitor the transaction for each Single-Use Account against the 
order. Subtotals are provided in the Adobe version showing the total transaction 
amount for each order, as well as a grand total for the entire report. This report is 
best viewed in PDF format.

Figure 67: Order Transaction Detail Report
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Report Information Includes

 Account Number
 Transaction ID
 Order ID
 Post Date
 Transaction Date
 Transaction Amount
 Merchant Name
 Merchant City

 Merchant State/Province
 MCC
 MCC Description
 Currency Code
 Original Amount
 Order ID:
 Sub-Total:
 Grand Total:

Order Transaction Detail - MS Excel (Report # R050E)

Description
Use this report to monitor the transaction for each Single-Use Account against the 
order. Subtotals are provided in the Adobe version showing the total transaction 
amount for each order, as well as a grand total for the entire report. This report is 
best viewed in Excel format.

Figure 68: Order Transaction Detail - MS Excel Report
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Report Information Includes

 Order ID
 Account Number
 Entry Date
 Begin Date
 End Date
 Account Pool Name
 MCC Group
 Order Item Description
 Order Item Unit Price Amount
 Item Quantity
 Order Item Unit Count
 Order Item Amount
 Order Amount
 Order Status
 Order Over Tolerance Percent
 Order Under Tolerance Percent
 Freight Amount
 Requestor Name
 Order Email Recipient Email
 Notes
 Total Matched Transaction Amount
 Order Custom Field Value 1
 Order Custom Field Value 2
 Order Custom Field Value 3
 Order Custom Field Value 4
 Order Custom Field Value 5

 Order Custom Field Value 6
 Order Custom Field Value 7
 Order Custom Field Value 8
 Order Custom Field Value 9
 Order Custom Field Value 10
 Custom Field Value 1
 Custom Field Value 2
 Custom Field Value 3
 Custom Field Value 4
 Custom Field Value 5
 Custom Field Value 6
 Custom Field Value 7
 Custom Field Value 8
 Custom Field Value 9
 Custom Field Value 10
 Order Default Accounting Code Value 1
 Order Default Accounting Code Value 2
 Order Default Accounting Code Value 3
 Order Default Accounting Code Value 4
 Order Default Accounting Code Value 5
 Order Default Accounting Code Value 6
 Order Default Accounting Code Value 7
 Order Default Accounting Code Value 8
 Order Default Accounting Code Value 9
 Order Default Accounting Code Value 10
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Transaction
This section displays an example of each of the Transaction report types available in 
PaymentNet. A brief description of each report’s purpose, a sample report output, 
and a list of fields included in each report are provided for your reference.

Note: A post date range is required when processing most Transaction reports.

 

Note: When additional information is included in the Merchant Name field (e.g., order ID, 
tracking number, P.O. number) of a transaction, J.P. Morgan “normalizes” the 
merchant name by removing the additional information. This is done to prevent a 
unique merchant from being created for every transaction from the merchant 
sending the additional information.
Due to this normalization process, your organization may notice that certain 
merchant names do not match when migrating from a previous version of 
PaymentNet to the current version. This affects merchant data displayed in the user 
interface, reports, and mappers.
You can obtain the Original Merchant name for a merchant name that has been 
normalized by running either a Flex Mapper or a Custom Mapper.
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This topic lists the following Transaction report samples:

 Air Travel Activity (Report # R051)
 Air Travel Activity - MS Excel (Report # R051E)
 Air Travel Summary By Hierarchy (Report # 

R052)
 Air Travel Summary for CTA (Report # R053)
 Airline Ticket Credit Summary (Report # R054)
 Cash Advance Detail by Hierarchy (Report # 

R055)
 Central Bill Reconciliation (Report # R056)
 Central Bill Reconciliation - MS Excel (Report # 

R056E)
 Central Bill Reconciliation Summary (Report # 

R057)
 Central Bill Reconciliation Summary - MS Excel 

(Report # R057E)
 Declines (Report # R058)
 Declines - MS Excel (Report # R058E)
 Diversion Detail by Cardholder (Report # R059)
 Foreign Currency (Report # R060)
 Fuel Purchase Detail Summary (Report # R061)
 Fuel Purchase Detail Summary - MS Excel 

(Report # R061E)
 Level III Temporary Services (Report # R062)
 Fuel Purchase Detail Summary - MS Excel 

(Report # R061E)
 Level III Temporary Services (Report # R062)
 Receipt Imaging Volume (Report # R063)
 Statement of Account (Report # R064)
 T & E Expense Activity by Cardholder (Report # 

R065)
 T & E Transaction Activity (Report # R066)
 T & E Transaction by Industry (Report # R067)
 Transaction Audit (Report # R068)
 Transaction Audit - MS Excel (Report # R068E)
 Transaction Detail (Report # R069)

 Transaction Detail - MS Excel (Report # R069E)
 Transaction Detail by Central Bill Account 

(Report # R070)
 Transaction Detail by Hierarchy (Report # R071)
 Transaction Detail by Parent Merchant (Report # 

R072)
 Transaction Detail with Accounting Codes and 

Notes (Report # R073)
 Transaction Detail with Level III Airline Data 

(Report # R074E)
 Transaction Detail with Level III Car Rental Data 

(Report # R075E)
 Transaction Detail with Level III Data (Report # 

R076E)
 Transaction Detail with Level III Lodging Data 

(Report # R077E)
 Transaction Detail with Level III Purchasing 

Data (Report # R078E)
 Transaction Detail with Page Breaks (Report # 

R079)
 Transaction Detail with Payments (Report # 

R080)
 Transaction Detail with Purchase Addendum 

(Report # R081)
 Transaction Disputes by Hierarchy (Report # 

R082)
 Transaction Summary by Hierarchy (Report # 

R083)
 Transaction Summary by Hierarchy - MS Excel 

(Report # R083E)
 Transaction Summary by Parent Merchant 

(Report # R084)
 Transaction Pending Review/Approval (Report # 

R085)

Air Travel Activity (Report # R051)

Description
Use this report to analyze airline spend by account and hierarchy. This report 
summarizes each airline transaction, including each trip leg. Subtotals are provided 
for each hierarchy and a grand total for the report. This report is best viewed in PDF 
format. 
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Figure 69: Air Travel Activity Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Traveler Name
 Departure Date
 Transaction Date
 Origination

 Destination
 Ticket Number
 Referenced Transaction Amount
 Transaction Amount
 Sub-total
 Grand total
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Air Travel Activity - MS Excel (Report # R051E)

Description
Use this report to analyze airline spend by account and hierarchy. This report 
summarizes each airline transaction, including each trip leg. Subtotals are provided 
for each hierarchy and a grand total for the report. This report is best viewed in 
Excel.

Figure 70: Air Travel Activity Report - MS Excel Report

Report Information Includes

 Last Name
 First Name
 Account Number
 Traveler Name
 Departure Date

 Transaction Date
 Origination
 Destination
 Ticket Number
 Transaction Amount

 

Air Travel Summary By Hierarchy (Report # R052)

Description
Use this report to review the total dollars spent on airline travel for each account 
within each level of the hierarchy. Subtotals are provided for each hierarchy level, 
as well as a grand total for the entire report. This report is best viewed in PDF 
format.
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Figure 71: Air Travel Summary By Hierarchy Report

Report Information Includes

 Account Hierarchy
 Account Number
 Cardholder Last Name
 Cardholder First Name

 Total Transaction Amount
 Sub-total
 Grand total
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Air Travel Summary for CTA (Report # R053)

Description
Use this report to review a consolidated overview of transactions that occur through 
a Central Travel Account (CTA). The report provides passenger name, ticket numbers 
and transaction amount for each purchase. To run this report, you must input a 
central travel account number. This report is best viewed in PDF format. 

Figure 72: Air Travel Summary for CTA Report

Report Information Includes

 Transaction Date
 Merchant Name
 Transaction ID
 Ticket Number
 Traveler Name

 Departure Date
 Transaction Amount
 Sub-total
 Grand total
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Airline Ticket Credit Summary (Report # R054)

Description
Use this report to review credits issued by airlines for purchased tickets. The report 
includes information about the ticket number, passenger name, credit amount and 
travel agent name. This report is best viewed in PDF format.

Figure 73: Air Ticket Credit Summary Report
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Report Information Includes

 Ticket Number
 Departure Date
 Traveler Name
 Merchant Name
 Transaction Date

 Post Date
 Travel Agency
 Credit Transaction Amount
 Grand total

Cash Advance Detail by Hierarchy (Report # R055)

Description
Use this report to analyze the transactions and accounts that have been charged to a 
central bill account. Subtotals are provided for each central bill account, as well as a 
grand total for the entire report. This report is best viewed in PDF format.

Note: Activity diverted to a diversion account is not listed on this report.
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Figure 74: Cash Advance Detail by Hierarchy Report

Report Information Includes

 Transaction Date
 Post Date
 Merchant Name 
 Merchant City
 Merchant State/ Province
 MCC

 Debit Transaction Amount
 Credit Transaction Amount
 Sales Tax
 Sub-total Transactions
 Sub-total Transactions
 Grand total Transaction
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Central Bill Reconciliation (Report # R056)

Description
Use this report to review detailed transaction, account and merchant data for all 
charges to a Central Bill Account (CBA). The Adobe version of the report provides 
subtotals for all CBAs and a grand total for the report. This report is best viewed in 
PDF format.

Note: Activity diverted to a diversion account is not listed on this report.

Figure 75: Central Bill Reconciliation Report
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Report Information Includes

 Transaction Date
 Post Date
 Transaction ID Reference Number
 Merchant Name 
 MCC
 Merchant City
 Merchant State/Province
 Merchant Zip/Postal
 Merchant Country

 Transaction Amount
 Cardholder name
 Billed To Account
 Account Number
 Central Bill Account
 Transactions
 Sub-Total Transactions
 Grand total Transactions

 

Central Bill Reconciliation - MS Excel (Report # R056E)

Description
Use this report to review detailed transaction, account and merchant data for all 
charges to a Central Bill Account (CBA). The Adobe version of the report provides 
subtotals for all CBAs and a grand total for the report. This report is best viewed in 
Excel.

Note: Activity diverted to a diversion account is not listed on this report.

Figure 76: Central Bill Reconciliation - MS Excel Report
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Report Information Includes

 Last Name 
 First Name
 Account Number
 Central Bill Account
 Bill To Account
 Transaction Date
 Post Date
 Transaction ID Reference Number

 Merchant Name 
 MCC
 Merchant City
 Merchant State/Province
 Merchant Zip/Postal
 Merchant Country
 Transaction Amount

 

Central Bill Reconciliation Summary (Report # R057)

Description
Use this report to review the total spend and number of transaction for each account 
linked to a Central Bill Account (CBA). The Adobe version provides totals for each 
CBA number and a grand total for the report. This report is best viewed in PDF 
format. 

Note: Activity diverted to an Account Number is not listed on this report.
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Figure 77: Central Bill Reconciliation Summary Report

Report Information Includes

 Billed to Account
 Cardholder Last Name
 Cardholder  First Name
 Account Number 

 Central Bill Account
 Total Number of Transactions
 Total Transaction Amount
 Grand total
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Central Bill Reconciliation Summary - MS Excel (Report # 
R057E)

Description
Use this report to review the total spend and number of transaction for each account 
linked to a Central Bill Account (CBA). The Adobe version provides totals for each 
CBA number and a grand total for the report. This report is best viewed in Excel.

Figure 78: Central Bill Reconciliation Summary - MS Excel Report

Report Information Includes

 Billed to Account
 Cardholder Last Name
 Cardholder  First Name
 Account Number 

 Central Bill Account
 Total Number of Transactions
 Total Transaction Amount
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Declines (Report # R058)

Description
Use this report to identify occurrences and reasons why cardholder accounts have 
been declined. You can use this information to analyze spend compliance and 
account restriction trends. This report is best viewed in PDF format. 

Note:  In the Declines report, the Decline reason for Decline code E3 is listed as Unknown. 
The correct Decline reason displays on the Authorizations/Declines screen as E3-
Exact Auth-Multi Trans Card Over Limit.
Access the Authorizations/Declines screen to determine the correct Decline reason 
for a transaction.

 

Note:  Single-Use Account declines display on the Declines report, even if the user who runs 
the report does not have access to the Single-Use Account hierarchy.
Add a hierarchy filter to restrict data and ensure that users only see report data for 
their associated hierarchies.
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Figure 79: Declines Report

Report Information Includes

 Last Name 
 First Name
 Account Number
 Decline Amount
 Decline Date
 Time
 Merchant Name

 Merchant City
 Merchant State/Province
 MCC
 Decline reason
 MCC Description
 Sub-Total
 Grand Total
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Declines - MS Excel (Report # R058E)

Description
Use this report to identify occurrences and reasons why cardholder accounts have 
been declined. You can use this information to analyze spend compliance and 
account restriction trends. This report is best viewed in Excel format.

Note:  In the Declines report, the Decline reason for Decline code E3 is listed as Unknown. 
The correct Decline reason displays on the Authorizations/Declines screen as E3-
Exact Auth-Multi Trans Card Over Limit.
Access the Authorizations/Declines screen to determine the correct Decline reason 
for a transaction.

 

Note:  Single-Use Account declines display on the Declines report, even if the user who runs 
the report does not have access to the Single-Use Account hierarchy.
Add a hierarchy filter to restrict data and ensure that users only see report data for 
their associated hierarchies.

Figure 80: Declines - MS Excel Report

Report Information Includes

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Decline Amount
 Decline Reason
 Decline Date

 Time
 Merchant Name
 Merchant City
 Merchant State/Province
 MCC
 MCC Description
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Diversion Detail by Cardholder (Report # R059)

Description
Use this report to analyze the charges to diversion accounts. Subtotals are provided 
for each diversion account, as well as a grand total for the entire report. This report 
is best viewed in PDF format.

Figure 81: Diversion Detail by Cardholder Report

Report Information Includes

 Transaction Date
 Post Date
 Reference Number
 Merchant Name
 MCC
 Merchant City

 Merchant State/Province
 Transaction Amount
 Sub-Total Transactions
 Sub-Total Transactions
 Grand Total Transactions
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Foreign Currency (Report # R060)

Description
Use this report to review transactions that occurred outside of the United States. 
The currency and exchange rate information is also displayed for the transaction. 
Subtotals are provided for each account number as well as a grand total for the 
entire report. This report is best viewed in PDF format.

Figure 82: Foreign Currency Report
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Report Information Includes

 Transaction Date
 Post Date
 MCC
 Merchant Name
 Transaction Amount

 Foreign Amount
 Exchange Rate
 Currency Description
 Sub-Total Transaction
 Grand Total Transactions

 

Fuel Purchase Detail Summary (Report # R061)

Description
Use this report to evaluate fuel purchases. This report is best viewed in PDF format. 
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Figure 83: Fuel Purchase Detail Summary Report

Report Information Includes

 Transaction Date
 Transaction Time
 Last name
 First name
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province
 Odometer
 Fleet ID #

 Purchase Day
 Fuel Service
 Quantity
 Description
 Unit Price
 Sales Tax
 Transaction Amount
 Grand Total
 Cardholders
 Transactions
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Fuel Purchase Detail Summary - MS Excel (Report # 
R061E)

Description
Use this report to evaluate fuel purchases. This report is best viewed in Excel. 

Figure 84: Fuel Purchase Detail Summary MS-Excel Report

Report Information Includes 

 Cardholder Last Name
 Cardholder First Name
 Account Number
 Transaction Date
 Transaction Time
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province

 Transaction Amount
 Odometer
 Fleet ID #
 Purchase Day
 Fuel Service
 Quantity
 Description
 Unit Price
 Sales Tax

Level III Temporary Services (Report # R062)

Description
Use this report to analyze information from temporary services. Total transactions 
are provided for each supervisor as well as a grand total for the entire report. This 
report is best viewed in PDF format.

Note: Although not indicated in the user interface, this report is optimized for Excel.

Make certain to select MS Excel from the Report Format drop-down when running this 
report.
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Figure 85: Level III Temporary Services Report

Report Information Includes

 Transaction ID
 Transaction Date
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province
 Transaction Amount
 Item Count
 Source ID
 Description
 Temporary Name
 Temporary SSN
 Requestor
 Job Code
 Supervisor)

 Message ID
 Customer Code
 Customer Code
 Start Date
 Week Ending
 Hours
 Overtime
 Rate
 Overtime Rate
 Rate Indicator
 Discount
 Sub-Total
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s
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Receipt Imaging Volume (Report # R063)

Description
Use this report to review the total number of receipt image files attached to 
transactions in your organization. It is grouped by hierarchy. A grand total of images 
uploaded, faxed, and overall is also included. This report is best viewed in PDF 
format.

Figure 86: Receipt Imaging Volume Report

Report Information Includes

 Transaction Count
 Total Number of Transactions with Faxed Receipts
 Total Number of Transaction with Uploaded Receipts

 Sub-Total:
 Grand Total:
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Statement of Account (Report # R064)

Description
Use this report to review a listing of the previous cycle transaction information and 
when available; accounting code allocations, transaction notes, custom fields and 
transaction addendum detail. 

The report includes signature lines at the bottom of the statement for the 
cardholder and supervisor to assist in the review and reconciliation process. 

This statement is not an official bank billing statement and cannot be used for 
remittance. This report is best viewed in PDF format.

Figure 87: Statement of Account Report
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Report Information Includes

 Transaction ID
 Transaction Date
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province
 MCC
 Original Amount

 Exchange Rate
 Sales Tax
 Transaction Amount
 Notes:
 Sub-Total: Transaction(s)
 Cardholder Signature Date
 Supervisor/Manager Signature Date

. 

T & E Expense Activity by Cardholder (Report # R065)

Description
Use this report to analyze at the cardholder level, the total and average dollar 
amount spent on each of the following travel and entertainment types: airlines, 
lodging, car, mass transportation, transportation, restaurant, cash, and other. 
Subtotals are provided for each cardholder, as well as a grand total for the entire 
report. This report is best viewed in PDF format.

Note:  The T&E Expense Activity by Cardholder report (# R065) is grouping transactions 
together from different accounts when the users have the same last and first name.
If you would like to see the accounts under unique group headers, run the report for 
each individual account.
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Figure 88: T & E Expense Activity by Cardholder Report

Report Information Includes

 Last Name, First Name
 T & E Type
 Total Number of Transactions

 Total Transaction Amount
 Transaction Average

T & E Transaction Activity (Report # R066)

Description
Use this report to review travel and entertainment transactions which are grouped 
by cardholder. This report is best viewed in PDF format.
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Figure 89: T & E Transaction Activity Report

Report Information Includes

 Transaction Date
 Merchant Name
 Debit Transaction Amount

 Credit Transaction Amount
 Sub-Total:
 Grand Total: Debit(s) 0.00 Credit(s) 0.00
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T & E Transaction by Industry (Report # R067)

Description
Use this report to analyze account usage with each merchant within the following 
travel & entertainment industries: airlines, lodging, car rental, transportation, 
restaurants, cash and other. Subtotals are provided for each type of industry. This 
report is best viewed in PDF format.

Figure 90: T & E Transaction by Industry Report
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Report Information Includes

 T&E Type
 Merchant Name
 Merchant City
 Merchant State/Province

 Total Number of Transactions
 Total Transaction Amount
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)

Transaction Audit (Report # R068)

Description
Use this report to review all transaction changes made over a selected date range. 
This is best viewed in PDF format.

Figure 91: Transaction Audit Report

Report Information Includes

 Transaction ID
 Account Number
 Change Date
 Change Time

 Field Name
 Previous Value
 New Value
 Modified by
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Transaction Audit - MS Excel (Report # R068E)

Description
Use this report to review all transaction changes made over a selected date range. 
This report is best viewed in Excel format.

Figure 92: Transaction Audit - MS Excel Report

Report Information Includes

 Transaction ID
 Account Number
 Change Date
 Change Time

 Field Name
 Previous Value
 New Value
 Modified by

 

Transaction Detail (Report # R069)

Description
Use this report to review the purchases for each account. Transactions as well as line 
items are included. Payments are excluded from this report. Subtotals are provided 
for each cardholder and central bill account, as well as a grand total for the entire 
report. This is best viewed in PDF format.
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Figure 93: Transaction Detail Report

Report Information Includes

 Transaction ID
 Transaction Date
 Transaction Amount
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province

 MCC
 Debit Amount
 Credit Amount 
 Sales Tax
 Transaction Type
 Sub-Total: Transaction(s) 0.00 0.00 0.00
 Grand Total: Transaction(s) 0.00 0.00 0.00

 

Transaction Detail - MS Excel (Report # R069E)

Description 
Use this report to review the purchases for each account. Transactions as well as line 
items are included. Payments are excluded from this report. Subtotals are provided 
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for each cardholder and central bill account, as well as a grand total for the entire 
report. This is best viewed in Excel format. 

Note: The Customer Code field in the Transaction Detail - MS Excel report is blank even 
though a Customer Code exists in the transaction details.
Use the Transaction Details screen to view the Customer Code information.

 

Note: Depending on the assigned PaymentNet user role, The Transaction Detail - MS Excel 
report is inconsistently returning no data; at times, the report contains data and at 
other times it is blank.
Users can run the Transaction Detail - MS Excel report for a specific hierarchy, 
without including children, to obtain a report with data. For users assigned to the 
Program Administrator role, run the report at the ROOT level and select the Include 
Children option to obtain a report with data.

 

Figure 94: Transaction Detail - MS Excel Report
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Report Information Includes

 Transaction ID
 Transaction Date
 Post Date
 Transaction Amount
 Account Number
 Cardholder Last Name
 Cardholder First Name
 Cardholder Middle Initial
 Central Bill Account
 Billed To Account
 Diversion Account
 Parent Merchant Name
 Merchant Name
 MCC
 MCC Description
 Merchant Address 1
 Merchant Address 2
 Merchant City
 Merchant State/Province
 Merchant Country
 Merchant Postal Code
 Transaction Code
 Transaction Code Reason Code
 Sales Tax
 Settled Currency
 Original Currency
 Original Amount
 Exchange Rate
 Item Description
 Item Unit Price Amount
 Item Quantity
 Item Detail Tax Amount
 Line Item Total
 Chart of Accounts 
 Transaction Item COA Segment Value 1
 Transaction Item COA Segment Value 2
 Transaction Item COA Segment Value 3
 Transaction Item COA Segment Value 4
 Transaction Item COA Segment Value 5
 Transaction Item COA Segment Value 6

 Transaction Item COA Segment Value 7
 Transaction Item COA Segment Value 8
 Transaction Item COA Segment Value 9
 Transaction Item COA Segment Value 10
 Hierarchy ID
 Hierarchy Description
 Reference Number
 Transaction Convenience Check Number
 Transaction Authorization Number
 Customer Code
 Transaction Type
 Dispute Indicator
 Dispute Status
 Transaction Export Status Code
 Transaction Approval Status
 Approval Indicator 1
 Transaction Approver Name 1
 Approval Indicator 2
 Transaction Approver Name 2
 Approval Indicator 3
 Transaction Approver Name 3
 Approval Indicator 4
 Transaction Approver Name 4
 Approval Indicator 5
 Transaction Approver Name 5
 Custom Field Value1
 Custom Field Value 2
 Custom Field Value 3
 Custom Field Value4
 Custom Field Value 5
 Custom Field Value 6
 Custom Field Value 7
 Custom Field Value 8
 Custom Field Value 9
 Custom Field Value 10
 Transaction Notes
 Order ID
 Order Status
 Requestor

Transaction Detail by Central Bill Account (Report # R070)

Description
Use this report to review the transactions and accounts that have been charged to 
central bill accounts. Subtotals are provided for each cardholder and central bill 
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account, as well as a grand total for the entire report. This report is best viewed in 
PDF format.

Figure 95: Transaction Detail By Central Bill Account Report

Report Information Includes

 Transaction Date
 Post Date
 Reference Number
 Transaction ID
 Merchant Name
 MCC
 Merchant City

 Merchant State/Province
 Transaction Amount
 Transaction Type
 Sub-Total: Transaction(s) 0.00
 Sub-Total: Transaction(s) 0.00
 Grand Total: Transaction(s) 0.00

 

Transaction Detail by Hierarchy (Report # R071)

Description
Use this report to review the number of transactions and total dollar amount for 
each account and hierarchy level. Transactions as well as line items are included and 
payments are excluded from this report. Subtotals are provided for each account 
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hierarchy and account number, as well as a grand total for the entire report. This 
report is best viewed in PDF format.

Figure 96: Transaction Detail by Hierarchy Report

Report Information Includes

 Transaction ID
 Transaction Date
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province
 MCC

 Debit Amount
 Credit Amount 
 Sales Tax
 Transaction Type
 Sub-Total: Transaction(s) 0.00 0.00 0.00
 Sub-Total: Transaction(s) 0.00 0.00 0.00
 Grand Total: Transaction(s) 0.00 0.00 0.00

 

Transaction Detail by Parent Merchant (Report # R072)

Description
Use this report to review the transactions and dollar amounts spent for each parent 
merchant. This report is best viewed in PDF format.
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Figure 97: Transaction Detail by Parent Merchant Report

Report Information Includes

 Merchant Name
 Merchant City
 Merchant State/Province
 Merchant ZIP/Postal
 MCC
 Transaction Amount
 Reference Number

 Transaction ID
 Last Name
 First Name
 Transaction Date
 Post Date
 Sub-Total: Transaction(s)
 Grand Total: Transaction(s)
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Transaction Detail with Accounting Codes and Notes 
(Report # R073)

Description
Use this report to review transactions with their account codes, notes and custom 
fields. Transactions as well as line items are included. Payments are excluded from 
this report. This report is best viewed in PDF format. 

Note: Although not indicated in the user interface, this report is optimized for Excel.

Make certain to select MS Excel from the Report Format drop-down when running this 
report.

 

Note: The Transaction Detail with Accounting Codes and Notes report is not displaying the 
information in the requested order sequence (ascending/descending).
Use a spreadsheet program, such as Microsoft Excel to manually sort the report as 
needed.

 

Note:  Custom fields within the Transaction Detail with Accounting Codes and Notes report 
(#R073)are sorted inconsistently from transaction to transaction. The report sorts 
custom fields by the custom field value in each transaction. Therefore, two 
transactions with the same custom fields might display in different orders based on 
the supplied values. Although the custom fields may display in a different order, the 
data in the custom fields is correct.
Use the Transaction Detail - MS Excel Report (#R069E) to view custom fields in the 
correct order.
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Figure 98: Transaction Detail with Accounting Codes and Notes Report

Report Information Includes

 Transaction ID
 Last Name
 First Name
 Account Number
 Transaction Date
 Post Date
 Merchant Name

 Merchant City
 Merchant State/Province
 MCC
 Sales Tax
 Transaction Amount
 Transaction Type
 Grand Total: Transaction(s) 0.00 0.00

 

Transaction Detail with Level III Airline Data (Report # 
R074E)

Description
Use this report to review transaction details and the associated airline addendum 
data (Level III). When viewing Level III airline data, columns for all Level III airline 
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data is visible but data is only populated for the addendum information provided by 
the processor. This report is best viewed in Excel.

Figure 99: Transaction Detail with Level III Airline Data Report

Report Information Includes

 Hierarchy Level
 Hierarchy ID
 Hierarchy Description
 Account Number
 Account Type
 Cardholder First Name
 Cardholder Middle Name
 Cardholder Last Name
 Account Balance
 Account Opened Date
 Account Closed Date
 Diversion Account Number
 PaymentNet Transaction ID
 Transaction Date
 Transaction Posting Date
 Transaction Amount
 Transaction Sales Tax Amount
 Transaction Original Amount
 Transaction Currency Code
 Transaction Code
 Transaction Reason Code
 Transaction Code Description
 Merchant PaymentNet ID
 Merchant Tax Payer ID
 Merchant Name
 Merchant Street Address
 Merchant City Name
 Merchant State
 Merchant Postal Code
 Merchant Country
 MCC 
 MCC Description
 MCC Type 
 T & E Type

 Transaction Addendum Indicator
 Passenger Name
 Ticket Number
  Exchange Ticket Number
 Exchange Ticket Amount
 Total Fare Amount
 Total Tax Amount
 Total Fee Amount
 Internet Indicator
 Electronic Ticket Indicator
 Travel Agency Code
 Travel Agency Name
 Agency Code
 Departure Date
 Arrival Date
 Carrier Code
 Carrier Code Description
 Flight Number
 Leg Number
 Originating City Code
 Destination City Code
 Fare Basis Code
 Conjunction Ticket Number
 Transaction Flags
 Transaction Authorization Number
 Transaction Check Number
 Transaction Customer Code
 Source Currency Exchange Rate
 US Dollar Currency Exchange Rate
 Interchange Fee Amount
 Transaction Created Date
 Transaction Addendum Type
 Transaction Approval Status ID
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Transaction Detail with Level III Car Rental Data (Report # 
R075E)

Description
Use this report to review transaction details and the associated car rental addendum 
data (Level III). When viewing Level III car rental data, columns for all Level III car 
rental data are visible but data is only populated for the addendum information 
provided by the processor. This report is best viewed in Excel.

Figure 100: Transaction Detail with Level III Car Rental Data Report
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Report Information Includes

 Hierarchy Level
 Hierarchy Name
 Hierarchy Description
 Account Number
 Account Type
 Cardholder First Name
 Cardholder Middle Name
 Cardholder Last Name
 Account Balance
 Account Opened Date
 Account Closed Date
 Diversion Account Number
 PaymentNet Transaction ID
 Transaction Date
 Transaction Posting Date
 Transaction Amount
 Transaction Sales Tax Amount
 Transaction Original Amount
 Transaction Currency Code
 Transaction Code
 Transaction Reason Code
 Transaction Code Description
 Merchant PaymentNet ID
 Merchant Tax Payer ID
 Merchant Name
 Merchant Street Address
 Merchant City Name
 Merchant State
 Merchant Postal Code
 Merchant Country
 MCC 
 MCC Description
 MCC Type 
 T & E Type
 Transaction Addendum Indicator
 Agreement Number
 Renter Name
 Return City Name

 Return State Code
 Return Date
 Return Location Text
 Customer Service Number
 Class Code
 Daily Rate
 Weekly Rate
 Mileage Rate
 Total Miles Number
 Maximum Free Miles Number
 Insurance Amount
 Adjustment Amount
 Program Code
 Check Out Date
 Tax Amount
 Tax Rate
 Tax Type Code
 Tax Rate Exponent Number
 Days Rented Count
 No Show Indicator
 Extra Amount
 Fuel Amount
 One Way Amount
 Towing Amount
 Extended Mileage Amount
 Late Return Amount
 Value Added Tax Amount
 Phone Amount
 Other Charge Amount
 Transaction Authorization Number
 Transaction Check Number
 Transaction Customer Code
 Source Currency Exchange Rate
 US Dollar Currency Exchange Rate
 Interchange Fee Amount
 Transaction Created Date
 Transaction Addendum Type
 Transaction Approval Status ID

 

Transaction Detail with Level III Data (Report # R076E)

Description
Use this report to monitor the purchases for each account. Transactions as well as 
line items are included and payments are excluded from this report. Subtotals are 
provided for each cardholder and central bill account, as well as a grand total for 
the entire report. This report is best viewed in Excel.
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Due to the large amount of information, this report is best viewed in Excel format. It 
is not suggested to run a PDF format.

Note: Although not indicated in the user interface, this report is optimized for Excel.

Make certain to select MS Excel from the Report Format drop-down when running this 
report.

 

Figure 101: Transaction Detail with Level III Data Report

Report Information Includes

 Last Name
 First Name
 Account
 Transaction ID
 Transaction Date
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province
 MCC
 Debit Amount
 Credit Amount
 Sales Tax Transaction Type
 Level III Detail Type
 Additional Order Date
 Business To Business Cost 

Center Number
 Business To Business Net 

Amount
 Business To Business 

Payment Method Code
 Business To Business 

Reimbursement Fee Amount

 Business To Business 
Settlements Days CountCountry

 Customer Code
 Duty Amount
 Freight AmountItem 

Commodity Text
 Purchasing Item Detail Tax Rate
 Item Detail Tax Type Code
 Item Detail Tax Type Text
 Item Product Code
 Item Unit of Measure
 Item Value Added Tax Amount
 Item Value Added Tax Rate
 Merchant Reference Number
 Order Date
 Purchase Timestamp
 Source Postal Code
 Tax Collection Indicator
 Tax Included Code
 Value Added Tax Invoice 

Number
 Ticket Number
 Exchange Ticket Amount
 Exchange Ticket Number

 Total Fare Amount
 Total Fee Amount
 Travel Agency Code
 Travel Agency Name
 Agency Code
 Passenger Name
 Internet Indicator
 Airline Electronic Ticket 

Indicator
 Carrier Code
 Carrier Code Description
 Originating Airline City Code
 Destination Airline City Code
 Item Stop Over Code
 Item Fare Basis Code
 Item Leg Number
 Item Coupon Number
 Item Conjunction
 Ticket Number
 Item Flight Number
 Item Departure Date
 Item Arrival Date
 Arrival Date
 Bill Adjustment Amount
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 Business Center Charge
 Amount Card
 Government Identification 

Number
 Customer Service Telephone 

Number
 Departure Date
 Extra Charge Type Code
 Folio Advances
 Amount Folio Number
 Food Charges Amount
 Gift Shop Charge Amount
 Health Club Charge Amount
 Lodging Laundry Charge 

Amount
 Length of Stay Duration
 Minibar Charge Amount
 Movie Charge Amount
 Other Service Code
 Phone Charge Amount
 Prepaid Amount
 Property Telephone Number
 Restaurant Room Service 

Amount
 Room Rate
 Room Tax Amount
 Sending Interbank Card 

Association Number
 Tax Exponent Number
 Total Non Room Charge 

Amount
 Valet Parking Charge Amount
 Valet Parking Charge Amount
 Adjustment Amount
 Agreement Number
 Checkout Date
 Class Code
 Customer Service Number
 Daily Rate
 Daily Rate
 Extended Mileage Amount
 Extra Amount
 Fuel Amount
 Insurance Amount
 Late Return Amount
 Car Rental Maximum Free 

Miles Number

 Weekly Rate
 Alternate Tax Indicator Text
 City Motor Tax Amount
 Company Vehicle Number
 County Motor Tax Amount
 Coupon Discount Amount
 Customer Criteria Text
 Detail Tax Rate Exponent 

Number
 Detail Type Code
 Discount Rate
 Driver Number
 Extended Item Amount
 Federal Excise Tax Amount
 Fuel Brand
 Gross Price Amount
 Item
 Alternate Tax Indicator
 Item Applicable Tax Text
 Item Detail Tax Type Indicator
 Item Discount Indicator
 Item Effective Date
 Item Extended Item Amount
 Item Gross
 Non-Fuel Amount
 Item Line
 Item Date
 Item Line
 Item Order Date
 Item Commodity Code
 Item
 Line Item Total Amount
 Item Local Tax
 Include Indicator
 Item Message Text
 Item Net Gross Indicator
 Fleet Item Net Non-Fuel 

Amount
 Item Product 1 Code
 Item Product 2 Code
 Item Product 3 Code
 Item Product 4 Code
 Item Product 5 Code
 Item Product 6 Code
 Item Product 7 Code
 Item Product 8 Code

 Odometer Reading Number
 Product Code (description)
 Product Identifier
 Purchase Date
 Purchase Type Code
 Sale Amount
 Service Code
 State Motor Tax Amount
 Tax Debit Credit Indicator
 Tax Exempt Amount
 Unit Cost Amount
 Unit Price Amount Value 

Added Tax Type Code
 Courier Name
 Customer Reference Number
 Delivery Date
 Descriptor Code
 Destination Contact Name
 Incentive Amount
 Net Amount
 Shipping Services Origination 

Contact Name
 Origination Postal Code
 Package Quantity
 Pickup Date
 Purchase IdentifierText
 Purchase IdentifierText
 Sender Name
 Shipping Amount
 Tracking Number
 Weight
 Quantity
 Cost Center Number
 Employee Government 

identification Number
 Employee Government 

Identification Type identifier
 End Date
 Flat Rate Indicator
 Job Code
 Job Description
 Message Identifier Text
 Miscellaneous Expense 

Amount
 Occurs Sequence Number
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Report Samples
Transaction Detail with Level III Lodging Data (Report # 
R077E)

Description
Use this report to review transaction details and the associated lodging addendum 
data (Level III). When viewing Level III lodging data, columns for all Level III lodging 
data are visible but data is only populated for the addendum information provided 
by the processor. This report is best viewed in Excel.

 Mileage Rate
 One Way Amount
 Phone Amount
 Regular Mileage Amount
 Renter Name
 Return City Name
 Return Date
 Return Location Text
 Return State Code
 Total Miles Number
 Towing Amount

 Quantity
 Item Shipping Tax Rate
 Item Tax Amount
 Item Tax Rate
 Item Tax Type Code
 Miscellaneous Exemption 

Indicator
 Miscellaneous Non Fuel Tax 

Amount
 Net Fuel Price Amount
 Net Gross Indicator
 Net Non Fuel Price Amount

 Original Message Format 
Code

 Temporary Services Overtime 
Hours Quantity

 Overtime Rate
 Purchase Identification Text
 Rate
 Regular Hours Quantity
 Regular Hours Rate
 Requestor Name
 Start Date
 Subtotal Amount
 Supervisor Name

 Tax Type Applied Code
 Temporary Employee Name
 Time Sheet Number
 Total Tax
 Collected Indicator
 Acceptor Government 

Identification Number
 Commodity Code
 Customer Value Added Tax 

Registration Number
 Description
 Destination Postal Code
 Detail Tax Amount
 Detail Tax Rate
 Detail Tax Type Code
 Discount Amount

 Item Amount
 Item Description
 Item Detail Tax Amount
 Item Discount Amount
 Item Discount Rate
 Item Quantity
 Item Sequence Number
 Item Total Amount
 Item Unit of Measure Text
 Common Fields Item Unit Price 

Amount
 Local Tax Amount
 Merchant Value Added Tax 

Registration Number Message 
Text

 National Tax Amount
 No Show Indicator
 Other Charge Amount
 Other Tax Amount
 Program Code
 Sequence Number
 Source Code
 Tax Amount
 Tax Rate
 Tax Rate Exponent
 NumberTax Type Code
 Total Tax Amount
 Unit of Measure Text
 Value Added Tax Amount
 Value Added Tax Rate
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Figure 102: Transaction Detail with Level III Lodging Data Report

Report Information Includes

 Hierarchy Level
 Hierarchy ID
 Hierarchy Description
 Account Number
 Account Type
 Cardholder First Name
 Cardholder Middle Name
 Cardholder Last Name
 Account Balance
 Open Date
 Closed Date
 Diversion Account
 Transaction ID
 Transaction Date
 Post Date
 Transaction Amount
 Sales Tax
 Original Amount
 Currency Code
 Transaction Code
 Transaction Reason Code
 Transaction Code Description
 Merchant ID
 TaxPayer ID
 Merchant Name
 Merchant Address
 Merchant City
 Merchant State
 Merchant Zip/Postal
 Merchant Country
 MCC
 MCC Description
 MCC Type
 Transaction Addendum Indicator
 T & E Type
 Arrival Date

 Departure Date
 Folio Number
 Property Telephone Number
 Customer Service Telephone Number
 Room Rate
 Room Tax
 Program Code
 Phone Charge Amount
 Restaurant Room Service Amount
 Minibar Charge Amount
 Gift Shop Charge Amount
 Laundry Charge Amount
 Other Service Code
 Other Charge Amount
 Bill Adjustment Amount
 No Show Indicator
 Tax Amount
 Food Charges Amount
 Length of Stay Duration
 Prepaid Amount
 Folio Advances Amount
 Valet Parking Charge Amount
 Movie Charge Amount
 Business Center Charge Amount
 Health Club Charge Amount
 Total Non Room Charge Amount
 Transaction Authorization Number
 Transaction Check Number
 Customer Code
 Source Currency Exchange Rate
 Exchange Rate
 Interchange Fee Amount
 Transaction Created Date
 Transaction Addendum Type
 Transaction Approval Status
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Report Samples
Transaction Detail with Level III Purchasing Data (Report 
# R078E)

Description
Use this report to review transaction details and the associated purchasing 
addendum data (Level III). When viewing Level III purchasing data, columns for all 
Level III purchasing data are visible but data is only populated for the addendum 
information provided by the processor. This report is best viewed in Excel.

Figure 103: Transaction Detail with Level III Purchasing Data Report
491



b | Reporting Reference

492
Report Information Includes

 Hierarchy Level
 Hierarchy Name
 Hierarchy Description
 Account Number
 Account Type
 Cardholder First Name
 Cardholder Middle Name
 Cardholder Last Name
 Account Balance
 Account Opened Date
 Account Closed Date
 Diversion Account Number
 PaymentNet Transaction ID
 Transaction Date
 Transaction Posting Date
 Transaction Amount
 Transaction Sales Tax Amount
 Transaction Original Amount
 Transaction Currency Code
 Transaction Code
 Transaction Reason Code
 Transaction Code Description
 Merchant PaymentNet ID
 Merchant Tax Payer ID
 Merchant Name
 Merchant Street Address
 Merchant City
 Merchant State
 Merchant Postal Code
 Merchant Country
 MCC
 MCC Description
 MCC Type
 Transaction Addendum 

Indicator

 Customer Code
 Tax Amount
 Freight Amount
 Destination Postal Code
 Source Postal Code
 Merchant Reference Number
 Detail Tax Amount
 Detail Tax Rate
 Detail Tax Type
 Duty Amount
 Line Item Sequence Number
 Item Product Code
 Item Description
 Item Quantity
 Item Unit of Measure
 Item Amount
 Item Discount Amount
 Item Discount Rate
 Item Total Amount
 Item Unit Price Amount
 Item Detail Tax Amount
 Item Detail Tax Rate
 Item Detail Tax Type
 Local Tax Amount
 Tax Included Code
 National Tax Amount
 Merchant Value Added Tax 

Registration Number
 Customer Value Added Tax 

Registration Number
 Commodity Code
 Other Tax Amount
 Discount Amount
 Value Added Tax Invoice 

Number

 Order Date
 Value Added Tax Amount
 Value Added Tax Rate
 Purchase Timestamp
 Additional Order Date
 Business to Business Payment 

Method Code
 Business to Business 

Reimbursement Fee Amount
 Currency Identifier
 Business to Business 

Settlement Days Count
 Business to Business Net 

Amount
 Business to Business Cost 

Center
 Item Commodity Text
 Item Value Added Tax 

Amount
 Item Value Added Tax Rate
 Transaction Authorization 

Number
 Transaction Check Number
 Transaction Customer Code
 Source Currency Exchange 

Rate
 US Dollar Currency Exchange 

Rate
 Interchange Fee Amount
 Transaction Created Date
 Transaction Addendum Type
 Transaction Approval Status 

ID

 

Transaction Detail with Page Breaks (Report # R079)

Description
Use this report to review all the purchases made for each account. Since each 
account’s activity is detailed on a separate page, this report can be printed and 
given to cardholders that do not have access to PaymentNet to review their 
transactions. Transactions as well as line items are included. Payments are excluded 
from this report. This report is best viewed in PDF format.
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Report Samples
Figure 104: Transaction Detail with Page Breaks Report

Report Information Includes

 Transaction ID
 Transaction Date
 Post Date
 Merchant Name
 Merchant City
 Merchant State/Province

 MCC
 Debit Amount
 Credit Amount
 Sales Tax
 Transaction Type
 Sub-Total: Transaction(s) 0.00 0.00 0.00
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Transaction Detail with Payments (Report # R080)

Description
Use this report to review the purchases and payments for each account. This report 
is best viewed in PDF format.

Note: Although not indicated in the user interface, this report is optimized for Excel.

Make certain to select MS Excel from the Report Format drop-down when running this 
report.

Figure 105: Transaction Detail with Payments Report
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Report Samples
Report Information Includes

 Transaction Date
 Post Date
 Transaction Amount
 Merchant Name
 Merchant City

 Merchant State/Province
 MCC
 Sub-Total: Transaction(s) 0.00
 Grand Total: Transaction(s) 0.00

Transaction Detail with Purchase Addendum (Report # 
R081)

Description
Use this report to review those transactions with purchasing addendum. The report 
groups the transactions by cardholder. This report is best viewed in PDF format.

Note: Although not indicated in the user interface, this report is optimized for Excel.

Make certain to select MS Excel from the Report Format drop-down when running this 
report.
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Figure 106: Transaction Detail with Purchase Addendum Report

Report Information Includes

 Transaction Date
 Post Date
 Transaction ID
 Merchant Name
 Merchant City
 Merchant State/Province

 MCC
 Debit Amount
 Credit Amount
 Sales Tax
 Sub-Total: Transaction(s) 0.00 0.00 0.00
 Grand Total: Transaction(s) 0.00 0.00 0.00
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Report Samples
Transaction Disputes by Hierarchy (Report # R082)

Description
Use this report to analyze the status of disputed transactions. This report is best 
viewed in PDF format.

Figure 107: Transaction Disputes by Hierarchy Report

Report Information Includes

 Last Name
 First Name
 Account Number
 Transaction ID
 Merchant Name
 Transaction Date

 Transaction Amount
 Date Disputed
 Date Resolved
 Dispute Status
 Sub-Total:
 Grand Total:

Note: For HP® Enterprise Services (HP) processor clients, the Transaction Dispute report 
may display incorrect dispute reasons. In addition, the report may not list all 
disputed transactions.
Contact a J.P. Morgan program coordinator if you have questions regarding a specific 
dispute.
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Transaction Summary by Hierarchy (Report # R083)

Description
Use this report to review the number of transactions and total dollar amount for 
each account by hierarchy. This report is best viewed in PDF format.

Figure 108: Transaction Summary by Hierarchy Report

Report Information Includes

 Account Number
 Last Name
 First Name
 Number of Debits
 Debit Transaction Amount
 Number of Credits

 Credit Transaction Amount
 Total Number of Transactions
 Total Transaction Amount
 Sub-Total: 0.00 0.00 Transaction(s) 0.00
 Grand Total: 0.00 0.00 Transaction(s) 0.00
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Report Samples
Transaction Summary by Hierarchy - MS Excel (Report # 
R083E)

Description
Use this report to review the number of transactions and total dollar amount for 
each account by hierarchy. This report is best viewed in Excel.

Figure 109: Transaction Summary by Hierarchy - MS Excel Report

Report Information Includes

 Account Hierarchy
 Account Number
 Last Name
 First Name
 Number of Debits

 Debit Transaction Amount
 Number of Credits
 Credit Transaction Amount
 Total Number of Transactions
 Total Transaction Amount

Transaction Summary by Parent Merchant (Report # R084)

Description
Use this report to review the number of transactions and total dollar amount for 
each parent merchant. This report is best viewed in PDF format.
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Figure 110: Transaction Summary by Parent Merchant Report

Report Information Includes

 Parent Merchant Name
 Number of Debits
 Debit Transaction Amount
 Number of Credits

 Credit Transaction Amount
 Total Number of Transactions
 Total Transaction Amount
 Grand Total: 0.00 0.00 Transaction(s) 0.00

Transaction Pending Review/Approval (Report # R085)

Description
Use this report to analyze transactions that need to be reviewed or approved. The 
report shows transaction information as well as those who are responsible for 
marking the transactions reviewed or approved. The report will display both types of 
transactions by default. 
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Report Samples
Due to the large amount of information, this report is best viewed in Excel format. It 
is not suggested to run a PDF format. 

Note: The criteria must be set to include either new transactions, reviewed transactions, or 
in-process transactions. A value of “R” in the report type field displays transactions 
needing to be reviewed only; a value of “A” in the report type displays transactions 
that have been reviewed, but not approved.

 

Note: The Transactions Pending Review/Approval report is incorrectly excluding exported 
transactions.

Figure 111: Transaction Pending Review/Approval Report 
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Report Information Includes

 Last Name
 First Name
 Account Number
 Approval Status
 Merchant Name
 Post Date

 Transaction Amount
 Transaction Assigned To
 Transaction ID
 Transaction Date
 Date Assigned

 

Standard File Options
If after running a flex mapper you still require data beyond the scope of a flex 
mapper, then review the Standard File Options table to locate the file layout that 
best meets your needs. 

See Table 19: “Summary of Available Standard File Options” on page 503 for a list of 
the file names, card programs support, output format, deliver options, the data you 
can export for each file, and a description of the type of data it includes.

After you choose a standard file, contact your J.P. Morgan representative for more 
information.

The columns in the Standard File Options table are:

File number
Each file has a unique number. This makes it easier to reference when 
communicating with users and J.P. Morgan representatives.

File name
The name of the standard data integration file used to extract new or modified 
cardholder data from PaymentNet.

Short name
The abbreviation of the file name. 

Card program
Sort by purchase card, Single-Use Account, and travel & entertainment.

Format
Each standard file is typically designed for fixed width, tab delimited, and XML.

Delivery options
The method you can use to transmit the file via email, H2H, and PaymentNet.
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Report Samples
Transaction, Account, Hierarchy, Chart of accounts, Custom fields, and Level 
III data
A yes or no in each of these columns indicates if the file includes that data.

Description
A brief explanation highlighting key aspects of the standard file data.

Table 19: Summary of Available Standard File Options 
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ABA Routing Number
The American Bankers Association (ABA) routing number is a nine digit bank code 
used in the United States. The routing number identifies the financial institution on 
which the check was drawn. It displays on the bottom of checks.

Account Pool
A pool of Single-Use Account numbers assigned to a specific hierarchy node within an 
organization. Only one Account Pool is allowed per hierarchy node, and consists of at 
least one Account Pool Group. It will always contain an Account Pool Group; a 
grouping of Single-Use Accounts with identical defaulted controls, for example, 
credit limit, daily transaction limit.

Account Pool Group
Within each account pool there is at least one Account Pool Group. It consists of 
groupings of Single-Use Accounts with identical defaulted controls such as credit 
limit. When a Single-Use Account is requested, the account is provided from the 
appropriate Account Pool Group, specifically from the group with a credit limit that 
is nearest to, but higher than the requested credit limit. This ensures that the 
account number can be used by the merchant even if there is an error that prevents 
the account from immediately being updated with the requested account controls.

Account Request Manager (ARM)
A tool that works with PaymentNet designed to assist in automating the end-to-end 
account creation and approval process. Using ARM, users enter application 
information directly into PaymentNet. The application information is then routed to 
the applicant's manager for review and approval. Once approved, the final 
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application is sent to the program administrator, who will then finalize the process 
and request a card for the cardholder.

Accounting Codes
A set of numbers, letters, or alphanumeric values that determine internal 
companies, departments, divisions, and general ledger account codes for a company. 
Accounting codes are comprised of a value (e.g., 12345) and an alpha description 
(e.g., Marketing). They can be assigned or allocated to transactions in order to track 
spending at the codes to which they are assigned. PaymentNet has a custom 
accounting code system that can imitate your existing system with accounting code 
segments that you define. Accounting codes can be defaulted to new transactions 
based on set criteria which will help facilitate the allocation and approval process.

Accounts
An individual credit card account that contains a record of financial transactions. 
The account contains the card account profile, including current balance, available 
credit, hierarchy ID, credit limit, and address information.

ACH
See Automated Clearinghouse (ACH).

Addendum (Icon)
A small icon on the left of transactions on the Transaction List screen, alerting 
cardholders that a merchant has passed enhanced transaction detail. Cardholders 
may view the transaction data by clicking the Addendum icon.

Adding Lines
The process of splitting a transaction into multiple parts and then being able to 
allocate it to different accounting code values. See Splits.

Administration Module
The main menu item for program administrators, used to configure PaymentNet 
functionality for their organization. This includes menu settings for hierarchy and its 
related features, chart of accounts, cycles, mappers, custom fields, customer code 
defaults, report setup, role setup, merchants, merchant category codes, merchant 
category code groups, and aggregator list.

Approval Rules
A hierarchy setting to designate the number of review and approval checkboxes as 
part of the approval workflow for posted transactions. This approval workflow is 
typically done between the cardholder, who reviews the transaction, and their 
manager, who approves it. It can also include additional approval levels when 
transactions that exceed a specific amount. Users who have authority to approve 
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transactions can elect to receive email notification of transactions awaiting their 
approval. PaymentNet offers unlimited approval levels to promote accountability at 
various stages.

Authorization
The state of a credit card transaction when it is between the point that it was 
approved at the point-of-sale by the merchant, but not yet posted to the credit card 
account of the cardholder. The exchange of goods or services has already occurred 
between the merchant and the cardholder, but the merchant does not receive 
payment until they submit the authorization for payment or post the transaction. 
The authorization date is known as the Transaction Date in PaymentNet.

Automated Clearinghouse (ACH)
A secure electronic payment transfer system that connects all U.S. financial 
institutions. Acts as the central clearing facility for all Electronic Fund Transfer (EFT) 
transactions that occur nationwide, representing a crucial link in the national 
banking system. This system makes direct deposit, many bank transfers, and various 
online bill payments possible. J.P. Morgan has developed several payment options, 
including online through PaymentNet via ACH.

Banner Message
See Greeting.

Billing Cycle
The period of time between billings based on the accounting needs of an 
organization. The cycle typically occurs 12 times a year for each client. Program 
administrators can select which day they would like to cycle each month (e.g. last 
business day of each month). Cycles can impact mappers and customized reports.

Card Verification Codes
A three- or four- digit security code that is printed on the back of debit and credit 
cards. This helps validate that a genuine card is used during a transaction, especially 
in situations like mail orders, telephone orders or Internet orders where the card is 
not present. Also called Card Verification Value (CVV) or Card ID (CID).

Card Verification Value
See Card Verification Codes.

Category Code
See Merchant Category Code (MCC).
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Central Bill
The consolidated billing statement issued for any of the credit cards that are 
attached to the central bill. It reflects the organization’s card accounts and the 
posted totals during the billing cycle. This allows organizations to make a single 
payment for multiple individual card accounts. 

Central Bill Account Request
A request form that program administrators must complete and submit in order to 
create a central bill account. The form goes to J.P. Morgan for processing.

Certificate
See Digital Certificate.

Chart of Accounts (COA)
A predefined accounting system in an organization that is compatible with its 
particular financial structure, and in agreement with the amount of detail required 
in its financial statements. It is made up of segments or groups whereby a user can 
only enter specific accounting code values. A COA is the structure of the accounting 
codes, and accounting codes are the actual values. During implementation, an 
organization’s chart of accounts can be loaded into PaymentNet to contain the 
general ledger accounts, cost centers, and any other required fields. See Accounting 
Codes.

Children
Children are entities in a hierarchy which is a defined structure of parent and child 
entities. Multiple children can report up or roll-up to a parent and, in turn, parents 
can roll-up and report to a parent above them. There is no limit to the number of 
children hierarchies.

Comma-Separated Values
A simple file format to move tabular data (numbers and text) between programs that 
operate on proprietary formats.

Company Number
A unique number that is assigned to you by J.P. Morgan from the credit card 
processor. Also referred to as Bank Corp.

Compliance Monitoring
Functionality to track and monitor cardholder transactions by ensuring that 
cardholder transactions adhere to an organization’s card policy. It includes the 
ability to flag transactions when they are split by the merchant, exceed certain 
spending thresholds, or used at questionable merchants or types of merchants. This 
monitoring allows organizations to closely track cardholder transactions.
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Constraint
The link that a program administrator makes between specific charts of accounts 
and users. Constraints allow an organization to limit the chart of account values a 
user can assign based on their hierarchy, role, account, or User ID. Constraints also 
allow users to have access to the accounting code values they need, but restrict 
access to accounting code values that outside of their scope of view.

Convenience Check
A check linked to the cardholder’s credit limit; it can be made in any amount, as 
long as it does not surpass a cardholder’s credit limit. Program administrators can 
give cardholders the option to manage their convenience checks, including allowing 
cardholders to order convenience checks and stopping payments on existing 
convenience checks.

Cost Center
A defined area of business, such as a department, division, or unit of an organization 
whose managers are responsible for all direct and indirect costs. 

Credit Limits
A maximum dollar amount for a card account. Also called Limits.

Custom Fields
A field label or field value that a system administrator helps define for a specific 
implementation. PaymentNet offers thousands of editable fields that can be 
modified for each user access role in key categories across an organization, including 
account, employee, merchant, MCC, transaction, and order. Authorized users can 
add fields for data input in several screens for custom data extraction and to require 
cardholder compliance. Custom fields can be included on queries and reports. Each 
custom field has its own set of acceptable characters, such as alphabetic or numeric 
or combination, maximum number of characters, and it can be either a checkbox, 
text box or drop-down list.

Customer Code
Identifies the industry that a supplier is associated with and the specific business the 
supplier performs. With customer code information, PaymentNet can generate 
statements or invoices showing products and services aligned with that code.

CVC, CVV
See Card Verification Codes.

Cycle
A period of time ending on the same date or having the same number of days in the 
cycle. See Billing Cycle.
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Digital Certificate
Acts as a form of electronic identification for electronic communications, serving to 
digitally authenticate that a message originated from the person whose signature is 
attached, and that the message has not been altered either intentionally or 
accidentally since it was signed. The Single-Use Account Web service uses digital 
certificates to establish a secure connection between PaymentNet and clients, and 
to help identify the role and scope of the requestor.

Dispute
To call into question and contend over a transaction on a card account. Disputes can 
be handled online through PaymentNet or through J.P. Morgan's Customer Service.

Employees
Any PaymentNet user role, such as a Cardholder, a Manager, an Auditor, or a Program 
Administrator. 

Export File
Refers to export files that are flat text files (versus relational that contain multiple 
tables of data that relate to each other) used to extract data out of PaymentNet. You 
can download the file and view the details. Export files are typically used to export 
the transaction and credit card data out of PaymentNet and integrate that data into 
an organization’s financial system. Also referred to as a download file or a mapper.

Greeting
Automated services that can be configured to post messages for employees. Program 
administrators use a hierarchy setting to define one or more greeting messages along 
with display start and display end dates. Messages are directed to specific user roles 
and display in a section on the PaymentNet Welcome screen that displays important 
information from both your organization and J.P. Morgan.

Hierarchy
Pyramid-like group structure where every group can have different access, 
permission and roles. PaymentNet supports a vertical limit of 25 levels deep, and no 
horizontal limit. Allows organizations and departments and users to have 
subordinate or parent-child relationships for access and reporting purposes. The top 
category might be the Acme Company. Its subordinate relationships might be the 
three regional offices, and each region might have its own child business units. 
Hierarchy serves two main purposes: It allows an organization to run reports based 
on areas of their organization, like the Acme Company. It also creates an opportunity 
for the company to assign people to parts of the hierarchy and manage their access 
levels within the hierarchy. A hierarchy does not need to match the company’s 
organizational structure. The hierarchy structure can reflect how managers view and 
analyze transaction data. When generating a report, clients can narrow the data to 
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be displayed using either criteria parameters or hierarchy parameters. See Hierarchy 
ID, Children.

Hierarchy ID
Represents an identity within the pyramid-like group structure. The hierarchy ID and 
the child relationships can be added, renamed, and moved, but not deleted from 
PaymentNet. A Hierarchy ID is comprised of two elements: The Hierarchy ID and the 
description. Both are alphanumeric. For example, a Hierarchy ID might be: 10 
Description: SW Division.

Import File
A data management solution to transfer information via an import file. Use an 
import file to transfer data into PaymentNet from an external file. An import allows 
an update or change to 10,000 records per import file. You can import data into 
PaymentNet to update accounting code values, account changes and additions, and 
new users and default accounting codes.

Limits
A maximum dollar amount for a card account. Also called Credit Limits.

Mappers
Electronic files of transaction data originating from the issuer and interfaced with an 
organization’s financial management system, such as a general ledger or enterprise 
resource planning (ERP) system. This extractable data file is in a specific layout and 
format, usually a delimited or fixed-length text or XML file, for importing into 
internal accounting and reporting systems.

Mass Update Request
Apply an update or make a change to common items such as accounts, transactions, 
merchants or users within PaymentNet. An update or change may include applying a 
modified chart of accounts to a specific department.

Merchant
Supplier with whom the organization does business; Purchasing-Card suppliers 
accept P-Cards as payment for goods or services.

Merchant Category Code (MCC)
A four-digit number assigned to a business by MasterCard or Visa. It classifies the 
business by the type of goods or services it provides and allows enhanced merchant 
data to be passed to PaymentNet. Each merchant is responsible for selecting their 
own MCC when they enroll to accept Visa or MasterCard.
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Merchant Category Code Groups (MCCG)
Program administrators define related Merchant Category Codes (MCC) into a group. 
Using an MCCG can help control whether cardholders may purchase from particular 
types of merchants.

Module
Refers to two areas:
1. Elements within PaymentNet such as Transactions, Employees, Accounts, and so 
on. They can be enabled or disabled by hierarchy by the Program Administrator. 
Modules that are not in use by a company would be disabled during the 
implementation.
2. Specific PaymentNet menu settings, accessible from the Administration tab, such 
as hierarchy and its related features, chart of accounts, cycles, mappers, custom 
fields, customer code defaults, report setup, role setup, merchants, merchant 
category codes, merchant category code groups, and aggregator list.

Order
Each Order represents a request for a Single-Use Account number, specifying the 
controls that will be applied to the Single Use Account number being requested, such 
as the credit limit, duration that the account will be active, Merchant Category Code 
Groups (MCCG), etc. Also serves as a place to house any other data that needs to be 
associated with the merchant/vendor payment, such as a client's reconciliation 
data.

Orphaned Transactions
This applies to the Single-Use Account transactions. When a posted transaction does 
not meet the criteria to match to an order, the transaction is referred to as an 
orphaned transaction. It can then be manually matched to an order as long as the 
order has not been reconciled or deactivated, and the transaction’s account number 
matches the account number of the order to which it is being matched. PaymentNet 
has an Orphan Transaction Detail Report which is useful in helping to find orphaned 
transactions.

Page Banner
A hierarchy setting to contain your organization’s logo, or other graphic, and screen 
background color. The graphic and background color will display at the top of each 
PaymentNet screen.

Payments
A module in PaymentNet that allows users to make ACH debit payments directly to 
their credit card accounts or their central bill accounts. The Payments module can 
be disabled for users if payments should not be made to their accounts, for example 
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for purchasing cardholders whose balances are centrally-billed and paid by their 
companies.
2. To pay for a purchase or discharge a debt.

Query
Request specific information from PaymentNet using field labels and values to then 
identify and sort the data relevant to your workflow and management tasks. An 
advanced query allows for detailed searches by criteria, hierarchy, and order by 
fields.

Reconcile
Process of reviewing and comparing card transactions to internal records of 
payments and receipts, including resolving discrepancies and validating or allocating 
transactions to appropriate accounting codes.

Role
See User Access Role.

Second Row of Embossing
Use this optional field to enter up to 21 (for MasterCard) or 19 (for Visa) 
alphanumeric characters that you want embossed or displayed on the second row of 
the credit card. This could be, for example, a department name or business unit 
name that would display below the cardholder name.

Single-Use Accounts
An electronic payment tool that provides an account number for each client 
purchase or payment. The account controls credit limit, Merchant Category Code 
Groups, etc., on those individual accounts that are configured for the specific 
purchase or payment. Once used, the transactions are automatically matched back 
to the account request and updated with any client specific reconciliation 
information, such as purchase order, invoice, receipt data, etc., that was provided 
when the account was requested, simplifying the reconciliation process.

Splits
Dividing transaction information into different lines of accounting so costs are 
allocated to the specific cost centers. This is referred to as Adding Lines to 
transactions in PaymentNet. See Adding Lines.

Statement
Chronological summary of all transactions associated with an account during a stated 
period, and their effect on the account.
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Transaction Allocation
The process of manually or automatically assigning accounting codes to each 
transaction based on transaction defaulting rules for employee, hierarchy, 
merchant, MCC, account, or customer code. Allocating transactions allows 
cardholders to separate an asset's value or expenditures among different 
organizations or line items.

Transactions
When a purchase price of goods or services is sent through a processor for 
authorization; if the amount is approved it is automatically submitted to the seller 
and the purchase amount is then listed on the cardholder’s statement and must be 
repaid. A transaction may also refer to a credit made to the cardholder’s account, 
such as when a good or service is returned for a refund. 

User Access Role
User access roles designate a user’s ability to view transactions and modify 
accounting codes. The access role is a three-part structure defined by role, 
hierarchy ID, and scope. This is how organization’s can manage access rules for 
groups of users. Each group of users is treated as a unit and is assigned permission to 
specific functions in respect to their job. Role management handles authorization, 
which enables program administrators to specify the resources that users are 
allowed to access, including reports.

Web Service
An Internet-facing software application that can receive, process, and respond to 
incoming message requests. Web services communicate using XML messages sent 
across the Internet. J.P. Morgan uses a web service to make PaymentNet Single-Use 
Account functionality available to clients, allowing them to automate the creation, 
modification, deactivation, and inquiry of Orders in PaymentNet.
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ABA routing number, defined, 505
account

applying a rush delivery, 148
creating, 148
status reason, 167

account import
creating a new account, 206
file layout, 194
updating an existing account, 208

Account Import File Layout, 194
account pool, defined, 505
account pool group, defined, 505
Account Request Manager

defined, 505
overview, 351

accounting codes, defined, 506
accounts

defined, 506
running a mass update, 165

add lines
defined, 506
transaction, 281

addendum, defined, 506
address, payment, 331
administration module, defined, 506

advanced query
accounts, 265
employees, 267
merchant category codes, 269
merchants, 270
overview, 264
Single-Use Accounts, 272
transactions, 274

approval rules, defined, 506
arrows, paging, 32
audit, PaymentNet data retention, 38
authentication questions, managing, 113
authorization, defined, 507
automated clearinghouse, defined, 507

B
bank account information

managing, 115
setting up, 331

bank corp, defined, 508
bank information, tab, 115
banner greeting, defined, 510
billing cycle, defined, 507
browser requirements, 20
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C
canceling recurring payment, 337
card verification codes, defined, 507
card verification value, defined, 507
central bill, defined, 508
central bill account request, defined, 508
certificate, defined, 510
chart of account, viewing information, 130
chart of accounts, 130

adding values to, 133
defined, 508
setting up, 132
setting up constraints, 133

chart of accounts import, file layout, 210, 
211

chart of accounts list, viewing, 131
color, customizing page banner, 40, 41, 42
comma-separated values, defined, 508
company number, defined, 508
compliance monitoring

configuring, 66
configuring the questionable merchant 

category codes monitor type, 69
configuring the questionable merchants 

monitor type, 70
configuring the single transaction amounts 

monitor type, 67
configuring the split transactions monitor 

type, 68
defined, 508

constraint, defined, 509
constraints, setting up, 133
contact information, setting up, 46
convenience check, defined, 509
convenience checks

managing, 121
module settings, 348
ordering, 121, 348
overview, 347
stopping payment, 121, 349

conventions, xvii
cost center, defined, 509

credit limits, defined, 509, 511
custom fields

defined, 509
setting up, 79

custom label, 354
custom messages, 31
custom roles, creating, 86
customer code

defaults, 142
defined, 509

customer code defaults
creating, 144
deleting, 145
editing, 144
viewing detail, 143

customer code defaults list, viewing, 142
cycle

creating, 91
deleting, 98
editing, 95
manually creating periods, 94
modifying existing period descriptions, 98
overview, 91
setting up automatic periods, 92

cycles, defined, 509

D
default accounting codes, 135
delivery, applying a rush, 168
digital certificate, defined, 510
display preferences, setting up, 47
dispute, defined, 510

E
email

creating merchant Single-Use Accounts 
orders, 346

setting up notifications, 113
employee import, file layout, 212
Employee Import File Layout, 213
employees role, defined, 510
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export file
configuring, 188
defined, 510
downloading, 190
overview, 187

F
feedback, sending, xviii
flex mapper, See mapper

G
general information, tab, 111
greeting, defined, 510

H
hierarchy

adding an ID, 126
children defined, 508
defined, 510
managing IDs, 125
moving an ID, 127
renaming an ID, 126
viewing information, 123

hierarchy ID
adding, 126
defined, 511
moving, 127
renaming, 126

hierarchy IDs, managing, 125
hierarchy import, file layout, 218, 219
hierarchy information, viewing, 123
hierarchy settings, 40
history

verifying rush card delivery, 171
viewing payment, 338

I
icons, 30
import file

configuring, 192
defined, 511
general tips, 229

import file (continued)
importing into PaymentNet, 228
overview, 187
troubleshooting errors, 231

Import File Failures, 232
Import File Layout Requirements, 193
items awaiting your action, 31

L
limits, defined, 511
Line Item Failures, 233
lists, sorting, 32
logging in, 21
logging on

first time, 22, 23
registered computer, 24
unregistered computer, 25

logging out, 28
logo, customizing page banner, 40, 41, 42

M
making a payment, 333
mapper

changing the status, 255
creating, 236
deleting, 254
downloading, 256
editing, 253
General Information Fields, 242
manually running, 254
Mapper Criteria and Transaction Editing 

Options, 251
Output Fields, 245, 250
overview, 235
Query Criteria Fields, 243, 244
Query Hierarchy Fields, 244
reverse export status, 237

mappers, defined, 511
mass update request, defined, 511
MCC, defined, 511
MCCG, defined, 512
MCCGs, creating, 109
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menu bar, 29
merchant, defined, 511
merchant category code

defined, 511
import file layout, 220

merchant category code group
creating, 109
defined, 512

Merchant Category Code Import File Layout, 
221

merchant import, file layout, 223
messages, welcome page, 42
mobile, J.P. Morgan Commercial Card mobile 

website, xvii
module, defined, 512
modules

disabling, 54
setting up, 48, 49

N
navigating, PaymentNet, 32

O
order, defined, 512
ordering convenience checks, 348
orphaned transactions, defined, 512

P
page banner

customizing, 40, 41, 42
defined, 512

paging arrows, 32
password, changing, 112
payment

canceling recurring, 337
making, 333
scheduling recurring, 336
viewing history, 338

payment address, 331
payment history, viewing, 338
PaymentNet, navigating, 32

payments, 331
defined, 512
recurring, 336

profile, managing, 110
publications, related, xvii

Q
query

defined, 513
deleting, 277
editing, 277
overview, 259
saving, 276
setting a default, 276

quick query
accounts, 260
employees, 261
merchant category codes, 261
merchants, 262
overview, 260
Single-Use Accounts, 263
transactions, 263

R
reconcile, defined, 513
reconciling, Single-Use Accounts orders 

manually, 345
recurring payment

canceling, 337
scheduling, 336

recurring payments, 336
related publications, xvii
report

Account report types, 371
Administration report types, 398
deleting an instance, 326
deleting an output, 326
downloading, 325
Merchant MasterCard report types, 428
Merchant report types, 406
Merchant Visa report types, 434
Order report types, 441
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report (continued)
overview, 317
running in real time, 322
samples by report type, 371
scheduling to run automatically, 323
setting up, 89
Transaction report types, 445

report instance
creating, 318
editing, 321

requirements
browser, 20
system, 20

role, defined, 514
roles, creating custom, 86
rush card delivery

overview, 168
reviewing history, 171

S
scheduling, recurring payment, 336
screen views

setting up, 117
setting up system, 54

Second Row of Embossing, defined, 513
Single-Use Accounts

configuring a merchant email notification, 
73

customizing settings, 71
defined, 513
overview, 71

Single-Use Accounts orders
creating, 340
creating merchant email messages, 346
reconciling manually, 345
viewing details, 343

sorting lists, 32
splits, defined, 513
statement, 327

defined, 513
printing, 329
viewing, 329

status reason, account, 167
stopping payment, convenience checks, 349
system requirements, 20

T
tab, bank information, 115
technical assistance, obtaining, xvi
transaction

allocating, 281
allocation defined, 514
approving, 316
attaching a receipt, 289
attaching multiple receipts, 293
cancelling a dispute, 312
configuring hierarchy settings, 63
defined, 514
deleting a receipt, 300
disputing, 306
editing, 281
managing approvers, 314
managing receipts, 288
overview, 279
PaymentNet data retention, 38
reviewing, 315
reviewing and approving, 314
reviewing audit history, 287
reviewing receipt audit history, 287, 298
reviewing receipts, 296
reviewing vendor addendum details, 284
running a mass update, 285
splitting, 281
viewing, 280
viewing authorizations and declines, 312
viewing flagged, 301

transaction default import, file layout, 225, 
226

U
user access role, defined, 514
user interface, understanding, 29
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W
Web service, defined, 514
welcome page

messages, 42
setting up, 30
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